# Contents

Using This Online Manual .......................................................... 19

Trademarks and Licenses ............................................................ 20

  Connecting Device to Printer Directly (Wireless Direct) .................. 35
  Available Connection Methods .................................................. 36

Handling and Use of Paper ......................................................... 39

  Paper ................................................................. 41
    Types of Paper ......................................................... 42
    Paper Sizes .......................................................... 43
    Using Paper Other Than Genuine Paper and feed confirmed Paper .... 45
    Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings ...... 46
    Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type .... 47
    Updating paper information ........................................... 48

Handling rolls ............................................................... 49

  Loading Rolls on the Roll Holder ............................................. 50
  Loading Rolls in the Printer .................................................. 54
  Changing the Type of Paper .................................................. 62
  Specifying the Paper Length ................................................. 65
  Removing the Roll from the Printer ......................................... 66
  Feeding Roll Paper Manually .................................................. 68
  Keeping Track of the Amount of Roll Paper Left .......................... 69
  Specifying the Ink Drying Time for Rolls ................................... 72
  Specifying the Cutting Method for Rolls .................................... 75
  Cutting the Leading Edge of Roll Paper Automatically .................... 80
  Reducing Dust from Cutting Rolls ........................................... 82
  Detecting Roll Paper was Replaced While the Power was Off .............. 84

Handling sheets ............................................................... 85

  Loading Sheets in the Printer ............................................... 86
  Printing From a Desired Starting Point ..................................... 92
  Removing Sheets .......................................................... 95

Basket ................................................................. 97

  Using the Basket ........................................................ 98
Changing Settings from Operation Panel/Web Browser ..................... 100

Operations and Touch Screen ............................................. 101

Operation Panel ............................................................. 102
Touch Screen ............................................................... 104
Checking Instructions During Printer Operations .......................... 108

Changing Settings from Operation Panel .................................. 110

Printer Menu Operations ................................................... 111
Menu Operations ............................................................. 113
Menu Structure ............................................................... 116

Advanced (Paper settings) .................................................... 131
Advanced (LAN settings) ..................................................... 133

Changing Settings from Operation Panel .................................. 136
Setting Items on Operation Panel ........................................... 138

Job management .............................................................. 139
Test print ........................................................................ 140
Print settings ................................................................. 141

HP-GL/2 Settings ............................................................... 142
LAN settings ................................................................. 143
Other device settings ......................................................... 151
Language selection ........................................................... 153
Paper-related settings ........................................................ 154
Auto maintenance settings ................................................... 156
Administrator password setting ............................................. 157

Setting Administrator Password on Operation Panel .................... 158
Monitoring service settings .................................................. 160
Printer information ........................................................... 161

HP-GL/2 Settings ............................................................... 142

Menus on HP-GL/2 print settings ............................................ 163

Color mode ................................................................. 164
Print quality ................................................................. 165
Input resolution ............................................................. 166
Print target ................................................................. 167
Paper src ................................................................. 168
Margin ................................................................. 169
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oversize</td>
<td>170</td>
</tr>
<tr>
<td>Conserve paper</td>
<td>174</td>
</tr>
<tr>
<td>Rotate</td>
<td>176</td>
</tr>
<tr>
<td>Auto rotation</td>
<td>177</td>
</tr>
<tr>
<td>Enlarge/Reduce</td>
<td>179</td>
</tr>
<tr>
<td>Print centered</td>
<td>182</td>
</tr>
<tr>
<td>Cut to standard size</td>
<td>184</td>
</tr>
<tr>
<td>Mirror</td>
<td>186</td>
</tr>
<tr>
<td>Merge</td>
<td>188</td>
</tr>
<tr>
<td>Smooth</td>
<td>189</td>
</tr>
<tr>
<td>Thicken fine lines</td>
<td>190</td>
</tr>
<tr>
<td>Adjust faint lines</td>
<td>191</td>
</tr>
<tr>
<td>Width correction</td>
<td>192</td>
</tr>
<tr>
<td>Print color list for palettes</td>
<td>194</td>
</tr>
<tr>
<td>Warning display</td>
<td>195</td>
</tr>
<tr>
<td>Detect image size</td>
<td>196</td>
</tr>
<tr>
<td>Select palette</td>
<td>197</td>
</tr>
<tr>
<td>Define palette</td>
<td>198</td>
</tr>
<tr>
<td>Pen 0 to Pen 15</td>
<td>199</td>
</tr>
<tr>
<td>Reset palette</td>
<td>200</td>
</tr>
</tbody>
</table>

Menu Setting Combinations 202

- Conserve paper and Auto rotation 203
- Enlarge/Reduce (Scaling) and Auto rotation 205
- Print centered and Cut to standard size 206
- Cut to standard size and Auto rotation and Enlarge/Reduce (Fit paper size) 208
- Detect image size and Oversize 211
- Detect image size and Print centered 213

Standard Size Table 214

Status Print 216

Changing Printer’s Setting Using Web Browser 218

- Configuration Changes Using Web Browser 219
- Changeable Setting Items Using Web Browser 222
- Setting Password 224
- Registering Printer’s Root Certificate to Web Browser for SSL Communication (Remote UI) 226
- Registering Printer’s Root Certificate to Local Computer for SSL Communication 230
- Generating Server Certificate (Self-signed Certificate) 236
Printing with Easy Setup .......................................................... 488
Setting the Number of Copies and Printing Order ......................... 493
Printing Photos and Business Documents ...................................... 494
  Printing By Setting Print Purpose ............................................. 495
  Edit in PosterArtist and Print ................................................ 498
Printing CAD Drawings .......................................................... 500
  Printing By Setting Print Purpose ............................................. 495
  Printing from AutoCAD ......................................................... 504
Changing the Print Quality and Correcting Image Data ..................... 505
  Adjusting Color Balance ....................................................... 506
  Setting the Print Quality Level (Custom) .................................. 508
  Printing a Color Document in Monochrome ................................ 510
  Specifying Color Correction ................................................ 512
    Optimal Photo Printing of Image Data ..................................... 515
    Adjusting Colors with the Printer Driver ................................ 516
    Printing with ICC Profiles ................................................ 519
  Adjusting Brightness .......................................................... 524
  Adjusting Contrast ............................................................ 526
  Printing Using Detailed Setting Mode ...................................... 528
Scaled Printing ........................................................................ 531
Printing to Oversized Paper Sizes .............................................. 533
Setting Paper Dimensions (Custom Size) ...................................... 536
Set a Custom Size Roll Width .................................................. 540
Printing without Edges Based on the Scenarios ............................... 542
  Printing without Margins to Match Paper Size ............................ 543
  Printing without Margins to Match Roll Paper Width .................... 546
  Printing Full-Size without Margins ......................................... 548
  Three-sided Borderless Printing on Roll Paper ........................... 550
Printing Hanging and Horizontal Banners (Large-Format Printing) .... 555
Printing by Dividing/Joining Documents ...................................... 557
  Lining Up and Printing Multiple Documents to Cut Sheets ............. 558
  Printing by Connecting Multiple Pages .................................... 560
  Printing Multiple Pages All on One Page .................................. 561
  Dividing and Printing Posters ............................................... 563
Printing Document in Center of Paper ........................................ 566
Printing by Saving Roll Paper. ................................................................. 569
  Saving Roll Paper by Rotating Document 90 Degrees. .................. 570
  Saving Roll Paper by Eliminating Upper and Lower Margins on Document. .................. 573
Switching the Paper Source to Match the Purpose. .......................... 576
Displaying the Print Results before Printing. .................................. 578
Other Convenient Settings. ................................................................. 579
  Stamp Printing. .......................................................... 580
    Registering a Stamp. .................................................. 581
  Setting a Page Size and Orientation. ........................................... 584
  Registering a Frequently Used Printing Profile. .......................... 585
  Cutting Roll Paper after Printing. ............................................. 587
HP-GL/2 Printing. .......................................................... 589
Printing from Smartphone/Tablet. ............................................... 590
  Connecting Smartphone/Tablet to Printer Directly (Wireless Direct). .... 591
Windows Software. .......................................................... 595
Printer Driver. .......................................................... 596
  Overview of the Printer Driver. .................................................. 597
    Canon IJ Printer Driver. ............................................. 598
    Changing the Print Options. ............................................. 599
    Canon imagePROGRAF Preview. ........................................ 600
    How to Open the Printer Driver Setup Window. ........................ 601
    Updating Media Information in Printer Driver. ........................ 602
    Setting Accounting Information. ..................................... 603
    Deleting the Undesired Print Job. ..................................... 605
    Canon IJ Status Monitor. ............................................. 606
      Checking the Ink Status from Your Computer. ......................... 608
    Instructions for Use (Printer Driver). .................................. 609
Printer Driver Description. ......................................................... 613
  Main Tab Description. ......................................................... 614
  Page Setup Tab Description. .................................................. 621
  Layout Tab Description. ...................................................... 626
  Favorites Tab Description. .................................................... 632
  Maintenance Tab Description. ................................................ 634
  Device Settings Tab Description. ............................................ 636
Paper is not cut. .......................................................... 683
Cutter Blade Does Not Work While Cutting Is in Progress. .... 684
Dent in the Tip of Paper. .............................................. 685
The size of clear film cannot be detected. ......................... 686
Printer Keeps Ejecting the Roll Paper. ......................... 687
Margins are wide. ...................................................... 689
When printing on roll paper, the printed surface becomes scratched. .................................................. 690

Printing Does Not Start. ........................................... 691
Printer Suddenly Stopped Working for Some Reason. .... 692
The Data lamp on the Operation Panel does not light up. ... 697
The printer does not respond even if print jobs are sent. ... 698
"Preparing the ink system." is displayed. ....................... 699
"Agitating the ink" is displayed. .................................. 700

The Printer Stops During a Print Job. ......................... 701
Printing stops and an error message is displayed. ........... 702
The printer ejects blank, unprinted paper. ..................... 703

Problems with the Printing Quality. ......................... 704
Printing is faint. .................................................... 705
Paper rubs against the Print Head. ............................. 707
The edges of the paper are dirty. .............................. 709
The surface of the paper is dirty. .............................. 711
The back side of the paper is dirty. ............................ 712
Immediately after borderless printing, the trailing edge margin is soiled during regular printing. .......... 713
Printed colors are inaccurate. ................................... 714
Banding in different colors occurs. ........................... 715
Colors in printed images are uneven. ......................... 717
Image edges are blurred or white banding occurs. .......... 719
The contrast becomes uneven during printing. .............. 720
The length of printed images is inaccurate in the feeding direction. .................................................. 721
Images are printed crooked. ..................................... 722
Documents are printed in monochrome. ....................... 723
Line thickness is not uniform. .................................. 724
Lines or colors are misaligned. .................................. 725
Borders appear in borderless printing. ....................... 726
Cannot Specify Extension for borderless printing After Warning Message. ............................. 727

Cannot Print over Network. ..................................... 728
Cannot Connect Printer to Network. ......................................................... 729
Cannot Print over TCP/IP Network. ......................................................... 730
Cannot Print over Bonjour networks. ....................................................... 731

Cannot Find Printer on Network. ........................................................... 732
Cannot Find Printer on Check Printer Settings Screen (Windows). .......... 733
Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen. 734
Searching Printer by IP Address or Host Name During Setup. ................. 736
Cannot Find Printer while Using Wi-Fi. .................................................. 740
Cannot Find Printer while Using Wired LAN. ......................................... 743
Cannot Print Using AirPrint. ................................................................... 744

Installation Problems. ........................................................................... 745
Removing Printer Software. ..................................................................... 746
Taking Time to Setup Process (Windows). .............................................. 748
Failed to Printer Driver Installation (Windows). ..................................... 749

HP-GL/2 problems. .................................................................................... 751
With HP-GL/2, printing is misaligned. ...................................................... 752
Lines or images are missing in printed HP-GL/2 jobs. ......................... 753
Lines are printed too thick or thin in HP-GL/2 print jobs. ...................... 754
HP-GL/2 jobs are printed in monochrome (or color). .............................. 755
Printed colors of lines are inaccurate during HP-GL/2 printing. .............. 756
HP-GL/2 jobs are printed 6 mm larger than specified. ......................... 757
HP-GL/2 jobs are printed at maximum size, even if a standard size is specified. 758
HP-GL/2 printing takes a long time. ......................................................... 759
The printer stops when printing a HP-GL/2 job (the carriage stops moving). 760

Other Problems. ....................................................................................... 761
Printer does not turn on. ....................................................................... 762
If the Printer Makes a Strange Sound. ..................................................... 763
Messages advising to check the maintenance cartridge are not cleared. .... 765
Printer consumes a lot of ink. ................................................................. 766
Ink Level Detection. ............................................................................... 767

List of Support Code for Error. ............................................................... 768
1005. ................................................................................................. 770
100A. ................................................................................................. 771
1012. ............................................................................................... 772
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6941</td>
<td>907</td>
</tr>
<tr>
<td>6942</td>
<td>908</td>
</tr>
<tr>
<td>6943</td>
<td>909</td>
</tr>
<tr>
<td>6944</td>
<td>910</td>
</tr>
<tr>
<td>6945</td>
<td>911</td>
</tr>
<tr>
<td>6946</td>
<td>912</td>
</tr>
<tr>
<td>7050</td>
<td>913</td>
</tr>
<tr>
<td>7051</td>
<td>914</td>
</tr>
<tr>
<td>7052</td>
<td>915</td>
</tr>
<tr>
<td>8200</td>
<td>916</td>
</tr>
<tr>
<td>9000</td>
<td>917</td>
</tr>
<tr>
<td>9110</td>
<td>918</td>
</tr>
<tr>
<td>B20A</td>
<td>919</td>
</tr>
<tr>
<td>B510</td>
<td>920</td>
</tr>
</tbody>
</table>
Using This Online Manual

➡ Symbols Used in This Document
➡ Touch-enabled Device Users (Windows)

Symbols Used in This Document

⚠️ Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by incorrect operation of the equipment. These must be observed for safe operation.

⚠️ Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect operation of the equipment. These must be observed for safe operation.

➡➡ Important
Instructions including important information that must be observed to avoid damage and injury or improper use of the product. Be sure to read these instructions.

➡➡ Note
Instructions including notes for operation and additional explanations.

🎉 Basics
Instructions explaining basic operations of your product.

➡➡ Note
• Icons may vary depending on your product.

Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating system. For example, if the action is set to "press and hold" on your operating system, replace "right-click" with "press and hold."
Trademarks and Licenses

- Microsoft is a registered trademark of Microsoft Corporation.
- Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.
- Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.
- Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.
- Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other countries.
- IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.
- Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and Google Play Logo are trademarks of Google LLC.
- Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.
- Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries.
- USB Type-C™ is a trademark of USB Implementers Forum.

Note

- The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2015 Apple Inc. All rights reserved.
Redisistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.
2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or Object form, provided that You meet the following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files; and
3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and
4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.
7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----
Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved
Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appears in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of CMU and The Regents of the University of California not be used in advertising or publicity pertaining to distribution of the software without specific written permission.
CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.
 Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS` AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

--- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER `AS IS` AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

--- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright c 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All rights reserved.
Use is subject to license terms below.
This distribution may include materials developed by third parties.
Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2012, Sparta, Inc
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of their contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com

Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----
Copyright (c) 2007 Apple Inc. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
   following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
   the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
   promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: ScienceLogic, LLC copyright notice (BSD) -----
Copyright (c) 2009, ScienceLogic, LLC
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
  following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
  following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse or
  promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

LEADTOOLS
Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

-----------------------------------------------------------
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-----------------------------------------------------------
MIT License

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University

Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.

COPYRIGHT (c) 1989-2000.

On-Line Applications Research Corporation (OAR).

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

(1) Red Hat Incorporated
Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.
This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it subject to the terms and conditions of the BSD License. This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or documentation are not subject to the BSD License and may only be used or replicated with the express permission of Red Hat, Inc.

(2) University of California, Berkeley
Copyright (c) 1981-2000 The Regents of the University of California.
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE
-----------------------------
2006-Jan-27
Copyright 1996-2002, 2006 by
David Turner, Robert Wilhelm, and Werner Lemberg
Introduction
============
The FreeType Project is distributed in several archive packages; some of them may contain, in addition to the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit license. The license affects thus the FreeType font engine, the test programs, documentation and makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which all encourage inclusion and use of free software in commercial and freeware products alike. As a consequence, its main points are that:

- We don't promise that this software works. However, we will be interested in any kind of bug reports. (`as is' distribution)
- You can use this software for whatever you want, in parts or full form, without having to pay us. (`royalty-free' usage)
- You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you must acknowledge somewhere in your documentation that you have used the FreeType code. (`credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this license. We thus encourage you to use the following text:

---

Portions of this software are copyright © <year> The FreeType Project (www.freetype.org). All rights reserved.

---

Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

= 0. Definitions

= -----------

0. Definitions

= -----------

Throughout this license, the terms `package', `FreeType Project', and `FreeType archive' refer to the set of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the `FreeType Project', be they named as alpha, beta or final release.

`You' refers to the licensee, or person using the project, where `using' is a generic term including compiling the project's source code as well as linking it to form a `program' or `executable'.

This program is referred to as `a program using the FreeType engine'.

This license applies to all files distributed in the original FreeType Project, including all source code, binaries and documentation, unless otherwise stated in the file in its original, unmodified form as distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify this.
The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg. All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED `AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute, perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project (in both source and object code forms) and derivative works thereof for any purpose; and to authorize others to exercise some or all of the rights granted herein, subject to the following conditions:

- Redistribution of source code must retain this license file (`FTL.TXT') unaltered; any additions, deletions or changes to the original files must be clearly indicated in accompanying documentation. The copyright notices of the unaltered, original files must be preserved in all copies of source files.
- Redistribution in binary form must provide a disclaimer that states that the software is based in part of the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial, advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software in your documentation or advertising materials: 'FreeType Project', 'FreeType Engine', 'FreeType library', or 'FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project is copyrighted material, only this license, or another one contracted with the authors, grants you the right to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and accept all the terms of this license.

4. Contacts

There are two mailing lists related to FreeType:

- freetype@nongnu.org
Discusses general use and applications of FreeType, as well as future and wanted additions to the library and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.

Our home page can be found at
http://www.freetype.org

--- end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly disclaim all implied, express or statutory warranties including, without limitation, the implied warranties of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++

Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The following applies only to products supporting Wi-Fi.

(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer in the documentation or other materials provided with the distribution.
* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Connecting Device to Printer Directly (Wireless Direct)

The printer supports "wireless direct" in which you can connect to the printer wirelessly from devices (e.g. smartphone, or tablet) without a wireless router.

Switch to "wireless direct" to print wirelessly.

→ Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)
Available Connection Methods

The following four connection methods are available on the printer.

Wi-Fi Connection

- With a wireless router

- Without a wireless router

Wired LAN Connection (Ethernet Cable)

USB Connection (USB Cable)

Wi-Fi Connection

There are two methods for connecting the printer to your device (e.g. smartphone or tablet). One method is to connect using a wireless router, and the other method is to connect without using a wireless router. The two connection methods cannot be used at the same time.
If you have a wireless router, we recommend using a wireless router.

When connecting another device while a device is already connected to the printer, connect it using the same connection method as the connected device.

If you connect using a different connection method, the connection to the device in use will be disabled.

• **Connection Using a Wireless Router**

  ◦ Connect the printer and a device using a wireless router.
  ◦ The connection procedure varies depending on the type of wireless router.
  ◦ You can change the network settings such as SSID and security protocol used by the printer from the printer.
  ◦ When the connection between a device and a wireless router is completed and 📱 (Wi-Fi icon) is displayed in the device's screen, you can connect the device to the printer using the wireless router.

• **Connection without Using a Wireless Router**

  ◦ Connect the printer and a device without using a wireless router. Connect the device and the printer directly using the printer's wireless direct.
  ◦ If you connect a device connected to the Internet via a wireless router to the printer that is in the wireless direct, the connection between the device and wireless router will be disabled. In that case, the connection of the device may switch to a mobile data connection automatically depending on your device. Transmission fees for connecting to the Internet using a mobile data connection apply.
  ◦ In the wireless direct, you can connect up to five devices at the same time. If you try to connect another device while five devices are already connected, disconnect a device you do not use and configure settings again.
  ◦ Network settings such as the SSID and security protocol are specified automatically.
Wired LAN Connection (Ethernet Cable)
Connect the printer and a hub or router with an Ethernet cable. Prepare an Ethernet cable.

USB Connection (USB Cable)
Connect the printer and a computer with a USB cable. Prepare a USB cable.

• Restrictions
Handling and Use of Paper

➤ Paper

- Types of Paper
- Paper Sizes
- Using Paper Other Than Genuine Paper and feed confirmed Paper
- Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings
- Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type
- Paper Information List
- Updating paper information

➤ Handling rolls

- Loading Rolls on the Roll Holder
- Loading Rolls in the Printer
- Changing the Type of Paper
- Specifying the Paper Length
- Removing the Roll from the Printer
- Removing Rolls From the Roll Holder
- Remove Jammed Roll Paper
- Feeding Roll Paper Manually
- Keeping Track of the Amount of Roll Paper Left
- Specifying the Ink Drying Time for Rolls
- Specifying the Cutting Method for Rolls
- Cutting the Leading Edge of Roll Paper Automatically
- Reducing Dust from Cutting Rolls
- Detecting Roll Paper was Replaced While the Power was Off

➤ Handling sheets
- Loading Sheets in the Printer
- Changing the Type of Paper
- Printing From a Desired Starting Point
- Removing Sheets
- Remove a Jammed Sheet

➤ Basket
- Using the Basket

➤ Media Configuration Tool Guide
Paper

- Types of Paper
- Paper Sizes
- Using Paper Other Than Genuine Paper and feed confirmed Paper
- Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings
- Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type
- Paper Information List
- Updating paper information
Types of Paper

The following media types are supported by the printer. For details on the media types supported by the printer, see "Paper Information List."

- Plain Paper
- Coated Paper
- Photo Paper
- Glossy Paper
- Proofing Paper
- CAD-dedicated Paper Etc.

The Paper Information List includes the following information.

- Types of paper
- Paper handling
- Paper product specifications
- Use precautions
- Setting of printer driver, operation panel etc.

Note

- For instructions on using paper not included in the Paper Information List, see "Using Paper Other Than Genuine Paper and feed confirmed Paper."

Method of Updating Supported Paper

Paper that is supported by the printer may be newly released on the Canon website.

To use newly released paper, register the latest paper information on the printer with the Media Configuration Tool. (See "Updating paper information."

Important

- Even if you are not using the printer driver, you should install the Media Configuration Tool in order to register the media types for your region in the printer.

(See "Media Configuration Tool Guide" (Windows).)

(See "Media Configuration Tool Guide" (macOS).)
Rolls

Rolls that meet the following conditions are supported.

- Outer diameter is 5.9 inches (150 mm) or less
- Inner diameter of paper core: 2 or 3 inches
- Printing side out

<table>
<thead>
<tr>
<th>Roll Width</th>
<th>Printer Driver Roll Paper Width Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>24.00 inches (609.6 mm)</td>
<td>24 in Roll (609.6mm)</td>
</tr>
<tr>
<td>23.62 inches (600.0 mm)</td>
<td>600mm Roll (600.0mm)</td>
</tr>
<tr>
<td>23.39 inches (594.0 mm)</td>
<td>A1/A2 Roll (594.0mm)</td>
</tr>
<tr>
<td>22.00 inches (558.8 mm)</td>
<td>22 in Roll (558.8mm)</td>
</tr>
<tr>
<td>20.28 inches (515.0 mm)</td>
<td>B2/B3 Roll (515.0mm)</td>
</tr>
<tr>
<td>20.00 inches (508.0 mm)</td>
<td>20 in Roll (508.0mm)</td>
</tr>
<tr>
<td>19.69 inches (500.0 mm)</td>
<td>500mm Roll (500.0mm)</td>
</tr>
<tr>
<td>18.00 inches (457.2 mm)</td>
<td>18 in Roll (457.2mm)</td>
</tr>
<tr>
<td>17.00 inches (431.8 mm)</td>
<td>17 in Roll (431.8mm)</td>
</tr>
<tr>
<td>16.54 inches (420.0 mm)</td>
<td>A2/A3 Roll (420.0mm)</td>
</tr>
<tr>
<td>16.00 inches (406.4 mm)</td>
<td>16 in Roll (406.4mm)</td>
</tr>
<tr>
<td>14.00 inches (355.6 mm)</td>
<td>14 in Roll (355.6mm)</td>
</tr>
<tr>
<td>12.95 inches (329.0 mm)</td>
<td>A3+ Roll (329.0mm)</td>
</tr>
<tr>
<td>12.00 inches (304.8 mm)</td>
<td>12 in Roll (304.8mm)</td>
</tr>
<tr>
<td>11.81 inches (300.0 mm)</td>
<td>300mm Roll (300.0mm)</td>
</tr>
<tr>
<td>11.69 inches (297.0 mm)</td>
<td>A3/A4 Roll (297.0mm)</td>
</tr>
<tr>
<td>10.12 inches (257.0 mm)</td>
<td>B4 Roll (257.0mm)</td>
</tr>
<tr>
<td>10.00 inches (254.0 mm)</td>
<td>10 in Roll (254.0mm)</td>
</tr>
<tr>
<td>8.00 inches (203.2 mm)</td>
<td>8 in Roll (203.2mm)</td>
</tr>
</tbody>
</table>

Sheets

Sheets of the following sizes are supported.
<table>
<thead>
<tr>
<th>Paper Sizes</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2</td>
<td>16.54 x 23.39 inches (420.0 x 594.0 mm)</td>
</tr>
<tr>
<td>A3</td>
<td>11.69 x 16.54 inches (297.0 x 420.0 mm)</td>
</tr>
<tr>
<td>A3+</td>
<td>12.95 x 19.02 inches (329.0 x 483.0 mm)</td>
</tr>
<tr>
<td>A4</td>
<td>8.27 x 11.69 inches (210.0 x 297.0 mm)</td>
</tr>
<tr>
<td>ISO B3</td>
<td>13.90 x 19.69 inches (353.0 x 500.0 mm)</td>
</tr>
<tr>
<td>ISO B4</td>
<td>9.84 x 13.90 inches (250.0 x 353.0 mm)</td>
</tr>
<tr>
<td>JIS B3</td>
<td>14.33 x 20.28 inches (364.0 x 515.0 mm)</td>
</tr>
<tr>
<td>JIS B4</td>
<td>10.12 x 14.33 inches (257.0 x 364.0 mm)</td>
</tr>
<tr>
<td>17&quot;x22&quot; (ANSI C)</td>
<td>17.00 x 22.00 inches (431.8 x 558.8 mm)</td>
</tr>
<tr>
<td>11&quot;x17&quot; (Ledger)</td>
<td>11.00 x 17.00 inches (279.4 x 431.8 mm)</td>
</tr>
<tr>
<td>13&quot;x19&quot; (Super B)</td>
<td>13.00 x 19.00 inches (330.2 x 482.6 mm)</td>
</tr>
<tr>
<td>Letter (8.5&quot;x11&quot;)</td>
<td>8.50 x 11.00 inches (215.9 x 279.4 mm)</td>
</tr>
<tr>
<td>Legal (8.5&quot;x14&quot;)</td>
<td>8.50 x 14.00 inches (215.9 x 355.6 mm)</td>
</tr>
<tr>
<td>12&quot;x18&quot; (ARCH B)</td>
<td>12.00 x 18.00 inches (304.8 x 457.2 mm)</td>
</tr>
<tr>
<td>9&quot;x12&quot; (ARCH A)</td>
<td>9.00 x 12.00 inches (228.6 x 304.8 mm)</td>
</tr>
<tr>
<td>DIN C3</td>
<td>12.76 x 18.03 inches (324.0 x 458.0 mm)</td>
</tr>
<tr>
<td>DIN C4</td>
<td>9.02 x 12.76 inches (229.0 x 324.0 mm)</td>
</tr>
<tr>
<td>14&quot;x17&quot;</td>
<td>14.00 x 17.00 inches (355.6 x 431.8 mm)</td>
</tr>
<tr>
<td>12&quot;x16&quot;</td>
<td>12.00 x 16.00 inches (304.8 x 406.4 mm)</td>
</tr>
<tr>
<td>10&quot;x12&quot;</td>
<td>10.00 x 12.00 inches (254.0 x 304.8 mm)</td>
</tr>
<tr>
<td>10&quot;x15&quot;</td>
<td>10.00 x 15.00 inches (254.0 x 381.0 mm)</td>
</tr>
<tr>
<td>US Photo 16&quot;x20&quot;</td>
<td>16.00 x 20.00 inches (406.4 x 508.0 mm)</td>
</tr>
<tr>
<td>13&quot;x22&quot;</td>
<td>12.95 x 21.97 inches (329.0 x 558.0 mm)</td>
</tr>
</tbody>
</table>

**Note**

- Borderless printing is not supported on sheets.
Using Paper Other Than Genuine Paper and feed confirmed Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use paper that meets the following conditions.

**Note**

- For Canon genuine paper/feed confirmed paper, see "Paper Information List."

- Paper where the size is described in "Paper Sizes" (See "Paper Sizes.")
- Paper where the thickness is described in "Paper Thickness" in "Specifications" (See "Specifications.")
- Paper where bleeding and ink overflow does not occur when printing
- Paper that does not warp severely when loading the paper or printing

**Important**

- If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides absolutely no guarantees regarding print quality or paper feed properties. For Canon genuine paper/feed confirmed paper, see "Paper Information List."

After loading the paper in the printer, select the media type in the operation panel and printer driver and then perform the printing. For the media type, you can select easily from existing settings or you can create and use settings for the paper you are using.

**Printing Using Existing Settings**

You can print easily by selecting from existing settings provided in the printer operation panel and printer driver. (See "Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings.")

**Printing Using Additional Settings**

You can use the Media Configuration Tool function for adding custom paper to create settings suitable for non-Canon genuine paper/feed confirmed paper and add as a new media type to the printer’s Operation Panel and the printer driver for printing. (See "Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type.")
Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making complicated settings by selecting the existing settings provided in the printer operation panel and printer driver depending on the media type you are using. The existing settings consist of general-purpose paper settings provided for different media types.

Important

• The Canon genuine paper settings provided in the printer operation panel and printer driver are optimized for Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other than Canon genuine paper and feed confirmed paper, we recommend that you select one of the following general-purpose paper settings.

Note

• For an overview of the media types, see "Types of Paper."

• For instructions on selecting the media type with the operation panel, see "Types of Paper". For instructions on selecting the media type with the printer driver, see "How to Open the Printer Driver Setup Window" (Windows) or "How to Open the Printer Driver Setup Dialog" (macOS).

Choosing General-Purpose Paper Settings

These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For details on the relationships between the conditions of paper other than Canon genuine paper and feed confirmed paper and the media type to select, see "Paper Information List."

Note

• If you cannot obtain the desired results by selecting the general-purpose paper settings, use the custom paper adding function in Media Configuration Tool to create settings suitable for the paper you are using. For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type."
Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than when printing with general-purpose settings. You can use this function to configure settings such as the amount of ink used and the height of the print head according to the characteristics of the paper being used, and thereby realize higher print quality. Also, you can add the settings created with this function as a new media type to the printer operation panel and printer driver.

For details on Media Configuration Tool, refer as follows.

- Media Configuration Tool Guide (Windows)
- Media Configuration Tool Guide (macOS)

**Important**

- For details on how to select the added media type in the operation panel, see "Changing the Type of Paper."

- You can select the media type to be used in printing from Media Type in the Main sheet (Windows) or Quality & Media (macOS) in the printer driver. For details, see "Main Tab Description" (Windows) or "Quality & Media" (macOS).

- We recommend that you use an ICC profile created using commercially available profile creation software to perform color management accurately on paper other than Canon genuine paper and feed confirmed paper. You can register the ICC profile you created when creating a custom paper with Media Configuration Tool.

(See "Adding Custom Paper" (Windows).)

(See "Adding Custom Paper" (macOS).)
**Updating paper information**

You can update the printer's media information to the latest information by applying the latest version of the Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.

- Media Configuration Tool Guide (Windows)
- Media Configuration Tool Guide (macOS)

**Important**

- If you are using the Media Configuration Tool, the new Media Information File is downloaded automatically when released on the Canon website. A computer connected to the Internet is required to download the Media Information File.
Handling rolls

- Loading Rolls on the Roll Holder
- Loading Rolls in the Printer
- Changing the Type of Paper
- Specifying the Paper Length
- Removing the Roll from the Printer
- Removing Rolls From the Roll Holder
- Remove Jammed Roll Paper
- Feeding Roll Paper Manually
- Keeping Track of the Amount of Roll Paper Left
- Specifying the Ink Drying Time for Rolls
- Specifying the Cutting Method for Rolls
- Cutting the Leading Edge of Roll Paper Automatically
- Reducing Dust from Cutting Rolls
- Detecting Roll Paper was Replaced While the Power was Off
Loading Rolls on the Roll Holder

When printing on roll paper, attach the roll paper to the roll holder.

Roll paper comes in two types: 2-inch and 3-inch cores. If using 3-inch core roll paper, attach the 3-inch paper core attachment to the roll holder and holder stopper.

⚠️ Caution

- Set the roll on its side on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and dropping a roll may cause injury.

➡️ Important

- When handling the roll, be careful not to soil the printing surface. This may affect the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.
- Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding problems and affect the printing quality. Be careful not to cut through any barcodes printed on the roll.
- Align the edges of the paper on both ends of the roll. This may cause feeding problems.
- If a feeding problem occurs, release the release lever and reload the roll paper.

➡️ Note

- For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information List".

➡️ Watch the movie
1. Rotate the holder stopper lever (A) towards 1 to release the lock, and while holding it in position (B), remove holder stopper from the roll holder.

2. If using 3-inch core paper, align 3-inch paper core attachment R tabs (A) with roll holder holes (B) and insert firmly.

3. With leading edge of roll paper facing forward as shown, insert Roll Holder from right side of roll. Insert firmly until roll paper touches flange (A) of roll holder.
**Important**

- When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage the roll holder.
- If you stand the roll holder vertically and set the roll paper by dropping, the roll holder may be damaged.

4. If using 3-inch core roll paper, attach 3-inch paper core attachment L to holder stopper.

   Align the tabs (A) of the attachment with the holes (B) of the holder stopper, and insert firmly.

5. Insert holder stopper from left into roll holder as shown, and then while holding in position (B), push firmly until holder stopper flange (A) touches roll paper. Lock the holder stopper lever (C) by rotating it towards 🔒.
Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

**Important**

- Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover.")

**Watch the movie**

1. Tap **Load paper** or **Replace paper** on the Home screen of the operation panel.

   **Note**
   - If the Home screen does not appear, tap the **HOME** button.

2. Tap **Load roll paper**.

   **Note**
   - If any paper has been advanced that will not be used, a message is shown requesting you to remove it.
   
   After following the instructions on the screen to remove the paper, go to the next step.

3. Holding the roll holder flange (A), rest the roll holder shaft on the roll holder resting ledge (B).

   At this time, position the holder as shown in the illustration so that the R label (C) on the roll holder flange is aligned with the R label (D) on the printer.
4. Holding the roll holder flange (A), guide the holder along the slide guides (B) on both ends, keeping the holder level as you load it in the roll holder slot.

**Caution**

- Do not force the roll holder into the printer with the right and left ends reversed. This may damage the printer and roll holder.
- Do not release the flanges until the holder is loaded in the roll holder slot.
• Be careful not to pinch your fingers between the slide guides (B) and the roll holder shaft (C) when loading rolls.

**Important**

- If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the leading edge of the roll paper with scissors or the like and straighten it.
- Load the roll paper so that it is not loaded in the opposite direction.

5. Insert the edge of the roll in the feed slot (A) and advance the roll until you hear the feed tone.

**Important**

- If the roll paper has become unwound, remove the slack before loading the roll paper.
- Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.
- If the paper is wrinkled or warped, straighten it out before loading it.
- Load the roll so that there is no gap between the right edge of the paper and the roll holder.
6. After paper feeding has started, do the following operations based on the Manage remaining roll amount setting and the barcode printed on the roll paper (see "Keeping Track of the Amount of Roll Paper Left").

- When selecting Disable or Warning message only in Manage remaining roll amount.
  A menu for selecting the media type appears on the operation panel. Operate the operation panel and select the media type to be used.

- When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.
  The type and amount of paper left is automatically detected based on the barcode printed on the roll. There is no need to specify the type and length of the paper.

- When selecting Barcodes in Manage remaining roll amount and if the barcode is not printed.
  A menu for selection of the media type and length is shown on the operation panel. Operate the operation panel, select the media type to be used, and enter its length.

>>> Important

- When selecting Enable in Keep media type, there is no need to specify the type of the paper.
- Cut the edge of the roll using the Cut paper function if the edge is creased or soiled. (See "Specifying the Cutting Method for Rolls.")
- When selecting the media type on the operation panel, make sure the media type set in the printer driver and the media type loaded on the printer match.

>>> Note

- For details on media types that you can select, see "Paper Information List."
- Cut the edge of the roll after the paper is advanced if it is soiled or if there are cuts from scissors or the blade after removing creased edges. (See "Specifying the Cutting Method for Rolls.")
- Adjusting the printhead alignment with the type of paper to be used in printing may enhance printing quality. (See "Automatic Adjustment to Straighten Lines and Colors."
Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

**Important**

- Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover".)

**Watch the movie**

1. Tap **Load paper** or **Replace paper** on the Home screen of the operation panel.

   ![Load paper on Home screen](image)

   **Note**
   
   - If the Home screen does not appear, tap the **HOME** button.

2. Tap **Load roll paper**.

   **Note**
   
   - If any paper has been advanced that will not be used, a message is shown requesting you to remove it.
     
     After following the instructions on the screen to remove the paper, go to the next step.

3. Holding the roll holder flange (A), rest the roll holder shaft on the roll holder resting ledge (B).

   At this time, position the holder as shown in the illustration so that the R label (C) on the roll holder flange is aligned with the R label (D) on the printer.
4. Holding the roll holder flange (A), guide the holder along the slide guides (B) on both ends, keeping the holder level as you load it in the roll holder slot.

⚠️ **Caution**

- Do not force the roll holder into the printer with the right and left ends reversed. This may damage the printer and roll holder.
- Do not release the flanges until the holder is loaded in the roll holder slot.
• Be careful not to pinch your fingers between the slide guides (B) and the roll holder shaft (C) when loading rolls.

**Important**

• If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the leading edge of the roll paper with scissors or the like and straighten it.

• Load the roll paper so that it is not loaded in the opposite direction.

5. Insert the edge of the roll in the feed slot (A) and advance the roll until you hear the feed tone.

**Important**

• If the roll paper has become unwound, remove the slack before loading the roll paper.

• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.

• Load the roll so that there is no gap between the right edge of the paper and the roll holder.
6. After paper feeding has started, do the following operations based on the **Manage remaining roll amount** setting and the barcode printed on the roll paper (see "Keeping Track of the Amount of Roll Paper Left").

- **When selecting Disable or Warning message only in Manage remaining roll amount.**

  A menu for selecting the media type appears on the operation panel. Operate the operation panel and select the media type to be used.

- **When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.**

  The type and amount of paper left is automatically detected based on the barcode printed on the roll. There is no need to specify the type and length of the paper.

- **When selecting Barcodes in Manage remaining roll amount and if the barcode is not printed.**

  A menu for selection of the media type and length is shown on the operation panel. Operate the operation panel, select the media type to be used, and enter its length.

  **Important**

  - When selecting **Enable** in **Keep media type**, there is no need to specify the type of the paper.
  - Cut the edge of the roll using the **Cut paper** function if the edge is creased or soiled. (See "Specifying the Cutting Method for Rolls.")
  - When selecting the media type on the operation panel, make sure the media type set in the printer driver and the media type loaded on the printer match.

  **Note**

  - For details on media types that you can select, see "Paper Information List."
  - Cut the edge of the roll after the paper is advanced if it is soiled or if there are cuts from scissors or the blade after removing creased edges. (See "Specifying the Cutting Method for Rolls.")
  - Adjusting the printhead alignment with the type of paper to be used in printing may enhance printing quality. (See "Automatic Adjustment to Straighten Lines and Colors.")
Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

If you continue using the same type of paper and set Keep media type to Enable, when you load paper, the media type selected before Enable was set is selected automatically, eliminating the need to set the media type. (See "Using the Same Type of Paper Regularly.")

**Important**

- For best printing results, the printer fine-tunes the print head height and the feed amount for each type of paper. Be sure to select the type of paper to use correctly before printing.
- Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of printed images may vary depending on the type of paper used. If margins and the size of images are not as you expected, adjust the paper feed amount. (See "Adjusting Feed Amount.")
- Rolls and sheets have different printing areas, and sheets having a larger bottom margin than rolls. (See "Print Area.")

**Changing the Type of Paper**

**Note**

- When you load roll paper, a menu for selecting the media type appears on the operation panel. Tap the media type.

If no barcode has been printed on the roll paper and you have set Manage remaining roll amount to Barcodes, specify the roll length after selecting the media type. (See "Specifying the Paper Length.")

1. Tap paper settings display area on Home screen of operation panel.

![Ready to print](image)

**Note**

- If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.

3. Tap Type.
4. Tap media type of roll paper loaded in printer.

5. Tap Register.

**Important**

- Be sure to select the correct paper type. If this setting does not match the loaded paper, it may cause feed errors and affect printing quality.

**Note**

- For details on media types, see "Paper Information List." At the factory default settings, Plain Paper is selected for the media type.
- When the release lever is operated, the settings automatically return to the last selected media type.

### Using the Same Type of Paper Regularly

Configure this setting so that current media type settings will be automatically selected when you load the same type of paper later.

1. Tap (Setup) on Home screen of operation panel.

   **Note**

   - If the Home screen does not appear, press the HOME button.

2. Tap Device settings.

3. Tap Paper-related settings.

4. Tap Keep media type.

5. Tap Enable.

**Note**

- The specified media type setting is updated in the following situations.
• When using sheets, if you send a print job before loading a sheet, the media type setting is updated to match the type of paper specified by the print job.

• If a barcode is printed on the roll paper and you have set **Manage remaining roll amount** to **Barcodes** in the operation panel menu, the media type setting is updated to match the media type specified by the barcode.

• To change the media type setting, see "Changing the Type of Paper."
Specifying the Paper Length

When changing the length of paper after the paper has been advanced, specify the length as follows.

⚠️ Note

• Specify the roll paper length when you have set Manage remaining roll amount to Barcodes. (See "Keeping Track of the Amount of Roll Paper Left.")

1. Tap paper settings display area on Home screen of operation panel.

2. Tap Paper settings.

3. Tap Advanced.

4. Tap Length.

5. Enter roll paper length.

Specify the roll length as follows.

1. Tap the numerical input field.
2. Tap the keypad appearing on the operation panel, enter the roll paper length, and then tap OK.
3. Check the entered length and tap OK.
Removing the Roll from the Printer

Remove rolls from the printer as follows.

>>> Note

• If you need to cut a printed roll, select Feed/cut in the printer menu and cut the roll paper at the desired position. (See "Specifying the Cutting Method for Rolls.")

1. Tap paper settings display area on Home screen of operation panel.

![Ready to print](image)

>>> Note

• If the Home screen does not appear, press the HOME button.

2. Tap Remove paper.

3. Tap Yes.

The roll is rewound.

>>> Important

• If Manage remaining roll amount is set to Barcodes in the operation panel menu, a barcode is printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the amount of roll paper left. (See "Keeping Track of the Amount of Roll Paper Left.")

4. Using both hands, rotate the roll holder toward the back to rewind the roll.
5. Hold roll holder by its flanges (A) and remove from roll holder slot.

Note

• For instructions on removing the roll holder from rolls, see "Removing Rolls From the Roll Holder."
• To load new roll paper in the printer at this point, see "Loading Rolls in the Printer."
• Clean inside the top cover before loading paper.
  (See "Cleaning Inside the Top Cover.").
Feeding Roll Paper Manually

After feeding the roll paper, you can move it forward and back.

1. Tap paper settings display area on Home screen of operation panel.

   ![Ready to print]

   **Note**
   
   - If the Home screen does not appear, press the HOME button.

2. Tap Feed/Cut.

3. Tap or touch **Advance** and **Rewind** to move roll paper forward or back.

   **Note**
   
   - Tapping **Advance** or **Rewind** moves the roll paper approximately 0.04 inch (1 mm).
   
   Touching **Advance** or **Rewind** moves the roll paper until you release the key. If "Cannot advance the paper any more." appears on the operation panel, release the key.

4. Tap **OK** when you have determined position of roll paper.
Keeping Track of the Amount of Roll Paper Left

There are two methods of managing the amount of roll paper left: by using the barcode and by estimating the amount of roll paper left.

Managing by the Barcode for the Amount of Roll Paper Left

When you set Manage remaining roll amount to Barcodes in Device settings on the Home screen, the amount of remaining roll paper and the media type information are printed as a barcode and text when the paper is removed. When Manage remaining roll amount is set to Barcodes and you load roll paper with a printed barcode, the media type and remaining amount are automatically detected after the roll paper is loaded. The barcode will be cut off after it has been read.

**Important**

- If the barcode on the roll is not detected, enter the type and length of paper on the operation panel. The length of the paper at this time can be set in Roll length (change default).

Follow the steps below when setting Manage remaining roll amount to Barcodes.

1. Tap (Setup) on Home screen of operation panel.

2. Tap Device settings.

3. Tap Paper-related settings.

4. Tap Manage remaining roll amount.

5. Tap Barcodes.
6. Check the length of the roll paper.

   Note
   • The length of the roll paper to be displayed can be set in Roll length (change default).
   • Setting the Default Value of the Amount of Roll Paper Left when Managing by the Barcode
   • If the length of the roll paper to be displayed is different from the length of the roll paper actually used, set the actual length.

7. Select the timing when the warning message appears.

   Note
   • If you increase the level in Roll amount warning setting, the warning message appears sooner.

Setting the Default Value of the Amount of Roll Paper Left when Managing by the Barcode

When you select Barcodes in Manage remaining roll amount and if you feed roll paper on which no barcode is printed, such as new roll paper, the screen to enter the roll paper length (remaining amount) appears.

In this screen, the length (remaining amount) of default value appears. If the length is not correct, tap the screen and enter a correct length.

When you want to change the length (remaining amount) of default value, follow the steps below.

1. Tap paper settings display area on Home screen of operation panel.

   Note
   • If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.

3. Tap Advanced.

4. Tap Roll length (change default).
Managing by Estimating the Amount of Roll Paper Left

When you set Manage remaining roll amount to Warning message only in Device settings on the Home screen, if the amount of roll paper left decreases, the Status lamp on the operation panel lights up orange and the warning message is displayed. The barcode is not printed.

The time to display warning message can be set in Roll amount warning setting. If you increase the level in Roll amount warning setting, the warning message appears sooner.

**Important**

- If the type of paper is not selected correctly, the amount of roll paper left may not be estimated correctly.

- When using the types of paper which are not displayed on "Paper Information List," set the paper thickness and the size of paper core with Media Configuration Tool.

  ➤ Media Configuration Tool Guide (Windows)

  ➤ Media Configuration Tool Guide (macOS)
Specifying the Ink Drying Time for Rolls

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait for the ink to dry after printing.

**Note**

- If the cutter touches the print surface on which the ink is not dry, the paper surface may become scratched or soiled, or the paper surface may rub when the paper falls and the surface may become soiled.

  To wait for the ink to dry without allowing printed materials to fall after printing, set **Cutting mode** on the printer menu to **Eject cut**. (See "Specifying the Cutting Method for Rolls.")

- The settings can also be made from the operation panel on the printer. From **(Setup)** on the Home screen, select **Device settings>Paper-related settings>Advanced paper settings>(media types selection)** and set **Pause between scans** or **Pause between pages**.

**Windows**

1. Display the printer driver dialog box.
   
   (See "How to Open the Printer Driver Setup Window.")

2. Select **Main** sheet and click **Specify...** for **Media Type**.

![Printing Preferences Dialog Box](image-url)
3. In the **Paper Detailed Settings** dialog box displayed next, select the desired values from the lists for **Between Pages** and **Between Scans** in **Drying Time**, and then click **OK**.

(See "Main Tab Description.")

----

**macOS**

1. Choose **Print** in the application menu.

2. Select **Paper Detailed Settings** panel.
3. Select desired values from lists for **Dry Time (Between Pages)** and **Dry Time (Between Scans)**.

(See "Paper Detailed Settings.")
Specifying the Cutting Method for Rolls

How rolls are cut after ejection varies depending on printer settings.

- **Automatic cut**
  The roll is automatically cut by the cutter blade according to the printer driver settings.
  
  - **Printer Setting**
    Tap paper settings display area > **Paper settings** > **Advanced** > **Cutting mode** > **Automatic cut**
  
  - **Driver Setting**
    **Automatic Cutting**: Yes
    
    ➤ See "Cutting Roll Paper after Printing" (Windows).
    
    ➤ See "Cutting Roll Paper after Printing" (macOS).

- **Eject (when the paper surface is being scratched / to wait for ink to dry)**
  Select this to move the cutter by operation panel operation and cut paper. With Automatic cut, the paper drops and may rub against the basket, resulting in damage to the print surface, but you can cut using this method and supporting the paper so that it does not drop to avoid damage to the paper. Also, you can prevent paper that has not dried from dropping by visually checking the ink has dried, and then cutting the paper.
  
  After printing, tap **Cut paper** and cut the roll paper on the cutter blade.
  
  - **Printer Setting**
    Tap paper settings display area > **Paper settings** > **Advanced** > **Cutting mode** > **Eject cut**
  
  - **Driver Setting**
    **Automatic Cutting**: Yes
    
    ➤ See "Cutting Roll Paper after Printing" (Windows).
    
    ➤ See "Cutting Roll Paper after Printing" (macOS).

- **Manual (when using media that cannot be cut with the cutter blade)**
  Select this if the paper cannot be cut on the cutter blade.
  
  Cut each page from the roll using scissors. For continuous printing (if you will cut each page later), select **Automatic Cutting**: Yes or select **Print Cut Guideline**.
  
  - **Printer Setting**
    Tap paper settings display area > **Paper settings** > **Advanced** > **Cutting mode** > **User cut**
  
  - **Driver Setting**
    **Automatic Cutting**: No, Yes, Print Cut Guideline
    
    ➤ See "Cutting Roll Paper after Printing" (Windows).
    
    ➤ See "Cutting Roll Paper after Printing" (macOS).
• **Paper cutting (to have the roll cut at your specified position)**

Select this when you want to cut the roll paper by operating the cutter blade using the operation panel after printing with **No** or **Print Cut Guideline** selected in **Automatic Cutting** in the printer driver.

Otherwise choose this option if you want to cut the roll edge after loading a roll.

  ◦ **Printer Setting**
    
    Tap paper settings display area > **Feed/cut>** Cut paper > **Yes**
  
  ◦ **Driver Setting**

    **Automatic Cutting** > **No, Yes, Print Cut Guideline**
    
    ➤ See "Cutting Roll Paper after Printing" (Windows).
    ➤ See "Cutting Roll Paper after Printing" (macOS).

**Note**

• Automatic and Eject are valid only when you have selected **Automatic Cutting** > **Yes** in the printer driver.

• With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is cut.

• **Eject cut** or **User cut** is the preset selection in **Cutting mode** for some types of paper. For this paper, we recommend keeping the preset cutting mode.

• If documents printed using Automatic, Eject, or manual cutting are short, rolls are advanced a specific amount before cutting to prevent problems with cutting and paper ejection. This may create a wider bottom margin, in some cases.

Cut rolls manually in the following cases:

### Eject (when the paper surface is being scratched / to wait for ink to dry)

**Important**

• When cutting wide printed documents after ejection, have two people support the documents. If the paper drops, printed documents may be damaged.

• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect the printing quality or cause rough cut edges.

**Note**

• Once the following step has been performed, the procedure can be started from step 7 the next time.

  • Printing the second and subsequent times
  
  • Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of operation panel.
2. Tap **Paper settings**.

3. Tap **Advanced**.

4. Tap **Cutting mode**.

5. Tap **Eject cut**.

6. Print the job.
   
   When printing is finished, the printer will stop without cutting.

7. While holding the printed document from the bottom edge to prevent it from dropping, tap **Cut paper** to cut the roll paper.

### Manual (when using media that cannot be cut with the cutter blade)

#### Note

- Once the following step has been performed, the procedure can be started from step 8 the next time.
  
  - Printing the second and subsequent times
  
  - Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of operation panel.
Ready to print

- Plain Paper
- A3

Replace paper
Feed/Cut

Note
- If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.

3. Tap Advanced.

4. Tap Cutting mode.

5. Tap User cut.

6. When Do you want to set to detect the leading edge of the paper? is displayed, select Detect (recommended).

7. Print the job.
   - The printer stops advancing the paper after printing.

8. Tap Advance paper.
   - Roll paper is fed to the specified cut position and then automatically stopped.

9. Cut the roll paper manually with scissors or the like.

10. Tap OK.
After the roll is rewound, it stops automatically.

### Paper cutting (to have the roll cut at your specified position)

1. Tap **Feed/Cut** on Home screen of operation panel.

   ![Ready to print]

   - **Plain Paper**
   - **Replace paper**
   - **Feed/Cut**

   **Note**
   - If the Home screen does not appear, press the **HOME** button.

2. Tap or touch **Advance** or **Rewind** to feed roll paper to desired cutting position.

3. Tap **Cut paper**.

4. Tap **Yes**.
   
   After the roll paper is cut, it is rewound automatically.
Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by using **Trim edge first** in the operation panel menu.

The following settings are available for **Trim edge first**.

- **Auto**
  If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling the printer.

- **On(Preset Length)**
  The amount to cut from the leading edge of the paper varies depending on the media type and is cut to a prescribed length. For the leading edge precut length, see "Paper Information List".

- **On(Input Length)**
  The amount to cut from the leading edge of paper is specified in the operation panel. The amount to cut from the leading edge can be specified in the range of lengths displayed in the operation panel. The range of lengths differs according to the media type.

  **Note**
  - The amount to cut from the leading edge of paper cannot be set shorter than the length displayed in the operation panel.

- **Manual**
  The amount to cut from the leading edge of paper can be adjusted by using the operation panel.
  To cut the paper after adjusting, tap **Cut paper** and select **Yes**.
  After cutting the paper, tap **Complete paper loading**.

  **Note**
  - If you do not tap **Complete paper loading** after cutting the paper, you cannot print the next job.

- **Off**
  The edge is not cut and scraps are not removed.

Follow these steps to change the **Trim edge first** setting.

1. Tap paper settings display area on Home screen of operation panel.
2. Tap **Paper settings**.

3. Tap **Advanced**.

4. Tap **Trim edge first**.

5. Tap desired **Trim edge first** settings.
   
   This setting takes effect the next time you load a roll.
Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting **Cut-dust reduction** to ON from the operation panel menu, which will coat the leading and trailing edges of the printed document with ink. As a result, you can reduce problems with the print head. You can set **Cut-dust reduction** according to the media type.

![The ink is coated.](image)

**Important**

- Do not set **Cut-dust reduction** to ON for paper that wrinkles easily, such as **Plain Paper** or lightweight paper. If not cut properly, the paper may jam.
- Borderless printing is not available when **Cut-dust reduction** is set to ON. When performing borderless printing, set **Cut-dust reduction** to OFF.

Follow these steps to set **Cut-dust reduction** to ON.

1. Tap paper settings display area on Home screen of operation panel.

   ![Ready to print](image)

   **Note**

   - If the Home screen does not appear, press the HOME button.

2. Tap **Paper settings**.

3. Tap **Advanced**.

4. Tap **Cut-dust reduction**.
5. Tap **ON**.
Detecting Roll Paper was Replaced While the Power was Off

When you turn the printer on, it can confirm whether the roll paper was replaced while the power was off.

From Device settings on the Home screen, set Auto feed at power on to Enable to detect the position of the roll paper's leading edge when the power is turned on. If the position of the roll paper’s leading edge is over 1 mm since the last time the power was turned off, the printer determines that the roll paper has been replaced, and then starts feeding paper automatically to detect the paper width and the barcode for the management of unused roll paper.

Note

• Setting Auto feed at power on to Enable causes the operations that can be done after turning on the power to take longer since the printer must detect the leading edge of the roll paper.

Follow these steps to set Auto feed at power on to Enable as follows.

1. Tap (Setup) on Home screen of operation panel.

   ![Setup menu]

   Ready to print

   ![Paper settings]

   • If the Home screen does not appear, press the HOME button.

2. Tap Device settings.

3. Tap Paper-related settings.

4. Tap Auto feed at power on.

5. Tap Enable.
Handling sheets

- Loading Sheets in the Printer
- Changing the Type of Paper
- Printing From a Desired Starting Point
- Removing Sheets
- Remove a Jammed Sheet
Loading Sheets in the Printer

The following are two ways to load sheets into the printer.

- Using the Roll Holder to Load Sheets
- Using the Paper Alignment Line to Load Sheets

If using the roll holder to load sheets does not work well, try using the paper alignment line to load the sheets.

**Important**

- One sheet of paper can be loaded in the feed slot at a time. Do not load more than one sheet at a time. This may cause paper jams.
- Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.
- Load the paper straight. Loading paper askew will cause an error. (See "1317."

**Note**

- For details on the sheet sizes that can be used, see "Sheets" in "Paper Sizes".
- Before loading cut sheets, check whether or not the inside of the top cover or the output guide is soiled. If these areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover.").
- Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

**Watch the movie**

**Using the Roll Holder to Load Sheets**

1. Attach the roll holder.

   Attach the roll holder, which holds the loaded roll paper, to the printer.
2. Select sheets as the paper source.

• If a print job was received
  Sheets are automatically selected, and the media type and size specified by the print job are shown on the operation panel.
  Tap OK and Load paper.

• If no print job was received
  1. Tap Load paper or Replace paper.

  Ready to print

  ![Image showing the operation panel]

  2. Tap Load cut sheet or Replace cut sheet.

Note

• If the Home screen does not appear, press the HOME button.
3. Align the sheets to load them onto the roll holder.

With their print side up, place the sheets against the flange (A) of the roll holder.

![Roll Paper Holder with Sheets](image)

4. Load the sheets into the paper feed slot.

Insert the paper until the leading edge makes contact.

An alarm sounds when the paper is inserted into the paper feed position.
5. Tap **Start feeding**.

   • If a print job was received
     Tap **Start feeding** to feed the paper and begin printing.

   • If no print job was received
     A menu for selecting the media type appears.
     Select the media type loaded and tap **OK**.
     The printer now starts feeding the paper.

**Note**

   • For details on media types that you can select, see "Paper Information List."

### Using the Paper Feed Guide to Load Sheets

1. Remove the roll holder.

   Remove the roll holder if it is attached to the printer.
2. Select sheets as the paper source.

- **If a print job was received**
  Sheets are automatically selected, and the media type and size specified by the print job are shown on the operation panel.
  Tap **OK** and **Load paper**.

- **If no print job was received**
  1. Tap **Load paper** or **Replace paper**.

  ![Ready to print](image)

  2. Tap **Load cut sheet** or **Replace cut sheet**.

  **Note**

  - If the Home screen does not appear, press the **HOME** button.

  **Note**

  - If any paper has been advanced that will not be used, a message is shown requesting you to remove it.

    Follow the instructions on the screen to remove the paper, and redo the operation.

3. Use the paper alignment line to align and load the sheets.

   With its print side up, load a sheet in the paper feed slot, with the right edge aligned with the paper alignment line's white line (A), and then insert the sheet into the paper slot.

   Insert the paper until the leading edge makes contact.

   An alarm sounds when the paper is inserted into the paper feed position.
4. Tap **Start feeding**.

   - **If a print job was received**
     Tap **Start feeding** to feed the paper and begin printing.

   - **If no print job was received**
     A menu for selecting the media type appears.
     Select the media type loaded and tap **OK**.
     The printer now starts feeding the paper.

**Note**

   - For details on media types that you can select, see "Paper Information List."
Printing From a Desired Starting Point

Print on sheets from a desired starting point as follows.

### Setting Detect paper width to Disable

1. Tap paper settings display area on Home screen of operation panel.

![Ready to print](image)

**Note**

- If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.

3. Tap Advanced.

4. Select Detect paper width and tap Disable.

### Load paper in the desired position to start printing from

Follow these instructions to load paper at the desired starting position for printing when Detect paper width is set to Disable.

1. If you did not send a print job in advance, a menu for selection of the type of paper is displayed.
   Tap media type loaded.

   **Note**

   - If a print job was received before the paper was fed, the media type and size specified by the job are shown on the operation panel.
   Go to step 2.

2. When "[Detect paper width] is disabled. Do you want to keep it disabled and continue?" appears on operation panel, tap Keep it disabled and continue.
3. Open top cover and check position where paper is loaded.

To start printing from the current position, close the top cover.
To reposition the paper, push the release lever back.

4. Load paper keeping right edge of paper aligned with extended line of paper alignment line (A) on right side of printer and position from which to start printing aligned with groove (B) at far end of platen.
5. Pull the release lever forward and close the top cover.

6. When screen for selecting paper size appears, select size of paper loaded.
Removing Sheets

Remove sheets from the printer as follows.

1. Tap paper settings display area on Home screen of operation panel.

   ![Paper Settings Display](image)

   **Note**
   - If the Home screen does not appear, press the `HOME` button.

2. Tap **Remove paper**.

3. Check operation panel message and tap **Yes**.
   The paper is ejected from the front of the printer.

4. Holding the paper, push the release lever back and remove the sheet.

5. Pull the release lever forward.
Basket

- Using the Basket
Using the Basket

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

**Important**

- When storing printed documents on the basket, always use it in position (1). If you do not, printed documents may not be dropped into the basket, and the printed surface may become soiled.

- To store printed documents in the basket, first pull down the side rod (B) evenly so that the front rod (A) is not askew, and then use the basket.

- The number of sheets that can be collected in the basket is one. If printing multiple pages, print after removing each sheet.

- The basket can hold printed documents from paper up to 48 inches (1219.2 mm) long.
• When moving the stand, make sure that the basket does not graze the floor and that all four of the casters are unlocked before moving the stand. Not doing so may damage the basket, scratch the floor, or cause injuries.
• If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the performance of the basket.
Changing Settings from Operation Panel/Web Browser

- **Operations and Touch Screen**
  - Operation Panel
  - Touch Screen
  - Checking Instructions During Printer Operations

- **Changing Settings from Operation Panel**
  - Printer Menu Operations
  - Menu Operations
  - Menu Structure
  - Changing Settings from Operation Panel
  - Setting Items on Operation Panel
  - HP-GL/2 Settings
  - Status Print

- **Changing Printer's Setting Using Web Browser**
  - Configuration Changes Using Web Browser
  - Changeable Setting Items Using Web Browser
  - Setting Password
  - Registering Printer's Root Certificate to Web Browser for SSL Communication (Remote UI)
  - Registering Printer's Root Certificate to Local Computer for SSL Communication
  - Generating Server Certificate (Self-signed Certificate)
  - Setting Mail Server
  - Receiving Printer Status by E-mail
Operations and Touch Screen

- Operation Panel
- Touch Screen
- Checking Instructions During Printer Operations
Operation Panel

A: HOME button
The HOME screen appears.

⇒ Touch Screen

B: Back button
Displays the screen before the current screen.

C: Stop button
Cancels print jobs in progress and ends the ink drying period.

D: ON button/ON lamp
Turns the printer on and off.

⇒ Turning the Printer On and Off

The ON lamp is lit when the printer is on or in Sleep mode.

E: Touch Screen
Shows printer menus, as well as the printer status and messages. You can select menu items and display buttons by gently touching the screen with your fingertip.

⇒ Touch Screen

F: Status lamp
- Flashing (white)
  During printing, this lamp flashes when the printer is receiving or processing print jobs. Otherwise, this lamp flashes when the print job is paused or the printer is updating the firmware.
- Lit (orange)
  A warning message is displayed.
- Flashing (orange)
  An error message is displayed.
- Off
  There are no active print jobs, warnings, or errors.
**Note**

- When the printer is in Sleep mode, to restore the display, press the buttons on the operation panel or touch the touch screen.
- When Operation panel lock is enabled, touch screen operations are invalid. For details on Operation panel lock, see [Changeable Setting Items Using Web Browser](#).
Touch Screen

After the printer starts up, the HOME screen appears on the touch screen.

From the HOME screen, you can check the printer status and select the maintenance, paper operations, settings, and other menus.

➤ Basic Touch Screen Operations

Ready to print

A: Printer Information Display Area
Displays the printer status, messages, and other information. Tap this item when a message appears to view the message on the list screen and to jump to the screen with detailed information and operations.

➤ Notification Messages

B: Paper Setting Display Area
Displays the information on loaded paper on the upper area. Tapping this option displays the menu relating paper and allows the paper settings. Replace paper and Feed/Cut frequently used in the menu appears on the lower area, and you can directly select.

C: Network
Displays the current network status. Select to display the basic network information or to change the network settings.

The icon differs depending on the network of use or the network status.

Wi-Fi is enabled and the printer is connected to the wireless router.

➤ Note

• Depending on the signal state, the icon will change.

(Signal strength: 81 % or more): You can use the printer over a Wi-Fi without any problems.

(Signal strength: 51 % or more): The problem such as the printer cannot print may occur according to the network status. We recommend placing the printer near the wireless router.
(Signal strength: 50 % or less): The problem such as the printer cannot print may occur. Place the printer near the wireless router.

Wi-Fi is enabled but the printer is not connected to the wireless router.

Wired LAN is enabled.

Wireless Direct is enabled.

Wi-Fi and Wired LAN are disabled.

D: Ink information
Selects when checking current estimated ink levels or replacing ink tanks.

E: Setup
Selects when changing the printer settings, performing maintenance, or checking printer information.

F: Job management
Select when checking or deleting print jobs.

Basic Touch Screen Operations
You can select various functions and settings by gently touching and swiping the touch screen with your fingertip.

Important
• Take the following precautions when operating the touch screen. Otherwise, the touch screen may malfunction or become damaged.
  • Do not forcibly press the touch screen with your finger.
  • Do not press the touch screen with an object other than your finger (such as a ballpoint pen, pencil, fingernail, or other object with a sharp tip).
  • Do not operate the touch screen with wet or dirty hands.
  • Do not place objects on top of the touch screen.
  • Do not place a protective film over the touch screen. Removing it can damage the touch screen.

Tap
Gently touch with your fingertip and then release.
Use this when selecting an item on the screen.
Touch

Gently touch with your fingertip.

To go (or return) to a menu or list, touch the directional mark.

Flick

Drag and release your finger up, down, left, or right.

Use this to quickly scroll through a menu or list.

Drag

Move your finger up, down, left, or right while gently keeping it in contact with the touch screen.

Use this to move a menu or list while viewing it.
Notification Messages

When the ink is low or there is another notification, New notice appears in the printer information display area. Tap this to display the Notice list screen to view messages with the newest one appearing first. Tap a message to display the message details screen to view the details and take action.

Example: Notices on the maintenance cartridge
Checking Instructions During Printer Operations

You can refer to instructions on the touch screen when loading paper, replacing ink tanks, or performing other operations.

How to view instructions

Once you complete an action described in the instructions, the printer detects the action and switches to the next instruction screen.

Operation screens are switched every 3 seconds, and the sequence of operations is shown repeatedly. For actions the printer cannot detect, tap OK to display the instruction screen for the next step.

Example: Ink tank replacement
Open the ink tank cover.

Remove the ink tank.

Remove the ink tank.

When installing a new ink tank, shake it side to side before opening it.

Install an ink tank of the correct color in the correct orientation.

Install an ink tank of the correct color in the correct orientation.

When finished, close the ink tank cover.

Ready to print

Plain Paper

A3 Rol

Replace paper

Feed/Cut

Ready to print
Changing Settings from Operation Panel

- Printer Menu Operations
- Menu Operations
- Menu Structure
- Changing Settings from Operation Panel
- Setting Items on Operation Panel
- HP-GL/2 Settings
- Status Print
Printer Menu Operations

On the HOME screen, the current status of the printer and buttons for displaying various menus are displayed.

A. Printer status
   Displays the current status (Ready to print / Printing...) of the printer.

B. Paper information
   Displays the current paper information.
   It is grayed out during printing.
   Tap to display Paper menu.

C. Replace paper
   It is grayed out during printing.
   Tap this button to change the roll paper or to set the cut paper.

D. Feed/Cut
   It is grayed out when paper feed mode is cut paper or during printing.
   Tap this button to feed or cut roll paper.

E. Jobs
   Tap to display Job management menu.

<table>
<thead>
<tr>
<th>Job management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print job</td>
</tr>
<tr>
<td>Job history</td>
</tr>
<tr>
<td>Pause printing</td>
</tr>
<tr>
<td>Delete all print jobs</td>
</tr>
</tbody>
</table>

F. Setup
   Tap to display Setup menu.
G. **Ink**

Tap to display the current ink level.
Also tap this button when replacing ink.

![Current estimated ink levels]

- **Replace**
- **Order ink now**

H. **Network**

Displays the current status of the LAN as an icon.
It is grayed out during printing.
Tap to display **LAN settings** menu.

![LAN settings]

- **Wi-Fi**
- **Wireless Direct**
- **Wired LAN**

**Note**

- The values set in the menu on the operation panel are applied to all print jobs. However, if the same setting item exists in the printer driver, the setting value of the printer driver takes precedence.
Menu Operations

The operation panel has a touch screen (A) and several buttons (B).
Flick the touch screen and tap the displayed button or item with your finger to select a menu.

Example of Using Touch Screen

Example: Operation to change the setting of automatic power off time

1. On the HOME screen, tap \(\text{Setup}\) (Setup).
2. Tap **Device settings**.

3. Flick up and down and tap **Other device settings**.

4. Tap **Energy saving settings**.

5. Tap **Auto power off**.
6. Tap the time you want to set.

7. Tap OK.

When the setting is completed, press the HOME button to return to the HOME screen.
You can also go back to the screen one level higher by pressing the Back button and continue with other settings.
Menu Structure

The * on the right side of an item indicates the default value.

• Paper menu (when roll paper is loaded)

This menu is displayed by tapping paper information area.

<table>
<thead>
<tr>
<th>Replace paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed/Cut</td>
</tr>
<tr>
<td>Remove paper</td>
</tr>
<tr>
<td>Paper settings</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

• Paper menu (when cut sheet is loaded)

This menu is displayed by tapping paper information area.

<table>
<thead>
<tr>
<th>Replace paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove paper</td>
</tr>
<tr>
<td>Paper settings</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

• Replace paper

• Feed/Cut

This menu is displayed when roll paper is loaded.

• LAN settings

This menu is displayed by tapping Network icon.

<table>
<thead>
<tr>
<th>Wi-Fi</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
</tr>
<tr>
<td>Network name (SSID)</td>
</tr>
<tr>
<td>Communication mode</td>
</tr>
<tr>
<td>Channel</td>
</tr>
<tr>
<td>Wi-Fi security</td>
</tr>
<tr>
<td>IPv4 address</td>
</tr>
<tr>
<td>IPv4 subnet mask</td>
</tr>
<tr>
<td>IPv4 default gateway</td>
</tr>
<tr>
<td>IPv4 DNS dynamic setting</td>
</tr>
<tr>
<td>IPv4 DNS host name</td>
</tr>
<tr>
<td>IPv4 DNS domain name</td>
</tr>
<tr>
<td>IPv6 link-local address</td>
</tr>
<tr>
<td>IPv6 link-local prefix length</td>
</tr>
<tr>
<td>IPv6 manual address</td>
</tr>
<tr>
<td>IPv6 manual prefix length</td>
</tr>
<tr>
<td>IPv6 stateless address 1</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 1</td>
</tr>
<tr>
<td>IPv6 stateless address 2</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 2</td>
</tr>
<tr>
<td>IPv6 stateless address 3</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 3</td>
</tr>
<tr>
<td>IPv6 stateless address 4</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 4</td>
</tr>
<tr>
<td>DHCPv6</td>
</tr>
<tr>
<td>DHCPv6 stateful address</td>
</tr>
<tr>
<td>DHCPv6 stateful prefix length</td>
</tr>
<tr>
<td>IPv6 default gateway 1</td>
</tr>
<tr>
<td>IPv6 default gateway 2</td>
</tr>
<tr>
<td>IPv6 default gateway 3</td>
</tr>
<tr>
<td>IPv6 default gateway 4</td>
</tr>
<tr>
<td>IPv6 primary DNS server address</td>
</tr>
<tr>
<td>IPv6 secondary DNS server add.</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: manual</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: stateless</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: stateful</td>
</tr>
<tr>
<td>IPv6 Use IPv4 host/domain name</td>
</tr>
<tr>
<td>IPv6 DNS host name</td>
</tr>
<tr>
<td>IPv6 DNS domain name</td>
</tr>
<tr>
<td>MAC address</td>
</tr>
<tr>
<td>IPsec settings</td>
</tr>
<tr>
<td>Printer name</td>
</tr>
<tr>
<td>Bonjour service name</td>
</tr>
<tr>
<td>Settings</td>
</tr>
<tr>
<td>Enable/disable Wi-Fi</td>
</tr>
</tbody>
</table>
## Wi-Fi setup

<table>
<thead>
<tr>
<th>Wi-Fi setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable / Disable</td>
</tr>
<tr>
<td>Easy wireless connect</td>
</tr>
<tr>
<td>Manual connect</td>
</tr>
<tr>
<td>WPS (Push button method)</td>
</tr>
<tr>
<td>Other connection types</td>
</tr>
<tr>
<td>Manual connect (adv.) / WPS (PIN code method)</td>
</tr>
</tbody>
</table>

## Advanced

<table>
<thead>
<tr>
<th>Wireless Direct</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
</tr>
<tr>
<td>Network (SSID)/device name</td>
</tr>
<tr>
<td>Password</td>
</tr>
<tr>
<td>Communication mode</td>
</tr>
<tr>
<td>Channel</td>
</tr>
<tr>
<td>Wi-Fi security</td>
</tr>
<tr>
<td>IPv4 address</td>
</tr>
<tr>
<td>IPv4 subnet mask</td>
</tr>
<tr>
<td>IPv4 default gateway</td>
</tr>
<tr>
<td>IPv4 DNS dynamic setting</td>
</tr>
<tr>
<td>IPv4 DNS host name</td>
</tr>
<tr>
<td>IPv4 DNS domain name</td>
</tr>
<tr>
<td>IPv6 link-local address</td>
</tr>
<tr>
<td>IPv6 link-local prefix length</td>
</tr>
<tr>
<td>MAC address</td>
</tr>
<tr>
<td>IPsec settings</td>
</tr>
<tr>
<td>Printer name</td>
</tr>
<tr>
<td>Bonjour service name</td>
</tr>
</tbody>
</table>

## Settings

<table>
<thead>
<tr>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/disable Wireless Direct</td>
</tr>
<tr>
<td>Yes / No</td>
</tr>
<tr>
<td>Update SSID/password</td>
</tr>
<tr>
<td>Yes / No</td>
</tr>
<tr>
<td>Wireless Direct device name</td>
</tr>
<tr>
<td>Connection request confirmation</td>
</tr>
<tr>
<td>ON* / OFF</td>
</tr>
</tbody>
</table>

**Advanced**
<table>
<thead>
<tr>
<th>Wired LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
</tr>
<tr>
<td>IPv4 address</td>
</tr>
<tr>
<td>IPv4 subnet mask</td>
</tr>
<tr>
<td>IPv4 default gateway</td>
</tr>
<tr>
<td>IPv4 DNS dynamic setting</td>
</tr>
<tr>
<td>IPv4 DNS host name</td>
</tr>
<tr>
<td>IPv4 DNS domain name</td>
</tr>
<tr>
<td>IPv6 link-local address</td>
</tr>
<tr>
<td>IPv6 link-local prefix length</td>
</tr>
<tr>
<td>IPv6 manual address</td>
</tr>
<tr>
<td>IPv6 manual prefix length</td>
</tr>
<tr>
<td>IPv6 stateless address 1</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 1</td>
</tr>
<tr>
<td>IPv6 stateless address 2</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 2</td>
</tr>
<tr>
<td>IPv6 stateless address 3</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 3</td>
</tr>
<tr>
<td>IPv6 stateless address 4</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 4</td>
</tr>
<tr>
<td>DHCPv6</td>
</tr>
<tr>
<td>DHCPv6 stateful address</td>
</tr>
<tr>
<td>DHCPv6 stateful prefix length</td>
</tr>
<tr>
<td>IPv6 default gateway 1</td>
</tr>
<tr>
<td>IPv6 default gateway 2</td>
</tr>
<tr>
<td>IPv6 default gateway 3</td>
</tr>
<tr>
<td>IPv6 default gateway 4</td>
</tr>
<tr>
<td>IPv6 primary DNS server address</td>
</tr>
<tr>
<td>IPv6 secondary DNS server add.</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: manual</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: stateless</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: stateful</td>
</tr>
<tr>
<td>IPv6 Use IPv4 host/domain name</td>
</tr>
<tr>
<td>IPv6 DNS host name</td>
</tr>
<tr>
<td>IPv6 DNS domain name</td>
</tr>
<tr>
<td>MAC address</td>
</tr>
</tbody>
</table>
### IPsec settings

#### Printer name

#### Bonjour service name

<table>
<thead>
<tr>
<th>Settings</th>
<th>Enable/disable Wired LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enable / Disable</td>
</tr>
<tr>
<td></td>
<td>Advanced</td>
</tr>
</tbody>
</table>

### Print details

- **Ink information**
  
  This menu is displayed by tapping **Ink** icon.

  - **Current estimated ink levels**
  - **Replace**
  - **Order ink now**

- **Setup**
  
  This menu is displayed by tapping **Setup** icon.

<table>
<thead>
<tr>
<th>Device settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Test print</strong></td>
</tr>
<tr>
<td>Nozzle Check</td>
</tr>
<tr>
<td>Status print</td>
</tr>
<tr>
<td>Status print (administrator)</td>
</tr>
<tr>
<td>Print LAN details</td>
</tr>
<tr>
<td>Print setting print</td>
</tr>
<tr>
<td>Print advanced paper settings</td>
</tr>
<tr>
<td>Print job history</td>
</tr>
<tr>
<td>Print menu map</td>
</tr>
<tr>
<td>Print color list for palettes</td>
</tr>
</tbody>
</table>

<p>| <strong>Print settings</strong> |
| Print head movable width setting |
| Data width* / Maximum movable width / Paper width |
| Prioritize paper size |
| Enable / Disable* |
| JPEG print settings |
| Print quality settings |
| Color mode |</p>
<table>
<thead>
<tr>
<th>Color (perceptual) / Color (saturation)* / Color (correct off) / Monochrome / Monochrome BMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print quality</td>
</tr>
<tr>
<td>5 (Fast) / 4 / 3* / 2 / 1 (High)</td>
</tr>
<tr>
<td>Input resolution</td>
</tr>
<tr>
<td>600 dpi / 300 dpi*</td>
</tr>
<tr>
<td>Print target</td>
</tr>
<tr>
<td>Photo* / Line drawing</td>
</tr>
</tbody>
</table>

**Paper settings**

<table>
<thead>
<tr>
<th>Paper src</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto select* / Roll paper / Manual</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>3mm* / 5mm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Border</th>
</tr>
</thead>
<tbody>
<tr>
<td>Borderless / Bordered*</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rotate</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 degrees* / 90 degrees</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enlarge/Reduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit paper size* / Same size / Scaling</td>
</tr>
</tbody>
</table>

**HP-GL/2 print settings**

**Print quality settings**

<table>
<thead>
<tr>
<th>Color mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (perceptual) / Color (saturation)* / Color (correct off) / Monochrome / Monochrome BMP</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print quality</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 (Fast) / 4 / 3* / 2 / 1 (High)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>600 dpi* / 300 dpi</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo / Line drawing*</td>
</tr>
</tbody>
</table>

**Paper settings**

<table>
<thead>
<tr>
<th>Paper src</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto select* / Roll paper / Manual</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>3mm* / 5mm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Oversize</th>
</tr>
</thead>
<tbody>
<tr>
<td>121</td>
</tr>
<tr>
<td>Setting</td>
</tr>
<tr>
<td>-------------------------</td>
</tr>
<tr>
<td>Enable* / Disable</td>
</tr>
<tr>
<td>Conserve paper</td>
</tr>
<tr>
<td>Rotate</td>
</tr>
<tr>
<td>Auto rotation</td>
</tr>
<tr>
<td>Enlarge/Reduce</td>
</tr>
<tr>
<td>Print centered</td>
</tr>
<tr>
<td>Cut to standard size</td>
</tr>
<tr>
<td>Mirror</td>
</tr>
<tr>
<td>Line &amp; pen manager</td>
</tr>
<tr>
<td>Merge</td>
</tr>
<tr>
<td>Pen setup</td>
</tr>
<tr>
<td>Select palette</td>
</tr>
<tr>
<td>Define palette</td>
</tr>
<tr>
<td>Palette A</td>
</tr>
<tr>
<td><strong>Pen 0 to Pen 15</strong></td>
</tr>
<tr>
<td>*Pen 0 to Pen 15 have the same menu structure.</td>
</tr>
<tr>
<td>Here to Defaults</td>
</tr>
<tr>
<td>Width</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Line attributes</td>
</tr>
</tbody>
</table>

**Palette B**

Menu structure same as Palette A

**Factory**

Pen 0 to Pen 15

*Pen 0 to Pen 15 have the same menu structure.

Here to Defaults

<table>
<thead>
<tr>
<th>Width</th>
<th>Color</th>
<th>Line attributes</th>
</tr>
</thead>
</table>

**Reset palette**

All palettes/Palette A/Palette B

**Smooth**

Software* / Smoothing

**Thicken fine lines**

ON / OFF*

**Adjust faint lines**

ON / OFF*

**Width correction**

Black/gray

-20 / -19 / ... / -1 / 0* / 1 / ... / 19 / 20

Color

-20 / -19 / ... / -1 / 0* / 1 / ... / 19 / 20

**Print color list for palettes**

**Processing options**

Warning display

Enable / Disable*

Detect image size

OFF* / Command priority

**Direct print settings from FTP**

Print settings 1
### Print quality settings

**Color mode**
- Color (perceptual) / Color (saturation) / Color (correct off) / Monochrome / Monochrome BMP

**Print quality**
- 5 (Fast) / 4 / 3 / 2 / 1 (High)

**Print target**
- Photo / Line drawing

### Paper settings

**Paper src**
- Auto select / Roll paper / Manual

**Margin**
- 3mm / 5mm

**Border**
- Borderless / Bordered

**Rotate**
- 0 degrees / 90 degrees

**Enlarge/Reduce**
- Fit paper size / Same size / Scaling

### Print settings 2

#### Print quality settings

**Color mode**
- Color (perceptual) / Color (saturation) / Color (correct off) / Monochrome / Monochrome BMP

**Print quality**
- 5 (Fast) / 4 / 3 / 2 / 1 (High)

**Print target**
- Photo / Line drawing

#### Paper settings

**Paper src**
- Auto select / Roll paper / Manual

**Margin**
- 3mm / 5mm

**Border**
- Borderless / Bordered

**Rotate**
Print settings 3

Print quality settings

Color mode

- Color (perceptual) / Color (saturation)** / Color (correct off) / Monochrome / Monochrome BMP

Print quality

- 5 (Fast) / 4 / 3** / 2 / 1 (High)

Print target

- Photo* / Line drawing

Paper settings

Paper src

- Auto select* / Roll paper / Manual

Margin

- 3mm* / 5mm

Border

- Borderless / Bordered* 

Rotate

- 0 degrees* / 90 degrees

Enlarge/Reduce

- Fit paper size* / Same size / Scaling

Print settings 4

Print quality settings

Color mode

- Color (perceptual) / Color (saturation)** / Color (correct off) / Monochrome / Monochrome BMP

Print quality

- 5 (Fast) / 4 / 3** / 2 / 1 (High)

Print target

- Photo* / Line drawing

Paper settings

Paper src

- Auto select* / Roll paper / Manual

Margin
### Default print settings

#### Print quality settings

- **Color mode**
  - Color (perceptual) / Color (saturation) / Color (correct off) / Monochrome / Monochrome BMP

- **Print quality**
  - 1 (High) / 2 / 3 / 4 / 5 (Fast)

- **Print target**
  - Photo / Line drawing

### LAN settings

The lower items of this menu are the same as the lower items of [LAN settings](#) displayed by tapping **Network** icon.

### Paper-related settings

- **Keep media type**
  - Enable / Disable

- **Manage remaining roll amount**
  - Barcodes / Warning message only / Disable

- **Roll amount warning setting**
  - Roll amount 1 / Roll amount 2 / Roll amount 3 (standard) / Roll amount 4 / Roll amount 5 / Roll amount 6 (earlier warning)

- **Detect paper setting mismatch**
  - Pause / Display warning / Do not detect

### Advanced paper settings

#### Paper size recognition settings

- Roll paper setting 1
- Roll paper setting 2
- Roll paper setting 3
- Roll paper setting 4
- Roll paper setting 5
| Roll paper setting 6 |
| Roll paper setting 7 |
| Auto feed at power on |
| Enable* / Disable |
| Print advanced paper settings |
| Reset paper settings for all paper |

**Auto maintenance settings**

| Auto nozzle check |
| Standard* / 1 page / 10 pages / Disable |
| Nozzle check error display |
| Enable / Disable* |
| System cleaning frequency |
| Standard* / Short |
| Print pattern after new head |
| ON / OFF* |

**Monitoring service settings**

| Enable/disable monitoring service |
| Enable / Disable* |
| Communication test |
| Communication log |
| Timing for ink level notification |
| Standard* / Earlier notification |

**Other device settings**

| Energy saving settings |
| Auto power off |
| 5 minutes / 10 min. / 30 min. / 1 hour / 4 hours / 8 hours / 12 hours / OFF |
| Sleep timer |
| 5 minutes* / 10 min. / 15 min. / 20 min. / 30 min. / 40 min. / 50 min. / 60 min. |
| Operation restrictions |
| Job history |
| Restrict / Do not restrict* |
| Remote UI |
| Restrict / Do not restrict* |

**Use USB connection**

| Use* / Do not use |

**Date/time setting**
<table>
<thead>
<tr>
<th><strong>Date settings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time setting</strong></td>
</tr>
</tbody>
</table>

**Date display format**
- YYYY/MM/DD
- MM/DD/YYYY
- DD/MM/YYYY

**Time zone (GMT)**
- 0 / +1 / ... / +12 / -12 / ... / -1

**Sound control**
- Keypad sound
  - ON / OFF*
- Alarm sound
  - ON* / OFF

**Length unit setting**
- Meters* / Feet/inches

**EOP timer setting**
- 1 minute / 2 minutes / 5 minutes / 10 minutes* / 30 minutes / 60 minutes

**Job history sending setting**
- Send / Do not send*

**Language selection**

**Firmware update**
- Install update
- Check current version
- Update notification setting
  - Yes* / No

**DNS server setup**
- Auto setup* / Manual setup

**Proxy server setup**
- Use / Do not use*

**Administrator password setting**
- Remote UI or other tools / LCD, Remote UI, or other tools

**Maintenance**
- **Nozzle Check**
- **Print head cleaning**
  - Cleaning
    - All colors / Pattern 1 / Pattern 2
  - Deep Cleaning
    - All colors / Pattern 1 / Pattern 2
<table>
<thead>
<tr>
<th>System cleaning</th>
<th>All colors / Pattern 1 / Pattern 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print head alignment</td>
<td></td>
</tr>
<tr>
<td>Auto (standard)</td>
<td>Roll paper / Manual</td>
</tr>
<tr>
<td>Auto (advanced)</td>
<td>Roll paper / Manual</td>
</tr>
<tr>
<td>Manual</td>
<td>Roll paper / Manual</td>
</tr>
<tr>
<td>Print head angle adjustment</td>
<td></td>
</tr>
<tr>
<td>Paper feed adjustment</td>
<td></td>
</tr>
<tr>
<td>Set priority</td>
<td>Roll paper</td>
</tr>
<tr>
<td></td>
<td>Auto* / Prioritize print quality / Prioritize length accuracy</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
</tr>
<tr>
<td></td>
<td>Auto* / Prioritize print quality / Prioritize length accuracy</td>
</tr>
<tr>
<td>Adjust print quality</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>Roll paper / Manual</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
</tr>
<tr>
<td></td>
<td>Roll paper / Manual</td>
</tr>
<tr>
<td>Adjust feed length</td>
<td>Print alignment pattern</td>
</tr>
<tr>
<td></td>
<td>Roll paper / Manual</td>
</tr>
<tr>
<td>Change adjustment values</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-0.70% / -0.68% / … / 0.68% / 0.70%</td>
</tr>
<tr>
<td>Maintenance cartridge info</td>
<td></td>
</tr>
<tr>
<td>Maintenance cartridge usage</td>
<td></td>
</tr>
<tr>
<td>Replace</td>
<td></td>
</tr>
<tr>
<td>Head replacement</td>
<td></td>
</tr>
<tr>
<td>Replace cutter blade unit</td>
<td></td>
</tr>
<tr>
<td>Platen cleaning</td>
<td></td>
</tr>
<tr>
<td>Prepare to move</td>
<td>Move on the same floor / Transport outdoors</td>
</tr>
<tr>
<td>Printer information</td>
<td></td>
</tr>
<tr>
<td>System information</td>
<td></td>
</tr>
</tbody>
</table>
### Job management

This menu is displayed by tapping **Jobs** icon.

<table>
<thead>
<tr>
<th>Print job</th>
<th>List of print jobs</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job history</td>
<td>Display job history</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print job history</td>
<td></td>
</tr>
<tr>
<td>Pause printing</td>
<td>Enable / Disable*</td>
<td></td>
</tr>
<tr>
<td>Delete all print jobs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Advanced (Paper settings)

Tap the paper information area and tap **Paper settings** to display this menu.

<table>
<thead>
<tr>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Roll length</strong></td>
</tr>
<tr>
<td>Change default</td>
</tr>
<tr>
<td><strong>Paper Thickness</strong></td>
</tr>
<tr>
<td>Head Height</td>
</tr>
<tr>
<td>-4 (Low) / -3 / -2 / -1 / 0 (Standard) / +1 / +2 / +3 (High)</td>
</tr>
<tr>
<td><strong>Skew detection accuracy</strong></td>
</tr>
<tr>
<td>Standard / Loose / OFF</td>
</tr>
<tr>
<td><strong>Cutting mode</strong></td>
</tr>
<tr>
<td>Automatic cut / Eject cut / User cut</td>
</tr>
<tr>
<td><strong>Cut speed</strong></td>
</tr>
<tr>
<td>Fast / Standard / Slow</td>
</tr>
<tr>
<td><strong>Trim edge first</strong></td>
</tr>
<tr>
<td>Auto / Off / On (Preset Length) / On (Input Length) / Manual</td>
</tr>
<tr>
<td><strong>Cut-dust reduction</strong></td>
</tr>
<tr>
<td>ON / OFF</td>
</tr>
<tr>
<td><strong>Transport unit vacuum strength</strong></td>
</tr>
<tr>
<td>Auto / Strong / Medium-strong / Standard / Medium-weak / Weak</td>
</tr>
<tr>
<td><strong>Roll paper tension (printing)</strong></td>
</tr>
<tr>
<td>High / Standard / Low</td>
</tr>
<tr>
<td><strong>Roll paper tension (feeding)</strong></td>
</tr>
<tr>
<td>High / Standard / Low</td>
</tr>
<tr>
<td><strong>Pause between scans</strong></td>
</tr>
<tr>
<td><strong>Ink drying wait time</strong></td>
</tr>
<tr>
<td>OFF / 0.5 seconds / 1 second / 3 seconds / 5 seconds / 7 seconds / 9 seconds</td>
</tr>
<tr>
<td><strong>Ink drying target area</strong></td>
</tr>
<tr>
<td>Overall / Leading edge</td>
</tr>
<tr>
<td><strong>Pause between pages</strong></td>
</tr>
<tr>
<td>OFF / 30 seconds / 1 minute / 3 minutes / 5 minutes / 10 minutes / 30 minutes / 60 minutes</td>
</tr>
<tr>
<td><strong>Leading edge margin (roll)</strong></td>
</tr>
<tr>
<td>3mm / 20mm</td>
</tr>
<tr>
<td><strong>Leading edge margin (sheet)</strong></td>
</tr>
<tr>
<td>3mm / 20mm</td>
</tr>
<tr>
<td><strong>Extension for borderless printing</strong></td>
</tr>
</tbody>
</table>

131
<table>
<thead>
<tr>
<th></th>
<th>Right side of paper</th>
<th>Left side of paper</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8 (max) / 7 / 6 / 5 / 4 / 3 / 2 / 1 (min)</td>
<td>8 (max) / 7 / 6 / 5 / 4 / 3 / 2 / 1 (min)</td>
</tr>
</tbody>
</table>

Detect paper width

- **Enable / Disable**

Reset paper settings by paper
### Advanced (LAN settings)

This menu is displayed by tapping **Network icon > Wi-Fi / Wireless Direct / Wired LAN > Settings > Advanced.**

The * on the right side of an item indicates the default value.

<table>
<thead>
<tr>
<th>Advanced</th>
<th></th>
<th>TCP/IP settings</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>IPv4</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>IPv6</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Set printer name</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TCP/IP settings</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>IPv4</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td></td>
<td>Auto setup*/ Manual setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNS server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>IPv6</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable/disable IPv6</td>
<td></td>
<td>Auto setup*/ Disable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPsec settings</td>
<td></td>
<td>Enable / Disable*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use DHCPv6</td>
<td></td>
<td>Use*/ Do not use</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual address</td>
<td></td>
<td></td>
<td>Use / Do not use*</td>
<td></td>
</tr>
<tr>
<td>DNS server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic update setting</td>
<td>Auto setup*/ Manual setup</td>
<td></td>
<td>IPv6 DNS dyn. update: manual</td>
<td>Enable / Disable*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IPv6 DNS dyn. update: stateless</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: stateful</td>
<td>Enable / Disable*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv6 Use IPv4 host/domain name</td>
<td>Enable / Disable*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv6 DNS host name</td>
<td>E</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv6 DNS domain name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### WSD setting

- **Enable/disable WSD**
  - Enable / Disable*

- **Optimize inbound WSD**
  - Enable* / Disable

- **Timeout setting**
  - 20 minutes / 15 minutes* / 10 minutes / 5 minutes / 1 minute

### Bonjour settings

- **Enable/disable Bonjour**
  - Enable* / Disable

- **Service name**

### IEEE802.1X settings

- **Authentication**
  - Do not use* / TLS / TTLS / PEAP

- **EAP-TTLS internal auth. method**
  - MSCHAPv2* / PAP

- **Weak encryption restriction**
  - Restrict* / Do not restrict

- **Weak certificate restriction**
  - Restrict* / Do not restrict

### Advanced setup

- **User-ID**
- **Username**
- **Password**
- **Authentication server name**
- **Last authentication result**

### SNTP settings

- **Client operation status**
  - Enable / Disable*
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTP server address</td>
<td></td>
</tr>
<tr>
<td>Polling interval</td>
<td></td>
</tr>
<tr>
<td>Spanning tree setting</td>
<td>Enable / Disable*</td>
</tr>
<tr>
<td>LPR protocol setting</td>
<td>Enable* / Disable</td>
</tr>
<tr>
<td>RAW protocol</td>
<td>ON* / OFF</td>
</tr>
<tr>
<td>LLMNR</td>
<td>ON* / OFF</td>
</tr>
<tr>
<td>Gigabit Ethernet settings</td>
<td>Autonegotiation* / 10 Mbps half duplex / 10 Mbps full duplex / 100 Mbps half duplex / 100 Mbps full duplex / 1 Gbps full duplex</td>
</tr>
<tr>
<td>Use Dedicated Port</td>
<td>ON* / OFF</td>
</tr>
<tr>
<td>Wi-Fi DRX setting</td>
<td>Enable* / Disable</td>
</tr>
<tr>
<td>Wired LAN DRX setting</td>
<td>Enable* / Disable</td>
</tr>
<tr>
<td>Reset SSL certificates</td>
<td></td>
</tr>
<tr>
<td>Reset LAN settings</td>
<td></td>
</tr>
</tbody>
</table>
Changing Settings from Operation Panel

This section describes the procedure for changing the settings, taking the steps to specify **Print head movable width setting** as an example.

1. Make sure printer is turned on.

2. On the HOME screen, tap (Setup).
   ➤ Menu Operations

3. Tap setting item to adjust.

   ![Device settings]
   
   The setting screen for the selected item appears.

4. Tap setting item.

   ![Print settings]

5. Tap setting to specify.

   ![Data width]
For more on setting items on the operation panel:

- Setting Items on Operation Panel
Setting Items on Operation Panel

Note

• The administrator password is required to change some setting items if it is enabled for changing settings using the operation panel.

For more on setting items which the administrator password is required:

⇒ Setting Administrator Password on Operation Panel

Items for Security

⇒ Administrator password setting

Items for Printer

⇒ Other device settings
⇒ Language selection
⇒ Firmware update

Items for Paper/Printing

⇒ Paper-related settings
⇒ Print settings

Items for Maintenance/Management

⇒ Job management
⇒ Printer information
⇒ Test print
⇒ LAN settings
⇒ Auto maintenance settings
⇒ Monitoring service settings
Job management

This setting item is displayed by tapping (Jobs) on the HOME screen.

• Print job
  Displays the print job list. Tapping a job displays the details. On the detail screen, you can delete the job.

• Job history
  Important
  • The administrator password is required to display the job history if it is enabled for changing settings using the operation panel.
  ◦ Display job history
    Displays the print job history. Tapping a print job displays the details.
  ◦ Print job history
    Prints out the print job history.

• Pause printing
  Selecting Enable while a print job is in progress pauses the print job after the current job is completed.

• Delete all print jobs
  Deletes all jobs in the job queue.
Test print

This setting item is displayed by tapping **Device settings** after tapping **(Setup)** on the HOME screen.

- **Nozzle Check**
  Prints out the nozzle check pattern.
  ➤ **Checking for Nozzle Clogging**

- **Status print**
  Prints out the printer status and setting value information.

  ➤ **Note**

  - **Status print (administrator)** is also displayed if the administrator password is enabled for changing settings using the operation panel.

  ➤ **Status Print**

- **Print LAN details**
  Prints out the network setting information.
  ➤ **Printing Network Settings**

- **Print setting print**
  Prints out the print settings list.

- **Print advanced paper settings**
  Prints out the setting values specified by **Advanced paper settings**.

- **Print job history**
  Prints out a record of print jobs, including the paper type and size, amount of ink consumed, and so on.
  Ink consumption indicates a rough estimate of the amount of ink consumed per print job.
  ➤ **Job management**

- **Print menu map**
  Prints out the menu list.

- **Print color list for palettes**
  Prints out color palette information.
Print settings

This setting item is displayed by tapping Device settings after tapping (Setup) on the HOME screen.

• Print head movable width setting
  Adjusts the Print head movable width.

• Prioritize paper size
  This is a setting item for roll paper.
  Select Enable to use the paper size setting as the basis for printing instead of other settings. The text or images in the margin are not printed.
  Select Disable to give priority to printing text or images.

  Note

  • The printed paper length is longer than the actual paper length. This is because the printed paper includes the upper/lower margins specified by Roll Paper Safety Margin and Near End Margin in the printer driver and excludes the paper margins.

• JPEG print settings
  Performs JPEG print settings.

• HP-GL/2 print settings
  Performs HP-GL/2 print settings.
  ➤ HP-GL/2 Settings

• Direct print settings from FTP
  Performs print settings when printing directly from FTP. You can perform four settings individually.

• Default print settings
  Prints out the default values of print settings.

• Print setting print
  Prints out the print settings list.
HP-GL/2 Settings

- Menus on HP-GL/2 print settings
- Menu Setting Combinations
- Standard Size Table
LAN settings

This setting item is displayed by tapping **Device settings** after tapping (Setup) on the HOME screen.

**Important**

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

**Note**

- You can also enter **LAN settings** by tapping (Network) on the HOME screen.

- **Wi-Fi**

  The following setting information on the Wi-Fi connection is displayed. (Some items are not displayed depending on printer settings.)

<table>
<thead>
<tr>
<th>Items</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Enabled (connected) / Enabled (disconnected) / Disable</td>
</tr>
<tr>
<td>Network name (SSID)</td>
<td>XXXXXXXXXXXXXXXXXXXXX XXXXXXXXXXXXXXXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Infrastructure</td>
</tr>
<tr>
<td>Channel</td>
<td>1 - 13</td>
</tr>
<tr>
<td>Wi-Fi security</td>
<td>Disable / WEP (64 bit) / WEP (128 bit) / WPA-PSK (TKIP) / WPA-PSK (AES) / WPA2-PSK (TKIP) / WPA2-PSK (AES)</td>
</tr>
<tr>
<td>IPv4 address</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
<tr>
<td>IPv4 subnet mask</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
<tr>
<td>IPv4 default gateway</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
<tr>
<td>IPv4 DNS dynamic setting</td>
<td>Enable / Disable</td>
</tr>
<tr>
<td>IPv4 DNS host name</td>
<td>XXXXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td>IPv4 DNS domain name</td>
<td>XXXXXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td>IPv6 link-local prefix length</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 manual prefix length</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 1</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------</td>
</tr>
</tbody>
</table>
| IPv6 stateless address 2       | XXXX: XXXX: XXXX: XXXX: 
|                                | XXXX: XXXX: XXXX: XXXX: (32 characters) |
| IPv6 stateless prefix length 2 | XXX (up to 3 digits) |
| IPv6 stateless address 3       | XXXX: XXXX: XXXX: XXXX: 
|                                | XXXX: XXXX: XXXX: XXXX: (32 characters) |
| IPv6 stateless prefix length 3 | XXX (up to 3 digits) |
| IPv6 stateless address 4       | XXXX: XXXX: XXXX: XXXX: 
|                                | XXXX: XXXX: XXXX: XXXX: (32 characters) |
| IPv6 stateless prefix length 4 | XXX (up to 3 digits) |

<table>
<thead>
<tr>
<th>DHCPv6</th>
<th>Enable / Disable</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCPv6 stateful address</td>
<td>XXXXXXXXXXXX</td>
</tr>
<tr>
<td>DHCPv6 stateful prefix</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td></td>
<td>length</td>
</tr>
</tbody>
</table>
| IPv6 default gateway 1     | XXXX: XXXX: XXXX: XXXX: 
|                            | XXXX: XXXX: XXXX: XXXX: (32 characters) |
| IPv6 default gateway 2     | XXXX: XXXX: XXXX: XXXX: 
|                            | XXXX: XXXX: XXXX: XXXX: (32 characters) |
| IPv6 default gateway 3     | XXXX: XXXX: XXXX: XXXX: 
|                            | XXXX: XXXX: XXXX: XXXX: (32 characters) |
| IPv6 default gateway 4     | XXXX: XXXX: XXXX: XXXX: 
|                            | XXXX: XXXX: XXXX: XXXX: (32 characters) |
| IPv6 primary DNS server address | XXXXXXXXXXXX |
| IPv6 secondary DNS server address | XXXXXXXXXXXX |
| IPv6 DNS dyn. update: manual | Enable / Disable |
| IPv6 DNS dyn. update: stateless | Enable / Disable |
| IPv6 DNS dyn. update: stateful | Enable / Disable |
| IPv6 Use IPv4 host/domain name | Enable / Disable |
| IPv6 DNS host name          | XXXXXXXXXXXX    |
| IPv6 DNS domain name        | XXXXXXXXXXXX    |
| MAC address                 | XX:XX:XX:XX:XX:XX (12 characters) |
| IPsec settings              | Enable (ESP) / Enable (ESP & AH) / Enable (AH) / Disable |
| Printer name                | XXXXXXXXXXXXXXXX (up to 15 characters) |
| Bonjour service name        | XXXXXXXXXXXXXXX |
|                            | XXXXXXXXXXXXXXX |
|                            | XXXXXXXXXXXXXXX |
|                            | XXXXXXXXXXXXXXXX (up to 52 characters) |

("XX" represents alphanumeric characters.)

To change the setting, tap Settings.
◦ Enable/disable Wi-Fi
Select Enable to wirelessly connect via wireless router.

◦ Wi-Fi setup
Select how to setup Wi-Fi.

☐ Easy wireless connect
Select if you specify the settings of the access point information to the printer directly from a
device (e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen
instructions of the connecting device for the setup procedure.

☐ Manual connect
Select when you perform settings for Wi-Fi manually using the operation panel of the printer.

☐ WPS (Push button method)
Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi Protected
Setup (WPS) push button method. Follow the on-screen instructions during setup.

☐ Other connection types

☐ Manual connect (adv.)
Select when you perform settings for Wi-Fi manually. You can specify multiple WEP keys.

☐ WPS (PIN code method)
Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.

Note
• By tapping Advanced, you can set LAN in detail.
  For the items that can be set, see the following.
  ➤ Advanced

• Wireless Direct
The following setting information on the Wireless Direct connection is displayed. (Some items are not
displayed depending on printer settings.)

<table>
<thead>
<tr>
<th>Items</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Enabled (connected) / Enabled (disconnected) / Disable</td>
</tr>
<tr>
<td>Network (SSID)/device name</td>
<td>DIRECT-XXXX-TA-20</td>
</tr>
<tr>
<td>Password</td>
<td>XXXXXXXXXXXX (10 characters)</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Wireless Direct</td>
</tr>
<tr>
<td>Channel</td>
<td>3</td>
</tr>
<tr>
<td>Wi-Fi security</td>
<td>WPA2-PSK (AES)</td>
</tr>
<tr>
<td>IPv4 address</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
<tr>
<td>IPv4 subnet mask</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
</tbody>
</table>
IPv4 default gateway | XXX. XXX. XXX. XXX (12 characters)
IPv4 DNS dynamic setting | Enable / Disable
IPv4 DNS host name | XXXXXXXXXXXX
IPv4 DNS domain name | XXXXXXXXXXXX
IPv6 link-local prefix length | XXX (up to 3 digits)
MAC address | XX:XX:XX:XX:XX:XX (12 characters)
IPsec settings | Disable
Printer name | XXXXXXXXXXXXXXXXXXX (up to 15 characters)
Bonjour service name | XXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX (up to 52 characters)

("XX" represents alphanumeric characters.)

To change the setting, tap **Settings**.

- **Enable/disable Wireless Direct**
  Select **Enable** to wirelessly connect without wireless router.

- **Update SSID/password**
  Updates the identifier (SSID) and password.

- **Wireless Direct device name**
  Changes the name (device name) of the printer displayed on Wi-Fi Direct compatible device.

- **Connection request confirmation**
  Changes the display / non-display of the confirmation screen when Wi-Fi Direct compatible devices are connected to the printer.

### Note
- By tapping **Advanced**, you can set LAN in detail.

  For the items that can be set, see the following.

  ➤ **Advanced**

- **Wired LAN**

  The following setting information on the Wired LAN connection is displayed. (Some items are not displayed depending on printer settings.)

<table>
<thead>
<tr>
<th>Items</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Enabled (connected) / Enabled (disconnected) / Disable</td>
</tr>
<tr>
<td>IPv4 address</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
<tr>
<td>IPv4 subnet mask</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
<tr>
<td>IPv4 default gateway</td>
<td>XXX. XXX. XXX. XXX (12 characters)</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>IPv4 DNS dynamic setting</td>
<td>Enable / Disable</td>
</tr>
<tr>
<td>IPv4 DNS host name</td>
<td>XXXXXXXXXXXXX</td>
</tr>
<tr>
<td>IPv4 DNS domain name</td>
<td>XXXXXXXXXXXXX</td>
</tr>
<tr>
<td>IPv6 link-local prefix length</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 manual prefix length</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 1</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 2</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 3</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 stateless prefix length 4</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>DHCPv6</td>
<td>Enable / Disable</td>
</tr>
<tr>
<td>DHCPv6 stateful address</td>
<td>XXXXXXXXXXXXX</td>
</tr>
<tr>
<td>DHCPv6 stateful prefix length</td>
<td>XXX (up to 3 digits)</td>
</tr>
<tr>
<td>IPv6 primary DNS server address</td>
<td>XXXXXXXXXXXXX</td>
</tr>
<tr>
<td>IPv6 secondary DNS server add.</td>
<td>XXXXXXXXXXXXX</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: manual</td>
<td>Enable / Disable</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: stateless</td>
<td>Enable / Disable</td>
</tr>
<tr>
<td>IPv6 DNS dyn. update: stateful</td>
<td>Enable / Disable</td>
</tr>
<tr>
<td>IPv6 Use IPv4 host/domain name</td>
<td>Enable / Disable</td>
</tr>
</tbody>
</table>
**IPv6 DNS host name** | XXXXXXXXXXXXX  
---|---  
**IPv6 DNS domain name** | XXXXXXXXXXXXX  
---|---  
**MAC address** | XX:XX:XX:XX:XX (12 characters)  
---|---  
**IPsec settings** | Enable (ESP) / Enable (ESP & AH) / Enable (AH) / Disable  
---|---  
**Printer name** | XXXXXXXXXXXXXXXXXXXXX (up to 15 characters)  
---|---  
**Bonjour service name** | XXXXXXXXXXXXX  
---|---  

("XX" represents alphanumeric characters.)

To change the setting, tap **Settings**.

- **Enable/disable Wired LAN**
  
  Select **Enable** when connecting to wired LAN.

### Note

- By tapping **Advanced**, you can set LAN in detail.
  
  For the items that can be set, see the following.
  
  ➤ **Advanced**

- **Print details**
  
  Prints out the LAN setting information of the printer with Wi-Fi connection, wired LAN connection, wireless direct connection.
  
  For the items that can be checked, see the following.
  
  ➤ **Printing Network Settings**

### Important

- Important information on your computer is stated on the paper on which the LAN setting information is printed. Please handle with care enough.

### Note

- You can also print out the LAN setting information by tapping in the following order.
  
  ➤ (Setup) > Device settings > Test print > Print LAN details

- **Advanced**
  
  By tapping **Advanced** on each setting screen of Wi-Fi connection, wired LAN connection, wireless direct connection, LAN information can be set in detail.

### Important

- If the LAN is disabled, the following items can not be selected.
• **Set printer name**
  Specifies the printer name. You can use up to 15 characters for the name.

  **Note**
  • You cannot use the same printer name as that already used for other LAN connected devices.
  • You cannot use a hyphen for the initial or last character of the printer name.

• **TCP/IP settings**
  Performs IPv4 or IPv6 setting.

• **WSD setting**
  Setting items when you use WSD (one of the network protocols supported in Windows 10, Windows 8.1, and Windows 7).
  □ **Enable/disable WSD**
    Selects whether WSD is enabled or disabled.

  **Note**
  • When this setting is enabled, the printer icon is displayed on the Network Explorer in Windows 10, Windows 8.1, and Windows 7.

  □ **Optimize inbound WSD**
    Selecting **Enable** allows you to receive the WSD printing data faster.

  □ **Timeout setting**
    Specifies the timeout length.

• **Bonjour settings**
  Setting items when you use Bonjour.
  □ **Enable/disable Bonjour**
    Selecting **Enable** allows you to use Bonjour to perform the network settings.

  □ **Service name**
    Specifies the Bonjour service name. You can use up to 48 characters for the name.

  **Note**
  • You cannot use the same service name as that already used for other LAN connected devices.

• **IEEE802.1X settings**
  Performs various settings for IEEE802.1X.

• **SNTP settings**
  Performs various settings for SNTP (Simple Network Time Protocol).

• **Spanning tree setting**
  Enables/Disables spanning tree. Selecting **Enable** avoids circulating data on a network.

• **LPR protocol setting**
  Enables/Disables the LPR setting.
- **RAW protocol**
  Enables/Disables RAW printing.

- **LLMNR**
  Specifies ON/OFF of LLMNR (Link-Local Multicast Name Resolution). Selecting **ON** allows the printer to detect printer's IP address from the printer name without a DNS server.

- **Gigabit Ethernet settings**
  Specifies the communication speed and communication method when using Gigabit Ethernet.

- **Use Dedicated Port**
  Selects whether to use a dedicated port for a command sent from a Canon application to the printer. Selecting **ON** allows you to use the dedicated port.

- **Wi-Fi DRX setting**
  Selecting **Enable** allows you to activate discontinuous reception when using Wi-Fi.

- **Wired LAN DRX setting**
  Selecting **Enable** allows you to activate discontinuous reception when the printer is connected to a device compatible with wired LAN.

- **Reset SSL certificates**
  Initializes SSL certificate information.

- **Reset LAN settings**
  Initializes the network settings on the printer.
  After resetting, perform setup again as necessary.
Other device settings

This setting item is displayed by tapping **Device settings** after tapping **Setup** on the HOME screen.

**Important**

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

- **Energy saving settings**
  
  To save electricity, enable this setting to turn off the printer automatically or to enter sleep mode when specified length of time has elapsed.

  ◦ **Auto power off**
  
  Sets the time until the printer turns off automatically. If no operations are performed on the printer for the specified duration of the time after entering Sleep mode, the printer automatically turns off.

  ◦ **Sleep timer**
  
  Specifies the length of time to enter sleep mode automatically when no operation is made.

- **Operation restrictions**

  Restricts the following operations.

  ◦ **Job history**
  
  Restricts to display the print job history.

  ◦ **Remote UI**
  
  Restricts to use Remote UI.

- **Use USB connection**

  Enables / Disables USB connection.

- **Date/time setting**

  Sets the current date and time.

- **Date display format**

  Sets the format of dates displayed on the touch screen and printed on photos.

- **Time zone (GMT)**

  Specifies the time zone according to a country or region you live in.

  Specifying the time zone allows you to display the correct time and date an e-mail was sent on your mail software.

  Select the time difference from GMT (Greenwich mean time) according to a country or region you live in.

- **Sound control**

  Select whether to sound / not sound for key touch sound and alarm sound.
• **Length unit setting**
  Selects the length unit (meter or feet/inch).

• **EOP timer setting**
  Specify the timeout period before cancellation of print jobs that cannot be received by the printer.

• **Job history sending setting**
  The printer sends a job history when *Send* is selected.
Language selection

This setting item is displayed by tapping **Device settings** after tapping **(Setup)** on the HOME screen.

**Important**

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

Changes the language for the messages and menus on the touch screen.
Paper-related settings

This setting item is displayed by tapping Device settings after tapping Setup (Setup) on the HOME screen.

- **Keep media type**
  Select Enable to keep using the same type of paper.

- **Manage remaining roll amount**
  Selects the method to manage remaining roll amount and that to display warning when the roll is running short.
  - **Barcodes**
    Manages remaining roll amount by using a barcode.
    By using the barcode every time you replace a roll, you can manage remaining roll amount properly. Specify the roll length properly when you load a new roll.
  - **Warning message only**
    Estimates remaining roll amount by using media type and roll diameter information. A warning appears when remaining roll amount comes closer to the specified value.
    Depending on the environment you are using the printer, selecting this setting may not manage remaining roll amount as precisely as you expected. We recommend you select a higher value for this setting item.
  - **Disable**
    Select to disable managing remaining roll amount.

- **Roll amount warning setting**
  Specifies when to warn the remaining roll paper amount.

- **Detect paper setting mismatch**
  Selects printer action when you start printing with the paper size, the media type, and print settings different from those registered.

- **Advanced paper settings**
  Specifies advanced paper settings for each paper type.

---

**Important**

- You can select Extension for borderless printing as a setting item for some paper types.
  If you select 1 (min) for Right side of paper or Left side of paper on this setting item, a slight border remains on the paper. In addition, the paper may be smudged with extra ink.

- **Paper size recognition settings**
  Selects which size is preferred when paper size detection is enabled.
  - **Roll paper setting 1**
Select whether B4 or 10 inch is applied when a roll of an intermediate size is detected.

- **Roll paper setting 2**
  Select whether A3 or 300 mm is applied when a roll of an intermediate size is detected.

- **Roll paper setting 3**
  Select whether 300 mm or 12 inch is applied when a roll of an intermediate size is detected.

- **Roll paper setting 4**
  Select whether 500 mm or 20 inch is applied when a roll of an intermediate size is detected.

- **Roll paper setting 5**
  Select whether B2 or 20 inch is applied when a roll of an intermediate size is detected.

- **Roll paper setting 6**
  Select whether A1 or 600 mm is applied when a roll of an intermediate size is detected.

- **Roll paper setting 7**
  Select whether 600 mm or 24 inch is applied when a sheet of an intermediate size is detected.

- **Auto feed at power on**
  When **Enable** is selected, the printer judges the existence of paper exchange when starting up, and if paper has been exchanged, paper feeding operation is performed.
  It may take time to judge paper exchange.
  When **Disable** is selected, the printer does not judge whether or not to change the paper when starting up, and waits with the current paper feed setting.

- **Print advanced paper settings**
  Tapping **Yes** prints out each setting specified in **Advanced paper settings**.

- **Reset paper settings for all paper**
  Tapping **Yes** initializes each setting specified in **Advanced paper settings**.
  Entering the administrator password is required if it is enabled.

- **Important**
  - When you set the paper settings back to the factory default, added or updated paper information using Media Configuration Tool is erased.
Auto maintenance settings

This setting item is displayed by tapping Device settings after tapping (Setup) on the HOME screen.

Important

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

- **Auto nozzle check**
  Enables/Disables automatic nozzle checking. You can also select the page interval to perform automatic nozzle checking.

- **Nozzle check error display**
  Enables/Disables displaying the nozzle check error.

- **System cleaning frequency**
  Specifies the frequency of automatic system cleaning.

Note

- To maintain print quality, we recommend you select Short if you use the printer at a higher place.

- **Print pattern after new head**
  Selects whether you print an adjustment pattern after replacing the Print head.
Administrator password setting

This setting item is displayed by tapping **Device settings** after tapping (Setup) on the HOME screen.

**Important**

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

You can specify or disable the administrator password.

If you specify the administrator password, select the range and specify the administrator password.

**Remote UI or other tools**

Entering the administrator password is required to change the setting items using Remote UI or some software.

**LCD, Remote UI, or other tools**

Entering the administrator password is required to change the setting items using the operation panel of the printer, Remote UI, or some software.

For details:

- [Setting Administrator Password on Operation Panel](#)
Setting Administrator Password on Operation Panel

You can specify or disable the administrator password.

Specifying the administrator password requires you to enter the password to use the items or change the settings below.

- LAN settings
- Other device settings
- Language selection
- Auto maintenance settings
- Administrator password setting
- Status print (administrator)
- Monitoring service settings
- Firmware update

Follow the procedure below to specify the administrator password.

1. **Make sure printer is turned on.**

2. On the HOME screen, tap (Setup).

3. Tap Device settings.

4. Tap Administrator password setting.

5. Enter the password on the administrator password input screen and tap OK.

   **Important**

   • The administrator password is set at the time of purchase. The printer's serial number is used as the password.

   For the administrator password, refer to Administrator Password.

   If an administrator password is not specified, the confirmation message appears. Confirm the message and tap Yes.

6. Tap Change administrator password.

   If an administrator password is not specified, the confirmation message appears. Confirm the message and tap OK.

7. Tap range where administrator password is valid.
Remote UI or other tools
Entering the administrator password is required to change the setting items using Remote UI or some software.

LCD, Remote UI, or other tools
Entering the administrator password is required to change the setting items using the operation panel of the printer, Remote UI, or some software.

8. Enter administrator password.

**Important**

- The following character restrictions apply to the password:
  - Set the password by using 4 to 32 characters.
  - The allowed characters are single-byte alphanumeric characters.
  - For security reasons, we recommend you use 8 and more alphanumeric characters.

9. Tap Apply.

10. Enter administrator password you specified again.

11. Tap OK.

   The administrator password is enabled.

**When You Want to Disable the Administrator Password:**

After operating steps 1 to 5 of the password specifying procedure, tap Remove administrator password. After that, please follow the instructions displayed on the touch screen.
Monitoring service settings

This setting item is displayed by tapping Device settings after tapping (Setup) on the HOME screen.

**Important**

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

- Enable/disable monitoring service
  Selecting Enable allows the printer to send error details to the service center.

- Communication test
  Performs a communication test with the service center.

- Communication log
  Displays the list of error numbers (up to 30), error code, and time the error occurs. Tapping an item displays the error details.

- Timing for ink level notification
  Sets the timing to notify the service center of remaining ink amount.
Printer information

This setting item is displayed by tapping setup (Setup) on the HOME screen.

• **System information**
  Displays printer's system information.

• **Error history**
  Displays the error history.
  ◦ **Hardware error**
    Displays the hardware error codes (up to 5).
  ◦ **Recoverable error**
    Displays the recoverable error (e.g. paper or ink related error) codes (up to 5).
  ◦ **Paper feed/transfer error**
    Displays the error codes for errors which occur during paper feed/transfer (up to 5).
    Tapping an error code displays the error details.
  For more on the error code, refer to [List of Support Code for Error](#).

• **Usage totals**
  Displays the printer's record of use such as total print area or the amount of ink consumption.

• **Head information**
  Displays the Print head serial number, elapsed days since the current Print head was installed, and dot count.

• **Head alignment performance log**
  Displays the Print head alignment performance log (up to 5).

• **Values applied with auto settings**
  Displays the print settings applied the last print job.
HP-GL/2 Settings

- Menus on HP-GL/2 print settings
- Menu Setting Combinations
- Standard Size Table
Menus on HP-GL/2 print settings

- Color mode
- Print quality
- Input resolution
- Print target
- Paper src
- Margin
- Oversize
- Conserve paper
- Rotate
- Auto rotation
- Enlarge/Reduce
- Print centered
- Cut to standard size
- Mirror
- Merge
- Smooth
- Thicken fine lines
- Adjust faint lines
- Width correction
- Print color list for palettes
- Warning display
- Detect image size
- Select palette
- Define palette
- Pen 0 to Pen 15
- Reset palette
Color mode

Lets you specify the color(s) to use when printing HP-GL/2 data.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Print quality settings

- **Color (perceptual)**
  - If you select **Line drawing** for **Print target**:
    Reproduces colors of general images naturally and features smooth gradation. In addition, selecting this setting allows you to adjust colors easily using an application software.
  - If you select **Photo** for **Print target**:
    Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting this setting allows you to adjust colors easily using an application software.

- **Color (saturation) (Initial setting)**
  - If you select **Line drawing** for **Print target**:
    Prints in easy-to-see colors suitable for line drawing.
  - If you select **Photo** for **Print target**:
    Reproduces vivid colors on data such as a poster.

- **Color (correct off)**
  Performs printing without color matching.

- **Monochrome**
  - If you select **Line drawing** for **Print target**:
    Select this setting to print a line drawing using black ink.
  - If you select **Photo** for **Print target**:
    Prints color data converting to monochrome. Continuous tones are reproduced using gray halftones.

- **Monochrome BMP**
  The colors other than white are printed in black.
Print quality

Lets you specify print quality.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Print quality settings

- **5 (Fast)**
  Select this setting for faster printing.

- **4**
  Printing speed is faster than that in selecting 3.

- **3 (Initial setting)**
  Select this setting for standard printing that balances print quality and printing speed.

- **2**
  Printing quality is higher than that in selecting 3.

- **1 (High)**
  Select this setting to give print quality priority.
  This causes printing to take longer than other settings, but print quality is higher.
**Input resolution**

Specifies the resolution for internal rendering process.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Print quality settings

- **600 dpi (Initial setting)**
  
  Specifies 600 dpi for internal rendering resolution.
  
  This setting raises the accuracy of internal processes for finer printing.

- **300 dpi**
  
  Specifies 300 dpi for internal rendering resolution.
  
  This setting increases the speed of internal processes for faster printing.
Print target

Specifies the print target of HP-GL/2 data.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Print quality settings

• Photo
  
  Select this setting to print a data which includes illustration or photo.

• Line drawing (Initial setting)
  
  Select this setting to print a drawing data which includes lines.
Paper src

Specifies the paper type (sheet or roll) for HP-GL/2 data printing.

This setting item is displayed by tapping in the following order:

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

- **Auto select (Initial setting)**
  Select an appropriate paper source automatically.

- **Roll paper**
  Select this setting to print on the roll paper.

- **Manual**
  Select this setting to print on the sheets.
Margin

Specifies the margins for HP-GL/2 data printing.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

Note

- If the Leading edge margin (roll) and/or Leading edge margin (sheet) settings on Advanced paper settings are different from the settings here, the larger of the settings is given priority.

- 3mm (Initial setting)
  
  Specifies 3 mm margin.

  However, the trailing edge margin for cut sheet paper is 20 mm.

- 5mm
  
  Specifies 5 mm margin.

  However, the trailing edge margin for cut sheet paper is 20 mm.
Oversize

Specifies whether margins are within or outside the HP-GL/2 data image drawing range.

This setting item is displayed by tapping in the following order.

- Setup > Device settings > Print settings > HP-GL/2 print settings > Paper settings

**Enable (Initial setting)**

Specifies margins outside the HP-GL/2 data image drawing range.

Adding margins outside the image drawing range will not cause part of the image to be cut off. However, you will need to print on paper of a size that is greater than the size of the image drawing range specified by the HP-GL/2 data plus the top, bottom, left, and right margins.

**Disable**

Specifies margins inside the HP-GL/2 data image drawing range.

Depending on the layout, adding margins inside the image drawing range may cause part of the image to be cut off.

**Note**

- Some CAD applications can cause the origin to be out of position and part of the image to be cut off. Experiment with the Disable and Enable settings of this function to find the one that works best.

### OVERSIZE SETTING EXAMPLES

- **A.** Printed page size
- **B.** Image drawing range

When you print an image above, using **Oversize** allows you to select where to apply margins (outside/inside the image) based on the image drawing range.

Select **Enable** to apply margins outside the image, or select **Disable** to apply those inside.

- **When Disable** is selected:
  
  Printing is performed based on the image drawing range. The origin is specified on the upper left of the paper.
Margins are added to the inside of the image drawing range.

B. Image drawing range

C. Margins

If the actual drawing image is smaller than the specified image drawing range, the image is not cut off by the margins.

• When Enable is selected:

Printing is performed based on the image drawing range. The origin is specified on the upper left of the paper.

Margins are added to the outside of the image drawing range.

B. Image drawing range

C. Margins

When you specify the paper size for printing, select the size which covers both the image drawing range and margins.
D. Paper for printing

E. Image drawing range with margins

If you select the paper size which cannot cover the margins, the image may be cut off.
F. Range which cannot be printed
G. Paper for printing
Conserve paper

When printing on roll paper, eliminates blank space (margins) above and/or below the image (if there is any) to conserve paper.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

- **ON**
  Blank space above and below the image is eliminated when printing.

- **OFF (Initial setting)**
  Paper is not conserved.

**CONSERVE PAPER SETTING EXAMPLES**

Print data (image drawing range)

- **When OFF is selected:**

- **When ON is selected:**
Rotate

Rotates the image according to the specified setting.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

• **0 degrees (Initial setting)**
  
  Image is not rotated.

• **90 degrees**
  
  Specified image is rotated by 90 degrees.
  
  If the part of rotated image is out of the paper width, the part is not printed.

>>> Note

• When the print data includes HP RTL, the HP RTL image part is not rotated.

>>> Note

• If **ON** is selected for **Auto rotation**, priority is given to the **Auto rotation** setting.
**Auto rotation**

Printing on paper while **Auto rotation** is set to **ON** causes the image to be rotated automatically in accordance with the most efficient image layout in order to conserve paper and avoid images running off the edges of the paper.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

- **ON**
  
  Image is rotated by 90 degrees in the cases described below.
  
  ◦ When the output page is in portrait orientation and the long side is shorter than the roll paper width
  ◦ When the output page is in landscape orientation, and the long side is longer than the paper width and the short side is shorter than the paper width

  Even if the long edge and short edge of the output page are both longer than the paper width, and the output page is in landscape orientation, the image is rotated to expand the print range.

  **Note**

  - The length that the roll paper will be cut to depends on rotation.
  - The desired printing results may not be obtained when HP-GL/2 data that does not include image drawing range information is received.

  In this case, select **Command priority** for **Detect image size**.
  - When the print data includes HP RTL, the HP RTL image part is not rotated.

- **OFF (Initial setting)**
  
  Images are not rotated automatically.

**AUTO ROTATE EXAMPLES**

- Efficient layout

- Prevents image from running off edge.
• Even if the image runs off the edge of the paper, it is rotated to expand the print range.
Enlarge/Reduce

Enlarges or reduces images

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

- **Fit paper size**
  Enlarges or reduces the image for printing to fit to the paper loaded in the printer.

  **Note**
  - Data line widths are not enlarged or reduced.
  - Margin widths are not enlarged or reduced. Because of this, paper size scaling and post-processing image scaling may not be the same.
  - The maximum enlarge/reduce rate for this setting is calculated by (maximum width/1 inch x 100 %). Therefore, the maximum rate is 2400 % for 24 inch model, 3600 % for 36 inch model, and 4400 % for 44 inch model. If the calculation result exceeds the maximum rate, the image is enlarged according to the maximum rate for each model.

- **Same size (Initial setting)**
  Image is not enlarged/reduced.

- **Scaling**
  Enlarges or reduces the image to the specified scaling value for printing.

  Scaling can be specified within a range of 25 % to 400 %.

  **Note**
  - Data line or margin widths are not enlarged or reduced.

**ENLARGE/REDUCE Scaling SETTING EXAMPLE**

The output object area is enlarged or reduced as specified by the Scaling setting. The origin is in the upper-left corner.

For example, doubling the length and width of A4 size paper results in A2 size paper.

If there are margins of 3 mm, the A4 size output object area measures 291 mm x 204 mm.

Specify a value of 200% for the Scaling setting to produce a post-processing size of 582 mm x 408 mm.

(Note that ambient conditions may cause paper to expand and contract.)
A. Output object area
B. 200% post-processing size

**ENLARGE/REDUCE Fit paper size SETTING EXAMPLE**

Fit paper size expands or reduces the long side of the print data's output object area so it matches the long side of the output page size output object area. The origin is in the upper-left corner.

Margin widths are not enlarged or reduced. Because of this, paper size scaling and post-processing image scaling may not be the same.

For example, doubling the length and width of A4 size paper results in A2 size paper.

If there are margins of 3 mm, the A4 size output object area measures 291 mm x 204 mm.

Specifying Fit paper size will result in a post-processing size of approximately 588 mm x 412 mm.

(Note that ambient conditions may cause paper to expand and contract.)
A. Output object area
B. Fit to long side post-processing size
Print centered

Prints the output object area in the center of the paper.
This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

• **ON**
  ◦ For cut sheet paper
    Prints the output object area in the center of the paper.
  ◦ For roll paper
    Prints the output object area in the horizontal center of the paper.

  [Note]
  • The output object area is not printed in the center when the paper size is smaller than the output page size.

• **OFF (Initial setting)**
  The output object area is not printed in the center of the paper.

PRINT CENTERED EXAMPLES

• **OFF** is selected when printing on sheet

• **ON** is selected when printing on sheet

• **OFF** is selected when printing on roll
• **ON** is selected when printing on roll
Cut to standard size

Specifies standard size as the output page size when printing on roll paper.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

• ON

Cuts to standard size in accordance with the roll paper width.

When there are two lengths/widths applicable for a given roll paper width, the optimum size is selected automatically.

Note

• If ON is selected for Conserve paper and there is blank space above/below the image, the size will not be standard size.

• When ON is selected for Print centered, printing will be in the center of the standard size.

• If there is no standard size corresponding to the roll paper width, operation is the same as if OFF is selected. No message is displayed.

• For information about supported standard sizes, see Standard Size Table.

• OFF (Initial setting)

Cutting according to standard size is not performed.

STANDARD CUT EXAMPLES

• A3-size width roll paper

A. Position of cut when OFF
B. Position of cut when ON

• A3-size width roll paper
A. Position of cut when OFF
B. Position of cut when ON
Mirror

Flip the image horizontally and print.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Paper settings

• **ON**
  
  Flip the image horizontally and print.
  
  Depending on the paper to be printed, the position where the horizontally flipped image is printed varies.

• **OFF (Initial setting)**
  
  Horizontal flip of the image is not performed.

HORIZONTAL FLIP (MIRROR) EXAMPLE

• When **OFF** is selected when printing on roll paper:

• When **ON** is selected when printing on roll paper:
  
  Do not move the position to print the image on the paper, flip the image horizontally.

• When **OFF** is selected when printing on cut paper or roll paper cut to standard size:
• When ON is selected when printing on cut paper or roll paper cut to standard size:
  Flip the image horizontally for each position where you print the image on the paper.
Merge

Specifies how colors should be processed when lines overlap.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager

Note

• The data is given priority when a specification command is included in the HP-GL/2 data.
• If the HP-GL/2 data does not include a specification command, the operation is performed using the specified selection value.

• ON
The section where lines overlap becomes the mixed color of the intersecting lines.

• OFF (Initial setting)
The section where lines overlap becomes the same color as one of the intersecting lines.

ENABLE MERGE EXAMPLE

• When OFF is selected:

  A
  B

  A. Data drawn previously
  B. Data drawn later than A

• When ON is selected:

---
Smooth

Makes arc drawing smoother.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager

- **Software** (Initial setting)

  Draws arcs using HP-GL/2 data settings.

  Default value of the central angle of an arc in HP-GL/2 is 5° (Regular 72-sided polygon) if the angle is not specified using a HP-GL/2 command.

- **Smoothing**

  Draws curves that are smoother than arcs with a central angle of 1°.

**SMOOTHING EXAMPLES**

- When **Software** is selected:

- When **Smoothing** is selected:
Thicken fine lines

Performs correction to avoid breaks in fine lines.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager

• **ON**
  
  Corrects line widths so fine lines are drawn more sharply, without breaking.
  
  The line color is not changed.

• **OFF (Initial setting)**
  
  Thin lines are not corrected.
  
  Some line thicknesses may cause them to become broken.
Adjust faint lines

Performs correction so that bright colored fine lines are printed more clearly.
This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager

• ON
  Adjusts the colors of brightly colored fine lines so they are drawn more clearly.

• OFF (Initial setting)
  Fine lines are not corrected.
Width correction

Corrects pen widths in accordance with a specific correction setting. Correction settings can be configured for two groups: Black/gray and Color.

Select and apply the correction amount according to the pen color when performing a line drawing command of HP-GL/2 data.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager

Note

• This setting is not applied for the white pen, which has the same RGB values (255).
• This setting is applied to vector data line widths.
• When this setting is a minus value, it is not applied to fine lines of widths that are less than the minimum line width of the printer.
• If the setting value is smaller than 1 dot, the value of 1 dot width is applied.
• When ON is selected for Thicken fine lines, the resulting line may be thicker than the specified setting.

• Black/gray

For configuring the correction setting of black and gray line widths.

A value within the range of -20 to +20 can be specified. 1 unit of the correction value is equivalent to 0.025 mm.

• Color

For configuring the correction setting of color line widths.

A value within the range of -20 to +20 can be specified. 1 unit of the correction value is equivalent to 0.025 mm.

LINE WIDTH CORRECTION EXAMPLE

• Negative (-) setting

• Positive (+) setting
Print color list for palettes

Prints out the sample (256 colors) of the color specified in each pen number. The coloring also changes depending on the paper type to be printed.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager
**Warning display**

Displays HP-GL/2 warnings.

The display is switched when two GL/2 warnings below occur.

- Warnings when the printer's parameter setting specification does not support the parameter settings of created HP-GL/2 data
- HP-GL/2 warning commands when the printer does not support the created HP-GL/2 data

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Processing options

**Note**

- Warning is always displayed when one of the errors below occurs regardless of the setting.
  - When virtual GL/2 memory exceeds acceptable level
  - When GL/2 display list memory is insufficient
  - When the number of polygon vertexes which GL/2 data has exceeds acceptable level
- Warning is always displayed on the status monitor or Remote UI regardless of the setting.

- **Enable**
  Displays specific GL/2 warning on the touch screen.

- **Disable (Initial setting)**
  Does not display specific GL/2 warning on the touch screen.
Detect image size

Specifies the output object area method that provides efficient printing, which avoids parts of images being cut off when a HP-GL/2 data does not include image drawing range information.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Processing options

• OFF (Initial setting)

Normally, use this setting.

Note

• When a HP-GL/2 data include image drawing range information, the image drawing range is determined using that information.

When a HP-GL/2 data does not include image drawing range information, the image drawing range use the printer's maximum roll paper width as the horizontal dimension and 1.5 times the maximum roll paper width as the vertical dimension.

• Command priority

When select OFF, the drawing image is missing or is output as a blank sheet, use this setting.

Note

• When a HP-GL/2 data include image drawing range information, the image drawing range is determined using that information.

When a HP-GL/2 data does not include image drawing range information, the image drawing range is determined using the value designated by another command in the data.

However, not all HP-GL/2 data can be supported.
Select palette

Selects a palette to use when printing HP-GL/2 data.

According to the setting of the selected palette, the line width, line color, and line attributes are specified.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager >

**Pen setup**

- **Software (Initial setting)**
  - Performs printing with the setting of HP-GL/2 data.

- **Palette A**
  - Performs printing with the setting of Palette A.

- **Palette B**
  - Performs printing with the setting of Palette B.

- **Factory**
  - Performs printing with the predefined settings.

**Note**

- When you select a palette other than **Software**, the printer performs printing with the pen setting of the specified palette even if the image data has the pen setting.

- **Palette A** and **Palette B** have the same settings as **Factory** in the initial state.
Define palette

Specifies each pen setting in Palette A and Palette B.

The pen setting in Factory cannot be changed.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager >

Pen setup

• Palette A
  Specifies the line width, line color, and line attributes from Pen 0 to Pen 15.
  Each initial pen setting in Palette A is same setting as Factory.

• Palette B
  Specifies the line width, line color, and line attributes from Pen 0 to Pen 15.
  Each initial pen setting in Palette B is same setting as Factory.

• Factory
  Performs printing with the predefined settings (line width/line color/line attributes).
  The pen setting cannot be changed.
Pen 0 to Pen 15

Specifies Width, Color, and Line attributes settings for each of the 16 pens (numbered 0 to 15) that make up each palette.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager > Pen setup > Define palette > Palette A or Palette B

• Width
   Specifies the line width as one of the values below.
   0.04mm/0.08mm/0.13mm/0.18mm/0.25mm/0.35mm
   0.50mm/0.65mm/0.70mm/0.80mm/0.90mm/1.0mm
   1.4mm/2.0mm/3.0mm/5.0mm/8.0mm/12.0mm

• Color
   Specifies the line color from the color palette number from 0 to 255 indicated by the color sample printed with Print color list for palettes.

• Line attributes
   Specifies line cap and joint attributes.
   ◦ No setting
     Leaves line caps unchanged.

   Leaves line joints mitered.

   ◦ Circle setting
     Rounds line caps and line joints.

   Leaves line caps and line joints rounded.
Reset palette

Resets palette pen parameters configured using Define palette.

This setting item sets the palette pen parameters back to the default.

This setting item is displayed by tapping in the following order.

(Setup) > Device settings > Print settings > HP-GL/2 print settings > Line & pen manager >

Pen setup

- **All palettes**
  - Resets all palette pen parameters.

- **Palette A**
  - Resets Palette A pen parameters.

- **Palette B**
  - Resets Palette B pen parameters.

### PALETTE DEFAULTS

Palette defaults are the same settings as Factory in the initial state.

<table>
<thead>
<tr>
<th>Pen number</th>
<th>Line Width (mm)</th>
<th>Colors (R, G, B)</th>
<th>Line Attributes</th>
<th>Tip</th>
<th>Connecting Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.13</td>
<td>0 (255, 255, 255)</td>
<td>Rounds</td>
<td>Rounds</td>
<td>Rounds</td>
</tr>
<tr>
<td>1</td>
<td>0.18</td>
<td>1 (0, 0, 0)</td>
<td>Rounds</td>
<td>Rounds</td>
<td>Rounds</td>
</tr>
<tr>
<td>2</td>
<td>0.25</td>
<td>2 (255, 0, 0)</td>
<td>Rounds</td>
<td>Rounds</td>
<td>Rounds</td>
</tr>
<tr>
<td>3</td>
<td>0.35</td>
<td>3 (0, 255, 0)</td>
<td>Rounds</td>
<td>Rounds</td>
<td>Rounds</td>
</tr>
<tr>
<td>4</td>
<td>0.50</td>
<td>4 (255, 255, 0)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>5</td>
<td>0.65</td>
<td>5 (0, 0, 255)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>6</td>
<td>0.70</td>
<td>6 (255, 0, 255)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>7</td>
<td>0.80</td>
<td>7 (0, 255, 255)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>8</td>
<td>0.90</td>
<td>8 (233, 233, 233)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>9</td>
<td>1.0</td>
<td>12 (127, 127, 127)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>10</td>
<td>1.4</td>
<td>19 (255, 214, 0)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>11</td>
<td>2.0</td>
<td>27 (0, 255, 214)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>12</td>
<td>3.0</td>
<td>35 (214, 0, 255)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>13</td>
<td>5.0</td>
<td>68 (205, 205, 0)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>14</td>
<td>8.0</td>
<td>100 (0, 168, 168)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
<tr>
<td>15</td>
<td>12.0</td>
<td>110 (168, 0, 115)</td>
<td>No setting</td>
<td>No setting</td>
<td>Miter</td>
</tr>
</tbody>
</table>
Menu Setting Combinations

- Conserve paper and Auto rotation
- Enlarge/Reduce (Scaling) and Auto rotation
- Print centered and Cut to standard size
- Cut to standard size and Auto rotation and Enlarge/Reduce (Fit paper size)
- Detect image size and Oversize
- Detect image size and Print centered
Conserve paper and Auto rotation

When **Conserve paper** and **Auto rotation** are both specified, **Auto rotation** is performed first, followed by the **Conserve paper** process.

After **Auto rotation** is applied to the print data, the image is printed with upper and lower blank areas removed.

---

**Conserve paper AND Auto rotation EXAMPLE**

Print data (image drawing range)

![Print data image]

Image after auto rotation

![Image after auto rotation]

A. Blank area

Printed image
Printed without upper/lower blank area.
**Enlarge/Reduce (Scaling) and Auto rotation**

When both **Enlarge/Reduce (Scaling)** and **Auto rotation** are specified, **Enlarge/Reduce (Scaling)** is done first and then **Auto rotation** is done to determine if printing is possible.

Printing is done without **Auto rotation** if the size of the image after doing **Enlarge/Reduce (Scaling)** would cause the image to run off the edge of the paper were **Auto rotation** executed.

### Enlarge/Reduce (Scaling) AND Auto rotation EXAMPLE

**Print data (image drawing range)**

- Printed image with **Enlarge/Reduce (Scaling)** only.

- Printed image when the image runs off the edge of paper.

Auto rotation is not performed.
Print centered and Cut to standard size

When both Print centered and Cut to standard size are specified, first the optimum standard size is determined based on the HP-GL/2 data and the roll paper loaded on the printer. Next, Print centered is performed in accordance with the standard size.

Print centered AND Cut to standard size EXAMPLE

When A3 width roll paper is loaded, A3 portrait is chosen as the optimal standard size based on the roll paper width and image size. Next, Print centered is performed in accordance with the A3 portrait.

Print data (image drawing range)

A. Virtual area for A3 size (portrait)
B. Virtual area for A4 size (landscape)

- Printed image when ON is selected for Print centered and OFF is selected for Cut to standard size
A. Position of cut

- Printed image when ON is selected for Print centered and ON is selected for Cut to standard size

A. Position of cut for A3 size (portrait)
Cut to standard size and Auto rotation and Enlarge/Reduce (Fit paper size)

When Cut to standard size, Auto rotation, and Enlarge/Reduce (Fit paper size) are all specified, first suitable standard size candidates are determined based on the roll paper loaded on the printer.

Next, it decides the optimum standard size and rotation direction from the matching result between the data to which Auto rotation is applied and all candidate sizes.

Finally, Enlarge/Reduce (Fit paper size) process is performed according to the decided standard size.

SMALL IMAGE EXAMPLE

When A3 width roll paper is loaded, A4 landscape is chosen as the optimal standard size based on the roll paper width and image size.

Next, Auto rotation is performed in accordance with the A4 landscape. Finally, the image is enlarged and printed to match A4 size paper.

Print data (image drawing range)

A. Virtual area for A4 size

Since the image fits on A4 size paper, A4 landscape is chosen as the standard size.

- Image after auto rotation
- Printed image after fit to paper
**LARGE IMAGE EXAMPLE**

When A3 width roll paper is loaded, A3 portrait is chosen as the optimal standard size based on the roll paper width and image size.

Next, **Auto rotation** is performed in accordance with the A3 portrait. Finally, the image is reduced and printed to match A3 size paper.

**Print data (image drawing range)**

Since the image does not fit on A3 size paper, A3 portrait is chosen as the maximum standard size.

- Image after auto rotation
A. Position of cut for A3 size
Detect image size and Oversize

Operation is as described below when both Detect image size and Oversize are specified.

• When OFF or Command priority is selected for Detect image size and Disable is selected for Oversize:

  First, determine the image drawing range based on the Detect image size setting, and then perform the processing when Disable is selected for Oversize.

  Since margins are added inside the image drawing range, images may be chipped depending on the layout.

• When OFF or Command priority is selected for Detect image size and Enable is selected for Oversize:

  First, determine the image drawing range based on the Detect image size setting, and then perform the processing when Enable is selected for Oversize.

  Since margins are added outside the image drawing range, images will not be chipped due to the margins.

  However, you will need to print on paper that is larger than the size of the image drawing range determined based on Detect image size setting, plus the top, bottom, left and right margins.

Note

• Not all HP-GL/2 data can be supported.

Detect image size AND Oversize EXAMPLE

The example below shows printing of data in which a figure is located in the upper left corner with margins below and to the right, on roll paper that is larger than the command-specified image drawing range (size normally specified by the application).

A: The image drawing range determined based on the Detect image size setting

• When OFF or Command priority is selected for Detect image size and Disable is selected for Oversize:

  Since margins are added inside the image drawing range, images may be chipped depending on the layout.
B: Position of cut

The paper is cut with the length of the image drawing range determined based on the **Detect image size** setting.

- **When OFF or Command priority is selected for Detect image size and Enable is selected for Oversize:**

  Since margins are added outside the image drawing range, images will not be chipped due to the margins.

C: Position of cut

The paper is cut with the length obtained by adding the upper and lower margins to the length of the image drawing range determined based on the **Detect image size** setting.
Detect image size and Print centered

When **ON** is selected for **Print centered**, the image drawing range determined based on the **Detect image size** setting is printed in the center of the paper.

Detect image size AND Print centered EXAMPLE

A: The image drawing range determined based on the **Detect image size** setting

Printed image

A: Position of cut

The image drawing range determined based on the **Detect image size** setting is printed at the center of the paper.
The table below shows the standard sizes supported by Cut to standard size.

For details on the page size supported by your printer, refer to Paper Sizes.

<table>
<thead>
<tr>
<th>Standard Size (Portrait)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Standard Size (Landscape)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO A0</td>
<td>841.0</td>
<td>1189.0</td>
<td>ISO A1</td>
<td>841.0</td>
<td>594.0</td>
</tr>
<tr>
<td>ISO A1</td>
<td>594.0</td>
<td>841.0</td>
<td>ISO A2</td>
<td>594.0</td>
<td>420.0</td>
</tr>
<tr>
<td>ISO A2</td>
<td>420.0</td>
<td>594.0</td>
<td>ISO A3</td>
<td>420.0</td>
<td>297.0</td>
</tr>
<tr>
<td>A3 Nobi</td>
<td>329.0</td>
<td>483.0</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>ISO A3</td>
<td>297.0</td>
<td>420.0</td>
<td>ISO A4</td>
<td>297.0</td>
<td>210.0</td>
</tr>
<tr>
<td>ISO A4</td>
<td>210.0</td>
<td>297.0</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard Size (Portrait)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Standard Size (Landscape)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO B1</td>
<td>707.0</td>
<td>1000.0</td>
<td>ISO B2</td>
<td>707.0</td>
<td>500.0</td>
</tr>
<tr>
<td>ISO B2</td>
<td>500.0</td>
<td>707.0</td>
<td>ISO B3</td>
<td>500.0</td>
<td>353.0</td>
</tr>
<tr>
<td>ISO B4</td>
<td>250.0</td>
<td>353.0</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard Size (Portrait)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Standard Size (Landscape)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIS B0</td>
<td>1030.0</td>
<td>1456.0</td>
<td>JIS B1</td>
<td>1030.0</td>
<td>728.0</td>
</tr>
<tr>
<td>JIS B1</td>
<td>728.0</td>
<td>1030.0</td>
<td>JIS B2</td>
<td>728.0</td>
<td>515.0</td>
</tr>
<tr>
<td>JIS B2</td>
<td>515.0</td>
<td>728.0</td>
<td>JIS B3</td>
<td>515.0</td>
<td>364.0</td>
</tr>
<tr>
<td>JIS B3</td>
<td>364.0</td>
<td>515.0</td>
<td>JIS B4</td>
<td>364.0</td>
<td>257.0</td>
</tr>
<tr>
<td>JIS B4</td>
<td>257.0</td>
<td>364.0</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard Size (Portrait)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Standard Size (Landscape)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI E</td>
<td>863.6</td>
<td>1117.6</td>
<td>ANSI D</td>
<td>863.6</td>
<td>558.8</td>
</tr>
<tr>
<td>ANSI F1</td>
<td>711.2</td>
<td>1016.0</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>ANSI D</td>
<td>558.8</td>
<td>863.6</td>
<td>ANSI C</td>
<td>558.8</td>
<td>431.8</td>
</tr>
<tr>
<td>ANSI C</td>
<td>431.8</td>
<td>558.8</td>
<td>Ledger</td>
<td>431.8</td>
<td>279.4</td>
</tr>
<tr>
<td>Ledger</td>
<td>279.4</td>
<td>431.8</td>
<td>Letter</td>
<td>279.4</td>
<td>215.9</td>
</tr>
<tr>
<td>Letter</td>
<td>215.9</td>
<td>279.4</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>No standard</td>
<td>-</td>
<td>-</td>
<td>Legal</td>
<td>355.6</td>
<td>215.9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard Size (Portrait)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Standard Size (Landscape)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARCH E</td>
<td>914.4</td>
<td>1219.2</td>
<td>ARCH D</td>
<td>914.4</td>
<td>609.6</td>
</tr>
<tr>
<td>ARCH E1</td>
<td>762.0</td>
<td>1066.8</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>ARCH E2</td>
<td>660.4</td>
<td>965.2</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>ARCH E3</td>
<td>685.8</td>
<td>990.6</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>ARCH D</td>
<td>609.6</td>
<td>914.4</td>
<td>ARCH C</td>
<td>609.6</td>
<td>457.2</td>
</tr>
<tr>
<td>Standard Size (Portrait)</td>
<td>Width (mm)</td>
<td>Height (mm)</td>
<td>Standard Size (Landscape)</td>
<td>Width (mm)</td>
<td>Height (mm)</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------</td>
<td>-------------</td>
<td>---------------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>ARCH C</td>
<td>457.2</td>
<td>609.6</td>
<td>ARCH B</td>
<td>457.2</td>
<td>304.8</td>
</tr>
<tr>
<td>ARCH B</td>
<td>304.8</td>
<td>457.2</td>
<td>ARCH A</td>
<td>304.8</td>
<td>228.6</td>
</tr>
<tr>
<td>ARCH A</td>
<td>228.6</td>
<td>304.8</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>DIN C1</td>
<td>648.0</td>
<td>917.0</td>
<td>DIN C2</td>
<td>648.0</td>
<td>458.0</td>
</tr>
<tr>
<td>DIN C2</td>
<td>458.0</td>
<td>648.0</td>
<td>DIN C3</td>
<td>458.0</td>
<td>324.0</td>
</tr>
<tr>
<td>DIN C3</td>
<td>324.0</td>
<td>458.0</td>
<td>DIN C4</td>
<td>324.0</td>
<td>229.0</td>
</tr>
<tr>
<td>DIN C4</td>
<td>229.0</td>
<td>324.0</td>
<td>No standard</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
Status Print

You can print a "Status Print" report indicating the current status of the printer.
With "Status Print", information is printed regarding the printer firmware version, various settings, and the status of consumables.

Follow the procedure below to print.

1. **Make sure printer is turned on.**

2. On the HOME screen, tap (Setup).

3. Tap Device settings.

4. Tap Test print.

5. Tap Status print.

   **Note**
   - If you specify the administrator password, tap Status print (administrator).

6. Tap Yes.

   The printer starts printing.

The following information is included.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canon xxxxxxxxxxxxxxxxxx Status Print</td>
<td>Printer model</td>
</tr>
<tr>
<td>S/N</td>
<td>Printer serial number</td>
</tr>
<tr>
<td>Firm</td>
<td>Firmware version</td>
</tr>
<tr>
<td>Boot</td>
<td>Boot ROM version</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time when the status print was output</td>
</tr>
</tbody>
</table>

**Paper Info**

<table>
<thead>
<tr>
<th>Roll Media</th>
<th>Type of roll paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut Sheet</td>
<td>Type of cut sheet</td>
</tr>
</tbody>
</table>

**Job Menu**

<table>
<thead>
<tr>
<th>Job History</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log *</td>
</tr>
</tbody>
</table>

Details of up to 5 jobs (Job name is printed as "**".)

*Printed only when Status print (administrator) is selected.*
<table>
<thead>
<tr>
<th>Printer settings</th>
<th>Setting values of Print head movable width setting and Prioritize paper size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper-related settings</td>
<td>Setting values of Paper-related settings</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Device settings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto maintenance settings</td>
<td>Setting values of Auto maintenance settings</td>
</tr>
<tr>
<td>Device user settings</td>
<td>Setting values of Other device settings</td>
</tr>
<tr>
<td>Language selection</td>
<td>Setting value of Language selection</td>
</tr>
<tr>
<td>Firmware update notification</td>
<td>Setting values of Update notification setting</td>
</tr>
<tr>
<td>Monitoring service settings</td>
<td>Setting values of Enable/disable monitoring service</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Usage Condition</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware error</td>
<td>History information of Hardware error</td>
</tr>
<tr>
<td>Error</td>
<td>History information of Recoverable error</td>
</tr>
<tr>
<td>Warning</td>
<td>Warning history information</td>
</tr>
<tr>
<td>Jam</td>
<td>History information of Paper feed/transfer error</td>
</tr>
<tr>
<td>Maintenance cartridge usage / Remaining ink level</td>
<td>Values of Ink consumed</td>
</tr>
<tr>
<td>Duty counter</td>
<td>Values of Duty counter</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PARTS STATUS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNTER</td>
<td>Part status</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Head information</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>HEAD LOT NUMBER/ DATE OF INSTALLATION</td>
<td>Information of Head information</td>
</tr>
<tr>
<td>Head alignment performance log</td>
<td>History information of Head alignment performance log</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>COUNTER</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MEDIA</td>
<td>Usage status by media</td>
</tr>
<tr>
<td>THE NUMBER OF CUTS</td>
<td>Total number of cuts</td>
</tr>
<tr>
<td>AFTER INSTALLATION</td>
<td>Number of days from the use start date</td>
</tr>
</tbody>
</table>
Changing Printer's Setting Using Web Browser

- Configuration Changes Using Web Browser
- Changeable Setting Items Using Web Browser
- Setting Password
- Registering Printer's Root Certificate to Web Browser for SSL Communication (Remote UI)
- Registering Printer's Root Certificate to Local Computer for SSL Communication
- Generating Server Certificate (Self-signed Certificate)
- Setting Mail Server
- Receiving Printer Status by E-mail
Configuration Changes Using Web Browser

You can check the printer status and change the printer settings using the web browser on your smartphone, tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

Note

• Remote UI is a software that enables you to perform operations, which are usually performed on the printer's operation panel, using a Web browser over a network.

LAN connection with the printer is required to use Remote UI.

• You can use Remote UI on the following OS and the web browser.

  • iOS device
    OS: iOS 11.0 or later
    Web browser: iOS standard Web browser (Mobile Safari)
  
  • Android device
    OS: Android 4.4 or later
    Web browser: Android standard Web browser (Browser or Chrome)
  
  • macOS device
    OS: Mac OS X 10.10 or later
    Web browser: Safari 10.0 or later
  
  • Windows device
    OS: Windows 7 SP1 or later
    Web browser: Internet Explorer 11 or later, Google Chrome, Mozilla Firefox

1. Make sure printer is turned on.

2. Check printer's IP address.

   1. On the HOME screen, tap the Network icon.

   Depending on the type of LAN enabled, the icon displayed on the button may differ.

   2. Tap the enabled LAN.
3. Check IPv4 address.

3. Open web browser on your smartphone, tablet, or computer and enter IP address.

   Enter as following in the URL field of the web browser.

   http://XXX.XX.X.XXX

   Enter the IP address of the printer in "XXX.XX.X.XXX".

   When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or computer.

4. If you display Remote UI for the first time on your smartphone, tablet, or computer, select For secure communication.

   Download the root certificate, and then register it.

   ➤ Registering Printer's Root Certificate to Web Browser for SSL Communication (Remote UI)

   ➤ Note

   • Once you register the root certificate to the web browser on your smartphone, tablet, or computer, this step is not necessary after the next time.

   • If the root certificate is not registered, a message to warn you that the secure connection is not guaranteed may appear.

5. Select Log in.

   The password authentication screen appears.

   ➤ Note

   • When the standard user mode is enabled, choose either administrator mode or standard user mode to log on.

   After choosing a mode and selecting Log in, the password authentication screen of each mode appears.

6. Enter password.

   When the password authentication is complete, the menus that can be utilized are displayed on the web browser.

   ➤ Important

   • The password is set at the time of purchase. The password is the printer serial number. The printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric characters (four alphabets followed by five numbers).

   For details on setting password, see Setting Password.

7. Check printer status and change printer settings.
For changeable setting items, see below.

Changeable Setting Items Using Web Browser

8. When you finish checking printer status and changing printer settings, select **Log out**.

Changeable Setting Items Using Web Browser

Note

• The items described here and the items displayed in the web browser may differ in display order.
• The item which can be used is different in administrator mode or in standard user mode.

Items for Security

Security (Item for administrator)
This function allows you to specify the password, the standard user mode settings, the operation restrictions, and SSL/TLS settings of certificate for encrypted communication.

For details on setting password, see Setting Password.

Operation panel lock (Item for administrator)
Select this item from Custom settings on Device settings.

Selecting Enable disables any operations using the operation panel.
A message informing you that operations are invalid appears when you tap the touch screen. An error or warning is displayed even while this function is enabled.

Items for Maintenance/Management

Utilities
This function allows you to set and execute the printer utility functions such as cleaning.

Job management
This function allows you to display the job history and print it. In addition, you can delete jobs from this item.

Note

• When you are logging on in administrator mode, you can restrict this function in standard user mode.

System info and LAN settings
This function allows you to check the system information and to change the LAN settings.

Using IP filtering in Advanced setup in LAN settings, you can permit or refuse the connection of a specific IP address for IPv4 address or IPv6 address.

Using SNMP settings in Advanced setup in LAN settings, you can specify the SNMP and MIB setting to management the printer via a network.

Important

• If you have refused the IP address of administrator's device using IP filtering by mistake, reset LAN settings of the printer. To reset LAN settings, select System info and LAN settings > LAN settings > Advanced setup > Reset LAN settings, and then select Yes.

If you place a check mark of Enable HTTPS redirection in CHMP settings in Advanced setup in LAN settings, it becomes possible to authenticate the communication partner and encrypt the communication data by HTTPS communication.
Note

• Some of the menu is available only when you logged on in administrator mode.

Language selection (Item for administrator)
This function allows you to change the language on the display.

Items for Printer

Device settings
This function allows you to change the printer settings such as the energy saving settings and the print settings.

Additionally, this function allows you to receive the printer status information such as the remaining ink level and the error.

➤ Setting Mail Server
➤ Receiving Printer Status by E-mail

You can disable any operations using the operation panel from Operation panel lock on Custom settings.

Note

• Some of the menu is available only when you logged on in administrator mode.

AirPrint settings
This function allows you to specify the AirPrint settings, such as position information.

Other Items

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed error information.

You can also connect to the ink purchase site or support page, and use Web Services.

Manual (Online)
This function displays the Online Manual.
Setting Password

Each of passwords for administrator and standard user can be set. When logging on with password for administrator, all settings can be changed. When logging on with password for standard user, some of the settings can be changed. When logging on with password for administrator, you can restrict the function for standard user.

- Setting Administrator Password
- Setting Standard User Password

**Note**
- Password can be set only when you are logged in administrator mode.

Setting Administrator Password

Change the administrator password by following the steps below.

**Important**
- The password is set at the time of purchase. The password is the printer serial number. The printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric characters (four alphabets followed by five numbers).

1. Start up Remote UI.
3. Select Administrator password setting.
4. Select Change administrator password.
   - If an administrator password is not specified, the confirmation message appears. Confirm the message and select Yes. When message appears again, confirm it and select OK.
5. Select range where administrator password is valid and select OK.
   - Remote UI or other tools
     - Entering the administrator password is required to change the setting items using the Remote UI or some software.
   - Operation panel/Remote UI/other tools
     - Entering the administrator password is required to change the setting items using the operation panel of the printer, the Remote UI, or some software.
6. Enter password and select OK.

**Important**
- The following character restrictions apply to the password:
• Set the password by using 4 to 32 characters.
• The allowed characters are single-byte alphanumeric characters.
• For security reasons, we recommend you use 8 and more alphanumeric characters.

7. When completion message appears, select OK.

### Setting Standard User Password

For restricting the function for standard user, enable the standard user mode and set a standard user password by following the steps below.

1. **Start up Remote UI.**

2. Select **Security**.
   The menus appear.

3. Select **Standard user mode settings**.

4. When confirmation message appears, select **Yes**.

5. Enter password and select **OK**.

   **Important**

   • The following character restrictions apply to the password:
     • Set the password by using 4 to 32 characters.
     • The allowed characters are single-byte alphanumeric characters.
     • For security reasons, we recommend you use 8 and more alphanumeric characters.

6. When completion message appears, select **OK**.
Registering Printer's Root Certificate to Web Browser for SSL Communication (Remote UI)

If the printer's root certificate has not been registered to the web browser, a message to warn you that the secure connection is not guaranteed may appear.

When you display Remote UI for the first time on your smartphone, tablet, or computer, download the root certificate, and then register it to the web browser. The secure connection will be confirmed and a message will not appear. However, the message may appear depending on a web browser even after you have registered the root certificate.

How to register the root certificate varies depending on the web browser.

- For Internet Explorer
- For Safari
- For Chrome on Android
- For Mobile Safari on iOS

Operating procedure may differ depending on the version of your web browser. For other web browser, refer to each help.

**Important**

- Make sure that you have accessed to the printer IP address correctly by checking the URL field of the web browser before registering the root certificate.
- If the printer is connected via IPv6 using Windows, you need to generate a server certificate using Remote UI.
  For details, see [Generating Server Certificate (Self-signed Certificate)](#).

---

**For Internet Explorer**

1. Select **For secure communication** on Remote UI.

2. Select **Download**.
   
   Downloading the root certificate is started.

3. If confirmation screen appears, select **Open**.
   
   Certificate screen is displayed.

   **Note**
   
   - To save the certificate file to your device and register it, select **Save**. Select **Internet options** from Tool menu of Internet Explorer, register the root certificate from **Certificates** on **Content** sheet.

4. Select **Install Certificate**.
   
   Certificate Import Wizard screen is displayed.
5. Select **Next**.

6. Select **Place all certificates in the following store**.

7. Select **Browse**.
   
   Select **Certificate Store** screen is displayed.

8. Select **Trusted Root Certification Authorities** and **OK**.

9. Select **Next** on **Certificate Import Wizard** screen.

10. If **Completing the Certificate Import Wizard** appears, select **Finish**.
    
    Security Warning screen is displayed.

11. Make sure that thumbprint on **Security Warning** screen matches printer's thumbprint.
    
    The printer's thumbprint is displayed in **Root cert. thumbprint (SHA-1)** column or **Root cert. thumbprint (SHA-256)** column when tapped in the following order.
    
    (Setup) > Printer information > System information

12. If thumbprint on **Security Warning** screen matches printer's thumbprint, select **Yes**.

13. Select **OK** on **Certificate Import Wizard** screen.
    
    The root certificate registration is completed.

---

**For Safari**

1. Select **For secure communication** on Remote UI.

2. Select **Download**.
   
   Downloading the root certificate is started.

3. Open the downloaded file.
   
   Keychain access starts up and **Add Certificates** screen is displayed.

4. Select **Add**.
   
   Information on the certificate is displayed.
5. Make sure that fingerprint of certificate detail information matches printer's thumbprint.

The printer's thumbprint is displayed in Root cert. thumbprint (SHA-1) column or Root cert. thumbprint (SHA-256) column when tapped in the following order.

(Setup) > Printer information > System information

6. If fingerprint of certificate detail information matches printer's thumbprint, display information on certificate from the menu or by double-clicking the certificate, and select Always Trust on Trust.

The root certificate registration is completed.

Note

- If a password is set on your device, entering a password may be required.

For Chrome on Android

1. Select For secure communication on Remote UI.

2. Select Download.

   Downloading the root certificate is started and then Name the certificate screen is displayed.

3. As entering the root certificate name is required, enter an arbitrary certificate name and select OK.

   The root certificate registration is completed.

Note

- If PIN or password is not set as security type, the attention screen may appear. Select OK, and then set the security type to PIN or password.

After Root Certificate Registration

We recommend that you make sure that the correct root certificate has been registered.

To make sure that the correct root certificate has been registered, make sure that thumbprint of certificate information matches printer's thumbprint. Follow the steps below.

Note

- Some Android devices cannot be checked the thumbprint of a registered route certificate.
1. From Settings menu on your device, select Security, Trust credentials, and USER.  
The list of downloaded certificates appears.

2. Select downloaded certificate.  
The certificate information appears.

3. Make sure that thumbprint of certificate information matches printer's thumbprint.  
The printer's thumbprint is displayed in Root cert. thumbprint (SHA-1) column or Root cert. thumbprint (SHA-256) column when tapped in the following order.  
   (Setup) > Printer information > System information

4. If thumbprint of certificate information screen matches printer's thumbprint, select OK.  
The root certificate registration is completed.  
If the message to warn you that the secure connection is not guaranteed appears when you select Log in on Remote UI after registering the root certificate, restart the web browser. The message will not appear on the web browser.

   Note  
   • Depending on the Android device, a warning may appear even after registering the proper root certificate.

For Mobile Safari on iOS

1. Select For secure communication on Remote UI.

2. Select Download.  
   Downloading the root certificate is started and then Install Profile screen is displayed.

3. Select Install.  
   Warning screen is displayed.
   Note  
   • If a password is set on your device, entering a password may be required.

4. Select Install.

5. Select Install on displayed dialog.  
The root certificate registration is completed.
Registering Printer’s Root Certificate to Local Computer for SSL Communication

To use Device Management Console or Accounting Manager, etc. when you connect the printer to a computer using SSL encrypted communication, you need to register (import) the printer’s root certificate to your computer.

Procedure to register the certificate varies depending on your operation environment.

Important

• If the printer is connected via IPv6 using Windows, you need to generate a server certificate using Remote UI.
  For details, see Generating Server Certificate (Self-signed Certificate).

For Windows 10/Windows 8.1
For Windows 7
For macOS

Operation procedure may differ depending on your OS version.

For Windows 10/Windows 8.1

The procedure below describes how to import a root certificate in Windows 10/Windows 8.1.

1. Start up Remote UI.

2. Select For secure communication.

   Note

   • You can download a certificate from Status Monitor.

   1. Open status monitor.
      Open the printer’s property, and select Status Monitor... on Main.

   2. Download a certificate.
      Select Download Security Certificate from the Remote UI menu.

3. Select Download.

   The root certificate will be downloaded.

4. When download confirmation screen is displayed, select Open.

   The Certificate screen appears.

5. Select Install Certificate.
The Certificate Import Wizard screen appears.


2. Select Next.

3. Select Yes on the displayed screen.

The Certificate Store screen appears.

7. Select Place all certificates in the following store.


1. Select Browse to open the Select Certificate Store screen.

2. Select Trusted Root Certificate Authorities from the list and select OK.


When the Completing the Certificate Import Wizard screen appears, check the settings and select Finish.
For Windows 7

The procedure below describes how to import a root certificate in Windows 7.

**Important**

- Be sure to create a certificate snap-in before importing a root certificate.
  
The root certificate will be registered to the local user if you import it without creating a certificate snap-in.

**Creating Certificate Snap-in**

1. Start up Microsoft Management Console.
   
Enter MMC on Search programs and files in the Start menu and press the Enter key.

2. Select Yes on displayed screen.

3. Select Add/Remove Snap-in from File menu.
   
The Add or Remove Snap-ins screen appears.

   
   1. Select Certificates from Available snap-ins list and select Add.
   
   2. Select Computer account for This snap-in will always manage certificates for on the Certificates snap-in screen and select Next.
   
   3. Select Local computer on the Select computer screen and select Finish.

4. Select OK on the Add or Remove Snap-ins screen.
**Downloading Certificate**

1. **Start up Remote UI.**

2. Select **For secure communication.**

   ▶️ Note
   
   • You can download a certificate from Status Monitor.

   1. Open status monitor.
      
      Open the printer's property, and select **Status Monitor... on Main.**

   2. Download a certificate.
      
      Select **Download Security Certificate** from the **Remote UI** menu.

3. Select **Download.**

4. Select **Save.**

**Importing Certificate**

1. Open **Certificate Import Wizard.**

   1. On the left window, open **Trusted Root Certificate** from **Certificate** on **Console Root.**

   2. Right-click **Certificates** and select **Import** from **All tasks.**

2. Specify certificate file to import.

   1. Select **Next.**

   2. Specify the certificate file to import on **File name** and select **Next.**

3. Specify certificate store.

   1. Select **Place all certificates in the following store.**

   2. Select **Trusted Root Certificate Authorities** for **Certificates Store.**

4. Finish certificate import wizard.

   1. Select **Next** and check the specified settings.

   2. Select **Finish** to finish the wizard.
3. Select OK on the displayed screen.

**Checking Imported Certificate**

Make sure the imported certificate has been registered to your computer.

1. Display certificate list.

On the left window of Microsoft Management Console, select **Console Root > Certificates (Local Computer) > Trusted Root Certificate Authorities** in this order, and Select **Certificates** to display the certificate list.

2. Check registered certificate.

Make sure the imported certificate name is displayed on the list.

[Note]
- Make sure you can see the registered certificate from **Current user** by creating the **Current user** snap-in.

[Note]
- When you finish Microsoft Management Console, a message asking you whether to save the console setting. If you continue to apply the same settings next, select **Yes** to save.

**For macOS**

The procedure below describes how to import a root certificate in macOS.

1. **Start up Remote UI.**

2. Select **For secure communication.**

3. Select **Download.**

   The root certificate will be downloaded.


   When the download procedure is completed, a downloaded item pops up on the right of the screen. Double-click the downloaded certificate on the list starts up **Keychain Access** and the **Add Certificates** screen appears.

[Note]
- If the downloaded item does not pop up, select the **Show Downloads** button on the right.
5. Select **Add**.

Select the destination for the certificate on **Keychain**.

Selecting **Add** displays information on the certificate.

**Note**

- You can add the certificate by selecting the same certificate on **Keychain Access**. Check the name of certification to add after selecting **View Certificates**.

6. Check certificate.

Make sure the fingerprint of certificate shown on **Details** corresponds with the root certificate thumbprint of the printer.

The printer's thumbprint is displayed in **Root cert. thumbprint (SHA-1)** column or **Root cert. thumbprint (SHA-256)** column when tapped in the following order.

(Setup) > Printer information > System information

7. Select **Always Trust**.

If the fingerprint of certificate detail information matches printer's thumbprint, display information on certificate from the menu or by double-clicking the certificate, and select **Always Trust** on **Trust**.

The root certificate has been registered.

**Note**

- Entering the password may be required if you specify it for your printer.
Generating Server Certificate (Self-signed Certificate)

When you use SSL connection via IPv6 network, you need to generate an IPv6 server certificate using the printer.

Generate the server certificate from Remote UI.

Follow the procedure below.

1. **Checking Printer's IP Address**
2. **Generating Server Certificate**
3. **Checking Generated Server Certificate**

**Important**

- If you generate an IPv6 server certificate, you cannot use SSL communication via IPv4. In addition, a warning message may appear if you are using Remote UI.

To reset the IPv6 server certificate, tap in the following order from the operation panel.

(Setup) > Device settings > LAN settings > Wi-Fi / Wireless Direct / Wired LAN > Settings > Advanced > Reset SSL certificates > Yes

---

### Checking Printer's IP Address

1. **Make sure printer is turned on.**

2. On the HOME screen, tap the **Network** icon.

   ![Network icon]

   Depending on the type of LAN enabled, the icon displayed on the button may differ.

3. Tap the enabled LAN.

   Diagonal lines are displayed for disabled LAN icons.

4. Flick the screen, check the value on **IPv6 link-local address**.

   Write down the value on **IPv6 link-local address** for your reference when you open Remote UI and generate a server certificate.
Generating Server Certificate

1. Open web browser on your smartphone, tablet, or computer and enter the printer IP address.
   Enter as following in the URL field of the web browser.
   http://[XXXX::XXXX::XXXX::XXXX]
   On "XXXX::XXXX::XXXX::XXXX", enter the IPv6 link-local address in abbreviated form.
The top screen of Remote UI appears.

2. Select Log in on Remote UI.
   
   **Note**
   - If you specify the administrator password, enter the password.


4. Select SSL/TLS settings.

5. Select Generate key and certificate.


7. Specify each setting item.
   - **Signature algorithm**
     Select SHA256.
   - **Public key length (bits)**
     Select 2048 bits.
   - Specify the expiration date.
     Enter the date you generated the server certificate on **Valid from**.
     Enter the date the server certificate expires on **Valid to**.
   - Enter the common name.
     On **Common name**, enter the IPv6 link-local address you checked in abbreviated form.
   
   **Note**
   - When you enter the common name, add [ ] to each end of the abbreviation value of the printer's IPv6 address.
   - Do not use a comma or make a space for the common name.

8. Select Next.
You need not enter anything on Country, State or province, Locality, Organization, or Organizational unit.

9. Select Generate.

The server certificate starts to be generated.

When the server certificate has been generated, Generated a self-signed certificate. appears.

10. Select Restart LAN.

LAN will be restarted.

When LAN has been restarted, Printer status on Remote UI appears.

Note

• If you cannot access to Remote UI after you restart LAN, reload your web browser.

Checking Generated Server Certificate

1. Select Security on Remote UI.

2. Select SSL/TLS settings.

3. Select Check key and certificate.

Make sure the issuer of the root certificate is displayed on Issued by, and the value you entered is displayed on Common name on Subject.
Setting Mail Server

To use mail function, specify the mail server settings.

*This function may not be available depending on the country or region of purchase.

**Note**

- If you did not specify the time zone setting using the printer's operation panel, a message to inform you that the correct time may not be reflected on the sent e-mail appears. We recommended that you set the time zone setting using the printer's operation panel.

  For the time zone setting, see Other device settings.

- These functions can be set only when you are logged in administrator mode.

1. Start up Remote UI.

2. Select Device settings.

3. Select Set mail server.

   The setting items for mail server appear.

4. Specify mail server settings.

   Specify the following items.

   **Sender address**
   Enter the e-mail address of the sender (this printer).

   **Outgoing mail server (SMTP)**
   Enter the address of your SMTP server.

   **Port number (SMTP)**
   Enter the port number of your SMTP server.

   **Secure connection (SSL)**
   Select if you use the secure connection (SSL).

   **Don't verify certificates**
   Select if you do not verify the certificate.

   **Authentication method**
   Select one of the following authentication methods.

   **SMTP authentication**
   Select if you send e-mail with SMTP authentication.

   Then select OK, and then make the following settings.

   **Outgoing account**
   Enter the account name for sending to perform the authentication.

   **Outgoing password**
   To set / change the password for sending in order to perform the authentication, check the Set/change password and then enter the password.
POP before SMTP
Select if you send e-mail with POP before SMTP authentication.

Then select OK, and then make the following settings.

Incoming mail server (POP3)
Enter the address of your POP3 server.

Port number (POP3)
Enter the port number of your POP3 server.

Incoming account
Enter the account name for receiving to perform the authentication.

Incoming password
To set / change the password for receiving in order to perform the authentication, check the
Set/change password and then enter the password.

Use APOP authentication
Select if you send the password by the encryption transmission.

Clear mailbox
Select if you delete the e-mails that remain in the POP3 server.

Important
• When this setting is enabled, e-mail in the Inbox on the server will have all been removed. If you specify the e-mail address of your everyday, be sure to disable this setting as unread e-mail is not deleted. We recommended that you prepare this printer dedicated e-mail account not to accidentally delete the unread e-mail.

5. Select OK.
The setting operation is completed.
Receiving Printer Status by E-mail

You receive the printer status information such as the remaining ink level and the error from the printer.

*This function may not be available depending on the country or region of purchase.

**Note**

- Specify the mail server settings in advance.
  
  ➤ [Setting Mail Server]

- If you did not specify the date and time setting using the printer’s operation panel, the date and time may not be reflected on the sent e-mail. We recommended that you set the date and time setting using the printer’s operation panel.
  
  For the date and time setting, see [Other device settings].

- These functions can be set only when you are logged in administrator mode.

1. [Start up Remote UI].

2. Select [Device settings].

3. Select [Status notification e-mail].

4. Select [Notification recipients].

5. Specify destination settings.
   
   Up to 5 destinations can be registered by following the steps below.
   
   1. Select number of destination.
   
   2. Select [Add].
   
   3. Enter e-mail address, and then select printer status to send information.
   
   4. Select [OK].
   
   The registration for destination is completed.

6. Select [Device settings] > [Status notification e-mail] > [Retry settings].

7. Specify resending settings.
   
   The number of resending can be specified by following the steps below.
   
   1. Specify number of resending.
   
   2. Specify interval of resending.
3. Select **OK**.
   
The resending setting is completed.
Printer Parts

- Printer Parts
  - Front
  - Side
  - Top Cover (Inside)
  - Where to Attach the Roll Holder
  - Carriage
  - Ink Tank Cover (Inside)
  - Stand
  - Operation Panel

- Optional accessories
  - Roll Holder Set
  - Stand
Printer Parts

- Front
- Side
- Top Cover (Inside)
- Where to Attach the Roll Holder
- Carriage
- Ink Tank Cover (Inside)
- Stand
- Operation Panel
(A) Top Cover
Open this cover to install the print head and remove any jammed paper from inside the printer, as needed. (See "Top Cover (Inside).")

(B) Paper Alignment Line
A white line for alignment of paper.

(C) Operation Panel
Use this screen to operate the printer and check the printer status. (See "Operation Panel."

(D) Release Lever
When releasing the Paper Retainer, push this lever back.

(E) Output Guide
Supports output paper.

(F) Ink Tank Cover
Open this cover to replace the ink tank. (See "Ink Tank Cover (Inside)."

(G) Maintenance Cartridge
Ink used for maintenance purposes such as head cleaning is absorbed. (Replace the cartridge when it is full.)
(H) Maintenance Cartridge Cover
   Open this cover to replace the maintenance cartridge.

(I) Stand
   A stand that holds the printer. Equipped with casters to facilitate moving it. (See "Stand.")
(A) Power Cord Connector
Connect the power cord to this connector.

(B) Carrying Grips
When carrying the printer, have two or more people hold it by these handles under both sides.
Furthermore, hold the left and right of these parts when moving the printer with a stand.
Number of people required to carry
For the TA-20 (approx. 37 kg) : 2 people or more

(C) Wired LAN Connector
Connect an Ethernet cable to this port. The lamp is lit if the Ethernet cable is connected correctly and communication is possible between the computer and printer.

(D) USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.
(A) Platen
The print head moves across the platen to print.

(B) Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.

(C) Linear Scale
The linear scale serves a key role in detecting the carriage position.

(D) Carriage Shaft
The Carriage slides along this shaft.

(E) Carriage
Moves the print head. The carriage serves a key role in printing. (See "Carriage.")

(F) Cleaning Brush
When cleaning inside the printer under the top cover, use this brush to sweep away paper dust on the platen.
(G) Borderless Printing Ink Grooves
   For catching ink outside the edges of paper during borderless printing.

(H) Cutter Blade
   A round-bladed cutter for automatic paper cutting.
Where to Attach the Roll Holder

(A) Slide Guide
Move the roll holder along this guide.

(B) Roll Holder Slot
Slide the roll holder into this slot.

(C) Holder Stopper
Secure the roll on the roll holder with this part.

(D) Roll Holder
Load the roll on this holder.
Carriage

(A) Print Head
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

(B) Print Head Locking Cover
Secures the print head.

(C) Angle Adjustment Lever
Fine-tunes the line misalignment when printing.

(D) Print Head Lock Lever
Lock print head locking cover.
(A) Ink Tank
Cartridges of ink in various colors.

(B) Ink Tank Lock Lever
A lever that locks the ink tank in place and protects it. Lift and press down the lever when replacing an ink tank.
(A) Stand
A stand that holds the printer. It is equipped with casters to facilitate movement.

(B) Basket
Catches the ejected printed documents.

(C) Locking Caster
The casters can be locked securely. When moving the printer, be sure to unlock the 4 casters. If you move it while the locking casters are locked, the floor may become scratched.

Note
- For instructions on how to use the basket, see "Using the Basket".
- Depending on the product, a stand may not be provided.
Optional accessories

- Roll Holder Set
- Stand
Roll Holder Set

Load a roll on the roll holder and then load the holder in the printer. The roll holder in the roll holder set RH2-28 is for use with both 2-inch and 3-inch paper cores. Use the correct attachment for the particular paper core. (See "Loading Rolls on the Roll Holder.")

- Roll holder set RH2-28
  - Roll holder (for 2- and 3-inch paper cores)
  - 3-inch paper core attachment
(A) Stand
A stand that holds the printer. It is equipped with casters to facilitate movement.

(B) Basket
Catches the ejected printed documents.

(C) Locking Caster
The casters can be locked securely. When moving the printer, be sure to unlock the 4 casters. If you move it while the locking casters are locked, the floor may become scratched.

Note
- For instructions on how to use the basket, see "Using the Basket".
- Depending on the product, a stand may not be provided.
Network Setting

- **Network Connection Tips**
  - Printer Connection Methods
  - Default Network Settings
  - Another Printer Found with Same Name
  - Connecting to Another Computer via LAN/Changing from USB to LAN Connection
  - Printing Network Settings
  - Reconfiguration Method of LAN Connection/Reconfiguration Method of Wi-Fi Connection
  - Reconfiguration of Network Settings using the Remote UI
  - Countermeasures against Unauthorized Access
  - Network Status and Troubleshooting

- **IJ Network Device Setup Utility (Windows)**
  - IJ Network Device Setup Utility
  - Starting Up IJ Network Device Setup Utility
  - Diagnosing and Repairing Network Settings
  - Performing/Changing Network Settings
  - List of Models Which Does Not Support Diagnosis and Repair Function
  - List of Models Which Does Not Support IPv6 Configuration via USB Connection
  - Other Network Information

- **IJ Network Device Setup Utility (macOS)**
  - IJ Network Device Setup Utility
  - Starting Up IJ Network Device Setup Utility
  - Diagnosing and Repairing Network Settings
  - List of Models Which Does Not Support Diagnosis and Repair Function
  - Other Network Information
» **Sharing the Printer on a Network (Windows)**
  - Setting Up a Shared Printer
  - Restrictions on Printer Sharing

» **Sharing the Printer on a Network (macOS)**
  - Settings on Print Server
  - Settings on Client PC
  - Restrictions on Printer Sharing

» **Connecting Smartphone/Tablet to Printer via Wi-Fi**
  - Connecting Smartphone/Tablet to Printer via Wireless Router
Network Connection Tips

- Printer Connection Methods
- Default Network Settings
- Another Printer Found with Same Name
- Connecting to Another Computer via LAN/Changing from USB to LAN Connection
- Printing Network Settings
- Reconfiguration Method of LAN Connection/Reconfiguration Method of Wi-Fi Connection
- Reconfiguration of Network Settings using the Remote UI
- Countermeasures against Unauthorized Access
- Network Status and Troubleshooting
Printer Connection Methods

LAN or USB connection is available to connect the printer to a smartphone/tablet.

- **LAN Connection:**
- **USB Connection:**
- **Another Connection Method:**

## LAN Connection:

Connect the printer to a smartphone/tablet via LAN.

Select one of the methods below for LAN connection.

- **Connection via wired LAN**
  
  Connect the printer and computer to a router using a LAN cable. If your router supports Wi-Fi connection, you can connect a device via Wi-Fi.

![](image)

**Note**

- Devices connected to the router must be connected to the same network

- **What Is Ethernet Cable?**
- **Advantages of Connecting Printer via Wired LAN**
- **Restrictions**

- **Connection via a wireless router**
  
  Connect the printer and computer or smartphone/tablet to a wireless router via Wi-Fi.

![](image)
**Note**

- Devices connected via Wi-Fi must be connected to the same network

- Advantages of Connecting Printer over Wi-Fi
- Restrictions

**USB Connection:**

Connect the printer to a computer using a USB cable.

![USB Connection Diagram](image)

- What Is USB Cable?

In USB connection, the printer is connected one-on-one to the computer.

If your computer is connected to LAN, you can use the printer with other devices by enabling the sharing setting on your computer.

**Note**

- You can connect the printer to a computer via USB even when the printer is already connected to another one via wired LAN.

![Note Diagram](image)

**Another Connection Method:**

Using Wireless Direct enables you to connect the printer directly to a computer or smartphone/tablet without a wireless router.
## Default Network Settings

### LAN Connection Defaults

<table>
<thead>
<tr>
<th>Item</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable LAN</td>
<td>Wired LAN enabled</td>
</tr>
<tr>
<td>Network name (SSID)</td>
<td>BJNPSETUP</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Infrastructure</td>
</tr>
<tr>
<td>Wi-Fi security</td>
<td>Disable</td>
</tr>
<tr>
<td>IP address (IPv4)</td>
<td>DHCP</td>
</tr>
<tr>
<td>IP address (IPv6)</td>
<td>Auto setup</td>
</tr>
<tr>
<td>Set printer name*</td>
<td>XXXXXXXXXXXXXXXX</td>
</tr>
<tr>
<td>Enable/disable IPv6</td>
<td>Enable</td>
</tr>
<tr>
<td>Enable/disable WSD</td>
<td>Disable</td>
</tr>
<tr>
<td>Timeout setting</td>
<td>15 minutes</td>
</tr>
<tr>
<td>Enable/disable Bonjour</td>
<td>Enable</td>
</tr>
<tr>
<td>Service name</td>
<td>Canon TA-20</td>
</tr>
<tr>
<td>LPR protocol setting</td>
<td>Enable</td>
</tr>
<tr>
<td>Wi-Fi DRX setting</td>
<td>Enable</td>
</tr>
<tr>
<td>Wired LAN DRX setting</td>
<td>Enable</td>
</tr>
</tbody>
</table>

("XX" represents alphanumeric characters.)

* Default value depends on printer. To check value, use operation panel.

⇒ [LAN settings](#)

### Wireless Direct Defaults

<table>
<thead>
<tr>
<th>Item</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network (SSID)/device name</td>
<td>DIRECT-abXX-TA-20 *1</td>
</tr>
<tr>
<td>Password</td>
<td>YYYYYYYYYYY *2</td>
</tr>
<tr>
<td>Wi-Fi security</td>
<td>WPA2-PSK (AES)</td>
</tr>
<tr>
<td>Connection request confirmation</td>
<td>Displayed</td>
</tr>
</tbody>
</table>

*1 "ab" is specified at random and "XX" represents last two digits of printer's wireless MAC address.
*2 The password is specified automatically when the printer is turned on for the first time.
Another Printer Found with Same Name

When the printer is found during setup, other printers with the same name may appear on the results screen.

Select a printer with checking the printer settings against those on detection result screen.

Check the printer's MAC address or serial to select the correct printer from the results.

Note

- Serial number may not appear on result screen.

Check the printer's MAC address and the serial number by one of the following methods.

- Display on the touch screen.
  - MAC address
    - LAN settings
  - Serial number
    - Printer information
- Print the network settings.
  - Printing Network Settings
Connecting to Another Computer via LAN/Changing from USB to LAN Connection

- For Windows:
- For macOS:

For Windows:

To add a computer to connect to the printer on a LAN or to change from USB to LAN connection, perform setup using the Setup CD-ROM or from the web page.

For macOS:

To connect an additional computer to the printer via LAN, or to change from USB to LAN connection, perform setup from the web page.
**Printing Network Settings**

Use the operation panel to print the printer's current network settings.

**Important**

- The network settings printout contains important information about your network. Handle it with care.

1. **Check that printer is turned on.**

2. Load plain paper.
   - [Loading Rolls on the Roll Holder](#)
   - [Loading Rolls in the Printer](#)
   
   If you use sheets, prepare at least 10 sheets (A4 or Letter-sized).
   - [Loading Sheets in the Printer](#)

3. Select (Setup) icon on HOME screen.

4. Select **Device settings**.

5. Select **LAN settings**.

6. Select **Print details**.

7. Select **Yes** on displayed screen.

8. Select **Yes** or **No** on displayed screen.

   The printer starts printing network settings information.

**Note**

- You can also print the printer's network settings. Select the **Setup** icon > **Device settings** > **Test print** > **Print LAN details** > **Yes** > **Yes**.

The printed network settings information is as follows: (Some setting values are not displayed depending on the printer settings.)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN Setting</td>
<td>Basic setting information</td>
<td>-</td>
</tr>
<tr>
<td>Basic Info</td>
<td>IPv4 setting information (Wired LAN)</td>
<td>-</td>
</tr>
<tr>
<td>Parameter</td>
<td>Setting</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>LAN Interface Mode</td>
<td>Current interface</td>
<td>Wired LAN/Wireless LAN(Infra)/Wireless LAN(AP)/Wireless(Wireless direct)/Disabled</td>
</tr>
<tr>
<td>Link Active</td>
<td>Operation status</td>
<td>Inactive/Active</td>
</tr>
<tr>
<td>Gigabit Ethernet Settings</td>
<td>Communication speed and communication method when using Gigabit Ethernet</td>
<td>Auto/10M half duplex/10M full duplex/100M half duplex/100M full duplex/1G full duplex</td>
</tr>
<tr>
<td>IP Address</td>
<td>IPv4 IP address</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>IPv4 default gateway</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>IPv4 subnet mask</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>IP Mode</td>
<td>Acquiring method of IPv4 IP address</td>
<td>Auto IP/DHCP/Manual</td>
</tr>
<tr>
<td>Use DNS Auto Mode</td>
<td>Acquiring DNS server automatically</td>
<td>On/Off</td>
</tr>
<tr>
<td>Primary DNS Server Address</td>
<td>Primary DNS server address</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Secondary DNS Server Address</td>
<td>Secondary DNS server address</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Control Filtering</td>
<td>SNMP filtering setting information</td>
<td>-</td>
</tr>
<tr>
<td>Use IP Filtering</td>
<td>Operation status of IP filtering</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Select</td>
<td>IP filtering method</td>
<td>Disabled/Enabled</td>
</tr>
<tr>
<td>IP Filtering Permission Address</td>
<td>IP filtering permission address</td>
<td>-</td>
</tr>
<tr>
<td>Start Address 1</td>
<td>Start address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 1</td>
<td>End address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 1</td>
<td>Use single on 1</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 2</td>
<td>Start address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 2</td>
<td>End address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 2</td>
<td>Use single on 2</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 3</td>
<td>Start address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 3</td>
<td>End address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 3</td>
<td>Use single on 3</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 4</td>
<td>Start address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 4</td>
<td>End address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 4</td>
<td>Use single on 4</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 5</td>
<td>Start address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 5</td>
<td>End address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Use Single On 5</td>
<td>Use single on 5</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Prohibit Address</td>
<td>IP filtering prohibit address</td>
<td>-</td>
</tr>
<tr>
<td>Start Address 1</td>
<td>Start address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 1</td>
<td>End address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 1</td>
<td>Use single on 1</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 2</td>
<td>Start address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 2</td>
<td>End address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 2</td>
<td>Use single on 2</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 3</td>
<td>Start address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 3</td>
<td>End address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 3</td>
<td>Use single on 3</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 4</td>
<td>Start address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 4</td>
<td>End address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 4</td>
<td>Use single on 4</td>
<td>On/Off</td>
</tr>
<tr>
<td>LAN Setting</td>
<td>Basic setting information</td>
<td>-</td>
</tr>
<tr>
<td>Basic Info</td>
<td>IPv4 setting information (Wired LAN)</td>
<td>-</td>
</tr>
<tr>
<td>Control Filtering</td>
<td>SNMP filtering setting information</td>
<td>-</td>
</tr>
<tr>
<td>IP Filtering Prohibit Address</td>
<td>IP filtering prohibit address</td>
<td>-</td>
</tr>
<tr>
<td>Start Address 5</td>
<td>Start address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 5</td>
<td>End address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 5</td>
<td>Use single on 5</td>
<td>On/Off</td>
</tr>
<tr>
<td>Print Filtering</td>
<td>Print filtering setting information</td>
<td>-</td>
</tr>
<tr>
<td>Use IP Filtering</td>
<td>Operation status of IP filtering</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Select</td>
<td>IP filtering method</td>
<td>Disabled/Enabled</td>
</tr>
<tr>
<td>IP Filtering Permission Address</td>
<td>IP filtering permission address</td>
<td>-</td>
</tr>
<tr>
<td>Start Address 1</td>
<td>Start address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 1</td>
<td>End address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 1</td>
<td>Use single on 1</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 2</td>
<td>Start address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>------------------</td>
</tr>
<tr>
<td>End Address 2</td>
<td>End address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 2</td>
<td>Use single on 2</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 3</td>
<td>Start address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 3</td>
<td>End address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 3</td>
<td>Use single on 3</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 4</td>
<td>Start address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 4</td>
<td>End address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 4</td>
<td>Use single on 4</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 5</td>
<td>Start address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 5</td>
<td>End address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 5</td>
<td>Use single on 5</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Prohibit Address</td>
<td>IP filtering prohibit address</td>
<td>-</td>
</tr>
<tr>
<td>Start Address 1</td>
<td>Start address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 1</td>
<td>End address 1</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 1</td>
<td>Use single on 1</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 2</td>
<td>Start address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 2</td>
<td>End address 2</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 2</td>
<td>Use single on 2</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 3</td>
<td>Start address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 3</td>
<td>End address 3</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 3</td>
<td>Use single on 3</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 4</td>
<td>Start address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 4</td>
<td>End address 4</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 4</td>
<td>Use single on 4</td>
<td>On/Off</td>
</tr>
<tr>
<td>Start Address 5</td>
<td>Start address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>End Address 5</td>
<td>End address 5</td>
<td>XXX.XXX.XXX.XXX</td>
</tr>
<tr>
<td>Use Single On 5</td>
<td>Use single on 5</td>
<td>On/Off</td>
</tr>
<tr>
<td>LAN Setting</td>
<td>Basic setting information</td>
<td>-</td>
</tr>
<tr>
<td>IPv6 Info</td>
<td>IPv6 setting information (Wired LAN)</td>
<td>-</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------</td>
<td>---</td>
</tr>
<tr>
<td>Link Local Address</td>
<td>Link local address</td>
<td>-</td>
</tr>
<tr>
<td>IP Address</td>
<td>IPv6 IP address</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length</td>
<td>Link local address prefix length</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>Use Manual Mode</td>
<td>Operation status of IPv6 manual address</td>
<td>On/Off</td>
</tr>
<tr>
<td>Manual Address</td>
<td>Manual address</td>
<td>-</td>
</tr>
<tr>
<td>IP Address</td>
<td>IPv6 IP address</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length</td>
<td>Prefix length</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>Use Stateful Address Mode</td>
<td>Operation status of stateful address mode</td>
<td>On/Off</td>
</tr>
<tr>
<td>Stateful Address</td>
<td>Stateful address</td>
<td>-</td>
</tr>
<tr>
<td>IP Address</td>
<td>IPv6 IP address</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length</td>
<td>Prefix length</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>Stateless Address</td>
<td>Stateless address</td>
<td>-</td>
</tr>
<tr>
<td>IP Address 1</td>
<td>IP address 1</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length 1</td>
<td>Prefix length 1</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>IP Address 2</td>
<td>IP address 2</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length 2</td>
<td>Prefix length 2</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>IP Address 3</td>
<td>IP address 3</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length 3</td>
<td>Prefix length 3</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>IP Address 4</td>
<td>IP address 4</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length 4</td>
<td>Prefix length 4</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>Gateway address</td>
<td>-</td>
</tr>
<tr>
<td>IP Address 1</td>
<td>IP address 1</td>
<td>XXX:XXXX:XXXX:XXXX XXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Prefix Length 1</td>
<td>Prefix length 1</td>
<td>XXX (0 to 128)</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| IP Address 2   | IP address 2   | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| Prefix Length 2 | Prefix length 2 | XXX (0 to 128) |
| IP Address 3   | IP address 3   | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| Prefix Length 3 | Prefix length 3 | XXX (0 to 128) |
| IP Address 4   | IP address 4   | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| Prefix Length 4 | Prefix length 4 | XXX (0 to 128) |
| Use DNS Auto Mode | Acquiring DNS server automatically | On/Off |
| Primary DNS Server Address | Primary DNS server address | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| Secondary DNS Server Address | Secondary DNS server address | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| Control Filtering | SNMP filtering setting information | - |
| Use IP Filtering | Operation status of IP filtering | On/Off |
| IP Filtering Select | IP filtering method | Disabled/Enabled |
| IPv6 Filtering Permission Info | IPv6 filtering permission information | - |
| IP Filtering Start Address 1 | IP filtering start address 1 | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| IP Filtering End Address 1 | IP filtering end address 1 | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| Use Single On 1 | Use single on 1 | On/Off |
| LAN Setting | Basic setting information | - |
| IPv6 Info | IPv6 setting information (Wired LAN) | - |
| Control Filtering | SNMP filtering setting information | - |
| IP Filtering Start Address 2 | IP filtering start address 2 | XXXX:XXXX:XXXX:XXXXX  
                          |                | XXXX:XXXX:XXXX:XXXXX |
| IP Filtering End Address 2 | IP filtering end address 2 | XXXX:XXXX:XXXX:XXXXX  
<pre><code>                      |                | XXXX:XXXX:XXXX:XXXXX |
</code></pre>
<table>
<thead>
<tr>
<th>Use Single On 2</th>
<th>Use single on 2</th>
<th>On/Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Filtering Start Address 3</td>
<td>IP filtering start address 3</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 3</td>
<td>IP filtering end address 3</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 3</td>
<td>Use single on 3</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Start Address 4</td>
<td>IP filtering start address 4</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 4</td>
<td>IP filtering end address 4</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 4</td>
<td>Use single on 4</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Start Address 5</td>
<td>IP filtering start address 5</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 5</td>
<td>IP filtering end address 5</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 5</td>
<td>Use single on 5</td>
<td>On/Off</td>
</tr>
<tr>
<td>IPv6 Filtering Prohibit Info</td>
<td>IPv6 Filtering prohibit information</td>
<td>-</td>
</tr>
<tr>
<td>IP Filtering Start Address 1</td>
<td>IP filtering start address 1</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 1</td>
<td>IP filtering end address 1</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 1</td>
<td>Use single on 1</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Start Address 2</td>
<td>IP filtering start address 2</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 2</td>
<td>IP filtering end address 2</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 2</td>
<td>Use single on 2</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Start Address 3</td>
<td>IP filtering start address 3</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 3</td>
<td>IP filtering end address 3</td>
<td>XXXX:XXXX:XXXX:XXXX XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 3</td>
<td>Use single on 3</td>
<td>On/Off</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Information</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>IP Filtering Start Address 4</td>
<td>IP filtering start address 4</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 4</td>
<td>IP filtering end address 4</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 4</td>
<td>Use single on 4</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Start Address 5</td>
<td>IP filtering start address 5</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 5</td>
<td>IP filtering end address 5</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 5</td>
<td>Use single on 5</td>
<td>On/Off</td>
</tr>
<tr>
<td>Print Filtering</td>
<td>Print filtering setting information</td>
<td>-</td>
</tr>
<tr>
<td>Use IP Filtering</td>
<td>Operation status of IP filtering</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Select</td>
<td>IP filtering method</td>
<td>Disabled/Enabled</td>
</tr>
<tr>
<td>IP Filtering Permission Info</td>
<td>IP filtering permission information</td>
<td>-</td>
</tr>
<tr>
<td>IP Filtering Start Address 1</td>
<td>IP filtering start address 1</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 1</td>
<td>IP filtering end address 1</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 1</td>
<td>Use single on 1</td>
<td>On/Off</td>
</tr>
<tr>
<td>IP Filtering Start Address 2</td>
<td>IP filtering start address 2</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 2</td>
<td>IP filtering end address 2</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 2</td>
<td>Use single on 2</td>
<td>On/Off</td>
</tr>
<tr>
<td>LAN Setting</td>
<td>Basic setting information</td>
<td>-</td>
</tr>
<tr>
<td>IPv6 Info</td>
<td>IPv6 setting information (Wired LAN)</td>
<td>-</td>
</tr>
<tr>
<td>Print Filtering</td>
<td>Print filtering setting information</td>
<td>-</td>
</tr>
<tr>
<td>IP Filtering Start Address 3</td>
<td>IP filtering start address 3</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>IP Filtering End Address 3</td>
<td>IP filtering end address 3</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 3</td>
<td>Use single on 3</td>
<td>On/Off</td>
</tr>
</tbody>
</table>
| IP Filtering Start Address 4 | IP filtering start address 4 | XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| IP Filtering End Address 4  | IP filtering end address 4  | XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| Use Single On 4             | Use single on 4             | On/Off |
| IP Filtering Start Address 5| IP filtering start address 5| XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| IP Filtering End Address 5  | IP filtering end address 5  | XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| Use Single On 5             | Use single on 5             | On/Off |
| IPv6 Filtering Prohibit Info| IPv6 Filtering prohibit information | - |
| IP Filtering Start Address 1| IP filtering start address 1| XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| IP Filtering End Address 1  | IP filtering end address 1  | XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| Use Single On 1             | Use single on 1             | On/Off |
| IP Filtering Start Address 2| IP filtering start address 2| XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| IP Filtering End Address 2  | IP filtering end address 2  | XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| Use Single On 2             | Use single on 2             | On/Off |
| IP Filtering Start Address 3| IP filtering start address 3| XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| IP Filtering End Address 3  | IP filtering end address 3  | XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| Use Single On 3             | Use single on 3             | On/Off |
| IP Filtering Start Address 4| IP filtering start address 4| XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| IP Filtering End Address 4  | IP filtering end address 4  | XXXX:XXXX:XXXX:XXXX 
|                             |                             | XXXX:XXXX:XXXX:XXXX |
| Use Single On 4             | Use single on 4             | On/Off |
| IP Filtering Start Address 5| IP filtering start address 5| XXXX:XXXX:XXXX:XXXX 
<p>|                             |                             | XXXX:XXXX:XXXX:XXXX |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Filtering End Address 5</td>
<td>IP filtering end address 5</td>
<td>XXXX:XXXX:XXXX:XXXX</td>
</tr>
<tr>
<td>Use Single On 5</td>
<td>Use single on 5</td>
<td>On/Off</td>
</tr>
<tr>
<td>MAC Info</td>
<td>MAC address setting information (Wired/Wi-Fi)</td>
<td>-</td>
</tr>
<tr>
<td>MAC Address(Wired)</td>
<td>MAC address (Wired LAN)</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address(Wireless)</td>
<td>MAC address (Wi-Fi)</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>Use MAC Address Filtering</td>
<td>Operation status of MAC address filtering</td>
<td>On/Off</td>
</tr>
<tr>
<td>MAC Filtering Select</td>
<td>MAC address filtering method</td>
<td>Disabled/Enabled</td>
</tr>
<tr>
<td>MAC Filtering Permission Info</td>
<td>MAC filtering permission information</td>
<td>-</td>
</tr>
<tr>
<td>MAC Address 1</td>
<td>MAC address 1</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 2</td>
<td>MAC address 2</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 3</td>
<td>MAC address 3</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 4</td>
<td>MAC address 4</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 5</td>
<td>MAC address 5</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>LAN Setting</td>
<td>Basic setting information</td>
<td>-</td>
</tr>
<tr>
<td>MAC Info</td>
<td>MAC address setting information (Wired/Wi-Fi)</td>
<td>-</td>
</tr>
<tr>
<td>MAC Filtering Prohibit Info</td>
<td>MAC filtering prohibit information</td>
<td>-</td>
</tr>
<tr>
<td>MAC Address 1</td>
<td>MAC address 1</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 2</td>
<td>MAC address 2</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 3</td>
<td>MAC address 3</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 4</td>
<td>MAC address 4</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>MAC Address 5</td>
<td>MAC address 5</td>
<td>XX:XX:XX:XX:XX:XX</td>
</tr>
<tr>
<td>Proxy Setting</td>
<td>Proxy server setting information</td>
<td>-</td>
</tr>
<tr>
<td>Use Proxy</td>
<td>Use proxy server</td>
<td>On/Off</td>
</tr>
<tr>
<td>Proxy Server Address</td>
<td>Proxy server address</td>
<td>XXXXXXXXXXXXXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>Proxy Port Number</td>
<td>Proxy port specification</td>
<td>1 to 65535</td>
</tr>
<tr>
<td>Use User Authority Mode</td>
<td>Use user authority mode</td>
<td>On/Off</td>
</tr>
<tr>
<td>Proxy Server User Name</td>
<td>Proxy server user name</td>
<td>XXXXXXXXXXXXXXXXXXX (up to 64 characters)</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Wireless LAN Setting</td>
<td>Wi-Fi setting information</td>
<td>-</td>
</tr>
<tr>
<td>Channel</td>
<td>Channel (infrastructure)</td>
<td>XXX (0 to 255)</td>
</tr>
<tr>
<td>SSID</td>
<td>SSID</td>
<td>Wi-Fi (infrastructure) SSID (up to 32 characters)</td>
</tr>
<tr>
<td>Security Type</td>
<td>Security type for Wi-Fi (infrastructure)</td>
<td>Disabled/WEP 64bit/WEP 128bit/WPA PSK TKIP/WPA PSK AES/WPA2 PSK TKIP/WPA2 PSK AES/MIXED</td>
</tr>
<tr>
<td>WEP1</td>
<td>WEP key 1 for Wi-Fi (infrastructure)</td>
<td>XXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>WEP2</td>
<td>WEP key 2 for Wi-Fi (infrastructure)</td>
<td>XXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>WEP3</td>
<td>WEP key 3 for Wi-Fi (infrastructure)</td>
<td>XXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>WEP4</td>
<td>WEP key 4 for Wi-Fi (infrastructure)</td>
<td>XXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>WEP Certificate</td>
<td>WEP certificate for Wi-Fi (infrastructure)</td>
<td>Open/Shared/Auto</td>
</tr>
<tr>
<td>WEP Format</td>
<td>WEP format for Wi-Fi (infrastructure)</td>
<td>Hex/String</td>
</tr>
<tr>
<td>Direct Connection Setting</td>
<td>Wireless direct setting information</td>
<td>-</td>
</tr>
<tr>
<td>Device Name</td>
<td>Wireless direct device name</td>
<td>Wireless direct device name (up to 32 characters)</td>
</tr>
<tr>
<td>Channel</td>
<td>Channel (Wireless direct)</td>
<td>XXX (0 to 255)</td>
</tr>
<tr>
<td>SSID</td>
<td>SSID</td>
<td>Wireless direct network name (SSID) (up to 32 characters)</td>
</tr>
<tr>
<td>Security Type</td>
<td>Security type for Wi-Fi (Wireless direct)</td>
<td>Disabled/WPA2 PSK TKIP/WPA2 PSK AES</td>
</tr>
<tr>
<td>WSD Setting</td>
<td>WSD setting information</td>
<td>-</td>
</tr>
<tr>
<td>Use WSD</td>
<td>Use WSD</td>
<td>On/Off</td>
</tr>
<tr>
<td>WSD Timeout</td>
<td>Timeout</td>
<td>1/5/10/15/20 [min]</td>
</tr>
<tr>
<td>Use WSD Rx Optimization</td>
<td>Use WSD reception optimization</td>
<td>On/Off</td>
</tr>
<tr>
<td>Protocol Setting</td>
<td>Protocol setting information</td>
<td>-</td>
</tr>
<tr>
<td>Printer Name</td>
<td>Printer name</td>
<td>XXXXXXXXX (up to 16 characters)</td>
</tr>
<tr>
<td>Use LPR</td>
<td>Use LPR</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use Wired DRX</td>
<td>Discontinuous reception (Wired LAN)</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use Wireless DRX</td>
<td>Discontinuous reception (Wi-Fi)</td>
<td>On/Off</td>
</tr>
<tr>
<td>Feature</td>
<td>Setting Information</td>
<td>On/Off</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Use RAW</td>
<td>Use RAW</td>
<td></td>
</tr>
<tr>
<td>Use LLMNR</td>
<td>Use LLMNR</td>
<td></td>
</tr>
<tr>
<td>Use Spanning Tree</td>
<td>Use spanning tree</td>
<td></td>
</tr>
<tr>
<td>Use Dedicated Port</td>
<td>Dedicated port setting</td>
<td></td>
</tr>
<tr>
<td>SNMP Setting</td>
<td>SNMP setting information</td>
<td>-</td>
</tr>
<tr>
<td>Use SNMPv1</td>
<td>Use SNMPv1</td>
<td></td>
</tr>
<tr>
<td>Use SNMPv3</td>
<td>Use SNMPv3</td>
<td></td>
</tr>
<tr>
<td>SNMP Community Name1</td>
<td>SNMPv1 community name 1</td>
<td>Xxxxxxxxx (up to 32 characters)</td>
</tr>
<tr>
<td>SNMP Community Name2</td>
<td>SNMPv1 community name 2</td>
<td>Xxxxxxxxx (up to 32 characters)</td>
</tr>
<tr>
<td>SNMP Extra Access Authority</td>
<td>SNMPv1 extra access authority</td>
<td>Disable/Read Only/Read Write</td>
</tr>
<tr>
<td>SNMP Access Authority1</td>
<td>SNMPv1 community1/2 access authority</td>
<td>Read Only/Read Write</td>
</tr>
<tr>
<td>SNMP Access Authority2</td>
<td>SNMPv1 community1/2 access authority</td>
<td>Disable/Read Only/Read Write</td>
</tr>
<tr>
<td>SNMPv3 Setting</td>
<td>SNMPv3 setting information</td>
<td>-</td>
</tr>
<tr>
<td>User1</td>
<td>User 1</td>
<td></td>
</tr>
<tr>
<td>User Name</td>
<td>User name</td>
<td>Xxxxxxxxx (up to 32 characters)</td>
</tr>
<tr>
<td>Use SNMPv3</td>
<td>Use SNMPv3</td>
<td></td>
</tr>
<tr>
<td>MIB Access Restriction</td>
<td>MIB access restriction</td>
<td>Read Only/Read Write</td>
</tr>
<tr>
<td>Security Setting</td>
<td>Security setting</td>
<td>No Auth No Priv/Auth No Priv/Auto Priv</td>
</tr>
<tr>
<td>Authority Algorithm</td>
<td>Authority algorithm</td>
<td>Null/MD5/SHA1</td>
</tr>
<tr>
<td>Encryption Algorithm</td>
<td>Encryption algorithm</td>
<td>Null/AES/DES</td>
</tr>
<tr>
<td>User2</td>
<td>User 2</td>
<td></td>
</tr>
<tr>
<td>User Name</td>
<td>User name</td>
<td>Xxxxxxxxx (up to 32 characters)</td>
</tr>
<tr>
<td>Use SNMPv3</td>
<td>Use SNMPv3</td>
<td></td>
</tr>
<tr>
<td>MIB Access Restriction</td>
<td>MIB access restriction</td>
<td>Read Only/Read Write</td>
</tr>
<tr>
<td>Security Setting</td>
<td>Security setting</td>
<td>No Auth No Priv/Auth No Priv/Auto Priv</td>
</tr>
<tr>
<td>Authority Algorithm</td>
<td>Authority algorithm</td>
<td>Null/MD5/SHA1</td>
</tr>
<tr>
<td>Encryption Algorithm</td>
<td>Encryption algorithm</td>
<td>Null/AES/DES</td>
</tr>
<tr>
<td>User3</td>
<td>User 3</td>
<td></td>
</tr>
<tr>
<td>User Name</td>
<td>User name</td>
<td>Xxxxxxxxx (up to 32 characters)</td>
</tr>
<tr>
<td>Setting</td>
<td>Value</td>
<td>Options</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Use SNMPv3</td>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>MIB Access Restriction</td>
<td>MIB access restriction</td>
<td>Read Only/Read Write</td>
</tr>
<tr>
<td>Security Setting</td>
<td>Security setting</td>
<td>No Auth No Priv/Auth No Priv/Auto Priv</td>
</tr>
<tr>
<td>Authority Algorithm</td>
<td>Authority algorithm</td>
<td>Null/MD5/SHA1</td>
</tr>
<tr>
<td>Encryption Algorithm</td>
<td>Encryption algorithm</td>
<td>Null/AES/DES</td>
</tr>
<tr>
<td>User Name</td>
<td>User name</td>
<td>XXXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>Use SNMPv3</td>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>MIB Access Restriction</td>
<td>MIB access restriction</td>
<td>Read Only/Read Write</td>
</tr>
<tr>
<td>Security Setting</td>
<td>Security setting</td>
<td>No Auth No Priv/Auth No Priv/Auto Priv</td>
</tr>
<tr>
<td>Authority Algorithm</td>
<td>Authority algorithm</td>
<td>Null/MD5/SHA1</td>
</tr>
<tr>
<td>Encryption Algorithm</td>
<td>Encryption algorithm</td>
<td>Null/AES/DES</td>
</tr>
<tr>
<td>User Name</td>
<td>User name</td>
<td>XXXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>Use SNMPv3</td>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>MIB Access Restriction</td>
<td>MIB access restriction</td>
<td>Read Only/Read Write</td>
</tr>
<tr>
<td>Security Setting</td>
<td>Security setting</td>
<td>No Auth No Priv/Auth No Priv/Auto Priv</td>
</tr>
<tr>
<td>Authority Algorithm</td>
<td>Authority algorithm</td>
<td>Null/MD5/SHA1</td>
</tr>
<tr>
<td>Encryption Algorithm</td>
<td>Encryption algorithm</td>
<td>Null/AES/DES</td>
</tr>
<tr>
<td>Dynamic DNS Setting</td>
<td>Dynamic DNS setting</td>
<td>-</td>
</tr>
<tr>
<td>IPv4</td>
<td>IPv4</td>
<td>-</td>
</tr>
<tr>
<td>Use Dynamic DNS</td>
<td>Operation status of Dynamic DNS</td>
<td>On/Off</td>
</tr>
<tr>
<td>Host Name</td>
<td>Host name</td>
<td>XXXXXXXXX (up to 64 characters)</td>
</tr>
<tr>
<td>Domain Name</td>
<td>Domain name</td>
<td>XXXXXXXXX (up to 65 characters)</td>
</tr>
<tr>
<td>IPv6</td>
<td>IPv6</td>
<td>-</td>
</tr>
<tr>
<td>Use Manual Address</td>
<td>DNS dynamic setting of manual address</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use Stateless Address</td>
<td>DNS dynamic setting of stateless address</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use Stateful Address</td>
<td>DNS dynamic setting of stateful address</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use Name As IPv4</td>
<td>Use same host name/domain name as that used for IPv4</td>
<td>On/Off</td>
</tr>
<tr>
<td>Setting</td>
<td>Information</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td><strong>Host Name</strong></td>
<td>Host name</td>
<td>XXXXXXXXX (up to 64 characters)</td>
</tr>
<tr>
<td><strong>Domain Name</strong></td>
<td>Domain name</td>
<td>XXXXXXXXX (up to 65 characters)</td>
</tr>
<tr>
<td><strong>SNTP Setting</strong></td>
<td>SNTP setting information</td>
<td>-</td>
</tr>
<tr>
<td><strong>Use SNTP</strong></td>
<td>Use SNTP</td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>SNTP Polling Interval</strong></td>
<td>SNTP polling interval</td>
<td>1 to 48 [sec]</td>
</tr>
<tr>
<td><strong>SNTP Server Name</strong></td>
<td>SNTP server name</td>
<td>XXXXXXXXX (up to 256 characters)</td>
</tr>
<tr>
<td><strong>FTP Setting</strong></td>
<td>FTP setting information</td>
<td>-</td>
</tr>
<tr>
<td><strong>Use FTP</strong></td>
<td>Use FTP</td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>Use FTP Authority</strong></td>
<td>Use FTP authority</td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>FTP User Name</strong></td>
<td>FTP user name</td>
<td>XXXXXXXXX (up to 33 characters)</td>
</tr>
<tr>
<td><strong>Bonjour Setting</strong></td>
<td>Bonjour setting information</td>
<td>-</td>
</tr>
<tr>
<td><strong>Use Bonjour</strong></td>
<td>Use Bonjour</td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>Bonjour Service Name</strong></td>
<td>Bonjour service name</td>
<td>Bonjour service name (Up to 50 alphanumeric characters)</td>
</tr>
<tr>
<td><strong>802.1X Setting</strong></td>
<td>802.1X setting information</td>
<td>-</td>
</tr>
<tr>
<td><strong>Authority Type</strong></td>
<td>Enable/disable 802.1X and authority type</td>
<td>Do not use/EAP-TLS/EAP-TTLS/PEAP</td>
</tr>
<tr>
<td><strong>EAP TTLS Type</strong></td>
<td>Internal authority type for EAP-TTLS</td>
<td>MSCHAPv2/PAP</td>
</tr>
<tr>
<td><strong>Weak Encryption Restriction</strong></td>
<td>Weak encryption restriction</td>
<td>Do not restrict/Restrict</td>
</tr>
<tr>
<td><strong>Weak Certificate Restriction</strong></td>
<td>Weak certificate restriction</td>
<td>Do not restrict/Restrict</td>
</tr>
<tr>
<td><strong>Login Name</strong></td>
<td>Login name</td>
<td>XXXXXXXXX (up to 24 characters)</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>User name</td>
<td>XXXXXXXXX (up to 24 characters)</td>
</tr>
<tr>
<td><strong>Server Name</strong></td>
<td>Server name</td>
<td>XXXXXXXXX (up to 43 characters)</td>
</tr>
<tr>
<td><strong>IPsec Setting</strong></td>
<td>IPsec setting information</td>
<td>-</td>
</tr>
<tr>
<td><strong>Use IPsec</strong></td>
<td>Use IPsec</td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>Phase2 Protocol</strong></td>
<td>IPSec phase2 protocol</td>
<td>AH/ESP/AH+ESP</td>
</tr>
<tr>
<td><strong>IPP Setting</strong></td>
<td>IPP confirmation setting</td>
<td>-</td>
</tr>
<tr>
<td><strong>Use IPP</strong></td>
<td>Use IPP</td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>Use IPP Authority</strong></td>
<td>Use IPP authority</td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>IPP User Setting</strong></td>
<td>IPP confirmation user setting</td>
<td>-</td>
</tr>
<tr>
<td><strong>User1</strong></td>
<td>User 1</td>
<td>-</td>
</tr>
<tr>
<td>User Name</td>
<td>User name</td>
<td>XXXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>User2</td>
<td>User 2</td>
<td></td>
</tr>
<tr>
<td>User3</td>
<td>User 3</td>
<td></td>
</tr>
<tr>
<td>User4</td>
<td>User 4</td>
<td></td>
</tr>
<tr>
<td>User5</td>
<td>User 5</td>
<td></td>
</tr>
<tr>
<td>User6</td>
<td>User 6</td>
<td></td>
</tr>
<tr>
<td>User7</td>
<td>User 7</td>
<td></td>
</tr>
<tr>
<td>User8</td>
<td>User 8</td>
<td></td>
</tr>
<tr>
<td>User9</td>
<td>User 9</td>
<td></td>
</tr>
<tr>
<td>User10</td>
<td>User 10</td>
<td></td>
</tr>
<tr>
<td>User Name</td>
<td>User name</td>
<td>XXXXXXXXX (up to 32 characters)</td>
</tr>
<tr>
<td>Email Setting</td>
<td>E-mail setting information</td>
<td>-</td>
</tr>
<tr>
<td>Retry Count</td>
<td>E-mail retry count</td>
<td>0 to 5</td>
</tr>
<tr>
<td>Retry Interval</td>
<td>E-mail retry interval</td>
<td>1 to 60 (min)</td>
</tr>
<tr>
<td>Use Email Notification</td>
<td>Use E-mail notification</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use SSL</td>
<td>Use SSL</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use SSL Cert No Check</td>
<td>Use SSL certification</td>
<td>On/Off</td>
</tr>
<tr>
<td>Use Mailbox Delete</td>
<td>Use mailbox delete</td>
<td>On/Off</td>
</tr>
<tr>
<td>SMTP Server Address</td>
<td>SMTP server address</td>
<td>XXXXXXXXX (up to 256 characters)</td>
</tr>
<tr>
<td>SMTP Server Port No</td>
<td>SMTP server port number</td>
<td>1 to 65535</td>
</tr>
<tr>
<td>SMTP State</td>
<td>SMTP state</td>
<td>Invalid/Authorized/POP before SMTP</td>
</tr>
<tr>
<td>From Address</td>
<td>From address</td>
<td>XXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>To Address 1</td>
<td>To address 1</td>
<td>XXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>Reply Address 1</td>
<td>Reply address 1</td>
<td>XXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>Notice Conditions 1</td>
<td>Notice conditions 1</td>
<td>-</td>
</tr>
<tr>
<td>Job End</td>
<td>Job end</td>
<td>On/Off</td>
</tr>
<tr>
<td>Error Occurred</td>
<td>Error occurred</td>
<td>On/Off</td>
</tr>
<tr>
<td>Warning Occurred</td>
<td>Warning occurred</td>
<td>On/Off</td>
</tr>
<tr>
<td>Signature 1</td>
<td>Signature 1</td>
<td>XXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>To Address 2</td>
<td>To address 2</td>
<td>XXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>Reply Address 2</td>
<td>Reply address 2</td>
<td>XXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>Notice Conditions 2</td>
<td>Notice conditions 2</td>
<td>-</td>
</tr>
<tr>
<td>Job End</td>
<td>Job end</td>
<td>On/Off</td>
</tr>
<tr>
<td>Error Occurred</td>
<td>Error occurred</td>
<td>On/Off</td>
</tr>
<tr>
<td>Warning Occurred</td>
<td>Warning occurred</td>
<td>On/Off</td>
</tr>
<tr>
<td>Signature 2</td>
<td>Signature 2</td>
<td>XXXXXXXXX (up to 128 characters)</td>
</tr>
<tr>
<td>RUI Setting</td>
<td>Remote UI setting information</td>
<td>-</td>
</tr>
<tr>
<td>Use RUI</td>
<td>Use Remote UI</td>
<td>On/Off</td>
</tr>
</tbody>
</table>

("XX" represents alphanumeric characters.)
Reconfiguration Method of LAN Connection/Reconfiguration Method of Wi-Fi Connection

**Changing LAN Connection Method**

Follow either procedure below to change LAN connection method (wired or wireless).

- **For Windows:**
  - Redo setup using the Setup CD-ROM or from the web page.
  - Select *Enable* for *Enable/disable Wired LAN* or *Enable/disable Wi-Fi* in the touch screen menu.
  
  After that, perform settings on the **Network Settings** screen on IJ Network Device Setup Utility.

  For details, refer to **Performing/Changing Wi-Fi Settings** or **Performing/Changing Wired LAN Connection (Ethernet Cable) Settings**.

- **For macOS:**
  
  Redo setup from the web page.

**Changing Wi-Fi Connection Method**

Follow either procedure below to change Wi-Fi connection method (infrastructure or wireless direct).

- **For Windows:**
  
  - Redo setup using the Setup CD-ROM or from the web page.
  - Perform settings on the **Network Settings** screen on IJ Network Device Setup Utility.

**Important**

- Before you perform settings using IJ Network Device Setup Utility, change the printer settings following the procedure below.

  1. Check that printer is turned on.

  2. Select **Network status** icon.

     **Menu Operations**

     If you specify the administrator password, enter the password.

  3. Select Wi-Fi.

  4. Select **Settings**.
5. Select **Wi-Fi setup**.

6. Select **Easy wireless connect**.

7. Check message and select **OK**.
   
   Follow instructions on your smartphone or tablet.

8. If message saying setup is completed appears, select **OK**.

- **For macOS:**
  
  Redo setup from the web page.
Reconfiguration of Network Settings using the Remote UI

You can use Remote UI on the following OS and the web browser.

- **iOS device**
  - OS: iOS 11.0 or later
  - Web browser: iOS standard Web browser (Mobile Safari)

- **Android device**
  - OS: Android 4.4 or later
  - Web browser: Android standard Web browser (Browser or Chrome)

- **macOS device**
  - OS: Mac OS X v10.10 or later
  - Web browser: Safari 10.0 or later

- **Windows device**
  - OS: Windows 7 SP1 or later
  - Web browser: Internet Explorer 11 or later, Google Chrome, Mozilla Firefox

For more on Remote UI, refer to Configuration Changes Using Web Browser.

**Important**

- Enable JavaScript and cookies in the web browser.
- If you access Remote UI with the printer name instead of its IP address, make sure the DNS settings are correctly configured.
- Depending on the network environment, you may not be able to start Remote UI.
- On the HOME screen, select (Setup) > Device settings > Other device settings > Operation restrictions, and then make sure Do not restrict is selected for Remote UI.

**Note**

- Remote UI also offers many other features. You can display the ink levels, check error messages and other status information, and cancel print jobs.
Countermeasures against Unauthorized Access

This section describes countermeasures against an unauthorized access to the printer from outside. When you use the printer via a network or you are an administrator, we recommend you read this section before using the printer.

Four countermeasures below can be helpful against an unauthorized access.

- Specify a Private IP Address
- Restrict Communication Using Firewall or Wi-Fi Router
- Specify a Password for the Printer
- Apply higher security level for Wi-Fi connection

Note
- As the setting procedure described below is an example, it may be different from that of your printer.
  For details, refer to your printer’s manual.

Specify a Private IP Address

An IP address is a numeric label assigned to each device on the network. There are two types of IP address. One is used for internet connection ("global IP address"), and the other is used for a local area network such as an inhouse LAN ("private IP address").

If a global IP address is specified for the printer, many and unspecified users on internet can access to the printer. As a result, you will face an increased risk of information leakage caused by an unauthorized access from outside. On the other hand, if a private IP address is specified for the printer, users who can access to the printer are confined to those on a local area network such as an inhouse LAN. Therefore, we recommend you specify a private IP address for the printer.

The range of addresses used as a private IP address is shown below. Make sure whether a private IP address is specified for your printer.

Range of private IP address
- 10.0.0.0 to 10.255.255.255
- 172.16.0.0 to 172.31.255.255
- 192.168.0.0 to 192.168.255.255

Procedure to check the IP address

Select Setup > Device settings > LAN settings on your printer to select a network connection method and check the IP address. For the procedure to check and specify the IP address, refer to your printer’s manual.

Note
- Establishing an environment to protect an access from outside using a firewall can reduce a risk of an unauthorized access even though a global IP address is specified for your printer.
Restrict Communication Using Firewall or Wi-Fi Router

Firewall is a system which prevents an unauthorized access from an external network user to protect an inhouse network against attack or intrusion.

Firewall enables your network to be protected against an unauthorized access by restricting a communication from the specific external IP address which seems to have a risk.

A home use Wi-Fi router has a similar function. Be careful when you change the settings.

Specify a Password for the Printer

Even if a malicious third party accesses to your printer by any chance, you can reduce a risk of information leakage drastically by specifying a password to protect various information on your printer.

In addition, though the printer can be protected by specifying a password, it is important to manage the specified password for security. Manage your password referring to the four points below. For details, refer to your printer’s manual.

• Be sure to change the default password.
• Change the password periodically.
• Do not use a password easy to guess for a third party.
• Do not tell a third party about the specified password casually.

Note

• A password is not specified for some printers at the time of purchase. In this case, specify the password for the printer.
• A password cannot be specified for some printers.

Password management using Remote UI (User Interface)

Remote UI is a software to access to the printer via a network by using a web browser. You can check the printer status or settings on Remote UI, which allows you to perform operations almost the same as those you can on the operation panel of the printer.

Entering the printer’s IP address or host name on the web browser displays the portal page of Remote UI.

For the procedure to start up or operations of Remote UI, refer to your printer’s manual.

Important

• Do not access to a website while you are using Remote UI on the web browser.

In addition, be sure to close the web browser when you leave your seat before you finish performing settings, or when you have finished performing settings.

Apply higher security level for Wi-Fi connection

When you use the printer via Wi-Fi, we recommend you apply a security method with higher security level (e.g. WPA/WPA2).

For more on operations, refer to your printer’s manual.
Network Status and Troubleshooting

Check the network status referring to LAN setting information on the touch screen.

- **Confirm LAN settings**

<table>
<thead>
<tr>
<th>Network Status</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected normally.</td>
<td>1. If you are unable to print, check the items below:</td>
</tr>
<tr>
<td>If you are unable to print, see 1 on What to Do.</td>
<td>- whether the computer is connected to Wi-Fi</td>
</tr>
<tr>
<td></td>
<td>- whether the firewall of your security software is enabled</td>
</tr>
<tr>
<td></td>
<td>- whether a privacy separator, SSID separator, or Network separation function is enabled on your wireless router</td>
</tr>
<tr>
<td></td>
<td>If one of the above is enabled, disable it before setup.</td>
</tr>
<tr>
<td></td>
<td>- whether the SSID of the printer (see &quot;3-2-6&quot; of network setting information printout) matches that of the router to connect</td>
</tr>
<tr>
<td></td>
<td>2. To change the network connection method (wired/wireless), change it on the printer’s network setting screen.</td>
</tr>
<tr>
<td>LAN is disabled on the printer.</td>
<td>Perform printer setup following the instructions of the manual.</td>
</tr>
<tr>
<td>Wired LAN connection is disabled.</td>
<td>• Make sure the printer is connected to the router with the LAN cable.</td>
</tr>
<tr>
<td></td>
<td>If the LAN cable is loose, connect the cable properly.</td>
</tr>
<tr>
<td></td>
<td>If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.</td>
</tr>
<tr>
<td></td>
<td>• Make sure the network devices (e.g. hub or router) are turned on.</td>
</tr>
<tr>
<td>IP address is not assigned.</td>
<td>• If you specify the printer's IP address automatically, enable DHCP on the router.</td>
</tr>
<tr>
<td></td>
<td>• If you specify the printer's IP address manually, the address is disabled because it is out of the valid range. You specified (0.0.0.0) as the IP address, for example.</td>
</tr>
<tr>
<td></td>
<td>Specify the valid IP address.</td>
</tr>
<tr>
<td>The default gateway is not specified.</td>
<td>Check the items below to communicate by hopping routers (e.g. using a cloud application).</td>
</tr>
<tr>
<td></td>
<td>• If you specify the printer's IP address manually, make sure the correct default gateway address is specified for the printer manually.</td>
</tr>
<tr>
<td></td>
<td>• Make sure the device specified as the default gateway is turned on.</td>
</tr>
<tr>
<td></td>
<td>• Specify the default gateway address correctly.</td>
</tr>
<tr>
<td></td>
<td>To check the default gateway, print out the network settings information.</td>
</tr>
<tr>
<td></td>
<td>• For some printers, you can check the default gateway on the operation panel.</td>
</tr>
<tr>
<td>Cannot connect to the specified network.</td>
<td>Check the status of the printer, network devices (e.g. wireless router), or smartphone/tablet.</td>
</tr>
<tr>
<td></td>
<td>• If they are turned off, turn them on.</td>
</tr>
<tr>
<td></td>
<td>• Make sure wireless signal is strong.</td>
</tr>
<tr>
<td></td>
<td>Monitor signal status and move the printer and wireless router as necessary.</td>
</tr>
<tr>
<td></td>
<td>• The security key specified for the wireless router may not match that you entered.</td>
</tr>
<tr>
<td>Issue</td>
<td>Resolution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The security key is case-sensitive.</td>
<td>Enter the correct security key.</td>
</tr>
<tr>
<td>The number of connected clients reaches the upper limit. Make sure the wireless signal is strong.</td>
<td>• Make sure the printer is not placed too far away from the wireless router.</td>
</tr>
<tr>
<td></td>
<td>• Wireless Direct does not allow more than 5 devices to be connected.</td>
</tr>
<tr>
<td></td>
<td>If you add a device to connect, disconnect a device you do not use before adding the device.</td>
</tr>
<tr>
<td>A link local address is assigned.</td>
<td>• Perform printer setup again.</td>
</tr>
<tr>
<td></td>
<td>• The security key specified for the wireless router may not match that you entered.</td>
</tr>
<tr>
<td></td>
<td>The security key is case-sensitive.</td>
</tr>
<tr>
<td></td>
<td>Enter the correct security key.</td>
</tr>
<tr>
<td>The specified SSID is left default value.</td>
<td>The SSID is not specified.</td>
</tr>
<tr>
<td></td>
<td>Enter the SSID specified for the destination.</td>
</tr>
</tbody>
</table>
IJ Network Device Setup Utility (Windows)

- IJ Network Device Setup Utility
- Starting Up IJ Network Device Setup Utility
- Diagnosing and Repairing Network Settings
- Performing/Changing Network Settings
- List of Models Which Does Not Support Diagnosis and Repair Function
- List of Models Which Does Not Support IPv6 Configuration via USB Connection
IJ Network Device Setup Utility

IJ Network Device Setup Utility allows you to diagnose or repair the network status, and to perform printer settings on network.

Use IJ Network Device Setup Utility for:

- Searching printers on network and performing initial network setup for detected printers
- Performing initial network setup by connecting the printer and computer using a USB cable (Not available for some models)
- Changing printer network settings
- Diagnosing the settings of the printer and those of computer on which IJ Network Device Setup Utility is installed if anything is wrong with connection. In addition, IJ Network Device Setup Utility repairs the status of the printer and computer (Not available for some models).

**Important**

- Depending on the printer you are using, an administrator password is already specified for the printer at the time of purchase. When you change the network settings, authentication by the administrator password is required.
- To use the printer over LAN, make sure you have the equipment necessary for the connection type, such as a wireless router or a LAN cable.
- When you install IJ Network Device Setup Utility, disable block function of firewall.
- Do not change network settings using IJ Network Device Setup Utility while printing is in progress.
Starting Up IJ Network Device Setup Utility

Start up IJ Network Device Setup Utility as shown below.

• In Windows 10, select Start > (All apps > ) > Canon Utilities > IJ Network Device Setup Utility.
• In Windows 8.1 or Windows 8, select IJ Network Device Setup Utility on the Start screen to start IJ Network Device Setup Utility. If IJ Network Device Setup Utility is not displayed on the Start screen, select the Search charm and search for "IJ Network Device Setup Utility".
• In Windows 7 or Windows Vista, click Start and select All Programs, Canon Utilities, IJ Network Device Setup Utility, and then IJ Network Device Setup Utility.

When you start up IJ Network Device Setup Utility, a message appears. Check the message and select Yes. The screen below appears.

Select Diagnose and Repair or Printer Network Setup on the displayed screen.

• If you select Diagnose and Repair:
  ➢ Diagnosing and Repairing Network Settings

• If you select Printer Network Setup:
  ➢ Performing/Changing Network Settings
Diagnosing and Repairing Network Settings

IJ Network Device Setup Utility diagnoses and repairs computer settings or connection between the computer and printer when a problem (e.g. cannot print from a printer on the network) occurs.

**Important**

- Some models do not support diagnosis and repair function.

  For details:
  - [List of Models Which Does Not Support Diagnosis and Repair Function](#)

Follow the procedure below.

1. **Start up IJ Network Device Setup Utility.**

2. Check the displayed message and select **Yes**.

3. **Select Diagnose and Repair** on the displayed screen. Perform operations following the instructions on the screen.

**Note**

- This function checks the following items:
  - whether the computer is connected to the router
  - whether a web page on the Internet can be viewed
  - whether the printer can be detected on the network
  - whether the signal strength or communication level is sufficient (when using Wi-Fi)
  - whether the printer port setting matches with the network setting
Performing/Changing Network Settings

- Canon IJ Network Device Setup Utility Screen
- Performing Network Settings
The screen below appears when you start up IJ Network Device Setup Utility and select **Printer Network Setup**. Detected printers are listed on the screen and the items below are shown.

A: **Product Name**
   Displays the product name of detected printer. The icon below appears on the left if the printer cannot be used.
   • : Appears when the printer requires setup or has not been configured.
   • : Appears when the IP address is duplicated to another printer.
   • : Appears when you cannot communicate with the printer.

**Note**
- If a printer you want to use is not detected, try to set the criteria for printer search.
  - **Setting Criteria for Printer Search/Searching Specific Printer**
- Right-clicking a printer displays setting items or items to confirm.

B: **Serial Number (Last 5 Digits)**
   Displays the last five digits of printer's serial number.

C: **Status**
   Displays the printer status as shown below.
   - **Available**
     Indicates the printer is available.
   - **Setup Completed**
Appears after performing network setup and clicking **Set** to close the window.

- **Requires Setup**
  Indicates the printer is required to perform Wi-Fi setup.
  ➔ **Performing/Changing Wi-Fi Settings**

- **Not Set**
  Indicates the printer cannot be used on network, or IPv6 is disabled. Specify an IP address or enable IPv6 on **Network Settings**....
  ➔ **Performing/Changing Wi-Fi Settings**

- **IP Address Overlap**
  Indicates the IP address is duplicated to another printer.

- **Unknown**
  Indicates the printer recognized as **Available** in the past cannot be used currently.

  ➔** Note**
  - If **USB** is selected from the pulldown menu on the toolbar, nothing is displayed.

**D: IP Address**
Displays the printer IP address. Nothing is displayed if the printer status is **Requires Setup**.

  ➔** Note**
  - If **USB** is selected from the pulldown menu on the toolbar, "-" is displayed.

**E: Location**
Displays the printer location if it is registered. Nothing is displayed if the printer status is **Requires Setup**.

  ➔** Note**
  - If **USB** is selected from the pulldown menu on the toolbar, nothing is displayed.

  ➔ **Assigning Printer Information**

**F: Connection Method**
Displays printer connection method (wired LAN, Wi-Fi, or USB).

  ➔** Note**
  - If **USB** is selected from the pulldown menu on the toolbar, **USB** is displayed.
  - If the printer supports both of the LAN connection methods, the printer is recognized as two printers and they are displayed separately. (The same numbers are displayed on **Serial Number (Last 5 Digits)**.)
  - If the printer does not support wired LAN, wired LAN is not displayed.
  - If you are using IJ Network Device Setup Utility on the computer which does not support Wi-Fi, Wi-Fi is not displayed.

**G: Setting Method**
Displays printer setting method.

- **Auto**
Appears if the printer is used by IP address specified automatically.

- Manual

Appears if the printer is used by IP address specified manually.

**Note**
- If USB is selected from the pulldown menu on the toolbar, ",." is displayed.

**H: MAC Address**
Displays the MAC address of the detected printer.

**Note**
- If USB is selected from the pulldown menu on the toolbar, ",." is displayed.

**I: Device Name**
Displays the printer device name if it is registered.

**Note**
- If USB is selected from the pulldown menu on the toolbar, nothing is displayed.
- The printer with Requires Setup displayed on Status is not displayed.

⇒ Assigning Printer Information

**J: IPv6**
On appears when an IPv6 address is assigned for the printer.

**Note**
- If USB is selected from the pulldown menu on the toolbar, ",." is displayed.

**K: Displays the printer status and operation guides.**
Selecting a printer from the printer list displays its current status and what to do next.

**Menus on Canon IJ Network Device Setup Utility Screen**
This section describes menus on Canon IJ Network Device Setup Utility screen.

A: Printer Settings menu
⇒ Printer Settings Menu

B: View menu
⇒ View Menu

C: Option menu
⇒ Option Menu
D: Help menu

Help Menu

Items on Canon IJ Network Device Setup Utility Screen Toolbar

This section describes items on Canon IJ Network Device Setup Utility Screen toolbar.

![Canon IJ Network Device Setup Utility Screen toolbar](image)

A: Perform wired or Wi-Fi setup.

Notes:
- This item has the same function as Network Settings... in the Printer Settings menu.

B: Redetects printers.

Notes:
- This item has the same function as Update in the View menu.

C: Stops detecting printers.

Notes:
- This item has the same function as Cancel in the View menu.

D: Switches the printer list. (IPv4, IPv6, or USB printers)

Notes:
- This item has the same function as Switch View in the View menu.
- You can also display the USB connected printer list. (Not available for some models.) In this case, select USB.

E: Displays this guide.

Notes:
- This item has the same function as Online Manual in the Help menu.
Performing Network Settings

- Performing/Changing Wired LAN Connection (Ethernet Cable) Settings
- Performing/Changing Wi-Fi Settings
- Assigning Printer Information
Performing/Changing Wired LAN Connection (Ethernet Cable) Settings

Follow the procedure below to perform/change wired LAN settings.

Note

• For some models, you can perform network setup for a USB connected printer using IJ Network Device Setup Utility. Select USB on Switch View under the View menu to display printers for which you can perform setup.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.


Detected printers are listed.

4. Select printer to perform/change settings from printer list.

Select the printer with Wired LAN displayed on Connection Method and Available displayed on Status to perform settings.

You can perform settings for a printer with Available not displayed on Status via USB connection.

To perform setup for a USB connected printer, select USB from the pulldown menu on the toolbar and select the printer to perform/change settings.

5. Select Network Settings... on Printer Settings menu.

The Confirm Printer Password screen appears.

For more on the password, refer to Administrator Password.

Note

• Clicking the icon allows you to perform/change settings.

• If you select a USB connected printer on step 4, the screen below appears after the Confirm Printer Password screen appears

Select Wired LAN and click OK.

6. Enter password and click OK.

The Network Settings screen appears.
7. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

- IPv4 settings

A: Use IPv4 address
   Always selected. (displayed in a gray out state)

B: Get IP address automatically
   Select this option to use an IP address automatically assigned by a DHCP server. DHCP server functionality must be enabled on your router.

C: Use next IP address
   Select this option if no DHCP server functionality is available in your setup where you use the printer, or you want to use a fixed IP address.
   Enter the IP address, subnet mask, and default gateway.

- IPv6 settings

Note

- If you select a USB connected printer on step 4, you cannot perform IPv6 settings depending on the printer you are using.

For details, see List of Models Which Does Not Support IPv6 Configuration via USB Connection.
A: Use IPv6 address
Select when you use the printer with IPv6 environment.

B: Use Stateless Address:
Select when you use an IP address assigned automatically. Use a router compatible with IPv6.

>>> Note
• This setting item is not available depending on the printer you are using.

C: Use Manual Address:
Select this option if no DHCP server functionality is available in your setup where you use the printer, or you want to use a fixed IP address.
Enter the IP address and IP address prefix length.

>>> Note
• This setting item is not available depending on the printer you are using.

D: Use DHCPv6:
Select when you obtain an IP address using DHCPv6.

>>> Note
• This setting item is not available depending on the printer you are using.

8. Click Set.
Performing/Changing Wi-Fi Settings

Follow the procedure below to perform/change Wi-Fi settings.

**Important**

- Enable Easy wireless connect (Cableless setup) before performing printer setup. (Not required if you change the IP address.) For details, search for "NR049" on your printer's online manual and see the page shown.
- If you use a printer over the Wi-Fi, we highly recommend you perform security settings for Wi-Fi network using WPA/WPA2 from the viewpoint of security.

**Note**

- For some models, you can perform network setup for a USB connected printer using IJ Network Device Setup Utility. Select **USB** on **Switch View** under the **View** menu to display printers.

1. **Start up IJ Network Device Setup Utility.**

2. Check the displayed message and select **Yes**.

3. Select **Printer Network Setup** on the displayed screen.

   Detected printers are listed.

4. Select printer to perform/change settings from printer list.

   Select the printer with **Wi-Fi** displayed on **Connection Method** and **Available** or **Requires Setup** displayed on **Status** to perform settings.

   You can perform settings for a printer with **Available** or **Requires Setup** not displayed on **Status** via USB connection.

   To perform setup for a USB connected printer, select **USB** from the pulldown menu on the toolbar and select the printer to perform/change settings.

5. Select **Network Settings...** on **Printer Settings** menu.

   The **Confirm Printer Password** screen appears.

   For more on the password, refer to Administrator Password.

**Note**

- Clicking the **** icon allows you to perform/change settings.
- If you select a USB connected printer on step 4 and the selected printer is compatible with wired LAN, the screen below appears after the **Confirm Printer Password** screen appears.
6. Enter password and click OK.

The Network Settings screen appears.

7. Perform/change settings.

You can switch the screen between IPv4 and IPv6. Click the tab to switch the protocol.

- IPv4/IPv6 settings

![Network Settings Interface](image)

A: Network Type:
Select the Wi-Fi mode.

- Infrastructure
  Connects the printer to the Wi-Fi with a wireless router.

- Direct
  Connects the printer to wireless communication devices (smartphone or tablet) without a wireless router.

Note
- If Wi-Fi is enabled on the computer and if you select a USB connected printer on step 4, you can select Direct depending on the printer you are using.
- If Direct is selected, all items are displayed in a gray out status and you cannot perform any settings.

In addition, you cannot connect to Internet from your computer depending on your operating environment.

B: Network Name (SSID):
The network name (SSID) of the Wi-Fi currently used is displayed.
The network name (SSID) for Wireless Direct appears while in Wireless Direct.

C: Search...
The Detected Wireless Routers screen is displayed to select a wireless router to connect to. For a wireless router already connected to the computer, Available is displayed on Communication Status.

If you select a wireless router with Not Connected on Communication Status from the list, clicking Set displays the WPA/WPA2 or WEP setting screen for a wireless router.

- If WEP Details Screen Appears
- If WPA/WPA2 Details Screen Appears

D: Encryption Type:
Displays the encryption method used over the Wi-Fi.

- IPv4 settings

Note

- The setting items below are available only when Infrastructure is selected for Network Type:

If Direct is selected, all items are displayed in a gray out status and you cannot perform any settings.
Enter the IP address, subnet mask, and default gateway.

- **IPv6 settings**

  **Note**

  - If you select a USB connected printer on step 4, you cannot perform IPv6 settings depending on the printer you are using.

  For details, see [List of Models Which Does Not Support IPv6 Configuration via USB Connection](#).

  - The setting items below are available only when **Infrastructure** is selected for **Network Type**.

  If **Direct** is selected, all items are displayed in a gray out status and you cannot perform any settings.

  ![IPv6 settings diagram](image)

  **A: Use IPv6 address**

  Select when you use the printer with IPv6 environment.

  **B: Use Stateless Address:**

  Select when you use an IP address assigned automatically. Use a router compatible with IPv6.

  **Note**

  - This setting item is not available depending on the printer you are using.

  **C: Use Manual Address:**

  Select this option if no DHCP server functionality is available in your setup where you use the printer, or you want to use a fixed IP address.

  Enter the IP address and IP address prefix length.

  **Note**

  - This setting item is not available depending on the printer you are using.
D: Use DHCPv6:
Select when you obtain an IP address using DHCPv6.

>>> Note

- This setting item is not available depending on the printer you are using.

8. Click Set.
Assigning Printer Information

Follow the procedure below to assign/change printer location name or device name.

The names appear on Device Name: and Location: on the Canon IJ Network Device Setup Utility screen.

Note

- If USB is selected from the pulldown menu on the toolbar, this setting item is not available.

1. **Start up IJ Network Device Setup Utility.**

2. Check the displayed message and select **Yes.**

3. Select **Printer Network Setup** on the displayed screen.
   
   Detected printers are listed.

4. Select printer to assign location name and device name.
   
   Select the printer with Available displayed on Status.

5. Select **Detailed Printer Settings...** on Printer Settings menu.
   
   The Confirm Printer Password screen appears.
   
   For more on the password, refer to Administrator Password.

6. Enter password and click **OK.**
   
   The Detailed Printer Settings screen appears.

7. Perform/change settings.

   ![Detailed Printer Settings](image)

   The setting items below are available.

   **A: Device Name:**
   
   Assigns the device name.

   **B: Location:**
   
   Assigns the location name.

8. Click **Set.**
### Initializing Network Settings

Follow the procedure below to initializing printer network settings.

1. **Start up** [IJ Network Device Setup Utility](#).

2. Check the displayed message and select **Yes**.

3. Select **Printer Network Setup** on the displayed screen.
   - Detected printers are listed.

4. Select printer to initialize settings.
   - Select the printer with **Available** displayed on **Status**.

5. Select **Reset LAN settings** on **Printer Settings** menu.
   - The **Confirm Printer Password** screen appears.
   - For more on the password, refer to **Administrator Password**.

6. Enter password and click **OK**.

7. Click **Yes** on the displayed screen.

8. Click **OK** on the displayed screen.
   - The printer network settings are initialized.
Change Administrator Password

Follow the procedure below to change the administrator password.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

   Detected printers are listed.

4. Select printer to change password.
   Select the printer with Available displayed on Status.

5. Select Change Password... on Printer Settings menu.
   The Change Printer Password screen appears.
   For more on the password, refer to Administrator Password.

6. Enter current password and new password.

7. Enter new password in Confirm: again.

8. Click OK.
   The administrator password is updated.
Setting Criteria for Printer Search/Searching Specific Printer

You can set the criteria for printer search when you start up IJ Network Device Setup Utility or update the printer search, or you can search the specific printer. Changing these settings may detect the printer you want to use if it is not detected.

Note

- If the printer you want to use is not detected, it may be detected by entering IP address, subnet mask, or default gateway on the operation panel and search again.

Setting Criteria for Printer Search

1. Start up IJ Network Device Setup Utility.
2. Check the displayed message and select Yes.
   Detected printers are listed.
4. Select Search Settings… on Option menu.
   The Search Settings screen appears.
5. Enter criteria for printer search.

A: Search Time:
   Specifies the time to search printers.

B: Time out:
   Specifies the timeout length for not receiving a response from printer.

Note

- Printers you want to find are more likely to be detected as the values are larger, however, it may take a while to search them.
6. Click Set.

Searching Specific Printer

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

   Detected printers are listed.

4. Select Specified Searching... on Option menu.
   The Specified Searching screen appears.

5. Select item to specify and enter value.

   ![Specified Searching Screen]

   **A: IPv4 Address**
   Specifies the IPv4 address of the printer you want to search.

   **B: IPv6 Address**
   Specifies the IPv6 address of the printer you want to search.

   **C: Host Name**
   Specifies the host name of the printer you want to search.

6. Click Search.
   IJ Network Device Setup Utility starts searching by the specified criteria and detected printers are listed.
If WEP Details Screen Appears

Enter the password (WEP key) according to wireless router’s encryption method if you change a wireless router to connect to the printer.

1. Enter items below when WEP Details screen appears.

   ![WEP Details Screen](image)

   A: WEP Key:  
   Enter the same key as the one set to the wireless router. 
   The number of characters and character type that can be entered differ depending on the combination of the key length and key format.

<table>
<thead>
<tr>
<th>Key Length:</th>
<th>64bit</th>
<th>128bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Format:</td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 characters</td>
<td>13 characters</td>
</tr>
<tr>
<td></td>
<td>Hexadecimal (Hex)</td>
<td>10 digits</td>
</tr>
</tbody>
</table>

   B: Key Length:  
   Select either 64bit or 128bit.

   C: Key Format:  
   Select either ASCII or Hex.

   D: Key ID:  
   Select the Key ID (index) set to the wireless router.

2. Click Set.

   **Important**
   - If the printer cannot communicate with the computer after the encryption type of the printer was switched, make sure encryption types for the computer and the wireless router match that set to the printer.
If WPA/WPA2 Details Screen Appears

Enter the password according to wireless router’s encryption method if you change a wireless router to connect to the printer.

1. Enter password when WPA/WPA2 Details screen appears.

   Enter the password set to the wireless router. The password should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal value.

   If you do not know the wireless router password, refer to the instruction manual provided with the wireless router or contact its manufacturer.

2. Click Set.

   **Important**

   • If the printer cannot communicate with the computer after the encryption type of the printer was switched, make sure encryption types for the computer and the wireless router match that set to the printer.
Checking Network Status

- Checking Wi-Fi Network Status
- Displaying Computer Network Information
- Displaying Printer Network Information
- Checking Connection Status between Printer and Wireless Router
- Checking Network Setting Difference
Checking Wi-Fi Network Status

Follow the procedure below to check the wireless network status (signal strength) between the printer and computer.

If anything is wrong with the Wi-Fi connection, check the network status from this menu.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

   Detected printers are listed.

4. Select printer to check wireless network status from printer list.
   Select the printer with Available displayed on Status.

5. Select Check Wireless Communication Status on View menu.
   The Confirm Printer Password screen appears.
   For more on the password, refer to Administrator Password.

6. Enter password and click OK.
   • If the printer is connected to the computer with a wireless router:
     The screen below appears.

     ![Check Communication Status](image1)

     • If the printer is connected to the computer using Wireless Direct:
     The screen below appears.

     ![Check Communication Status](image2)

     Clicking Update measures the signal strength again.
7. Click **OK** to close screen.
Displaying Computer Network Information

Follow the procedure below to display the network information of the computer which the printer selected in the Canon IJ Network Device Setup Utility screen connects to and on which IJ Network Device Setup Utility is installed.

1. Start up IJ Network Device Setup Utility.

2. Check the displayed message and select Yes.

   Detected printers are listed.

4. Select Computer Network Information on View menu.
   The screen below appears.

   ![Computer Network Information Screen](image)

   Clicking Copy Info copies all network information on the clipboard.

5. Click OK to close screen.
Displaying Printer Network Information

Follow the procedure below to display the printer network information.

1. **Start up IJ Network Device Setup Utility.**

2. Check the displayed message and select **Yes.**

3. Select **Printer Network Setup** on the displayed screen.
   
   Detected printers are listed.

4. Select printer to display network information from printer list.
   
   Select the printer with **Available** displayed on **Status.**

5. Select **Printer Network Information** on **View** menu.
   
   The **Confirm Printer Password** screen appears.
   
   For more on the password, refer to Administrator Password.

6. **Enter password and click OK.**
   
   The screen below appears.

   ![Printer Network Information](image)

   Clicking **Copy Info** copies all network information on the clipboard.

7. **Click OK** to close screen.
**Checking Connection Status between Printer and Wireless Router**

Follow the procedure below to check the wireless router information detected by the printer.
Detected wireless routers around the printer and the detected ones are listed. Use this menu to make sure whether the printer is located properly.

1. Start up **IJ Network Device Setup Utility**.

2. Check the displayed message and select **Yes**.

3. Select **Printer Network Setup** on the displayed screen.
   - Detected printers are listed.

4. Select printer to check connection status between printer and wireless router from printer list.
   - Select the printer with **Available** displayed on **Status** and **Wi-Fi** displayed on **Connection Method**.

5. Select **Connection Status of Printer and Wireless Router** on **View** menu.
   - The **Confirm Printer Password** screen appears.
   - For more on the password, refer to **Administrator Password**.

6. Enter password and click **OK**.
   - The screen below appears.

   ![Wireless Router Information Detected by Printer]

   Clicking **Update** searches wireless routers again.

7. Click **OK** to close screen.
Checking Network Setting Difference

If you cannot use a printer you used on the network before, compare the current network status with that when you could use the printer and check the difference.

1. **Start up IJ Network Device Setup Utility.**

2. Check the displayed message and select **Yes**.

3. Select **Printer Network Setup** on the displayed screen.

   Detected printers are listed.

4. Select printer with **Unknown** or **Not Set** displayed on **Status** from printer list.

5. Select **Check Connection Status** on **View** menu.

   The screen below appears.

   ![Check Connection Status Screen]

   If the network status when you used the printer is different from the current status, **Mismatch** appears on **Status** and the items are displayed in red. Check the red items.

6. Click **OK** to close screen.

Performing Network Settings via USB Connection

When the **Check Connection Status** screen is displayed, you can perform printer network setup by connecting the printer and computer using a USB cable. Follow the procedure below.
1. Click **Set up the network connection via USB**.

   Follow the displayed message to connect the printer to perform setup to the computer using a USB cable. Make sure the printer is turned on.

2. Click **Yes** on displayed screen.

   The detected printers are listed.

3. Select printer to perform setup from the printer list.

   Perform setup following the on-screen instructions.
IJ Network Device Setup Utility Menus

➤ Printer Settings Menu
➤ View Menu
➤ Option Menu
➤ Help Menu
This section describes the items displayed on the Printer Settings menu.

A: Network Settings...
Performs wired or Wi-Fi settings.
- Performing/Changing Wired LAN Connection (Ethernet Cable) Settings
- Performing/Changing Wi-Fi Settings

Note
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this item.

B: Detailed Printer Settings...
Assigns the printer device name and location name.
- Assigning Printer Information

C: Reset LAN settings
Initializes the printer LAN settings.
- Initializing Network Settings

D: Change Password...
Changes the password specified for the printer.
- Change Administrator Password

E: Set up device by using web browser
Check the printer information or perform settings in detail on the web page.

Note
• You can use this function on the following the OS and the web browser.
  OS: Windows 10/Windows 8.1/Windows 7 SP1 or later
  Web browser: Internet Explorer 11 or later, Google Chrome, Mozilla Firefox
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this item

F: Exit
Finishes IJ Network Device Setup Utility.
View Menu

This section describes the items displayed on the View menu.

A: Check Connection Status
If you cannot use a printer you used on the network before, compare the current network status with that when you can use the printer and check the difference.

⇒ Checking Network Setting Difference

Note
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this item.

B: Check Wireless Communication Status
Check Wi-Fi communication status.

⇒ Checking Wi-Fi Network Status

Note
• Right-clicking a printer on the Canon IJ Network Device Setup Utility screen also displays this item.

C: Computer Network Information
Check the computer network information.

⇒ Displaying Computer Network Information

D: Printer Network Information
Check the printer network information.

⇒ Displaying Printer Network Information

E: Connection Status of Printer and Wireless Router
Searches wireless routers and check the wireless router information (wireless channel, communication status, and signal strength) detected by the printer.

⇒ Checking Connection Status between Printer and Wireless Router
F: **Switch View**
Switches the printer list between IPv4 printers and IPv6 printers. For some models, you can list USB connected printers.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Right-clicking a printer on the <strong>Canon IJ Network Device Setup Utility</strong> screen also displays this item.</td>
</tr>
</tbody>
</table>

G: **Delete from List**
Deletes the selected printer from the printer list temporarily.

Selecting **Update** will detect the deleted printer if it exists on the network.

H: **Cancel**
Cancels printer search.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You can also cancel printer search by clicking the [] icon.</td>
</tr>
</tbody>
</table>

I: **Update**
Searches printers again.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You can also search printers again by clicking the [] icon.</td>
</tr>
</tbody>
</table>
Option Menu

This section describes the items displayed on the Option menu.

A: Search Settings...
   Specifies criteria for printer search.
   ➤ Setting Criteria for Printer Search

B: Specified Searching...
   Searches the printer by an IP address or host name.
   ➤ Searching Specific Printer

327
Help Menu

This section describes the items displayed on the Help menu.

A: Online Manual
Displays this guide.

B: Cautions for Wi-Fi Connection
Displays the caution message for Wi-Fi connection.

C: Changing Wired LAN/Wi-Fi Connections
Displays the message on changing LAN connection method (wired or wireless) for the selected printer.

Note
• This item is displayed in a gray out status if USB is selected from the pulldown menu on the toolbar.

D: About
Displays IJ Network Device Setup Utility version information.
List of Models Which Does Not Support Diagnosis and Repair Function

The following models does not support "Diagnose and Repair" function of IJ Network Device Setup Utility.

- G4000 series
- PRO-500 series
- PRO-1000 series
- MB2100 series
- MB2700 series
- MB5100 series
- MB5400 series
- iB4000 series
- PRO-520
- PRO-540
- PRO-540S
- PRO-560
- PRO-560S
- PRO-2000
- PRO-4000
- PRO-4000S
- PRO-6000
- PRO-6000S
- TS9000 series
- TS8000 series
- TS6000 series
- TS5000 series
- MG3000 series
- E470 series
List of Models Which Does Not Support IPv6 Configuration via USB Connection

For the following models, you can perform settings only for IPv4 using IJ Network Device Setup Utility. (You cannot perform settings for IPv6.)

• iB4100 series
• MG3000 series
• E470 series
• G4000 series
• TS5000 series
• TS6000 series
• TS8000 series
• TS9000 series
• TR8500 series
• TR7500 series
• TS9100 series
• TS8100 series
• TS6100 series
• TS5100 series
• TS3100 series
• E3100 series
• TS300 series
• E300 series
• TR8580 series
• TS9180 series
• TS8180 series
• TS6180 series
• TR8530 series
• TR7530 series
• TS8130 series
• TS6130 series
• XK70 series
• XK50 series
• G4010 series
• G3010 series
• TR4500 series
• E4200 series
• TS6200 series
• TS6280 series
• TS6230 series
• TS8200 series
• XK80 series
• TS8280 series
• TS8230 series
• TS9500 series
• TS9580 series
• TR9530 series
Other Network Information

- Technical Terms
- Restrictions
- Firewall
- List of Devices Which May Interfere with Wi-Fi Communication
Technical Terms

In this section, technical terms used in the manual are explained.

- **Ad-hoc**
  Client computer and printer setting where wireless communication occurs on a peer-to-peer basis, i.e., all clients in with the same network name (SSID) communicate directly with each other. No wireless router is required. This printer does not support ad-hoc communication.

- **Admin Password**
  Administrator password in IJ Network Device Setup Utility to restrict access to network users. It must be entered to access the printer and change printer settings.

- **AES**
  An encryption method. It is optional for WPA. Strong cryptographic algorithm adopted within U.S. government organizations for information processing.

- **Authentication Method**
  The method that a wireless router uses to authenticate a printer through a Wi-Fi. The methods are agreeable each other.

  For WPA/WPA2, authentication method is PSK.
B

- Bonjour
  A service to detect the connectable devices on a network automatically.

C

- Channel
  Frequency channel for wireless communication. In the infrastructure mode, the channel is automatically adjusted to match that set to the wireless router. This printer supports channels 1 to 13. (Channels 12 and 13 are not supported depending on the country or region of purchase.) Note that the number of channels that can be used for your Wi-Fi varies depending on the region or country.

D

- Default Gateway
  A relay device to connect to another network such as a router or a computer.

- Default router address
  A default IP address set for a router.

- DHCP server functionality
  The router assigns an IP address automatically whenever the printer or the personal computer on a network starts up.

- DHCPv6
  A protocol to assign necessary information automatically when a computer connects to network. DHCPv6 can be used when IPv6 is enabled.

- DNS server
  A server that converts device names into IP addresses. When specifying IP addresses manually, specify the addresses of both a primary and a secondary server.

E

- Easy wireless connect (Cableless setup)
  Specifies a wireless router settings using a device (e.g. smartphone) directly without using a wireless router.
F

• Firewall
It is a system that prevents an unlawful computer access in the network. To prevent, you can use the firewall function of a broadband router, the security software installed in the computer, or operation system for computer.

H

• Host name
A name for a computer or printer on network so that it can be recognized easily. Single-byte alphanumeric characters are used generally.

I

• IEEE802.11b
International standard for Wi-Fi using the 2.4 GHz frequency range with a throughput of up to 11 Mbps.

• IEEE802.11g
International standard for Wi-Fi using the 2.4 GHz frequency range with a throughput of up to 54 Mbps. Compatible with 802.11b.

• IEEE802.11n
International standard for Wi-Fi using the 2.4 GHz and 5 GHz frequency ranges. Even when using two or more antennas simultaneously or obtaining a bigger transfer rate than before by using multiple communication channels at the same time, the transmission speed may be influenced by the connected apparatus.
At the maximum transfer rate of 600 Mbps, it is possible to communicate with multiple computer terminals within a dozen or so metre radius.
Compatible with 802.11b and 802.11g.

• Infrastructure
One of the wireless communication methods. Wireless communication devices (e.g. computer or printer) are connected to the network via a wireless router.

• IP Address
A unique number with four parts separated by dots. Every network device that is connected to the Internet has an IP address. Example: 192.168.0.1
An IP address is usually assigned by a wireless router or a DHCP server of the router automatically.

• IPv4/IPv6
They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and IPv6 uses 128-bit addresses.
K

• **Key Format**
  Select either **ASCII** or **Hex** as the WEP key format. The character that can be used for the WEP key differs depending on the selected key formats.
  
  ◦ **ASCII**
    Specify with a 5 or 13-character string that can include alphanumeric and underscore " _ " characters. It is case-sensitive.
  
  ◦ **Hex**
    Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to f).

• **Key Length**
  Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a more complex WEP key.

L

• **Link local address**
  An IP address generated automatically from a specific prefix (information of current network: fe80::) and an interface identifier generated from printer’s MAC address.

• **Link Quality**
  The status of the connection between the wireless router and the printer excluding noise (interference) is indicated with a value from 0 to 100%.

• **LPR**
  A platform-independent printing protocol used in TCP/IP networks. It does not support bidirectional communication.

M

• **MAC Address**
  Also known as the physical address. A unique and permanent hardware identifier that is assigned to network devices by its manufacturer. MAC addresses are 48 bits long and are written as a hexadecimal number separated by colons, i.e., 11:22:33:44:55:66.

O

• **Operation Status**
  Indicates the status on whether the printer can be used.
P

• Prefix length
The number of bits on the network part of an IP address. The number of bits is 8 bit to 24 bit for IPv4, and 64 bit for IPv6.

• Proxy server
A server that links a LAN-connected computer to the Internet. When using a proxy server, specify the address and the port number of the proxy server.

• PSK
An encryption method employed by WPA/WPA2.

R

• Router
A relay device to connect to another network.

S

• Signal Strength
The strength of the signal received by the printer from the wireless router is indicated with a value from 0 to 100%.

• Network name (SSID)
Unique label for Wi-Fi. It is often represented such as a network name or a wireless router name. network name (SSID) distinguishes one Wi-Fi from another to prevent interference.
The printer and all clients on a Wi-Fi must use the same network name (SSID) in order to communicate with each other. The network name (SSID) can be up to 32 characters long, and is made up of alphanumeric characters. The network name (SSID) may also be referred to by its network name.

• Stealth
In the stealth mode, a wireless router hides itself by not broadcasting its network name (SSID). The client must specify the network name (SSID) set to the wireless router to detect it.

• Stateful address
An IPv6 address acquired from a DHCP server using DHCPv6.

• Stateless address
A tentative IPv6 address generated automatically using a prefix included in RA (Router Advertisement) and a MAC address. An IPv6 address is generated in an environment where a DHCP server is not available.
• **Subnet Mask**

IP address has two components, the network address and the host address. Subnet Mask used to calculate the Subnet Mask address from the IP address. A Subnet Mask is usually assigned by a wireless router or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123
Subnet Mask: 255.255.255.0
Subnet Mask Address: 192.168.127.0

• **TCP/IP**

Suite of communications protocols used to connect hosts on the Internet or the LAN. This protocol allows different terminals to communicate with each other.

• **TKIP**

An encryption protocol employed by WPA/WPA2.

• **USB**

Serial interface designed to enable you to “hot-swap” devices, i.e., by plugging and unplugging them without turning off the power.

• **WCN (Windows Connect Now)**

Users running Windows Vista or later can obtain the setting information directly via wireless network (WCN-NET).

• **WEP/WEP Key**

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and decrypt data sent over wireless networks. This printer supports key length of 64 bits or 128 bits, key format of ASCII code or Hexadecimal, and key number of 1 to 4.

• **Wi-Fi**

International association that certifies interoperability of Wi-Fi products based on the IEEE 802.11 specification.

This printer is a Wi-Fi authorized product.
• **Wireless Direct**

The printer is used as a wireless router to connect external wireless communication devices (e.g. computers, smartphones, or tablets) in an environment where no wireless router is available. You can connect up to 5 devices to the printer using Wireless Direct.

• **Wireless LAN**

A network that, instead of being connected by physical wires, is connected by a wireless technology, such as Wi-Fi.

• **Wireless Router**

A wireless transceiver or base station that receives information from wireless clients/the printer and rebroadcasts it. Required in an infrastructure network.

• **WPA**

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been strengthened more than WEP.

  ◦ **Authentication**

  WPA defines the following authentication methods: PSK that can be used without an authentication server, plus WPA-802.1x that do require an authentication server.

  This printer supports WPA-PSK.

  ◦ **Passphrase**

  This encrypted key is used to perform WPA-PSK authentication.

  The password should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal value.

• **WPA2**

Security framework released by the Wi-Fi Alliance in September 2004 as a later version of WPA. Provides a stronger encryption mechanism through Advanced Encryption Standard (AES).

  ◦ **Authentication**

  WPA2 defines the following authentication methods: PSK that can be used without an authentication server, plus WPA2-802.1x that do require an authentication server.

  This printer supports WPA2-PSK.

  ◦ **Passphrase**

  This encrypted key is used to perform WPA2-PSK authentication.

  The password should be a string of 8 to 63 alphanumeric characters or a 64-digit hexadecimal value.

• **WPS (Wi-Fi Protected Setup)**

WPS is a standard for easy and secure establishment of a wireless network.

There are 2 primary methods used in the Wi-Fi Protected Setup:

  PIN entry: a mandatory method of setup for all WPS certified devices
Push button configuration (PBC): an actual push button on the hardware or through a simulated push button in the software.
Restrictions

If you use a printer over the Wi-Fi, we highly recommend you perform security settings for Wi-Fi network using WPA/WPA2 from the viewpoint of security. Wireless communication with a product that does not comply with the Wi-Fi standard cannot be guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.

If you use a printer with Wireless Direct, you cannot perform the following settings:

• Specifying an IP address manually
• Enabling/disabling IPv6
Firewall

A firewall is a function of the security software installed in the computer or operation system for computer, and is a system that is designed to prevent unauthorized access to a network.

Precautions When Firewall Function is Enabled

• A firewall function may limit communications between a printer and a computer. This may disable printer setup and communications.
• During the printer setup, you may be prompted to enable or disable communications, depending on the firewall function of the security software or operation system. If so, choose to enable communications.
• When using IJ Network Device Setup Utility, you may be prompted to enable or disable communications, depending on the firewall function of the security software. If so, choose to enable communications.
• If you cannot set up the printer, temporarily disable the firewall function of the security software or operation system.

Important

• If you disabled the firewall function, disconnect your network from the Internet.

• Some applications (like the network configuration software) override firewall settings. Check the application's settings beforehand.
• If the printer you use is set to **Get IP address automatically**, the IP address changes every time the printer connects to the network. This may disable printer setup and communications, depending on the firewall settings. In this case, either change the firewall settings or assign a fixed IP address to the printer. An IP address can be set using IJ Network Device Setup Utility.
  - Performing/Changing Wired LAN Connection (Ethernet Cable) Settings
  - Performing/Changing Wi-Fi Settings

When assigning a fixed IP address to the printer, you will need to specify an IP address with which the computer can communicate.

Note

• For the operation system firewall settings or the security software firewall settings, refer to the instruction manual of the computer or software, or contact its manufacturer.
List of Devices Which May Interfere with Wi-Fi Communication

While using the printer via Wi-Fi, the following devices near the printer or wireless router may cause radio frequency interference and affects connection between the printer and wireless router. Radio frequency interference may cause sending print jobs or printing speed to slow down.

- Microwave oven
- Baby monitor
- Wireless mouse
- Wireless keyboard
- Wireless earphone/headphones
- Wireless camera (e.g. security camera)

We recommend you take measures below to avoid radio frequency interference.

- Place the devices above as far away from the printer or wireless router as possible.
- Turn the devices off and stop using them temporarily.
Sharing the Printer on a Network (Windows)

When computers are used in a network environment, documents can be printed from multiple computers that share a single printer.

• Setting Up a Shared Printer

This section describes how to set up the print server and the client.

**Note**

• The Windows versions of the computers connected to the network do not necessarily have to be the same.

**Related Topic**

• [Restrictions on Printer Sharing](#)
Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the print server.

1. Install the printer driver on the print server system

2. Display the Devices and Printers window
   Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
   The Devices and Printers window is displayed.

3. Click the icon for the model name of printer to be shared
   Press the Alt key, and from the displayed File menu, select Printer properties -> Sharing tab.

   ! Important
   - When starting up the software and performing install or uninstall, a confirmation or warning dialog box may appear.
     This dialog box appears when administrative rights are required to perform a task.
     When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
     Some applications require an administrator account to continue. In such cases, switch to an administrator account, and restart the operation from the beginning.

4. Set sharing
   On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an additional driver

   1. Display the Devices and Printers, Printers, or Printers and Faxes window.

   2. Select the printer icon, click Print server properties, and select the Drivers tab.

   3. Click Add....

   4. When the Add Printer Driver Wizard window is displayed, click Next.

   5. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit architecture, select x86. Then click Next.

   6. Click Have Disk....

   7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver, specify the "inf" file, and click OK.
8. Select the printer to be used, and click **Next**.

   **Note**
   - If an error message is displayed, select the other printer.

9. Click **Finish**

   The setup on the print server system is complete. Next, set up the client systems.

6. On the client, open Explorer, and double-click the icon of the printer to be shared

7. Follow the window instructions, and install the printer driver

   The setup on the client system is complete.
   
   Even when you perform the setup on a different client, follow the same steps 6 and 7.
Restrictions on Printer Sharing

These are restrictions that apply when you are using a printer in a network environment. Check the restrictions for the environment you are using.

Restriction on setting up printer sharing

- If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:
  1. Start Explorer on the print server and on the client with the different architecture, paste the following path in the address bar, and press Enter on the keyboard:
     `%windir%\system32\driverstore\`
  2. Right-click the FileRepository folder, and click Properties.
  3. On the Sharing tab, click Share.
  4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder that was shared in step 3, and click OK.
     If there are multiples copies, select the file with the latest update date and time.

Restrictions on sharing and using a printer

- A print completion message may be displayed. To disable the message display, follow the procedure below.
  1. In the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers window of the client system, select the printer, and click Print server properties on the command bar.
  2. Uncheck Show informational notifications for network printers on the Advanced tab, and then restart the computer.

- The bi-directional communication function is disabled and the correct printer status may not be recognized.
  If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional support check box cleared on the Ports tab, the bidirectional communication function of the print server may also be disabled.
  In this case, check Enable bidirectional support check box on both the print server system and the client system.

- When you print from a client system, the following functions cannot be used.
  - The Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab
  - The Canon imagePROGRAF Preview feature

- When the functions on the Device Settings tab cannot be set properly from a client system, they may be grayed out. In this case, change the settings from the print server.
  When you change the settings of the print server, you should delete the icon of the shared printer from the client system, and then specify the shared settings again in the client system.

- If the same driver installed on the print server is also installed on the client, the network printer icon may be created automatically.

- If an error occurs when you print a document on a shared printer from a client, the error message of the Canon IJ status monitor is displayed on both the client and the print server. If a document is printed out normally, the Canon IJ status monitor is displayed only on the client.
Connecting Smartphone/Tablet to Printer via Wi-Fi

• To connect a smartphone or tablet to printer via a wireless router:

  ➤ Connecting Smartphone/Tablet to Printer via Wireless Router

• To connect a smartphone or tablet to printer without a wireless router:

  ➤ Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)
Connecting Smartphone/Tablet to Printer via Wireless Router

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

- Wi-Fi connection (connecting devices via a wireless router)
- Wireless Direct connection (connecting devices without using a wireless router)

This section describes Wi-Fi connection via a wireless router.

Follow the procedure below to connect via a wireless router.

1. Confirm the Printer's Wi-Fi Connection is Enabled
2. Connect Smartphones and Tablets to the Printer

**Important**

- Check the usage restrictions and change the printer LAN setting.

  Restrictions

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

**Confirm the Printer's Wi-Fi Connection is Enabled**

If a different network icon is displayed on the HOME screen, follow the procedure below to enable Wi-Fi connection.

1. On the HOME screen, tap the **Network** icon.

   ➤ **Menu Operations**

2. Tap **Wi-Fi**.

3. Tap **Settings**.

4. Tap **Enable/disable Wi-Fi**.

5. Tap **Enable**.

   The printer's Wi-Fi is enabled and you can connect the Wi-Fi you connected previously.
Connect Smartphones and Tablets to the Printer

For Android device

1. Open "Settings" menu on your device.

2. Enable "Wi-Fi".

3. Select wireless router SSID you use from detected device list.

4. Enter wireless LAN router password.
   
   Your device is connected to the printer.

5. Start printing from application.

For iOS device

1. Open "Settings" menu on your device.

2. Enable "Wi-Fi".

3. Select wireless router SSID you use from detected device list.
4. Enter wireless LAN router password.
   Your device is connected to the printer.

5. Start printing from application.
Adjustments for Better Print Quality

- **Adjusting the Print Head**
  - Adjusting the Print Head
  - Troubleshooting Paper Abrasion and Blurry Images

- **Adjusting Feed Amount**
  - Adjusting Feed Amount
  - Adjusting Vacuum Strength
Adjusting the Print Head

- Adjusting the Print Head
- Troubleshooting Paper Abrasion and Blurry Images
Adjusting the Print Head

If printed documents are affected by the following problems, try adjusting the print head.

- **If printing is faint or affected by banding in different colors**
  
  Execute **Nozzle Check** in the touch screen menu to check for print head nozzle clogging.
  
  ➪ **Checking for Nozzle Clogging**

- **If printed lines are misaligned, vertical lines are warped, or colors are out of alignment**
  
  If printed lines are misaligned, execute **Print head angle adjustment** in the touch screen menu to adjust the print head angle.
  
  Always adjust the print head angle after replacing the print head.
  
  After executing **Print head angle adjustment**, adjust the print head position.
  
  ➪ **Adjusting Line Misalignment**

  If printed vertical lines are warped or colors are out of alignment, execute **Print head alignment** in the touch screen menu to adjust the print head position.

  First, execute **Auto (standard)** of **Print head alignment**. If the print result is not improved, execute **Auto (advanced)** or **Manual**.

  ➪ **Automatic Adjustment to Straighten Lines and Colors**
  
  ➪ **Manual Adjustment to Straighten Lines and Colors**

- **If paper rubs against the print head, or image edges are blurred**
  
  Setting **Paper Thickness (Head Height)** in the touch screen menu and changing the height of the print head may improve the situation.

  ➪ **Troubleshooting Paper Abrasion and Blurry Images**
Adjusting Line Misalignment

If printed lines are misaligned, execute **Print head angle adjustment** to adjust the print head angle. **Print head angle adjustment** requires you to examine a printed test pattern and adjust the angle using the angle adjustment lever.

Always adjust the print head angle after replacing the print head.

**Important**

- Because the results of adjustment vary depending on the type of paper used for adjustment, use the same type of paper as you will use for printing.
- When using cut sheets, do not move the release lever until instructions (guidance) for removing the paper are displayed.

Moving the release lever during printing or maintenance operations will cause the printer to stop.

**Paper to Prepare**

**When using rolls**
- An unused roll at least 10.00 in. (254.0 mm) wide

**When using sheets**
- One sheet of unused paper of at least A4/Letter size

Perform adjustment as follows.

1. Load paper.
   - [Loading Rolls on the Roll Holder](#)
   - [Loading Rolls in the Printer](#)
   - [Loading Sheets in the Printer](#)

**Important**

- Always make sure the loaded paper matches the type of paper specified on the printer.
  Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap (Setup) > **Maintenance** on HOME screen.
   - [Touch Screen](#)

   The **Maintenance** screen appears.

3. Tap **Print head angle adjustment**.
   A confirmation message appears.

4. Tap **Yes**.
   The carriage moves and the guidance for the print head angle adjustment procedure appears on the touch screen.
5. Open the top cover.

6. Align the angle adjustment lever with the red square and close the top cover.

A test pattern is printed for adjustment.

**Important**

- Do not touch the linear scale (A) or carriage shaft (B). Touching these may cause malfunction.
7. Examine the test pattern for adjustment. Determine the straightest set of lines.

Example 1: Select "+2" in pattern (C).

![Pattern C]

Example 2: Move the angle adjustment lever to a position between the numbers or between the number and the square (D) of the two sets of lines that are least misaligned. In this case, select -1.

![Pattern D]

8. Open top cover and move angle adjustment lever to match number (or square) of straightest set of lines.

![Adjustment Lever]

9. Close the top cover.

The print head is now straight, and adjustment is complete.
Note

- If the problem, such as misaligned lines or color unevenness, is not solved after adjustment, execute **Print head angle adjustment** and move the angle adjustment lever in the front or the rear of the last position. When finished, execute **Print head alignment** again.
Automatic Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute **Print head alignment** and adjust the print head position.

Choose from **Auto (standard)** or **Auto (advanced)** for automatically adjusting the print head.

Minor warping and misaligned colors can usually be improved by executing **Auto (standard)**. If there is no improvement, perform **Auto (advanced)** or **Manual**.

⇒ Manual Adjustment to Straighten Lines and Colors

When you execute **Auto (standard)** or **Auto (advanced)**, the adjustment pattern is printed, and the print head position is adjusted based on the printing result automatically.

### Important

- If the problem, such as misaligned lines, is conspicuous, or other problem, such as color unevenness, is not solved after executing **Print head alignment**, execute **Print head angle adjustment** and then execute **Print head alignment** again.
  
  ⇒ Adjusting Line Misalignment

- Because the results of adjustment vary depending on the type of paper used for adjustment, use the same type of paper as you will use for printing.
- This function is not available with Tracing Paper, Translucent Matte Film, or Clear Film.
- When using cut sheets, do not move the release lever until instructions (guidance) for removing the paper are displayed.

  Moving the release lever during printing or maintenance operations will cause the printer to stop.

### Note

- After print head replacement, we recommend executing **Print head alignment**. When **Print pattern after new head** is set to **ON**, print head position adjustment is automatically executed after print head replacement.
- To change the paper type or for more beautiful color borders, perform **Auto (standard)**.
- To ensure clear quality and when replacing the print head, perform **Auto (advanced)** to fine-tune the position between nozzles and colors. To ensure high-quality printing, we recommend that you execute **Auto (advanced)**.
- If adjustment is not possible as expected using special paper, try another type of paper or try **Manual** adjustment.

  ⇒ Manual Adjustment to Straighten Lines and Colors

### Paper to Prepare

**When using rolls**

An unused roll at least 10.00 in. (254.0 mm) wide
When using sheets

**Auto (standard):** Three sheets of unused paper, A4/Letter size or larger (or one sheet when using A2 or larger)

**Auto (advanced):** Five sheets of unused paper, A4/Letter size or larger (or one sheet when using A2 or larger)

Perform adjustment as follows.

1. Load paper.
   - [Loading Rolls on the Roll Holder](#)
   - [Loading Rolls in the Printer](#)
   - [Loading Sheets in the Printer](#)

[Important]
- Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap (Setup) > **Maintenance** on HOME screen.
   - [Touch Screen](#)

   The **Maintenance** screen appears.

3. Tap **Print head alignment**.

4. Tap **Auto (standard)** or **Auto (advanced)**.
   - A confirmation message appears.

5. Tap **Yes**.
   - The paper source setting screen appears.

6. Tap **Roll paper** or **Manual**.
   - A test pattern is printed for adjustment.

[Note]
- If you are printing on sheets smaller than A2 size, a confirmation message prompting you to continue printing appears on the touch screen. Tap **OK** and follow the instructions on the touch screen.
Manual Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute **Print head alignment** and adjust the print head position.

Normally, execute **Auto (standard)**.

- **Automatic Adjustment to Straighten Lines and Colors**

However, when printing on special paper or if printing is not improved after **Auto (advanced)**, try **Manual**.

**Manual** adjustment requires you to examine the printed test pattern and enter an adjustment value.

---

**Important**

- Because the results of adjustment vary depending on the type of paper used for adjustment, use the same type of paper as you will use for printing.
- When using cut sheets, do not move the release lever until instructions (guidance) for removing the paper are displayed.

Moving the release lever during printing or maintenance operations will cause the printer to stop.

---

**Paper to Prepare**

**When using rolls**

An unused roll at least 10.00 in. (254.0 mm) wide

**When using sheets**

Four sheets of unused paper, A4/Letter size or larger (or two sheets when using A2 or larger)

Perform adjustment as follows.

1. **Load paper.**

   - **Loading Rolls on the Roll Holder**
   - **Loading Rolls in the Printer**
   - **Loading Sheets in the Printer**

   **Important**

   - Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. **Tap** (Setup) > **Maintenance** on HOME screen.

   **Touch Screen**

   The **Maintenance** screen appears.
3. Tap Print head alignment.


A confirmation message appears.

**Note**

- If you do not execute Auto (advanced), a confirmation message prompting you to execute Auto (advanced) appears. In this case, tap Yes and execute Auto (advanced).

5. Tap Yes.

The paper source setting screen appears.


A test pattern is printed for adjustment.

7. Tap D-1.

8. Examine adjustment test pattern D-1 and determine the number with straight lines.

![A: Example with straight lines
B: Example with misaligned lines](image)

**Note**

- If two patterns seem equally good and you cannot decide which one is better, choose an intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

9. Repeat steps 7–8 to specify adjustment value for D-2 to D-41.

Note that D-6, D-12, D-18, D-24, D-30, and D-36 cannot be configured.

10. Tap OK.

The adjustment value is now registered, and adjustment is complete.
The print head height setting affects printing quality.

Specifying a low print head height makes images clearer and enhances printing quality but may cause paper to rub against the print head.

On the other hand, specifying a high print head height will prevent paper from rubbing against the print head but may reduce the printing quality.

> **Important**

- Paper rubbing against or becoming caught on the print head may jam or result in printed documents that are soiled.

> **Note**

- Raise or lower print head, depending on nature of the problem.
  - Paper rubs against the Print Head
  - The edges of the paper are dirty
  - Image edges are blurred or white banding occurs

1. Tap paper setting display area on HOME screen.

   ➤ Touch Screen

   Ready to print

   ![Image](image.png)

   The **Paper menu** screen appears.

2. Tap **Paper settings**.

   The **Paper settings** screen appears.

3. Tap **Advanced**.

   The **Advanced paper settings** screen appears.

4. Tap **Paper Thickness (Head Height)**.

5. Drag slider to set paper thickness (head height) and tap **OK**.
Note

- When Auto is set to ON, before printing, the printer automatically adjusts the print head height to the level optimal for the ambient temperature and humidity. You can check the setting for the previous print job in Values applied with auto settings.
  ➤ Printer information
- When Auto is set to OFF, the setting selected during this procedure is applied.
- Depending on the type of paper, some setting values may not be available.
Adjusting Feed Amount

- Adjusting Feed Amount
- Adjusting Vacuum Strength
Adjusting Feed Amount

- Selecting Feed Amount Adjustment Method
- Automatic Banding Adjustment
- Manual Banding Adjustment
- Fine-Tuning Paper Feed Amount
- Adjusting Line Length
Selecting Feed Amount Adjustment Method

There are two methods of adjusting the paper feed amount, Prioritize print quality and Prioritize length accuracy, either of which will be applied during printing.

Since the method that is applied during printing is determined from the value of the Set priority setting, configure Set priority to match the print target.

Follow the procedure below to perform settings.

1. Load paper.
   - Loading Rolls on the Roll Holder
   - Loading Rolls in the Printer
   - Loading Sheets in the Printer

2. On the HOME screen, tap (Setup).
   - Menu Operations

3. Tap Maintenance.

4. Tap Paper feed adjustment.

5. Tap Set priority.

6. Tap paper to adjust.

7. Tap setting.
   - Auto
     Prioritize print quality or Prioritize length accuracy is selected, depending on the setting as selected in the printer driver at the time of printing.
   - Prioritize print quality
     Adjusts the feed amount to reduce banding across the sheet in printed documents. Adjust print quality settings are applied. When Paper feed fine adjustment is executed, the Paper feed fine adjustment settings are applied in addition to the Adjust print quality settings.
   - Prioritize length accuracy
     Adjusts the feed amount for better accuracy of lines in printed documents. The value of Change adjustment values in Adjust feed length is applied.

8. Tap OK.
Automatic Banding Adjustment

If printed images are affected by banding in different colors across the sheet, execute Adjust print quality for automatic adjustment of the paper feed amount.

The printer prints and reads a test pattern for automatic adjustment of the feed amount.

**Important**

- When using highly transparent media, use manual adjustment.
  
  ➤ Manual Banding Adjustment

**Note**

- We recommend executing the adjustment if you have changed the paper type or paper size.
- Always check the Set priority values.
  
  ➤ Selecting Feed Amount Adjustment Method

- If additional fine-tuning is necessary, execute Paper feed fine adjustment.
  
  ➤ Fine-Tuning Paper Feed Amount

- Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.
  
  ➤ Adjusting Line Length

- This may take some time, depending on the type of paper.

**Items to Prepare**

<table>
<thead>
<tr>
<th>When Using Rolls</th>
<th>An unused roll at least 254.0 mm (10.00 in) wide</th>
</tr>
</thead>
<tbody>
<tr>
<td>When Using Sheets</td>
<td>One sheet of unused paper of at least A4/Letter size</td>
</tr>
</tbody>
</table>

Follow the procedure below to adjust.

1. Load paper.
   
   ➤ Loading Rolls on the Roll Holder
   ➤ Loading Rolls in the Printer
   ➤ Loading Sheets in the Printer

2. On the HOME screen, tap (Setup).
   
   ➤ Menu Operations

3. Tap Maintenance.

4. Tap Paper feed adjustment.

5. Tap Adjust print quality.

6. Tap Auto.
7. Tap paper to adjust.

   A test pattern is printed for adjustment and adjustment is finished.
Manual Banding Adjustment

If printed images are affected by banding in different colors, execute **Adjust print quality** for adjustment of the paper feed amount.

Use manual adjustment with highly transparent media.

Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

**Note**

- We recommend executing the adjustment if you have changed the paper type or paper size.
- Always check the **Set priority** values.
  - [Selecting Feed Amount Adjustment Method](#)
- If additional fine-tuning is necessary, execute **Paper feed fine adjustment**.
  - [Fine-Tuning Paper Feed Amount](#)
- Use **Adjust feed length** to ensure that lines in CAD drawings are printed at exactly the right length.
  - [Adjusting Line Length](#)

### Items to Prepare

<table>
<thead>
<tr>
<th>When Using Rolls</th>
<th>An unused roll at least 254.0 mm (10.00 in) wide</th>
</tr>
</thead>
<tbody>
<tr>
<td>When Using Sheets</td>
<td>Two sheets of unused paper of at least A4/Letter size</td>
</tr>
</tbody>
</table>

Follow the procedure below to adjust.

1. Load paper.
   - [Loading Rolls on the Roll Holder](#)
   - [Loading Rolls in the Printer](#)
   - [Loading Sheets in the Printer](#)

   **Important**
   - Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. On the HOME screen, tap [Setup](#).

3. Tap **Maintenance**.

4. Tap **Paper feed adjustment**.

5. Tap **Adjust print quality**.

6. Tap **Manual**.
7. Tap paper to adjust.
   Test pattern A is printed for manual adjustment.

   **Note**
   - When printing on sheets, follow the instructions on the screen and remove the sheet.

8. Examine test pattern A for adjustment. Determine pattern in which banding is least noticeable.

   ![Test Pattern A](image)

   **Note**
   - If banding seems least noticeable in two patterns but you cannot decide which one is better, choose an intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

9. Tap number you decided.
   Test pattern B is printed for manual adjustment.

   **Note**
   - If you printed test pattern A on a sheet, follow the instructions on the screen and use another sheet of the same type of paper. Additionally, after test pattern B is printed, follow the instructions on the screen and remove the sheet.

10. Examine test pattern B for adjustment. Determine pattern in which banding is least noticeable.

11. Tap number you decided.
    The adjustment value is now registered, and adjustment is complete.
Fine-Tuning Paper Feed Amount

If the contrast is uneven or banding in different colors appears at 30 mm (1.2 in) intervals in printed documents, try executing **Paper feed fine adjustment** during printing to fine-tune the feed amount.

### Note

- The **Paper feed fine adjustment** menu is only displayed during printing. Additionally, it is displayed when you have selected **Auto** or **Prioritize print quality** in **Set priority** in **Paper feed adjustment**.

- Always execute **Adjust print quality** before **Paper feed fine adjustment**.

  Once you execute **Adjust print quality**, the **Paper feed fine adjustment** value will revert to 0.

  - ➤ **Automatic Banding Adjustment**
  - ➤ **Manual Banding Adjustment**

Follow the procedure below to adjust.

1. On the HOME screen, tap **(Setup)**.
   
   ➤ **Menu Operations**

2. Tap **Maintenance**.

3. Tap **Paper feed fine adjustment**.

4. Tap value.
   
   At this time, if banding in dark colors appears, select a setting value in the range 1 to 5, and if banding in light colors appears, select a setting value in the range -1 to -5.
Adjusting Line Length

To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust feed length to adjust the amount that paper is advanced.

There are two options in Adjust feed length: Print alignment pattern and Change adjustment values.

Note

- We recommend executing the adjustment if you have changed the paper type or paper size.
- Always check the Set priority values before adjustment.

Selecting Feed Amount Adjustment Method

<table>
<thead>
<tr>
<th>Items to Prepare</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>When Using Rolls</td>
<td>An unused roll at least 254.0 mm (10.00 in) wide</td>
</tr>
<tr>
<td></td>
<td>High-precision ruler</td>
</tr>
<tr>
<td>When Using Sheets</td>
<td>One sheet of unused paper of at least A4/Letter size</td>
</tr>
<tr>
<td></td>
<td>High-precision ruler</td>
</tr>
</tbody>
</table>

Follow the procedure below to adjust.

1. Load paper.

   ➤ Loading Rolls on the Roll Holder
   ➤ Loading Rolls in the Printer
   ➤ Loading Sheets in the Printer

   Important

   • Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. On the HOME screen, tap (Setup).

   ➤ Menu Operations

3. Tap Maintenance.

4. Tap Paper feed adjustment.

5. Tap Adjust feed length.

6. Tap Print alignment pattern or Change adjustment values.

   • If you tap Print alignment pattern:
     The test pattern is printed for you to measure the scale and calculate the discrepancy.
     The scale bar prints "Millimeter" in 50 mm increments and "Inch" in 1-inch increments.
• If you tap **Change adjustment values**:

No test pattern is printed. Instead, you will measure a document already printed to determine the discrepancy.

7. Tap amount of discrepancy.

If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative value.

The feed amount can be adjusted in 0.02% increments.
Adjusting Vacuum Strength

When printing on heavyweight paper or paper that curls or wrinkles easily, if the Print head rubs against paper, adjusting the level of suction against paper on the platen may improve results.

**Important**

- Paper rubbing against or becoming caught on the Print head may jam or result in printed documents that are soiled.

1. On the HOME screen, tap paper information area.

2. Tap **Paper settings**.

3. Tap **Advanced**.

4. Tap **Transport unit vacuum strength**.

5. Tap vacuum strength.
Maintenance and Consumables

- **Ink Tanks**
  - Ink Tanks
  - Replacing Ink Tanks
  - Checking Ink Tank Levels
  - When to Replace Ink Tanks

- **Print Head**
  - Print Head
  - Checking for Nozzle Clogging
  - Cleaning the Print Head
  - Replacing the Print Head

- **Maintenance Cartridge**
  - Maintenance Cartridge
  - Replacing the Maintenance Cartridge
  - Checking the Remaining Maintenance Cartridge Capacity
  - When to Replace the Maintenance Cartridge

- **Cutter Blade**
  - Cutter Blade
  - Replacing the Cutter Blade

- **Performing Maintenance Functions from Your Computer (Windows)**
  - Cleaning the Print Heads
  - Printing a Nozzle Check Pattern

- **Performing Maintenance Functions from Your Computer (macOS)**
  - Opening Remote UI for Maintenance
  - Cleaning the Print Heads
  - Printing a Nozzle Check Pattern

- **Cleaning the Printer**
- Cleaning the Printer Exterior
- Cleaning Inside the Top Cover
- Cleaning the Print Head

➤ Other Maintenance
- Preparing to Transfer the Printer
- Reinstalling the Printer
- Firmware update
Ink Tanks

- Ink Tanks
- Replacing Ink Tanks
- Checking Ink Tank Levels
- When to Replace Ink Tanks
Ink Tanks

When purchasing, check the Model number.

1.9 fl oz (55 ml)

<table>
<thead>
<tr>
<th>Colors</th>
<th>Model number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matte Black</td>
<td>PFI-030 MBK</td>
</tr>
<tr>
<td>Black</td>
<td>PFI-030 BK</td>
</tr>
<tr>
<td>Cyan</td>
<td>PFI-030 C</td>
</tr>
<tr>
<td>Magenta</td>
<td>PFI-030 M</td>
</tr>
<tr>
<td>Yellow</td>
<td>PFI-030 Y</td>
</tr>
</tbody>
</table>

**Note**

- For instructions on replacing the ink tanks, see *Replacing Ink Tanks.*
Replacing Ink Tanks

Compatible Ink Tanks
For details on compatible ink tanks, see Ink Tanks.

Precautions When Handling Ink Tanks
Take the following precautions when handling ink tanks.

**Caution**
- For safety, keep ink tanks out of the reach of children.
- If ink is accidentally ingested, contact a physician immediately.

**Important**
- There may be ink around the ink holes of an ink tank you removed. Handle the ink tanks carefully during replacement. The ink may stain clothing.
- Do not install ink tanks used in this printer in another model of printer. This will prevent correct ink level detection, which may damage the printer or cause other problems.
- We recommend using up an ink tank in the course of printing within six months after breaking the seal. Printing quality may be affected if you use older ink tanks.
- Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual ink may become clogged inside the printer and affect printing quality.

How to Replace an Ink Tank
If a message indicates you should replace an ink tank, check the message details and go to step 2.

1. Selecting Ink Tank Replacement from Menu
2. Removing Ink Tanks
   - Removing ink tank
3. Loading New Ink Tanks
   - Loading ink tank

**Important**
- Do not remove an ink tank during initialization immediately after turning on the printer, or during print head cleaning. Ink may leak out.

**Note**
- Ink tank replacement is possible even during printing, when print jobs are being canceled, or when paper is being advanced.
Selecting Ink Tank Replacement from Menu

1. Tap (Ink information) on HOME screen.

   ➡ Touch Screen

   The Current estimated ink levels screen appears.

2. Tap Replace.

   Instructions for the ink tank replacement procedure appear on the touch screen.

Removing ink tank

1. Open ink tank cover.

   ➢ Important

   • Avoid jarring the printer a lot when replacing an ink tank. Handle the printer gently when replacing tanks. Jarring the printer during printing may affect printing quality.

2. Press tip of ink tank lock lever of color for replacement horizontally and pull ink tank lock lever up to open it.
3. Remove ink tank by grips (A), and then tap **OK**.

![Image of ink tank removal](image)

**Important**
- Do not turn off the printer, except transport preparation, while the ink tank is removed. It may cause the interior of the ink tank cover to become soiled.
- Store the removed ink tank with ink remaining with the ink holes (B) facing up. Otherwise, ink may leak and cause stains. Put the removed ink tank in a plastic bag and close the bag.

![Image of ink tank with ink holes facing up](image)

**Note**
- Dispose of the used ink tank in accordance with local regulations.

**Loading ink tank**

1. Before opening the pouch, tilt the ink tank to the left and right gently one or two times.

   Agitate the ink in the ink tank by slowly rotating the ink tank upside-down and right side up repeatedly.
Important

- Do not remove and agitate an ink tank that has already been installed in the printer. Ink may leak out.
- Failure to agitate the ink tank may cause the ink components to precipitate and may affect printing quality.

Note

- If the ink tank is at a low temperature, allow it to warm up to room temperature before installing.

2. Open the pouch and remove the ink tank.

Important

- Never touch the ink holes (B) or the metal contacts (C). This may cause stains, damage the ink tank, and affect printing quality.
3. Tap **OK** and insert the ink tank into the holder with the label side of the ink tank up and the label text aligned in the right direction.

![](image)

**Important**

- An ink tank cannot be loaded in the holder if the color or orientation is incorrect.
  
  If the ink tank does not fit in the holder, do not force it into the holder. Reinstall while checking the label color display, ink tank color, and ink tank orientation.

- Do not push the ink tank in by hand. Forcing the ink tank into the holder may damage the printer.

![](image)

4. Push the ink tank lock lever closed until it clicks into place.
5. Close ink tank cover.
Checking Ink Tank Levels

On the touch screen, you can check how much ink is left in the ink tank.

1. Tap (Ink information) on HOME screen.

   The **Current estimated ink levels** screen appears.

   ![Current estimated ink levels screen]

   This printer has ink tanks (A) and sub-ink tanks (B). Even if ink runs out, printing can continue with ink in the sub-ink tanks.

   When the remaining ink is low, 😥 will appear on the remaining ink level. When ink runs out, ❌ will appear. See the figure below.

   ![Remaining ink level symbols]

   If the touch screen indicates to replace the ink tank, replace the ink tank. If a message is displayed indicating to check the remaining ink levels, or after tasks that consume a lot of ink such as large-format printing or head cleaning, check the remaining levels and replace ink tank as needed.

   **Replacing Ink Tanks**

   **Note**

   - Tap **Order ink now** to view the ink supplier information.
   - When the function for detecting the remaining ink level is disabled, 😕 will appear on the remaining ink level.
   - If an ink tank is not inserted, there is no ink tank display.
When to Replace Ink Tanks

Replace or prepare to replace ink tanks in the following situations.

• If ink confirmation message appears on touch screen

  If ink is low, the Status lamp lights orange and a notification message will appear on the touch screen. You can continue to print, but prepare the ink tanks.

  ➔ Checking Ink Tank Levels

• Before print jobs and maintenance that consume a lot of ink

  If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance, which require a lot of ink. Replace or prepare to replace the ink tanks in the following situations.

• If message for ink replacement appears on touch screen

  When the ink runs out, the Status lamp flashes orange, a message regarding ink tanks replacement appears on the touch screen, and printing is disabled. Replace the ink tank.
Print Head

- Print Head
- Checking for Nozzle Clogging
- Cleaning the Print Head
- Replacing the Print Head
Print Head

When purchasing, check the Model number.

Model number: PF-06

Note

- For instructions on replacing the print head, see Replacing the Print Head.
Checking for Nozzle Clogging

If printing is faint or affected by banding in different colors, make sure the print head nozzles are clear by printing a test pattern to check the nozzles.

**Important**

- When using cut sheets, do not move the release lever until instructions (guidance) for removing the paper are displayed.
  
  Moving the release lever during printing or maintenance operations will cause the printer to stop.

**Note**

- By default, nozzles are checked at fixed intervals.
  
  Auto maintenance settings

Paper to Prepare

**When using rolls**

An unused roll at least 10.00 in. (254.0 mm) wide

**When using sheets**

One sheet of unused paper of at least A4/Letter size

1. Load paper.
   
   Loading Rolls on the Roll Holder  
   Loading Rolls in the Printer  
   Loading Sheets in the Printer

2. Tap (Setup) > Maintenance on HOME screen.
   
   Touch Screen
   
   The Maintenance screen appears.

3. Tap Nozzle Check.
   
   A confirmation message appears.

4. Tap Yes.
   
   The printer now prints a test pattern for checking the nozzles.

5. Check the printing results.
   
   If the horizontal lines are not faint or incomplete, the nozzles are clear.
If some sections of the horizontal lines are faint or incomplete, the nozzles for those colors are clogged.

If horizontal lines are faint or incomplete, execute print head cleaning.

→ Cleaning the Print Head
Cleaning the Print Head

If printing is faint, cleaning the print head may improve results.

Choose one of three print head cleaning modes (Cleaning, Deep Cleaning, or System cleaning), depending on the problem to resolve.

- **Cleaning**
  
  Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes the least amount of ink.
  
  It takes about 2 to 3 minutes.

- **Deep Cleaning**
  
  Use this mode if no ink is ejected at all or if Cleaning does not solve the problem.
  
  It takes about 3 minutes.

- **System cleaning**
  
  Use this mode if printing is not improved after Deep Cleaning. System cleaning consumes a very large amount of ink. Performing this frequently consumes the ink faster. Perform this only when needed.
  
  It takes about 4 minutes.

**Important**

- Do not remove the maintenance cartridge or ink tanks during Cleaning, Deep Cleaning, or System cleaning.
  
  Ink may leak or an error may occur.

- If printing is not improved after System cleaning, the print head may be at the end of its service life. Contact your Canon dealer for assistance.

- When using cut sheets, do not move the release lever until instructions (guidance) for removing the paper are displayed.
  
  Moving the release lever during printing or maintenance operations will cause the printer to stop.

**Note**

- Check the nozzle check pattern and select an ink group for which to perform cleaning as needed. You can clean all print heads or select pattern 1 or 2 to clean the print heads with a clogged nozzle.
Perform cleaning as follows.

1. Tap  (Setup) > Maintenance on HOME screen.

   ➤ Touch Screen

   The Maintenance screen appears.

2. Tap Print head cleaning.

3. Tap Cleaning, Deep Cleaning, or System cleaning.

4. Tap ink group to be cleaned.
   - All colors
   - Pattern 1: MBK / BK
   - Pattern 2: Y / M / C

   A confirmation message appears.

5. Tap Yes.

   Head cleaning is now executed.

6. Print a test pattern to check the nozzles and determine whether cleaning has cleared the nozzles.

   ➤ Checking for Nozzle Clogging
Replacing the Print Head

If the touch screen indicates to replace the print head or if instructed to do so by your Canon dealer, replace the print head.

Compatible Print Head

For details on compatible print head, see Print Head.

Precautions When Handling Print Head

Take the following precautions when handling the print head.

⚠️ Caution

- For safety, keep print head out of the reach of children.
- If ink is accidentally ingested, contact a physician immediately.
- Do not touch the print head immediately after printing. The print head becomes extremely hot, and there is a risk of burns.

>>> Important

- There may be ink around the nozzles of the print head you remove. Handle the print head carefully during replacement. The ink may stain clothing.
- Do not open the print head pouch until immediately before installation. After removing the print head from the pouch, install it right away. If the print head is left as is after the pouch is opened, the nozzles may dry out, which may affect printing quality.

How to Replace Print Head

⚠️ Caution

- When replacing the print head immediately after printing, wait a few minutes before replacing it. The metal parts of the print head become hot during printing, and there is a risk of burns from touching these parts.

>>> Important

- Your hands may become dirty during print head replacement. Use the gloves provided in the box with the new print head for replacement.

>>> Note

- Prepare a new ink tank when ink levels are low.
- Prepare a new maintenance cartridge when the remaining capacity of the maintenance cartridge is low.

1. Tap (Setup) > Maintenance on HOME screen.

Touch Screen
The Maintenance screen appears.

2. Tap **Head replacement**.
   A confirmation message appears.

3. Tap **Yes**.
   Ink begins being drawn in. When it finishes, instructions for the print head replacement procedure appear on the touch screen.
   It takes about 1 to 2 minutes for ink to be drawn into the system and remove ink from the print head.

4. Open top cover.

5. If the print head locking cover and print head lock lever are dirty, use a damp cloth that you have wrung out completely to wipe them clean.

>>> **Important**

- Do not touch the linear scale (A) or carriage shaft (B). Touching these may cause malfunction.
• Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not to scratch the surface.

6. Pull down print head lock lever toward the front while holding its center (C) with your fingertip.

7. Grab grip (D) and open print head locking cover.
8. Grab grips (E), remove print head, and then tap **OK**.

---

**Important**

- Never touch the metal contacts of the carriage. Furthermore, do not allow any dirt or debris to become adhered to the metal contacts of the carriage. These may damage the printer.

**Note**

- Dispose of the used print head in accordance with local regulations.

9. Take new print head out of its pouch by grabbing grips (E).
10. Remove orange protective caps (F, G).

Grab grip (H) to remove protective cap (G).

**Important**

- Always carry the print head by holding its right and left grips. Never touch nozzle (I) or metal contacts (J). This may damage the print head and affect printing quality.
- Never touch the ink holes (K). This may affect printing quality.
The inside surface of the protective cap is coated with ink to protect the nozzle. Be careful not to touch these surfaces when removing the caps.

The print head contains ink to protect the nozzle. We recommend removing the protective cap while holding it over the pouch that contained the print head or otherwise safely out of the way to avoid spilling ink and staining your clothes or the surrounding area. If ink accidentally spills, wipe off the ink with a dry cloth.

If you need to put a print head somewhere temporarily before installation, do not set it down with the nozzles and metal contacts facing down. If the nozzles or metal contacts are damaged, it may affect the printing quality.

Do not reattach the removed protective part. Dispose of these materials in accordance with local regulations.

11. Turn ink holes (K) toward the front and insert print head into carriage.

Insert the print head all the way into the carriage, while taking care to keep parts that were protected by the protective caps from touching the carriage.

12. Grasp tab (D) of print head locking cover and lower it to front to lock print head.
13. While holding center part (C) of print head lock lever, lower it toward back.

14. Align angle adjustment lever with the red square position.

15. Close top cover.
Ink now fills the print head. It takes about 10 minutes.

**Important**

- While ink is being filled, definitely do not remove the ink tank or maintenance cartridge. Ink may leak out.

**Note**

- Print head position adjustment is executed when **Print pattern after new head** is set to **ON**. Follow the instructions on the touch screen to load paper.
  - [Auto maintenance settings](#)
Maintenance Cartridge

- Maintenance Cartridge
- Replacing the Maintenance Cartridge
- Checking the Remaining Maintenance Cartridge Capacity
- When to Replace the Maintenance Cartridge
Maintenance Cartridge

When purchasing, check the Model number.

Model number: MC-31

Note

- For instructions on replacing the maintenance cartridge, see Replacing the Maintenance Cartridge.
Replacing the Maintenance Cartridge

Compatible Maintenance Cartridges
For details on compatible maintenance cartridge, see [Maintenance Cartridge](#).

Precautions When Handling Maintenance Cartridge
Take the following precautions when handling the maintenance cartridge.

⚠️ Caution
- For safety, keep maintenance cartridge out of the reach of children.
- If ink is accidentally ingested, contact a physician immediately.

👉 Important
- Do not remove the maintenance cartridge except to replace it. Ink may leak out.
- Do not remove a maintenance cartridge during initialization immediately after turning on the printer, during print head cleaning, while ink is being drawn out, or during initialization immediately after replacing the maintenance cartridge.
  
  The maintenance cartridge may become damaged or ink may leak out.
- To prevent ink from leaking from a used maintenance cartridge, avoid dropping the cartridge or storing it at an angle. Otherwise, ink may leak and cause stains.
- Ink adheres to the top of the maintenance cartridge after it has been used. Handle the maintenance cartridge carefully during replacement. The ink may stain clothing.

How to Replace a Maintenance Cartridge
If a message indicates you should replace a maintenance cartridge, check the message details and go to step 4.

1. Tap ✉️ (Setup) > Maintenance on HOME screen.
   
   ➡️ Touch Screen
   
   The Maintenance screen appears.

2. Tap Maintenance cartridge info.
   
   The Maintenance cartridge info screen appears.

3. Tap Replace.
   
   Instructions for the maintenance cartridge replacement procedure appear on the touch screen.

4. Open box, and remove plastic bag and maintenance cartridge.
**Important**

- Never touch the metal contacts (A). This may damage the maintenance cartridge.

5. Open maintenance cartridge cover.

6. Hold the used maintenance cartridge by the grip (B) with one hand and put your other hand under the maintenance cartridge to hold it firmly on the bottom, keeping it level as you pull it out.
**Important**

- A used maintenance cartridge is heavy. Always grasp the cartridge firmly and keep the cartridge level during removal. If you drop a used maintenance cartridge or store it at an angle, ink may leak and cause stains.

7. Put used maintenance cartridge in supplied plastic bag and store on flat surface.

8. Check the top and bottom of the maintenance cartridge, place in the box, and store the box on a flat surface.

**Important**

- Always put the used maintenance cartridge back in the box and store the box on a flat surface.

**Note**

- Dispose of the used maintenance cartridge in accordance with local regulations.

9. Wipe away any soiling on the maintenance cartridge cover.
10. Keeping the new maintenance cartridge level, insert it all the way in.

The maintenance cartridge is initialized.

11. Close maintenance cartridge cover.
Checking the Remaining Maintenance Cartridge Capacity

The maintenance cartridge absorbs excess ink from print head cleaning. You can confirm the remaining capacity of the maintenance cartridge by checking the touch screen.

1. Tap (Setup) > Maintenance on HOME screen.

   ➡ Touch Screen

   The Maintenance screen appears.

2. Tap Maintenance cartridge info.

   The Maintenance cartridge info screen appears.

   ![Maintenance cartridge info screen]

   If the touch screen indicates to replace the maintenance cartridge, replace the maintenance cartridge.

   If a message appears indicating to check the remaining capacity of the maintenance cartridge, or before tasks that deplete much of the capacity such as head cleaning or preparations to move the printer, check the remaining maintenance cartridge capacity and prepare a new maintenance cartridge as needed.

   ➡ Replacing the Maintenance Cartridge
When to Replace the Maintenance Cartridge

Replace or prepare to replace the maintenance cartridge in the following situations.

• If maintenance cartridge confirmation message appears on touch screen
  When the maintenance cartridge is almost used up, the Status lamp lights orange and a notification message will appear on the touch screen. You can continue to print, but check the remaining maintenance cartridge capacity and prepare to replace the maintenance cartridge with a new one.

  ➤ Checking the Remaining Maintenance Cartridge Capacity

• When the maintenance cartridge capacity is drastically depleted
  Print head cleaning, print head replacement, and preparations to transfer the printer deplete much of the maintenance cartridge capacity. (In particular, preparing to move the printer depletes a lot of the capacity.)

  Check the remaining maintenance cartridge capacity before this maintenance and replace the maintenance cartridge if necessary.

• If message for maintenance cartridge replacement appears on touch screen
  When the maintenance cartridge is used up, the Status lamp blinks orange, a message regarding maintenance cartridge replacement appears on the touch screen, and printing is disabled. Replace the maintenance cartridge with a new one.
Cutter Blade

- Cutter Blade
- Replacing the Cutter Blade
Cutter Blade

When purchasing, check the Model number.

Model number: CT-08

Note

- For instructions on replacing the cutter blade, see Replacing the Cutter Blade.
Replacing the Cutter Blade

Compatible Cutter Blade

For details on compatible cutter blade, see Cutter Blade.

How to Replace Cutter Blade

Important

• The cutter blade can not be replaced if there is paper in the moving range of the cutter. Remove the paper.

1. Tap (Setup) > Maintenance on HOME screen.

   Touch Screen

   The Maintenance screen appears.

2. Tap Replace cutter blade unit.

   A confirmation message appears.

3. Tap Yes.

   The carriage moves and after it stops moving, instructions for the cutter blade replacement procedure appear on the touch screen.

4. If cutter blade is dirty, use damp cloth that you have wrung out completely to wipe it clean.

   Important

   • Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not to scratch the surface.

5. Turn hex screw with hex wrench until loose.
6. Remove cutter blade while holding A.

**Caution**

- Never touch any part other than A. This may stain your hands or cause injury. Additionally, this may damage the printer.
- Do not disassemble the cutter blade. Touching the blade may cause injury.

**Note**

- Dispose of the used cutter blade in accordance with local regulations.

7. Install new cutter blade while aligning B to C and D to E.

8. Turn hex screw until securely fixed.
Important

- After the cutter blade is secured, check that the cutter blade does not come off. If the cutter blade comes off, this may damage the printer.

9. Tap Done.

10. Tap Yes.
Performing Maintenance Functions from Your Computer (Windows)

- Cleaning the Print Heads
- Printing a Nozzle Check Pattern
Cleaning the Print Heads

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for print head cleaning is as follows:

1. Open the printer driver setup window

2. Click Print Head Cleaning on the Maintenance tab

   When the Print Head Cleaning dialog box opens, select the head cleaning to be performed from the following:
   
   • **Cleaning**
     
     Perform Cleaning if printing is faint or a specific color fails to print, even though there is enough ink.
   
   • **System Cleaning**
     
     System Cleaning is a more powerful cleaning function. Perform System Cleaning if there is no improvement even after repeating Cleaning several times.

   >>> Important
   
   • System Cleaning consumes an extremely large amount of ink.
     
     Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore, execute system cleaning only when necessary.

3. Execute cleaning

   Make sure that the printer is on and then click **OK**.

   Print head cleaning starts.

>>> Note

- After Cleaning or System Cleaning is complete, perform Print Nozzle Check Pattern and check the cleaning results.

Related Topic

- Printing a Nozzle Check Pattern
Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

1. Open the printer driver setup window
2. Load paper in the printer
3. Click **Print Nozzle Check Pattern** on the **Maintenance** tab
   
   The **Print Nozzle Check Pattern** dialog box opens.
4. Select feed position
   
   Select the feed position from the displayed dialog box.
5. Print a nozzle check pattern
   
   Make sure that the printer is on and click **OK**.
   
   Printing of the nozzle check pattern begins.
   
   Click **OK** when the confirmation message appears.
6. Check the print result
   
   Check the print results.

   ![Nozzle Check Pattern](image)

   (A) As long as the horizontal lines are in line, and not missing, the nozzle is working normally.
   
   (B) Where the horizontal lines are not in line or are missing, the color nozzle is blocked.

**Note**

- From the nozzle check pattern printing results, if it becomes patchy or there are areas that cannot be printed, use **Print Head Cleaning** to clean the print heads.
  
  Once cleaning is complete, print the nozzle check pattern again and check the results.
Related Topic

Cleaning the Print Heads
Cleaning the Printer

- Cleaning the Printer Exterior
- Cleaning Inside the Top Cover
- Cleaning the Print Head
Cleaning the Printer Exterior

Clean the printer regularly to maintain better printing quality and help prevent problems. To ensure a comfortable working environment, clean the printer exterior about once a month.

1. Turn printer off.  
   ➤ Turning the Printer On and Off

2. Unplug power cord from outlet.
   
   **Caution**
   
   • Always turn off the printer and unplug the power cord before cleaning or maintenance. Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the printer.

3. Wring out soft cloth with water or watered-down neutral detergent, and use it to wipe off dirt.

   Clean the printer exterior and the power cord plug.

   ![Cleaning the Printer Exterior](image)

   **Warning**
   
   • Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

   ![Cleaning the Printer Exterior](image)

   **Important**
   
   • If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend cleaning the output guide even if it does not appear dirty, because it may actually be covered with paper dust.  
   ➤ Cleaning Inside the Top Cover

   • Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not to scratch the surface.

   • When neutral detergent is used, be sure to wipe off the detergent with soft cloth with water.

4. When dirt is wiped off, wipe off water with dry soft cloth.

5. Plug power cord into outlet.
Cleaning Inside the Top Cover

Clean inside the top cover about once a month to maintain better printing quality and help prevent problems. Also clean inside the top cover in the following situations to ensure optimal operation.

- If the printed surface or the underside of paper is dirty after printing
- After you have used up a roll
- After borderless printing
- After printing on small paper
- After printing on paper that generates a lot of cutting debris
- If you have replaced the roll
- After printing on paper that generates a lot of paper dust
- After printing on adhesive paper

**Important**

- If the platen inside the top cover becomes dirty, it may soil the underside of paper. We recommend cleaning the platen after borderless printing or printing on small paper.
- If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend cleaning the output guide even if it does not appear dirty, because it may actually be covered with paper dust.
- Printing on adhesive paper may leave adhesive on the platen, paper retainer, or other parts. To prevent paper jams, we recommend cleaning inside the top cover after printing.
- Cleaning may not be performed if there is paper in the cleaning area. Remove the paper.

1. Tap (Setup) > Maintenance on HOME screen.

   ➔ Touch Screen

   The Maintenance screen appears.

2. Tap Platen cleaning.

   A confirmation message appears.

3. Tap Yes.

   The carriage moves and after it stops moving, instructions appear on the touch screen.

4. Open top cover.
5. If paper dust has accumulated in vacuum holes (A) on platen or in borderless printing ink grooves (B), use cleaning brush (C), provided with printer, to wipe it away.

**Important**
- Do not touch the linear scale (D) or carriage shaft (E). Touching these may cause malfunction.

**Note**
- If the cleaning brush is dirty, rinse it in water.

6. Using a damp cloth that you have wrung out completely, wipe inside the top cover to clean it.
Wipe away any ink residue and paper dust (debris from cutting) on entire platen (F), paper retainer (G), borderless printing ink grooves (H), and output guide (I), and so on.

⚠️ **Warning**
- Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

➤ **Important**
- Do not use a dry cloth to wipe inside the top cover. This may create a static charge, which may attract dust and affect the printing quality.
- Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not to scratch the surface.

➤ **Note**
- When cleaning between the platen and ejection guide, use a damp cloth that you have wrung out completely to wipe over the output tray and along grooves.
2. Close top cover.
Other Maintenance

- Preparing to Transfer the Printer
- Reinstalling the Printer
- Firmware update
Preparing to Transfer the Printer

To protect the internal parts in transit, always follow these steps before transferring the printer to a new location.

For details on packing the printer and installing it after transfer, see Reinstalling the Printer.

**Important**

- Avoid tilting the printer excessively in transit. This may cause ink in the printer to leak and cause stains.
- When moving the printer, make sure that the basket does not rub against the floor. If the basket rubs on the floor, it may get dirty or damaged.

**Note**

- The maintenance cartridge replacement may be required when you execute the Prepare to move menu. Prepare the maintenance cartridge in advance while referring below. The number of maintenance cartridge required varies depending on the amount remaining in the maintenance cartridge being used.
- If you can move the printer in a level state using casters or something similar, you do not need to execute Prepare to move.
- Always follow the instructions of the service representative when preparing to transfer the printer.

The following lists transport restrictions by type of transport.

**Move on the same floor**

Usage Examples: Move indoors by carrying

- Transport and storage in low temperature environments: No
- Required maintenance cartridges: 1

**Transport outdoors**

Usage Examples: Transport by vehicle

- Transport and storage in low temperature environments: Yes
- Required maintenance cartridges: 1

Preparing for Transportation

1. Remove the paper.
   - Rolls
     ➔ Removing the Roll from the Printer
   - Sheet
     ➔ Removing Sheets

2. If touch screen indicates to replace maintenance cartridge, replace maintenance cartridge.
   ➔ Replacing the Maintenance Cartridge
3. Tap ☐️ (Setup) > Maintenance on HOME screen.
   ➪ Touch Screen

   The Maintenance screen appears.

4. Tap Prepare to move.

5. Tap Move on the same floor or Transport outdoors.

   A confirmation message appears.

6. Tap Yes.

   The printer is now prepared for transfer.

   When the preparation is finished, a message prompting you to open the ink tank cover appears on the touch screen.

   ➪ Important

   • If consumables must be replaced, a message appears on the touch screen, and preparation is disabled. If the message appears, tap OK and contact your Canon dealer for assistance.

7. Open ink tank cover to remove all ink tanks.
   ➪ Replacing Ink Tanks

8. Push all ink tank lock levers closed until they click into place.

9. Close ink tank cover.

   Ink is now drawn into the maintenance cartridge.

   A confirmation message will appear when the process is finished.

   ➪ Important

   • Do not remove the maintenance cartridge except when the message indicating replacement is displayed.
If you remove the maintenance cartridge while ink is being removed, the ink may leak out.

10. Press ON button and turn off printer.

Packing Printer

1. Disconnect power cord and interface cable.

   **Important**
   - Turn off the printer before you unplug it. Unplugging the printer before it is off and moving it may damage the printer. If you accidentally unplug the printer, plug it in again, reinstall the ink tanks, and follow this procedure again.

2. Tape down printer covers to secure them, in the reverse order of tape removal during installation.

3. Remove the stand by reversing the installation procedure, when it was attached to the printer.

4. Disassemble and repackage the stand by following the installation procedure in reverse.

5. Repack roll holder, holder stopper, and printer in shipping materials, and then package them in shipping box.
Reinstalling the Printer

The basic workflow for reinstalling the printer is as follows.

For detailed instructions, see the Setup Guide.

Assemble the stand

Note

• Depending on the product, a stand may not be provided.

1. To use the optional stand, assemble the stand by referring to the Printer Stand Setup Guide that was provided with the stand.

⚠️ Caution

• The stand must be assembled by at least two people on a flat surface. Attempting assembly by yourself poses a risk of injury or bending the Stand.

• When assembling the stand, lock all four of the casters. Attempting to move the stand when the casters are locked poses a risk of injury or damage to the location site.

• When moving the stand, make sure that the basket does not graze the floor and that all four of the casters are unlocked before moving the stand. Not doing so may damage the basket, scratch the floor, or cause injuries.

Install the printer

1. Mount the printer on the assembled stand and tighten the screws firmly.
**Caution**

- Moving the printer requires at least two people. Be careful to avoid back strain and other injuries.
- When moving the printer, firmly grasp the carrying grips. When lifting TA-20 with 2 people, use the carrying grips on each side in the base. Do not use the carrying grips at the rear side. The printer may be unsteady if you hold it at other positions, which poses a risk of injury from dropping the printer.
• When placing the printer on the stand, lock all four of the casters of the stand. Attempting to place the printer on the stand while the casters are not locked poses a risk of injury.

2. Remove tape and packaging material attached to the printer.

3. Connect the power cord to the power cord connector on the right side of the printer.

4. Plug the power cord into the outlet.

5. Press ON button to turn on printer.

   When "Install the printer here? Do not install the ink tanks yet." appears, tap Yes.
6. When instructions for loading ink tank appear on operation panel, open ink tank cover and load ink tank.

**Note**

- After installing the ink tank, a message may appear that tells you to install a second ink tank. If this happens, first remove the installed ink tank, and then install a second one.

7. Loading Rolls on the roll holder

(See "Loading Rolls on the Roll Holder.")

8. Load the Roll Media in the printer.

(See "Loading Rolls in the Printer.")
9. Install the software.

Note that the driver installation procedure varies depending on the type of connection.

(See "Installing the Printer Driver" (Windows).)

(See "Installing the Printer Driver" (macOS).)

**Important**

- When the printer is connected to a network (via TCP/IP), the printer's IP address may be changed if you reinstall the printer.

  In this case, be sure to reconfigure the printer's IP address.
Firmware update

This setting item is displayed by tapping Device settings after tapping [Setup] on the HOME screen.

Important

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.

You can update the firmware of the printer, check the firmware version, or perform settings of a notification screen, a DNS server and a proxy server.

Note

- If LAN is disabled, you can not use Install update, DNS server setup, Proxy server setup.

- Install update

Performs the firmware update of the printer. If you select Yes, the firmware update starts. Follow the on-screen instructions to perform update.

Important

- When you use this function, make sure the printer is connected to the Internet.

Note

- If the firmware update is not complete, check the following and take an appropriate action.
  - Check the network settings such as a wireless router.
  - If Cannot connect to the server. is displayed on the touch screen, select OK and try again after a while.

- Check current version

You can check the current firmware version.

- Update notification setting

When Yes is selected and the firmware update is available, the screen to inform you of the firmware update is displayed on the touch screen.

- DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup, follow the display on the touch screen to perform settings.

- Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
Specifications

- Specifications
- Print Area
## Specifications

### Important

- The following values may vary depending on the operating environment.

### Printer

<table>
<thead>
<tr>
<th>Power supply</th>
<th>100-240 V AC (50/60 Hz)</th>
</tr>
</thead>
</table>
| Power consumption | **When printing:** 52 W max. *1  
**In Sleep mode:** 3.6 W max. *1  
**When power is off:** 0.3 W max. *2  
*1 Wired LAN connection  
*2 The printer uses a trace amount of power even when turned off. To stop all power consumption, turn off the printer and unplug the power cord. |

### Operating environment

| Temperature: 59 to 86 °F (15 to 30 °C)  
Humidity: 10 to 80 % RH (with no condensation) |

### Dimensions (W x D x H)

| Printer only:  
Approx. 38.7 x 29.5 x 17.3 in. (982 x 748 x 438 mm)  
**Printer and Stand SD-24 (when opening the basket):**  
Approx. 38.7 x 34.3 x 41.7 in. (982 x 870 x 1059 mm)  
Actual basket shipped with printer device may vary according to region. |

### Weight

| Printer only (without print head and ink tanks):  
Approx. 81 lb (37 kg)  
**Printer and Stand SD-24 (without print head and ink tanks):**  
Approx. 100 lb (46 kg) |

### Space for installation (W x D x H)

| Printer only:  
Approx. 54.5 x 53.1 x 29.1 in. (1382 x 1348 x 738 mm)  
**Printer and Stand SD-24 (when opening the basket):**  
Approx. 54.5 x 57.9 x 53.6 in. (1382 x 1470 x 1359 mm) |

### Printing performance

<table>
<thead>
<tr>
<th>Print method</th>
<th>Bubblejet</th>
</tr>
</thead>
</table>
| Maximum resolution | 2400 dpi (horizontally) * x 1200 dpi (vertically)  
* Prints with a minimum 1/2400 inch dot pitch between ink droplets. |

<table>
<thead>
<tr>
<th>Print head</th>
<th>PF-06</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of nozzles</td>
<td>MBK: 5120 nozzles, others: each 2560 nozzles</td>
</tr>
</tbody>
</table>
## Memory

| Memory | 2 GB |

## Interface

You can use both USB and LAN at the same time.

You cannot use Wi-Fi and wired LAN at the same time.

### USB

<table>
<thead>
<tr>
<th>Hi-Speed USB *</th>
</tr>
</thead>
<tbody>
<tr>
<td>* To use Hi-Speed USB, your computer must support Hi-Speed USB. Additionally, the Hi-Speed USB interface is completely backward compatible with USB 1.1, so the printer can be connected even if the computer interface is USB 1.1.</td>
</tr>
</tbody>
</table>

### LAN

| Wired LAN: IEEE802.3ab (1000BASE-T) / IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T) |
| Wi-Fi: IEEE802.11n / IEEE802.11g / IEEE802.11b |

## Network Specifications

<table>
<thead>
<tr>
<th>Communication protocol</th>
<th>SNMP, HTTP, TCP/IP (IPv4/IPv6), FTP</th>
</tr>
</thead>
</table>

### Wired LAN specifications

| Compliance standards: IEEE802.3ab (1000BASE-T) / IEEE802.3u (100BASE-TX) / IEEE802.3 (10BASE-T) |
| Transmission speed: 10 Mbps / 100 Mbps / 1000 Mbps (automatically selected) |
| Security: IEEE802.1X (EAP-TLS/EAP-TTLS/PEAP) |

### Wi-Fi specifications

| Compliance standards: IEEE802.11n / IEEE802.11g / IEEE802.11b |
| Frequency range: 2.4 GHz |
| Channels: 1-11 or 1-13 * |
| * Varies by country and region. |
| Effective range: Indoors 164 feet/50 m * |
| * Varies according to environmental conditions. |
| Security: |
| WEP (64/128 bits) |
| WPA-PSK (TKIP/AES) |
| WPA2-PSK (TKIP/AES) |
| Setup: |
| WPS (push button method/PIN code method) |
| Easy wireless connect |
### Operating Conditions

If operating conditions of the operating system are high, follow those.

#### Windows

<table>
<thead>
<tr>
<th>Compatible Operating System (Standard supplied printer driver)</th>
<th>32-bit version:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 10</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
</tr>
<tr>
<td></td>
<td>Use the latest Service Pack available.</td>
</tr>
<tr>
<td></td>
<td><strong>64-bit version:</strong></td>
</tr>
<tr>
<td></td>
<td>Windows 10</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2012, Windows Server 2012 R2</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2016</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2019</td>
</tr>
<tr>
<td></td>
<td>Use the latest Service Pack available.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recommended operating environment *</th>
<th>CPU: Pentium 4 or later, or Athlon 64 or later processor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Memory: 1 GB or more</td>
</tr>
<tr>
<td></td>
<td>Free hard disk space: 20 GB or more</td>
</tr>
</tbody>
</table>

* Depending on the application software and data being used, the printer may not output correctly even with the above environmental conditions.

#### macOS

<table>
<thead>
<tr>
<th>Compatible Operating System (Standard supplied printer driver)</th>
<th>OS X 10.10.5 - OS X 10.11, macOS 10.12 - macOS 10.14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended operating environment *</td>
<td>CPU: Intel multi-core processor or later</td>
</tr>
<tr>
<td></td>
<td>Memory: 2 GB or more</td>
</tr>
<tr>
<td></td>
<td>Free hard disk space: 20 GB or more</td>
</tr>
</tbody>
</table>

* Depending on the application software and data being used, the printer may not output correctly even with the above environmental conditions.

- An Internet connection is required to use the Online Manual.
- To install the software while using Windows, you must have a CD-ROM drive or a network connection.
- To install the software while using macOS, you must have a network connection.
Ink

For information on the ink the printer supports, see Ink Tanks.

Paper

For details on the compatible media types, see Paper Information List.

<table>
<thead>
<tr>
<th>Paper width</th>
<th>For details on the paper widths supported by the printer, see Paper Sizes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum paper length</td>
<td>Rolls: 8.00 in. (203.2 mm)</td>
</tr>
<tr>
<td></td>
<td>Sheets: 11.00 in. (279.4 mm)</td>
</tr>
<tr>
<td>Maximum printable length</td>
<td>Rolls: 59 feet (18 m) *</td>
</tr>
<tr>
<td></td>
<td>* Varies depending on the operating system or application.</td>
</tr>
<tr>
<td></td>
<td>Sheets: 23.4 in. (594 mm)</td>
</tr>
<tr>
<td>Thickness</td>
<td>Rolls: 3-31 mil (0.07-0.8 mm)</td>
</tr>
<tr>
<td></td>
<td>Sheets: 3-31 mil (0.07-0.8 mm)</td>
</tr>
<tr>
<td>Roll maximum outer diameter</td>
<td>5.9 in. (150 mm) or shorter</td>
</tr>
<tr>
<td>Supported paper core inner diameter</td>
<td>2.00 in./3.00 in. (50.8 mm/76.2 mm)</td>
</tr>
<tr>
<td></td>
<td>Optional items are required depending on products.</td>
</tr>
<tr>
<td>Print area</td>
<td>For details about Print Area, see Print Area.</td>
</tr>
</tbody>
</table>
Print Area

A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in borderless printing, the actual printing area corresponds to the paper size minus the space for this margin.

**Note**

- **Printable Area:** The area that can be printed.
- **For borderless printing with roll paper,** the margin is 0 in. (0 mm).
  - Printing without Edges Based on the Scenarios (Windows)
  - Printing without Edges Based on the Scenarios (macOS)
- **Recommended Print Area:** We recommend printing within this area.
- **To match the document size with the actual printing area,** print on oversize paper with the required margin added.
  - Printing to Oversized Paper Sizes (Windows)
  - Printing to Oversized Paper Sizes (macOS)

### Sheets

**Printable Area:**

A margin of 0.2 in. (3 mm) on top, 0.5 in. (12.7 mm) on bottom*, and 0.2 in. (3 mm) on left and right sides is required.

**Recommended Print Area:**

A margin of 0.8 in. (20 mm) on top, 0.8 in. (20 mm) on bottom*, and 0.2 in. (3 mm) on left and right sides is required.

* The bottom margin for cut sheet depends on an OS and applications.

---

A: Top Edge  
B: Bottom Edge  
C: Left Edge  
D: Right Edge
## Rolls

**Printable Area:**
A margin of 0.2 in. (3 mm) on top and bottom and 0.2 in. (3 mm) on left and right sides is required. For borderless printing, the margins on top, bottom, left, and right are 0 in. (0 mm). For paper that supports borderless printing, see Paper Information List.

**Recommended Print Area:**
A margin of 0.8 in. (20 mm) on top, 0.2 in. (3 mm) on bottom, and 0.2 in. (3 mm) on left and right sides is required.

A: Top Edge
B: Bottom Edge
C: Left Edge
D: Right Edge
Safety

- Safety Precautions
- Regulatory Information
- WEEE (EU&EEA)
- When Repairing, Lending, or Disposing of the Printer
Safety Precautions

Choosing a location

- Never install the printer on an unstable or vibrating surface.
- Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close to a heating source.
  To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in the Specifications.
- Do not place the printer on a thick rug or carpet.
- Do not place the printer with its back attached to the wall.
- We recommend ensuring ample space for installation.
- Do not install the printer near sources of strong electromagnetic fields, whether equipment that generates such fields or places where such fields occur.

Power Supply

- Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the power cord if necessary.
- Never remove the plug by pulling on the cord.
  Pulling the cord may damage the power cord, leading to possible fire or electrical shock.
- Do not use an extension lead/cord.

Working Around the Printer

- Never put your hands or fingers in the printer while it is printing.
- Firmly grasp the recesses on each side in the base and carrying handles at the rear side. Holding the printer at other positions is dangerous and cause injury and damage if the printer is dropped.
- When lifting the TA-20 with 2 people, do not use the carrying handles at the rear side. This is dangerous and may cause injury and damage if the printer is dropped.
- Use the following number of people to hold the printer when transporting the printer by carrying it. The weight may cause pain such as back pain.
  For the TA-20 : 2 people or more
- When using and transferring the printer, do not tilt it, stand it on its side, or turn it upside down. There is a risk of the ink spilling.
- When transferring the printer tilted, always perform the steps in "Preparing to Transfer the Printer" in order to protect the internal structure.
- Do not place any object on the printer. Especially do not place metal objects (paper clips, staples, etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the printer.

Print Heads/Ink Tanks/Maintenance Cartridges

- Keep ink tanks out of the reach of children. In case ink is accidentally licked or swallowed, rinse out mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical advice immediately.
• In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice immediately.

• Never touch the electrical contacts on a print head after printing. The metal parts may be very hot and could cause burns.

• Do not throw ink tanks and maintenance cartridges into fire.

• Do not attempt to disassemble or modify the print head, ink tanks, and maintenance cartridges.

• Avoid dropping or shaking print head, ink tanks, and maintenance cartridges.
Regulatory Information

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10503 (Contains FCC Approved WLAN Module K30357)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules. Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes or modifications should be made, you could be required to stop operation of the equipment. Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This equipment should be installed and operated with minimum distance at least 20cm between the radiator and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or operated with any other antenna or transmitter.

Canon U.S.A., Inc.
One Canon Park
Melville, New York 11747
1-800-652-2666

Interference

Do not use the printer around medical equipment or other electronic devices. Signals from the printer may interfere with the correct operation of these devices.
Only for European Union and EEA (Norway, Iceland and Liechtenstein)

These symbols indicate that this product is not to be disposed of with your household waste, according to the WEEE Directive (2012/19/EU), the Battery Directive (2006/66/EC) and/or national legislation implementing those Directives. If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above an applicable threshold specified in the Battery Directive. This product should be handed over to a designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product or to an authorized collection site for recycling waste electrical and electronic equipment (EEE) and batteries and accumulators. Improper handling of this type of waste could have a possible impact on the environment and human health due to potentially hazardous substances that are generally associated with EEE. Your cooperation in the correct disposal of this product will contribute to the effective usage of natural resources. For more information about the recycling of this product, please contact your local city office, waste authority, approved scheme or your household waste disposal service or visit www.canon-europe.com/weee, or www.canon-europe.com/battery.

Nur für Europäische Union und EWR (Norwegen, Island und Liechtenstein)


**Union Européenne, Norvège, Islande et Liechtenstein uniquement.**

Ces symboles indiquent que ce produit ne doit pas être mis au rebut avec les ordures ménagères, comme le spécifient la Directive européenne DEEE (2012/19/UE), la Directive européenne relative à l'élimination des piles et des accumulateurs usagés (2006/66/CE) et les lois en vigueur dans votre pays appliquant ces directives. Si un symbole de toxicité chimique est imprimé sous le symbole illustré ci-dessus conformément à la Directive relative aux piles et aux accumulateurs, il indique la présence d'un métal lourd (Hg = mercure, Cd = cadmium, Pb = plomb) dans la pile ou l'accumulateur à une concentration supérieure au seuil applicable spécifié par la Directive. Ce produit doit être confié au distributeur à chaque fois que vous achetez un produit neuf similaire, ou à un point de collecte mis en place par les collectivités locales pour le recyclage des Déchets des Équipements Électriques et Électroniques (DEEE). Le traitement inapproprié de ce type de déchet risque d’avoir des répercussions sur l’environnement et la santé humaine, du fait de la présence de substances potentiellement dangereuses généralement associées aux équipements électriques et électroniques. Votre entière coopération dans le cadre de la mise au rebut correcte de ce produit favorisera une meilleure utilisation des ressources naturelles. Pour plus d’informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-organisme ou les autorités locales compétentes, ou consultez le site www.canon-europe.com/weee, ou www.canon-europe.com/battery.

**Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen, IJsland en Liechtenstein)**

Met deze symbolen wordt aangegeven dat dit product in overeenstemming met de AEEA-richtlijn (2012/19/EU), de richtlijn 2006/66/EG betreffende batterijen en accu’s en/of de plaatselijk geldende wetgeving waarin deze richtlijnen zijn geïmplementeerd, niet bij het normale huisvuil mag worden weggegooid. Indien onder het hierboven getoonde symbool een chemisch symbool gedrukt staat, geeft dit in overeenstemming met de richtlijn betreffende batterijen en accu’s aan dat deze batterij of accu een zwaar metaal bevat (Hg = kwik, Cd = cadmium, Pb = lood) waarvan de concentratie de toepasselijke drempelwaarde in overeenstemming met de genoemde richtlijn overschrijdt. Dit product dient te worden ingeleverd bij een hiervoor aangewezen inzamelpunt, bijv. door dit in te leveren bij een hiertoe erkend verkooppunt bij aankoop van een gelijksoortig product, of bij een officiële inzameldienst voor de recycling van elektrische en elektronische apparatuur (EEA) en batterijen en accu’s. Door de potentieel gevaarlijke stoffen die gewoonlijk gepaard gaan met EEA, kan onjuiste verwerking van dit type afval mogelijk nadelige gevolgen hebben voor het milieu en de menselijke gezondheid. Uw medewerking bij het op juiste wijze weggooien van dit product draagt bij tot effectief gebruik van natuurlijke hulpbronnen. Voor verdere informatie over recycling van dit product kunt u contact opnemen met uw plaatselijke gemeente,

Sólo para la Unión Europea y el Área Económica Europea (Noruega, Islandia y Liechtenstein)

Estos iconos indican que este producto no debe desecharse con los residuos domésticos de acuerdo con la Directiva sobre RAEE (2012/19/UE) y la Directiva sobre Pilas y Acumuladores (2006/66/CE) y/o la legislación nacional. Si aparece un símbolo químico bajo este icono, de acuerdo con la Directiva sobre Pilas y Acumuladores, significa que la pila o el acumulador contiene metales pesados (Hg = Mercurio, Cd = Cadmio, Pb = Plomo) en una concentración superior al límite especificado en dicha directiva. Este producto deberá entregarse en un punto de recogida designado, por ejemplo, entregándolo en el lugar de venta al adquirir un producto nuevo similar o en un centro autorizado para la recogida de residuos de aparatos eléctricos y electrónicos (RAEE), baterías y acumuladores. La gestión incorrecta de este tipo de residuos puede afectar al medio ambiente y a la salud humana debido a las sustancias potencialmente nocivas que suelen contener estos aparatos. Su cooperación en la correcta eliminación de este producto contribuirá al correcto aprovechamiento de los recursos naturales. Los usuarios tienen derecho a devolver pilas, acumuladores o baterías usados sin coste alguno. El precio de venta de pilas, acumuladores y baterías incluye el coste de la gestión medioambiental de su desecho, y no es necesario mostrar la cuantía de dicho coste en la información y la factura suministradas a los usuarios finales. Si desea más información sobre el reciclado de este producto, póngase en contacto con su municipio, el servicio o el organismo encargado de la gestión de residuos domésticos o visite www.canon-europe.com/weee, o www.canon-europe.com/battery.

Només per a la Unió Europea i a l’Espai Econòmic Europeu (Noruega, Islàndia i Liechtenstein)

Aquests símbols indican que aquest producte no s’ha de llençar amb les escombraries de la llar, d’acord amb la RAEE (2012/19/UE), la Directiva relativa a Pilas i acumuladors (2006/66/CE) i la legislació nacional que implementi aquestes directives. Si al costat d’aquest símbol hi apareix imprès un símbol químic, segons especifica la Directiva relativa a Pilas i acumuladors, significa que la bateria o l’acumulador conté un metall pesant (Hg = mercuri, Cd = cadmi, Pb = plom) en una concentració superior al límit aplicable especificat en la Directiva. Aquest producte s’hauria de lliurar en un dels punts de recollida designats, com per exemple, intercanviant un per un en comprar un producte similar o lliurant-lo en un lloc de recollida autoritzat per al reciclatge de residus d’aparells elèctrics i electrònics (RAEE) i piles i acumuladors. La manipulació inadequadament d’aquest tipus de residus podria tenir un impacte negatiu en l’entorn i en la salut humana, a causa de les substàncies potencialment perilloses que normalment estan associades a l’RAEE. La vostra cooperació a l’hora de rebutjar correctament aquest producte contribuirà a la utilització efectiva dels recursos naturals. Els usuaris tenen dret a retornar les bateries o els
acumuladors usats sense cap càrrec. El preu de venda de les bateries i els acumuladors inclou el cost de la gestió ambiental dels residus i no es necessària mostrar l’import d’aquest cost en aquest follet o en la factura que es liuré a l’usuari final. Per a més informació sobre el reciclatge d’aquest producte, contacteu amb l’oficina municipal, les autoritats encarregades dels residus, el pla de residus homologat o el servei de recollida d’escombraries domèstiques de la vostra localitat o visiteu www.canon-europe.com/weee, o www.canon-europe.com/battery.

**Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)**

Questi simboli indicano che il prodotto non può essere smaltito con i rifiuti domestici, ai sensi della Direttiva RAEE (2012/19/UE), della Direttiva sulle Batterie (2006/66/CE) e/o delle leggi nazionali che attuano tali Direttive. Se sotto il simbolo indicato sopra è riportato un simbolo chimico, in osservanza della Direttiva sulle batterie, tale simbolo indica la presenza di un metallo pesante (Hg = Mercurio, Cd = Cadmio, Pb = Piombo) nella batteria o nell’accumulatore con un livello di concentrazione superiore a una soglia applicabile specificata nella Direttiva sulle batterie. Il prodotto deve essere conferito a un punto di raccolta designato, ad esempio il rivenditore in caso di acquisto di un nuovo prodotto simile oppure un centro di raccolta autorizzato per il riciclaggio di rifiuti di apparecchiature elettriche ed elettroniche (RAEE) nonché di batterie e accumulatori. Un trattamento improprio di questo tipo di rifiuti può aver conseguenze negative sull'ambiente e sulla salute umana a causa delle sostanze potenzialmente nocive solitamente contenute in tali rifiuti. La collaborazione dell'utente per il corretto smaltimento di questo prodotto contribuirà a un utilizzo efficace delle risorse naturali ed eviterà di incorrere in sanzioni amministrative ai sensi dell'art. 255 e successivi del Decreto Legislativo n. 152/06. Per ulteriori informazioni sul riciclaggio di questo prodotto, contattare le autorità locali, l’ente responsabile della raccolta dei rifiuti, un rivenditore autorizzato o il servizio di raccolta dei rifiuti domestici, oppure visitare il sito www.canon-europe.com/weee, o www.canon-europe.com/battery.

**Apenas para a União Europeia e AEE (Noruega, Islândia e Liechtenstein)**

Estes símbolos indicam que este produto não deve ser eliminado juntamente com o seu lixo doméstico, segundo a Diretiva REEE de 2012/19/UE, a Diretiva de Baterias (2006/66/CE) e/ou a sua legislação nacional que transponha estas Diretivas. Se houver um símbolo químico impresso como mostrado abaixo, de acordo com a Diretiva de Baterias, isto indica que um metal pesado (Hg = Mercúrio, Cd = Cádmi, Pb = Chumbo) está presente nesta pilha ou acumulador, numa concentração acima de um limite aplicável especificado na Diretiva. Este produto deve ser entregue num ponto de recolha designado, por exemplo num local autorizado de troca quando compra um equipamento novo idêntico, ou num local de recolha autorizado para reciclar equipamento elétrico e eletrónico (EEE) em fim de vida, bem como pilhas e baterias. O tratamento inadequado deste tipo de resíduos pode ter um impacto negativo no ambiente e na saúde humana, devido a substâncias potencialmente perigosas que estão associadas com
equipamentos do tipo EEE. A sua cooperação no tratamento correto deste produto irá contribuir para a utilização mais eficaz dos recursos naturais. Para obter mais informações acerca de como reciclar este produto, por favor contacte as suas autoridades locais responsáveis pela matéria, serviço de recolha aprovado para pilhas e baterias ou serviço de recolha de resíduos sólidos domésticos da sua municipalidade, ou visite www.canon-europe.com/weee, ou www.canon-europe.com/battery.

**Gælder kun i Europæiske Union og EØS (Norge, Island og Liechtenstein)**


**Μόνο για την Ευρωπαϊκή Ένωση και τον ΕΟΧ (Νορβηγία, Ισλανδία και Λιχτενστάιν)**

Αυτά τα σύμβολα υποδεικνύουν ότι αυτό το προϊόν δεν πρέπει να απορρίπτεται μαζί με τα οικιακά απορρίμματα, σύμφωνα με την Οδηγία για τα Απόβλητα Ηλεκτρικού και Ηλεκτρονικού Εξοπλισμού (AHHE) (2012/19/ΕΕ), την Οδηγία για τις Ηλεκτρικές Στήλες (2006/66/ΕΚ) ή/και την εθνική νομοθεσία που εφαρμόζει οι Οδηγίες εκείνες. Εάν κάποιο χημικό σύμβολο είναι τυπωμένο κάτω από το σύμβολο που φαίνεται παραπάνω, σύμφωνα με την Οδηγία για τις Ηλεκτρικές Στήλες, υποδηλώνει ότι κάποιο βαρύ μέταλλο (Hg = Υδράργυρος, Cd = Κάδμιο, Pb = Μόλυβδος) υπάρχει στην μπαταρία ή τον συσσωρευτή σε συγκέντρωση μεγαλύτερη από το ισχύον επίπεδο που καθορίζεται στην Οδηγία για τις Ηλεκτρικές Στήλες. Αυτό το προϊόν πρέπει να παραδίδεται σε καθορισμένο σημείο συλλογής, π.χ. σε μια εξουσιοδοτημένη βάση ανταλλαγής ή σε μια εξουσιοδοτημένη θέση συλλογής για την ανακύκλωση των αποβλήτων ηλεκτρικού και ηλεκτρονικού εξοπλισμού (ΗΗΕ) και των ηλεκτρικών στηλών και συσσωρευτών. Ο ακατάλληλος χειρισμός αυτού του τύπου αποβλήτων μπορεί να έχει αρνητικό αντίκτυπο στο περιβάλλον και την υγεία του ανθρώπου, λόγω δυνητικά επικίνδυνων ουσιών που
γενικά συνδέονται με τον HHE. Η συνεργασία σας για τη σωστή απόρριψη αυτού του προϊόντος θα συμβάλει στην αποτελεσματική χρήση των φυσικών πόρων. Για περισσότερες πληροφορίες σχετικά με ανακύκλωση αυτού του προϊόντος, επικοινωνήστε με το τοπικό γραφείο της πόλης σας, την υπηρεσία απορριμμάτων, το εγκεκριμένο σχήμα ή την υπηρεσία απόρριψης οικιακών αποβλήτων ή επισκεφθείτε τη διεύθυνση www.canon-europe.com/weee ή www.canon-europe.com/battery.

Gjelder kun den europeiske union og EØS (Norge, Island og Liechtenstein)


Vain Euroopan unionin sekä ETA:n (Norja, Islanti ja Liechtenstein) alueelle.

Endast för Europeiska unionen och EES (Norge, Island och Liechtenstein)


Pouze Evropská unie a EHP (Norsko, Island a Lichtenštejnsko)

Tento symbol znamená, že podle směrnice OEEZ (2012/19/EU), směrnice o bateriích (2006/66/ES) a/ nebo podle vnitrostátních právních prováděcích předpisů k těmto směrnicím nemá být tento výrobek likvidován s odpadem z domácností. Je-li v souladu s požadavky směrnice o bateriích vytištěna pod výše uvedeným symbolem chemická značka, udává, že tato baterie nebo akumulátor obsahuje těžké kovy (Hg = rtuť, Cd = kadmium, Pb = olovo) v koncentracii vyšší, než je příslušná hodnota předepsaná směrnicí. Tento výrobek má být vrácen do určeného sběrného místa, např. v rámci autorizovaného systému odběru jednoho výrobku za jeden nově prodaný podobný výrobek, nebo do autorizovaného sběrného místa pro recyklaci odpadních elektrických a elektronických zařízení (OEEZ), baterií a akumulátorů. Nevhodné nakládání s tímto druhem odpadu by mohlo mít negativní dopad na životní prostředí a lidské zdraví, protože elektrická a elektronická zařízení zpravidla obsahují potenciálně nebezpečné látky. Vaše spolupráce na správné likvidaci tohoto výrobku napomůže efektivnímu využívání přírodních zdrojů. Chcete-li získat podrobné informace týkající se recyklace tohoto výrobku, obraťte se prosím na místní úřad, orgán pro nakládání s odpady, schválený systém nakládání s odpady či společnost zajíždějící likvidaci domovního odpadu, nebo navštivte webové stránky www.canon-europe.com/weee nebo www.canon-europe.com/battery.
Csak az Európai Unió és az EGT (Norvégia, Izland és Liechtenstein) országaiban

Ezek a szimbólumok azt jelzik, hogy a termék hulladékkezelése a háztartási hulladéktól különválasztva, az elektromos és elektronikus berendezések hulladékairól (WEEE) szóló (2012/19/EU) irányelvnek és az elemekről és akkumulátorokról, valamint a hulladék elemekről és akkumulátorokról szóló (2006/66/EK) irányelvnek megfelelően és/vagy ezen irányelveknek megfelelő helyi előírások szerint történik.

Amennyiben a fent feltüntetett szimbólum alatt egy vegyjel is szerepel, az elemekről és akkumulátorokról szóló irányelvben foglaltak értelmében ez azt jelzi, hogy az elem vagy az akkumulátor az irányelvben meghatározott határértéknél nagyobb mennyiségben tartalmaz nehézfémeket (Hg = higany, Cd = kadmium, Pb = ólom). E terméket az arra kijelölt gyűjtőhelyre kell juttatni – pl. hasonló termék vásárlásakor a régi betezésére vonatkozó hivatalos program keretében, vagy az elektromos és elektronikus berendezések (EEE) hulladékainak gyűjtésére, valamint a hulladék elemek és hulladék akkumulátorok gyűjtésére kijelölt hivatalos gyűjtőhelyre. Az ilyen jellegű hulladékok nem előírásszerű kezelése az elektromos és elektronikus berendezésekhez (EEE) általánosan kapcsolható potenciálisan veszélyes anyagok révén hatással lehet a környezetre és az egészségre. E termék megfelelő leszejtésével Ön is hozzájárul a természeti források hatékony használatához. A termék újrahasznosítását illetően informálódjon a helyi polgármesteri hivatalnál, a helyi közterület-fenntartó vállalatnál, a hivatalos hulladéklerakó telephelyen vagy a háztartási hulladék begyűjtését végző szolgáltatónál, illetve látogasson el a www.canon-europe.com/weee, vagy www.canon-europe.com/battery internetes oldalra.

Tylko dla krajów Unii Europejskiej oraz EOG (Norwegia, Islandia i Liechtenstein)

Te symbole oznaczają, że produktu nie należy wyrzucać razem z odpadami gospodarstwa domowego, zgodnie z dyrektywą WEEE w sprawie zużytego sprzętu elektrycznego i elektronicznego (2012/19/UE) lub dyrektywą w sprawie baterii (2006/66/WE) bądź przepisami krajowymi wdrażającymi te dyrektywy. Jeśli pod powyższym symbolem znajduje się symbol chemiczny, zgodnie z dyrektywą w sprawie baterii oznacza to, że bateria lub akumulator zawiera metal ciężki (Hg = rtęć, Cd = kadm, Pb = ólom) w stężeniu przekraczającym odpowiedni poziom określony w dyrektywie w sprawie baterii. Użytkownicy baterii i akumulatorów mają obowiązek korzystać z dostępnego programu zwrotu, recyklingu i utylizacji baterii oraz akumulatorów. Niewłaściwe postępowanie z tego typu odpadami może mieć wpływ na środowisko i zdrowie ludzi ze względu na substancje potencjalnie niebezpieczne, związane ze zużytym sprzętem elektrycznym i elektronicznym. Państwa współpraca w zakresie właściwej utylizacji tego produktu przyczyni się do efektywnego wykorzystania zasobów naturalnych. W celu uzyskania informacji o sposobie recyklingu tego produktu prosimy o kontakt z właściwym urzędem miejskim lub zakładem gospodarki komunalnej bądź zapraszamy na stronę www.canon-europe.com/weee, lub www.canon-europe.com/battery.
Platí len pre štáty Európskej únie a EHP (Nórsko, Island a Lichtenštajnsko)

Tieto symboly označujú, že podľa Smernice o odpade z elektrických a elektronických zariadení (OEEZ) 2012/19/EÚ, Smernice o batériách (2006/66/ES) a podľa platnej legislatívy Slovenskej republiky sa tento produkt nesmie likvidovať spolu s komunálnym odpadom. Ak je chemická značka vytlačená pod vyššie uvedeným symbolom, znamená to, že tato batéria alebo akumulátor obsahuje tăžký kov (Hg = ortuť, Cd = kadmiu, Pb = olovo) v koncentrácií vyššej, ako je príslušná povolená hodnota stanovená v Smernici o batériách. Produkt je potrebné odovzdať do určenej zberne, napr. prostredníctvom výmeny za kúpu nového podobného produktu, alebo na autorizované zberné miesto, ktoré správne odpad z elektrických a elektronických zariadení (EEZ), batérií a akumulátorov. Nesprávna manipulácia s takýmto typom odpadu môže mať negatívny vplyv na životné prostredie a ľudské zdravie, pretože elektrické a elektronické zariadenia obsahujú potenciálne nebezpečné látky. Spoluprácou na správnej likvidácii tohto produktu prispejete k účinnému využívaniu prírodných zdrojov. Ďalšie informácie o recyklácii tohto produktu získate od miestneho úradu, úradu životného prostredia, zo schváleného plánu OEEZ alebo od spoločnosti, ktorá zaisťuje likvidáciu komunálneho odpadu. Viac informácií nájdete aj na webovej stránke: www.canon-europe.com/weee, alebo www.canon-europe.com/battery.

Üksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)

Samo za Evropsko unijo in EGP (Norveška, Islandija in Lihtenštajn)


Само за Европейския съюз и ЕИП (Норвегия, Исландия и Лихтенщайн)

Тези символи показват, че този продукт не трябва да се изхвърля заедно с битовите отпадъци съгласно Директивата за ИУЕЕО (2012/19/EC), Директивата за батерии (2006/66/ЕО) и/или Вашето национално законодателство, прилагащо тези Директиви. Ако под показания горе символ е отпечатан символ за химически елемент, съгласно разпоредбите на Директивата за батерии, този втори символ означава наличието на тежък метал (Hg = живак, Cd = кадмий, Pb = олово) в батерията или акумулатора в концентрация над указаната граница за съответния елемент в Директивата. Този продукт трябва да бъде предаден в предназначен за целта пункт за събиране, например на база размяна, когато купувате нов подобен продукт, или в одобрен събирателен пункт за рециклиране на излязло от употреба електрическо и електронно оборудване (ИУЕЕО), батерии и акумулатори. Неправилното третиране на този тип отпадъци може да доведе до евентуални отрицателни последствия за околната среда и човешкото здраве поради потенциално опасните вещества, които обикновено са свързани с ЕЕО. В същото време Вашето съдействие за правилното изхвърляне на този продукт ще допринесе за ефективното използване на природните ресурси. За повече информация относно това къде можете да предадете за рециклиране на този продукт, моля свържете се с Вашието местни власти, с органа, отговорен за отпадъците, с одобренията система за ИУЕЕО или с Вашата местна служба за битови отпадъци, или посетете www.canon-europe.com/weee, или www.canon-europe.com/battery.
Doar pentru Uniunea Europeană și EEA (Norvegia, Islanda și Liechtenstein)

Aceste simboluri indică faptul că acest produs nu trebuie aruncat împreună cu deșeurile menajere, în conformitate cu Directiva DEEE (2012/19/UE), Directiva referitoare la baterii (2006/66/CE) și/sau legile dvs. naționale ce implementează aceste Directive. Dacă un simbol chimic este imprimat sub simbolul de mai sus, în conformitate cu Directiva referitoare la baterii, acest simbol indică prezența în baterie sau acumulator a unui metal greu (Hg = Mercur, Cd = Cadmiu, Pb = Plumb) într-o concentrație mai mare decât pragul admis specificat în Directiva referitoare la baterii. Acest produs trebuie înmânat punctului de colectare adecvat, ex: printr-un schimb autorizat unu la unu atunci când cumpărați un produs nou similar sau la un loc de colectare autorizat pentru reciclarea reziduurilor de echipament electric și electronic (EEE) și baterii și acumulatori. Administrarea neadecvată a acestui tip de deșeuri, ar putea avea un impact asupra mediului și asupra sănătății umane datorită substanțelor cu potențial de risc care sunt în general asociate cu EEE. Cooperarea dvs. în direcția reciclării correcte a acestui produs va contribui la o utilizare eficientă a resurselor naturale. Pentru mai multe informații despre reciclarea acestui produs, vă rugăm să contactați biroul dvs. local, autoritățile responsabile cu deșeurile, schema aprobată sau serviciul dvs. responsabil cu deșeurile menajere sau vizitați-ne la www.canon-europe.com/weee, sau www.canon-europe.com/battery.

Samo za Europsku uniju i EEA (Norveška, Island i Lihtenštajn)

Oznaka pokazuje da se ovaj proizvod ne smije odlagati s komunalnim i ostalim vrstama otpada, u skladu s direktivom WEEE (2012/19/EC), Direktivom o baterijama (2006/66/EC) i Pravilnikom o gospodarenju otpadnim baterijama i akumulatorima te Pravilnikom o gospodarenju otpadnim električnim i elektroničkim uređajima i opremom. Ako je ispod prethodno prikazane oznake otisnut kemijski simbol, u skladu s Direktivom o baterijama, to znači da se u ovoj bateriji ili akumulatoru nalazi teški metal (Hg = živa, Cd = kadmij, Pb = olovo) i da je njegova koncentracija iznad razine propisane u Direktivi o baterijama. Ovaj bi proizvod trebalo predati ovlaštenom skupljaču EE otpada ili prodavatelju koji je dužan preuzeti otpadni proizvod po sistemu jedan za jedan, ukoliko isti odgovara vrsti te je obavljao primarne funkcije kao i isporučena EE oprema. Otpadne baterije i akumulatori predaju se ovlaštenom skupljaču otpadnih baterija ili akumulatora ili prodavatelju bez naknade i obveze kupnje za krajnjeg korisnika. Neodgovarajuće rukovanje ovom vrstom otpada može utjecati na okoliš i ljudsko zdravlje zbog potencijalno opasnih supstanci koje se najčešće nalaze na takvim mjestima. Vaša suradnja u pravilnom zbrinjavanju ovog proizvoda pridonijet će djelotvornom iskorištavanju prirodnih resursa. Dodatne informacije o recikliranju ovog proizvoda zatražite od svog lokalnog gradskog ureda, službe za zbrinjavanje otpada, odobrenog programa ili komunalne službe za uklanjanje otpada ili pak na stranicama www.canon-europe.com/weee ili www.canon-europe.com/battery.
Korisnici u Srbiji

When Repairing, Lending, or Disposing of the Printer

If you have entered personal data, passwords and/or other security settings on the printer, such information may be stored in the printer.

When sending the printer for repair, lending or transferring the printer to another person, or disposing of the printer, please be sure to follow the steps below in order to delete such information and prevent third parties from accessing it.

- **Initializing network settings**

  (Setup) > Device settings > LAN settings > Wi-Fi / Wireless Direct / Wired LAN > Settings > Advanced > Reset LAN settings > Yes

- **Initializing SSL information**

  (Setup) > Device settings > LAN settings > Wi-Fi / Wireless Direct / Wired LAN > Settings > Advanced > Reset SSL certificates > Yes

- **Deleting the administrator password**

  (Setup) > Device settings > Administrator password setting > Enter the administrator password > OK > Remove administrator password > Yes > OK
Screenshots in This Manual

For Windows:
The screenshots used in this manual are the screens that appear when the operating system Windows 10 is used.

For macOS:
The screenshots used in this manual are the screens that appear when the operating system macOS Mojave 10.14 is used.
Basic Printing Workflow

- Printing procedure
- Canceling print jobs
- Pausing Printing
Printing procedure

- Printing Options Using Rolls and Sheets
- Turning the Printer On and Off
- Loading and Printing on Rolls
- Loading and Printing on Sheets
- Printing in Windows
- Printing from macOS
Printing Options Using Rolls and Sheets

The printer supports both rolls and sheets.

This section introduces the main features of each, as well as the main printing methods available. Select rolls or sheets to suit your particular printing application.

Note

• For information on the types of paper the printer supports, see "Types of Paper."

• A variety of other ways to print are available besides those introduced here. For details, see "Enhanced Printing Options."

Roll printing

Media in spooled rolls is generally called Roll Media. Rolls are loaded on the roll holder, which are in turn loaded in the printer.

Rolls can be used to print large photos or create posters or banners that cannot be printed on regular sheets.

• Large-format printing
  
  Easily print vertical or horizontal banners from familiar applications such as Microsoft Office applications.
  
  (See "Printing Hanging and Horizontal Banners (Large-Format Printing)" (Windows.).)
  
  (See "Printing Hanging and Horizontal Banners (Large-Format Printing)" (macOS.).)

• Borderless printing
  
  Print without a margin (border) around posters or photos.
  
  (See "Printing without Edges Based on the Scenarios" (Windows.).)
  
  (See "Printing without Edges Based on the Scenarios" (macOS.).)

• Banner printing
  
  You can print multiple pages as a single continuous image, without margins between pages.
  
  (See "Printing by Connecting Multiple Pages" (Windows.).)
  
  (See "Printing by Connecting Multiple Pages" (macOS.).)

• 90-degree rotation before printing
  
  Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.
  
  (See "Saving Roll Paper by Rotating Document 90 Degrees" (Windows.).)
  
  (See "Saving Roll Paper by Rotating Document 90 Degrees" (macOS.).)

• Enlarged/reduced printing
  
  You can freely adjust the size of originals by enlarging or reducing originals before printing.
  
  (See "Scaled Printing" (Windows.).)
  
  (See "Scaled Printing" (macOS.).)
• imagePROGRAF Free Layout (Windows), imagePROGRAF Free Layout (macOS) and Free Layout plus (Windows)

Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so on) next to each other.

(See "Lining Up and Printing Multiple Documents" (Windows).)
(See "Lining Up and Printing Multiple Documents" (macOS).)

Sheet printing

Sheets refer to individual sheets of paper.

Insert the sheet between the platen and the paper retainer.

• Enlarged/reduced printing

You can freely adjust the size of originals by enlarging or reducing originals before printing.

(See "Scaled Printing" (Windows).)
(See "Scaled Printing" (macOS).)

• imagePROGRAF Free Layout (Windows) and imagePROGRAF Free Layout (macOS)

Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so on) next to each other.

(See "Lining Up and Printing Multiple Documents" (Windows).)
(See "Lining Up and Printing Multiple Documents" (macOS).)
Turning the Printer On and Off

Turning the printer on

1. Press ON button to turn on printer.

   The ON button lights up and the printer will now start up.
   The Canon logo appears on the operation panel, and then "Starting the system...Please wait momentarily" appears.

When startup is finished, the printer enters standby mode.

The printer will not enter standby mode in the following situations. Take action as necessary.

- **The top cover is open**
  Close the top cover.

- **The ink tank cover is open**
  Close the ink tank cover.

- **The print head is not installed**
  ➤ [Replacing the Print Head](#)
• The ink tank is not installed
  ➡️ Replacing Ink Tanks

• If "Error" is shown on the operation panel
  Check the message on the operation panel and take action as necessary.

• The ON button and Status lamp never light up, and nothing appears on the operation panel
  Check the connection at the plug and electrical outlet.

## Turning the printer off

### Important

• Never disconnect the printer's power supply or unplug it during a print job. This may damage the printer.

1. Make sure no print jobs are in progress.
   While the Status lamp is flashing, the printer is running. The color of the lamp indicates the following states.

   ![Status lamp flashing](image)

   If the Status lamp is flashing orange, check the message on the operation panel and take action as necessary.
   If the Status lamp is flashing white, the printer is printing, receiving data, etc. Turn off the power after the Status lamp turns off.

2. Hold down the ON button for more than a second.

   ![Hold down ON button](image)

   "Ending... Please wait momentarily" appears on the operation panel, and the printer turns off.
Loading and Printing on Rolls

These are the basic steps for loading and printing on rolls.

Follow these steps to load and print on rolls.

**Note**

- For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information List".
- To wait until the ink dries after printing before cutting the roll, set Drying Time in the printer driver. (See "Specifying the Ink Drying Time for Rolls.")
- Once you have used all the paper on a roll, clean the platen. If the platen inside the top cover becomes dirty, it may soil the underside of paper. (See "Cleaning Inside the Top Cover.").

1. Turn the printer on. (See "Turning the Printer On and Off.")

2. Load a roll on the roll holder. (See "Loading Rolls on the Roll Holder.")

3. Load the Roll Media in the printer. (See "Loading Rolls in the Printer")
4. Select the type of paper. (See "Changing the Type of Paper.")

Note

- If no barcode has been printed on the roll paper and you have set Manage remaining roll amount to Barcodes, specify the roll length after selecting the media type. (See "Specifying the Paper Length.")

5. Complete settings in the printer driver for the type of paper and other details.

- How to Open the Printer Driver Setup Window (Windows)
- How to Open the Printer Driver Setup Dialog (macOS)
6. Send the print job.

- Printing in Windows
- Printing from macOS

Start printing.

>>> Important

- Do not move the release lever during printing.
Loading and Printing on Sheets

These are the basic steps for loading sheets and then printing.

Follow the steps below to load and print on sheets.

Note

- For details on paper sizes and types that can be loaded, see "Paper Sizes" or "Paper Information List".
- Borderless printing is not supported on sheets. For the features and the main printing methods available for sheet printing, see "Printing Options Using Rolls and Sheets."

1. Turn the printer on. (See "Turning the Printer On and Off.")

2. Complete settings in the printer driver for the type of paper and other details.
   - How to Open the Printer Driver Setup Window (Windows)
   - How to Open the Printer Driver Setup Dialog (macOS)
3. Send the print job.
   - Printing in Windows
   - Printing from macOS

4. Load the sheet. (See "Loading Sheets in the Printer."

Start printing.

**Important**

- Do not move the release lever until instructions (guidance) for removing the paper are displayed. Moving the release lever during printing will cause printing to stop.
Printing in Windows

Print from the application menu.

**Important**

- We recommend exiting unnecessary applications before printing. Running several applications while printing may interrupt the transfer of print data and affect printing quality.

1. In the source application, select **Print** from the **File** menu to display the dialog box for printing conditions.

2. After confirming that the printer is selected in the dialog box, click **Print** or **OK** to start printing.

**Note**

- The appearance of the dialog box varies depending on the software application. In most cases, the dialog box includes basic printing options and enables you to choose the printer, specify the range of pages, number of copies, and so on.

Example: Print dialog box displayed by the application

- If another printer is selected, select the printer you want to use under **Select Printer** or in the dialog box displayed after clicking **Printer**.
You can use the printer driver dialog box to configure various printing settings such as for enlarged or reduced printing and borderless printing. You can open the printer driver dialog box from the application software or from the operating system menu. For details, see "How to Open the Printer Driver Setup Window" (Windows) or "How to Open the Printer Driver Setup Dialog" (macOS).
Printing from macOS

Print from the application menu after registering the printer.

**Important**

- We recommend exiting unnecessary applications before printing. Running several applications while printing may interrupt the transfer of print data and affect printing quality.

Registering the printer

The printer needs to be registered in **Print & Scan** (identified as Printers & Scanners or **Print & Fax** in other versions of macOS X) in **System Preferences** before printing.

For instructions on registering printers, see "Sharing the Printer on a Network (macOS)."

**Important**

- During this setup process, the printer will not be listed among available printers if it is off or disconnected.

Printing from the application software

1. In the application software, select **Print** from the **File** menu to display the dialog box for printing conditions.

**Note**

- This dialog box includes basic printing options and enables you to choose the printer, specify the range of pages, number of copies, and so on.

2. Select the printer in the **Printer** list.

3. Click **Print** to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete settings for various methods of printing, including enlarged and reduced printing, borderless printing, and so on.
Canceling print jobs

- Canceling Print Jobs from the Operation Panel
- Canceling Print Jobs from Windows
- Canceling Print Jobs from macOS
Canceling Print Jobs from the Operation Panel

To cancel printing or reception of print jobs, press the Stop button on the operation panel.

When you press the Stop button during printing, the printer operation varies depending on the current status.

- **You press the Stop button before printing starts**
  
  Pressing the Stop button before printing starts displays a confirmation message. To cancel the print job, select Yes.

- **You press the Stop button during printing**

  Pressing the Stop button during printing displays a confirmation message. To cancel the print job immediately, select Yes.
Canceling Print Jobs from Windows

In the printer window, you can cancel jobs that are being sent to the printer.

Using CanonIJ Status Monitor, you can cancel print jobs that have already been received by the printer or that are currently being printed.

1. Click the printer icon in the taskbar to display the printer window.
   
   **Note**
   
   • You can proceed from the folder for configuring the printer settings in the OS you are using. For example, in Windows 7, open the **Devices and Printers** window from the **start** menu and double-click the printer icon.

2. Right-click the job to cancel and select Cancel.

3. If job to be canceled is not shown in printer window (that is, if print data has already been received by printer), click taskbar icon to display CanonIJ Status Monitor.

4. Click **Cancel Printing**.
Note

- The screen may differ slightly depending on the model you are using.
Canceling Print Jobs from macOS

In the printer window, you can cancel jobs that are being sent to the printer.

>>> Note
- Print jobs are shown in the printer window while they are being sent from the computer. After transmission, jobs are not displayed even during printing.

1. Click the printer icon in the Dock to display the printer window.

2. Either click × for the job to cancel printing or select the job to cancel printing and then click Delete to delete the job.

>>> Note
- If the job to be canceled is not shown in the printer window (that is, if the print data has already been received by the printer), you can cancel printing from the operation panel on the printer or from RemoteUI. For details, "Canceling Print Jobs from the Operation Panel" or see "Configuration Changes Using Web Browser."
Pausing Printing

> Pausing Printing
Pausing Printing

During printing, if you set Pause printing to Enable, the printer enters a state in which printing is paused, after the completion of the printing process when this setting was made.

Printing from the job queue is not possible in this state.

To restore normal operation after pausing printing, set Pause printing to Disable.

**Note**

- In the following cases, the status is cleared even if you do not set Pause printing to Disable, and printing from the job queue resumes.
  - When paper is advanced
  - If you changed the media type from the paper settings display area

1. Tap (Jobs) on Home screen during printing.

   ![Printing Screen]

   **Note**
   
   - If the Home screen does not appear, press the HOME button.

2. Tap Pause printing.

3. Tap Enable or Disable.
Enhanced Printing Options

➤ **Printing from Your Computer (Windows)**

- **Printing with Easy Setup**
  - Changing the Type of Paper
- Setting the Number of Copies and Printing Order
- **Printing Photos and Business Documents**
  - Printing By Setting Print Purpose
  - Edit in PosterArtist and Print
- **Printing CAD Drawings**
  - Printing By Setting Print Purpose
  - Printing from AutoCAD
- **Changing the Print Quality and Correcting Image Data**
  - Adjusting Color Balance
  - Setting the Print Quality Level (Custom)
  - Printing a Color Document in Monochrome
  - Specifying Color Correction
    - Optimal Photo Printing of Image Data
    - Adjusting Colors with the Printer Driver
    - Printing with ICC Profiles
  - Adjusting Brightness
  - Adjusting Contrast
  - Printing Using Detailed Setting Mode
- **Scaled Printing**
- **Printing to Oversized Paper Sizes**
- **Setting Paper Dimensions (Custom Size)**
- **Set a Custom Size Roll Width**
- **Printing without Edges Based on the Scenarios**
  - Printing without Margins to Match Paper Size
- Printing without Margins to Match Roll Paper Width
- Printing Full-Size without Margins
- Three-sided Borderless Printing on Roll Paper

- Printing Hanging and Horizontal Banners (Large-Format Printing)

- Printing by Dividing/Joining Documents
  - Inputting Multiple-file Documents into Free Layout plus
  - Lining Up and Printing Multiple Documents to Cut Sheets
  - Printing by Connecting Multiple Pages
  - Printing Multiple Pages All on One Page
  - Dividing and Printing Posters

- Printing Document in Center of Paper

- Printing by Saving Roll Paper
  - Saving Roll Paper by Rotating Document 90 Degrees
  - Saving Roll Paper by Eliminating Upper and Lower Margins on Document

- Switching the Paper Source to Match the Purpose

- Displaying the Print Results before Printing

- Other Convenient Settings
  - Stamp Printing
    - Registering a Stamp
  - Setting a Page Size and Orientation
  - Registering a Frequently Used Printing Profile
  - Cutting Roll Paper after Printing

- Printing from Computer (macOS)
  - Printing with Easy Setup 💻Basics
    - Changing the Type of Paper
  - Setting the Number of Copies and Printing Order
  - Changing the Print Quality and Correcting Image Data
    - Adjusting Color Balance
    - Setting the Print Quality Level (Custom)
Printing a Color Document in Monochrome

Specifying Color Correction

- Optimal Photo Printing of Image Data
- Adjusting Colors with the Printer Driver
- Printing with ICC Profiles (Specifying an ICC Profile from the Application Software)
- Printing with ICC Profiles (Specifying an ICC Profile from the Printer Driver)

- Adjusting Brightness
- Adjusting Contrast

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Set a Custom Size Roll Width

Print Area

Printing without Edges Based on the Scenarios

- Printing without Margins to Match Roll Paper Width
- Printing Full-Size without Margins
- Three-sided Borderless Printing on Roll Paper

Printing Hanging and Horizontal Banners (Large-Format Printing)

Printing by Dividing/Joining Documents

- Lining Up and Printing Multiple Documents
- Printing by Connecting Multiple Pages
- Printing Multiple Pages All on One Page

Printing Document in Center of Paper

Printing by Saving Roll Paper

- Saving Roll Paper by Rotating Document 90 Degrees
- Saving Roll Paper by Eliminating Upper and Lower Margins on Document

Switching the Paper Source to Match the Purpose

Cutting Roll Paper after Printing

Printing Using AirPrint
➤ HP-GL/2 Printing

➤ Printing from Smartphone/Tablet

  - Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)
  - Printing from iOS Device (AirPrint)
Printing from Your Computer (Windows)

- Printing with Easy Setup
- Setting the Number of Copies and Printing Order
- Printing Photos and Business Documents
- Printing CAD Drawings
- Changing the Print Quality and Correcting Image Data
- Scaled Printing
- Printing to Oversized Paper Sizes
- Setting Paper Dimensions (Custom Size)
- Prints without Edges Based on the Scenarios
- Printing Hanging and Horizontal Banners (Large-Format Printing)
- Printing by Dividing/Joining Documents
- Printing Document in Center of Paper
- Printing by Saving Roll Paper
- Set a Custom Size Roll Width
- Switching the Paper Source to Match the Purpose
- Displaying the Print Results before Printing
- Other Convenient Settings
This section describes the simple setting procedure so that you can carry out appropriate printing on this printer.

1. **Check that printer is turned on**

2. **Load paper on the printer**  
   Set roll paper or cut paper to a printer.

3. **Open the printer driver setup window**

4. **Select the media type**

   Select the type of paper loaded in the printer from the **Media Type** list on the **Main** tab.  
   If **Auto (Use Printer Settings)** is selected, the paper configured in printer settings is printed.

   ![Image of printer driver setup window]

   **Important**
   
   - See "Paper Information List" for Canon authentic paper or Canon output check paper.

   **Note**
   
   - Click **Get Information...** to display the **Paper Information on Printer** dialog box. The **Paper Information on Printer** dialog box allows you to get the paper information from the printer and to set the paper source and the media type on the printer driver.
   
   - For instructions on changing the media type from the printer’s operation panel, see "Changing the Type of Paper."
5. Select print target

From the pull-down menu, select **Easy Settings**, and then select the setting that matches your purpose from the **Print Target** list.

6. Select the print quality

For **Print Quality**, select **High**, **Standard** or **Fast** according to your purpose.

---

**Important**

- The print quality settings that can be selected may differ depending on a printing profile.

7. Select the paper size
From the **Page Size** list on the **Page Setup** tab, select the same size as that of the document that was created with the application software.

8. Select the paper source

   For **Paper Source**, select the setting that matches your purpose.

9. Select roll paper width

   If you selected a roll paper for **Paper Source**, set **Roll Paper Width** to the width of the roll paper loaded in the printer.
10. Complete the setup

Click OK.

When you execute print, the document is printed with settings that match your purpose.

⚠️ Note

- If the paper settings in the printer driver differ from the paper information registered on the printer, an error message may appear on the printer's operation panel. You can execute Print, but you may not obtain the correct printing result.

Checking Printer Settings and Applying Settings to Printer Driver

1. Open printer driver setup window
2. Click **Get Information...** on **Main** tab

   The **Paper Information on Printer** dialog box appears.

3. Select the paper source

   From **Paper Source**, check the setting or select a new paper source.
   The current printer settings appear in **Media Type** and **Roll Width**.

4. Apply settings

   To apply the printer settings to the printer driver, click **OK**.

   **Note**

   - If the media type and the output paper size are not set on the printer, **OK** will be grayed out and cannot be clicked.
   - If communication with the printer is disabled, the **Get Information...** does not appear or printer media information from the printer cannot be obtained.
Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window

2. Specify the number of copies to be printed
   For Copies on the Layout tab, specify the number of copies to be printed.

3. Specify the print order
   Check the Print from Last Page check box when you want to print from the last page in order, and uncheck the check box when you want to print from the first page.
   Check the Collate check box when you are printing two or more copies, and want to print them in groups, and uncheck the check box when you want to print them as a group on the same page.

4. Complete the setup
   Click OK.
   When you execute print, the specified number of copies will be printed with the specified printing order.

**Important**

- When the application software that you used to create the document has the same function, specify the settings on the printer driver. However, if the print results are not acceptable, specify the function settings on the application software. When you specify the number of copies and the printing order with both the application software and this printer driver, the number of copies may be multiplied numbers of the two settings or the specified printing order may not be enabled.
Printing Photos and Business Documents

- Printing By Setting Print Purpose
- Edit in PosterArtist and Print
Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type
   Select the type of paper loaded in the printer from the Media Type list on the Main tab. If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select print setting mode
   From the pull-down menu, select Easy Settings.
4. Select print purpose

For Print Target, select the setting that matches the document.

**Default Settings**
Select this setting to print a general document such as an business documents.

**Photo (Color)**
Select this setting to print a color illustration or a photo.

**Poster**
Select this setting to print a poster.

**CAD (Color Line Drawing)**
Select when printing data such as drawings.

**CAD Monochrome**
Select when printing data such as drawings in monochrome.

**Perspective, GIS**
Select when printing data such as perspectives and GIS.

**Note**
- To check the settings of the items that are set by Print Target, click View Settings.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was created with the application software.

The current settings are displayed in the settings preview on the left side of the window.
6. Select the paper source
   For **Paper Source**, select the setting that matches your purpose.

   **Important**
   - The paper feed method will differ according to the paper settings.

7. Set the other items
   Set the other items as necessary.

8. Complete the setup
   Click **OK**.
   When you print, the document is printed to match the specified print purpose.
Edit in PosterArtist and Print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited and printed from PosterArtist.

The following explains the procedure for editing original documents made in multiple application software in PosterArtist and printing in a poster layout.

1. Open Printer Driver Settings Screen

2. Select edit in PosterArtist

   Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.

![Printer Driver Settings Screen]

   • Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist

   Click OK.

   When printing is executed, PosterArtist starts up and PageCapture window opens.

4. Select page to get in PosterArtist

5. Edit page in PosterArtist

   Image editing and sorting is implemented in PosterArtist.

   By repeating steps 1 through 4 without closing the PosterArtist window, documents made in multiple application software can be arranged on one page.

   After editing is complete, please print from PosterArtist menu.

   498
Note

- For instructions on how to edit and rearrange images, refer to the PosterArtist manual.
Printing CAD Drawings

- Printing By Setting Print Purpose
- Printing from AutoCAD
Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the **printer driver setup window**

2. Select the media type

Select the type of paper loaded in the printer from the *Media Type* list on the *Main* tab. If *Auto (Use Printer Settings)* is selected, the paper configured in printer settings is printed.

3. Select print setting mode

From the pull-down menu, select *Easy Settings*. 

![Printer Driver Setup Window](image-url)
4. Select print purpose

For **Print Target**, select the setting that matches the document.

**Default Settings**
Select this setting to print a general document such as an business documents.

**Photo (Color)**
Select this setting to print a color illustration or a photo.

**Poster**
Select this setting to print a poster.

**CAD (Color Line Drawing)**
Select when printing data such as drawings.

**CAD Monochrome**
Select when printing data such as drawings in monochrome.

**Perspective, GIS**
Select when printing data such as perspectives and GIS.

**Note**
- To check the settings of the items that are set by **Print Target**, click **View Settings**.

5. Select the paper size

From the **Page Size** list on the **Page Setup** tab, select the same size as that of the document that was created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
6. Select the paper source

For **Paper Source**, select the setting that matches your purpose.

**Important**

- The paper feed method will differ according to the paper settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click **OK**.

When you print, the document is printed to match the specified print purpose.
Printing from AutoCAD

Printer Driver Optimization Module for AutoCAD is software for printing optimally from AutoCAD with the printer driver.

By optimally controlling the processing resolution of raster data and the memory to be used in image processing of AutoCAD, printing superior in reliability and productivity is realized.

If you install Printer Driver Optimization Module for AutoCAD on a computer on which supported AutoCAD is installed, it will be installed automatically.

Note

- Printer Driver Optimization Module for AutoCAD is applied automatically when you print from AutoCAD, and optimal printing is performed.

Confirming the Installation of Printer Driver Optimization Module for AutoCAD

You can confirm whether Printer Driver Optimization Module for AutoCAD is installed by the following method.

1. From the File menu of AutoCAD, select Print

   The Plot dialog box is displayed.

2. Confirm if the device name in use is displayed

   Printer Driver Optimization Module for AutoCAD is installed if "XXX - Optimized driver - by Canon Inc." (where "XXX" is your model name) is displayed in Plotter of Printer/plotter.
Changing the Print Quality and Correcting Image Data

- Adjusting Color Balance
- Setting the Print Quality Level (Custom)
- Printing a Color Document in Monochrome
- Specifying Color Correction
- Adjusting Brightness
- Adjusting Contrast
- Printing Using Detailed Setting Mode
Adjusting Color Balance

You can adjust the color tints when printing. Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes the total color balance of the document. Use the application software when you want to change the color balance significantly. Use the printer driver only when you want to adjust the color balance slightly. The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so that the overall colors are more uniform.

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window
2. Select the advanced settings
   Select Advanced Settings from the pull-down menu on the Main tab.

   ![Advanced Settings Menu]

3. Select color mode
   For Color Mode, select Color, and then click Color Settings. The Color Settings dialog box appears.
4. Adjust color balance

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the corresponding slider is moved to the right, and becomes weaker when the corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.

5. Complete the setup

Click OK on the Main tab.

When you execute print, the document is printed with the adjusted color balance.

Related Topics

- Setting the Print Quality Level (Custom)
- Specifying Color Correction
- Adjusting Brightness
- Adjusting Contrast
Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select advanced settings

   From the Main tab pull-down menu, select Advanced Settings.

3. Select the print quality

   For Print Quality, select Custom.
   The Custom dialog box opens.

4. Setting the print quality level

   Drag the slider bar to select the print quality level and click OK.

Important

- If Auto (Use Printer Settings) is selected for Media Type, Custom cannot be selected.
Important

• Certain print quality levels cannot be selected depending on the settings of Media Type.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

Related Topics

➤ Specifying Color Correction
➤ Adjusting Color Balance
➤ Adjusting Brightness
➤ Adjusting Contrast
Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window

2. Select advanced settings

   From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode

   For Color Mode, select Monochrome or Monochrome Bitmap.

   **Note**

   - The selectable Color Mode depends on the media type selected for Media Type on the Main tab.
   - You can select Monochrome Bitmap for Color Mode only if Line Drawing/Text is selected in Print Priority.

4. Complete the setup
Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color document in monochrome.

Important

- When Monochrome or Monochrome Bitmap are selected, the printer driver processes image data as sRGB data. In this case, actual colors printed may differ from those in the original image data.
  When using the grayscale printing function to print Adobe RGB data, convert the data to sRGB data using an application software.

Note

- With Monochrome or Monochrome Bitmap inks other than black ink may be used as well.
Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed. Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or ICC Profile Matching. When you want to use an application software to specify a printing ICC profile, select None.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window

2. Select advanced settings
   From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode
   For Color Mode, select Color, and then click Color Settings. The Color Settings dialog box appears.

4. Select color correction
   Click Matching tab, select Color Correction setting that matches your purpose from the following, and click OK.
Driver Matching
Print with the optimal color using the driver's original color profile. Normally, you should choose this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing from an ICM function-compatible application.

None
Print without performing color matching on the printer driver. Select this when performing color matching using applications such as Adobe Photoshop, or printing a color chart using a profile creation tool.

5. Complete the setup
Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

Important
- When ICM is disabled in the application software, ICM is unavailable for Color Correction and the printer may not be able to print the image data properly.
- If Auto (Use Printer Settings) is selected for Media Type, the Matching sheet is not displayed, and color correction occurs according to printer settings.
Related Topics

- Optimal Photo Printing of Image Data
- Adjusting Colors with the Printer Driver
- Printing with ICC Profiles
Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ from those of actual image or those displayed on the monitor. To get the print results as close as possible to the desired color tones, you must select a printing method that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color management (color matching) is a method that manages device-dependent "colors" as a common color space.

For Windows, a color management system called "ICM" is built into the operating system. sRGB is one of the common color spaces that is frequently used. ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and carrying out color management, you can draw out the color space of the image data within the color reproduction area that the printer can express.

Note

- Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a format called RAW. RAW data refers to an image saving format that requires a computer to develop the image. You can embed an input ICC profile tag into a RAW file by using special application software.

Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space of the image data or the application software to be used.

There are two typical printing methods. Check the color space of the image data and the application software to be used, and then select the printing method suited to your purpose.

Adjusting Colors with the Printer Driver

This section describes the procedure for printing data by using the color correction function of the printer driver. Select this function when you want to print impressions that are close to those displayed on the monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles

Describes the procedure for printing by using the color space of the image data effectively. You can print with a common color space by setting up the application software and the printer driver so that the color management matches the input ICC profile of the image data. The method for setting up the printer driver differs depending on the application software to be used.
Adjusting Colors with the Printer Driver

To use driver matching when printing, turn on the printer driver’s color correction function. Driver matching accurately applies the characteristics of data displayed on the monitor and allows you to obtain print results of impressions that are close to those displayed on the monitor.

Important

- When printing using driver matching, Canon recommends that you set the monitor and the environment light as follows:
  - Monitor
    Color temperature: D50 (5000K)
    Brightness: 100 to 120cd/m2
    Gamma: 2.2
  - Environment light
    Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering properties)
    Brightness when looking at printed materials: 500 lx ± 125 lx

Note

- When printing from an application software that can identify ICC profiles and allows you to specify them, use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select advanced settings

   From the Main tab pull-down menu, select Advanced Settings.
3. Select color mode

For **Color Mode**, select **Color**, and then click **Color Settings**. The **Color Settings** dialog box appears.

4. Select color correction

Click **Matching** tab, and select **Driver Matching** for **Color Correction**.

5. Select the rendering intent

Select the coloring adjustment method in **Rendering Intent**.

- **Perceptual (Photo)**  
  Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting this setting allows you to adjust colors easily using an application software.

- **Saturation (Poster/CAD)**  
  Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable for line drawing.

6. Set the other items

If necessary, click **Color Adjustment** tab, and adjust the color balance (**Cyan**, **Magenta**, **Yellow**) and adjust **Brightness**, and **Contrast** settings, and then click **OK**.

7. Complete the setup

Click **OK** on the **Main** tab.
When you execute print, the printer driver adjusts the colors when printing the data.
Related Topics

- Setting the Print Quality Level (Custom)
- Specifying Color Correction
- Adjusting Color Balance
- Adjusting Brightness
- Adjusting Contrast
Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional, or any application software that allows you to specify input and printing ICC profiles, you print by effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself, be sure to select color management items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select advanced settings

   From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode

   For Color Mode, select Color, and then click Color Settings.

   The Color Settings dialog box appears.

4. Select color correction
Click Matching tab, and select None for Color Correction.

5. Set the other items

   If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and adjust Brightness, and Contrast settings, and then click OK.

6. Complete the setup

   Click OK on the Main tab.
   When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print

When you print from application software that cannot identity input ICC profiles or does not allow you to specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window

2. Select advanced settings
   
   From the Main tab pull-down menu, select Advanced Settings.
3. Select color mode

For **Color Mode**, select **Color**, and then click **Color Settings**. The **Color Settings** dialog box appears.

4. Select color correction

Click **Matching** tab, and select **ICC Profile Matching** for **Color Correction**.

5. Select **Input Profile**

Select the input profile you want to use.
Important

• When the application software specifies an input profile, the input profile setting of the printer driver becomes invalid.

6. Select the printer profile

Select Printer Profile as follows:

• To set the printer profile automatically:
  Select Auto Settings.
• To set the printer profile manually:
  Select a printer profile that matches the media type to be used.

7. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting this setting allows you to adjust colors easily using an application software.

Important

• When you select Perceptual to print images, Canon recommends that you set the monitor and the environment light as follows:
  • Monitor
    Color temperature: D50 (5000K)
    Brightness: 100 to 120cd/m2
    Gamma: 2.2
  • Environment light
    Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering properties)
    Brightness when looking at printed materials: 500 lx ± 125 lx

Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable for line drawing.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image data so the color reproduction approximates the shared color regions. Select this method to print image data with colors that are close to the original colors.

Absolute Colorimetric
When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper (background color). However, when Absolute Colorimetric is selected, how the white spots are reproduced depends on the image data.

Important

• Depending on the media type, you may obtain the same print results even when you change the Rendering Intent setting.
8. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and adjust Brightness, and Contrast settings, and then click OK.

9. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics
- Setting the Print Quality Level (Custom)
- Specifying Color Correction
- Adjusting Color Balance
- Adjusting Brightness
- Adjusting Contrast
Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing. The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment   Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window
2. Select advanced settings
   From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode
   For Color Mode, select Color, and then click Color Settings.
   The Color Settings dialog box appears.

4. Adjust brightness
   On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors, and moving the slider to the left darkens (intensifies) the colors.
   You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The current settings are displayed in the settings preview on the left side of the printer driver.
5. Complete the setup

Click **OK** on the **Main** tab.
When you execute print, the data is printed at the adjusted brightness.

**Related Topics**

- [Setting the Print Quality Level (Custom)](#)
- [Specifying Color Correction](#)
- [Adjusting Color Balance](#)
- [Adjusting Contrast](#)
Adjusting Contrast

You can adjust the image contrast during printing. To make the differences between the light and dark portions of images greater and more distinct, increase the contrast. On the other hand, to make the differences between the light and dark portions of images smaller and less distinct, reduce the contrast.

No adjustment  Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window
2. Select advanced settings
   From the Main tab pull-down menu, select Advanced Settings.

3. Select color mode
   For Color Mode, select Color, and then click Color Settings.... The Color Settings dialog box appears.
4. Adjust the contrast
On the **Color Adjustment** tab, moving the **Contrast** slider to the right increases the contrast, and moving the slider to the left decreases the contrast. You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The current settings are displayed in the settings preview on the left side of the printer driver. After adjusting each color, click **OK**.

![Color Adjustment Tab](image)

5. **Complete the setup**
   
   Click **OK** on the **Main** tab. When you execute print, the image is printed with the adjusted contrast.

**Related Topics**

- Setting the Print Quality Level (Custom)
- Specifying Color Correction
- Adjusting Color Balance
- Adjusting Brightness
Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window

2. Select the media type
   Select the type of paper loaded in the printer from the Media Type list on the Main tab. If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select advanced settings
   From the Main tab pull-down menu, select Advanced Settings.
4. Set print conditions

Set the following items as necessary.

**Print Priority**
Select elements to prioritize for print results.

**Print Quality**
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

**Color Mode**
Selects color adjustment method.

**Thicken Fine Lines**
Prints thin lines thicker for easy viewing.

5. Select the paper size

From the **Page Size** list on the **Page Setup** tab, select the same size as that of the document that was created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
6. Select the paper source

For **Paper Source**, select the setting that matches your purpose.

**Important**

- The paper feed method will differ according to the paper settings.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click **OK**.

When you print, the document is printed with the print conditions you set.

**Related Topics**

- [Adjusting Color Balance](#)
- [Setting the Print Quality Level (Custom)](#)
- [Specifying Color Correction](#)
- [Adjusting Brightness](#)
- [Adjusting Contrast](#)
## Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the [printer driver setup window](#).

2. Select the paper size of the document

   Using **Page Size** on the **Page Setup** tab, select the page size that is set with your application software.

3. Select the paper source

   For **Paper Source**, select the setting that matches your purpose.

   **Important**
   
   - The paper feed method will differ according to the paper settings.

4. Select roll paper width

   If you selected a roll paper for **Paper Source**, set **Roll Paper Width** to the width of the roll paper loaded in the printer.

5. Select scaled printing

   Check the **Enlarged/Reduced Printing** check box.

6. Set one of scaling methods described below

   From the items listed below, select the setting that matches your purpose and select the corresponding check box.

   The current settings are displayed in the settings preview on the left side of the window.

   - **Fit Paper Size**
Scales the document to match the paper size.

- **Fit Roll Paper Width**

Scales the document to match the roll paper width.

- **Scaling**

Allows you to specify the scaling by entering a number directly or by selecting the paper size you want from the **Printer Paper Size** list.

The document is reduced when a size smaller than the **Page Size** setting is selected from the **Printer Paper Size** list, and enlarged when a size larger is selected.

7. Complete the setup

Click **OK**. When you execute print, the document will be printed with the specified scale.

**Important**

- When the application software which you used to create the original has the scaled printing function, configure the settings on your application software. You do not need to configure the same setting in the printer driver.

**Note**

- Selecting **Enlarged/Reduced Printing** changes the printable area of the document.
Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window

2. Select the paper size

   From the Page Size list on the Page Setup tab, select the same size as that of the document that was created with the application software.

3. Click Size Options...

   The Paper Size Options dialog box opens.

4. Select oversize

   Select the Oversize check box, and click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

**Important**

- The paper feed method will differ according to the paper settings.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded in the printer.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.

When you print, the document is printed using oversize.

**Important**

- When printing to oversized paper sizes, use paper that has the following necessary margins added to the document size.
  - Cut sheet: 6 mm or more added to width and 23 mm or more added to height of document size
  - Roll paper: 6 mm or more added to width and 6 mm or more added to height of document size

**Note**

- An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.
To set an oversized paper size for a non-standard paper size, register the paper size in the **Paper Size Options** dialog box. An oversized paper size cannot be set for paper sizes that were set in the **Custom Size Settings** dialog box.
Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:

Setting from Paper Size Options

1. Open the printer driver setup window

2. Click Size Options... on the Page Setup tab

   ![Paper Size Options dialog box](image)

   The Paper Size Options dialog box opens.

3. Set user-defined paper

   Set Custom Paper Size Name, Units, and Size, and then click Add.
   For Size, specify an size or select the paper size to be used from Paper Size List.
   To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
By selecting the **Borderless Printing Size** check box for **Size**, you can select a size from the paper sizes that support **Borderless Printing**. By selecting the **Fix the Ratio of the Width to Height** check box, you can change the size while keeping the **Width** and **Height** ratio.

4. Set user-defined paper

Click **OK**, then it returns to **Page Setup** tab.

The paper size registered by using **Custom Paper Size Name** is registered to **Custom Paper Size** of **Page Size** and can be selected at any time.

**Setting from Custom Size**

1. Open the [printer driver setup window](#)

2. Select the paper size

   For **Page Size** on the **Page Setup** tab, select **Custom Size** from the **Custom Paper Size** list.
3. Set the custom paper size

Enter the **Width** and **Height** values of the paper to be used, specify the **Units**, and then click **OK**.

4. Complete the setup

Click **OK** on the **Page Setup** tab.

When you execute print, the data is printed with the specified paper size.

**Important**

- If the application software that created the document has a function for specifying height and width values, use the application software to set the values. If the application software does not have such a function or if the document does not print correctly, perform the above procedure from the printer driver to set the values.
- Printing may be disabled depending on the size of the specified user-defined media. For information about printable sizes for user-defined media, see "Paper Sizes."
- Any paper size that was set by using **Custom Size** can no longer be used after the application software is closed.
Note

- If the paper settings in the printer driver differ from the paper information registered on the printer, an error message may appear on the printer's operation panel. You can still print but you may not be able to obtain correct print results.
- The maximum configurable size with Custom Size is 3.2m.
Set a Custom Size Roll Width

By specifying the roll paper width with a value, you can use roll paper with a width that cannot be selected in Roll Paper Width.

The procedure for setting custom size roll width is described below.

1. Open the printer [driver setup window](#).

2. Select the paper source

   From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

   In Roll Paper Width, select Custom Size (XXXX).

   The Custom Size Settings dialog box opens.

4. Set paper roll width

   Enter the roll width you want to use, specify Units, and then click OK.
Note

- If the value you entered is the same as the standard roll width, a message will be displayed, and the standard roll paper size will be set.
- Get the paper information of the printer from Get Information in the Main tab.

5. Complete the setup

Click OK on the Page Setup tab.
If you perform the print, the roll paper with the specified width will be used for printing.

Note

- If the paper settings in the printer driver differ from the paper information registered on the printer, an error message may appear on the printer's operation panel. You can execute Print, but you may not obtain the correct printing result.
Printing without Edges Based on the Scenarios

➤ Printing without Margins to Match Paper Size
➤ Printing without Margins to Match Roll Paper Width
➤ Printing Full-Size without Margins
➤ Three-sided Borderless Printing on Roll Paper
The procedure for borderless printing by enlarging or reducing documents to match paper size is described below.

1. In the printer driver, open the settings screen.

2. Select the paper source

   From the Paper Source list on the Page Setup tab, select Roll Paper.

   **Important**
   
   • The feeding methods you can choose from vary depending on paper settings.

3. Select paper roll width

   For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

   Place a checkmark next to the Borderless Printing option.
After the Information dialog is displayed, under Roll Width, select the same paper width as that of the paper roll loaded in the printer and click OK.

5. Select a method for printing borderless

Select Fit Paper Size in Borderless Printing Method.
If the size of the document is different from the size of the paper you want to print on, select the paper size you want to print on from Printer Paper Size.

6. Complete the setting process

Click OK.
If you print now, the document will be printed without margins to fit the paper size.

**Important**

- If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered options in the Layout tab will be displayed in gray out and you will not be able to configure them.
- Depending on paper size, the length/width ratio of the paper may be different from that of the image, making it impossible for the whole image to fit on the paper. When this happens, crop the image with the application software to match paper size.
- When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper Options dialog box select No from the Automatic Cutting list. When you do so, the document will be printed without the left and right margins. After the printed material has exited the printer and has been cut, cut the upper and lower edges with a pair of scissors.
- When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to be unevenly cut. You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.
- Margins may be formed on the left and right of the document even when borderless printing is set. Also, stains may appear on the back of the paper.
• If margins are formed on the left and right of the document, adjust the amount extending off paper during borderless printing from the printer's control panel. See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

Note

• When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
Printing without Margins to Match Roll Paper Width

Procedure for printing borderless by enlarging/reducing documents to match roll paper width.

1. In the printer driver, open the settings screen

2. Select the paper source

   From the Paper Source list on the Page Setup tab, select Roll Paper.

   Important
   • The feeding methods you can choose from vary depending on paper settings.

3. Select paper roll width

   For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

   Place a checkmark next to the Borderless Printing option.
After the Information dialog is displayed, under Roll Width, select the same paper width as that of the paper roll loaded in the printer and click OK.

5. Select a method for printing borderless

Select Scale to fit Roll Paper Width in Borderless Printing Method.

6. Complete the setting process

Click OK.
Job will print to the entire roll width without a white border.

>> Important

• If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered options in the Layout tab will be displayed in gray out and you will not be able to configure them.
• Depending on paper size, the length/width ratio of the paper may be different from that of the image, making it impossible for the whole image to fit on the paper. When this happens, crop the image with the application software to match paper size.
• When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper Options dialog box select No from the Automatic Cutting list. When you do so, the document will be printed without the left and right margins. After the printed material has exited the printer and has been cut, cut the upper and lower edges with a pair of scissors.
• When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to be unevenly cut.
You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.
• Margins may be formed on the left and right of the document even when borderless printing is set. Also, stains may appear on the back of the paper.
• If margins are formed on the left and right of the document, adjust the amount extending off paper during borderless printing from the printer's control panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

>> Note

• When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
Printing Full-Size without Margins

Procedure for printing borderless images in the same size as the original document without enlarging/reducing them.

1. In the printer driver, open the settings screen

2. Select the paper source

   From the Paper Source list on the Page Setup tab, select Roll Paper.

   **Important**
   - The feeding methods you can choose from vary depending on paper settings.

3. Select paper roll width

   For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

   Place a checkmark next to the Borderless Printing option.
After the **Information** dialog is displayed, under **Roll Width**, select the same paper width as that of the paper roll loaded in the printer and click **OK**.

5. **Select a method for printing borderless**
   
   Select **Print Image with Actual Size** in **Borderless Printing Method**.

6. **Complete the setting process**
   
   Click **OK**.

   Job will print to original size without white border.

   **Important**

   - If **Amount of Extension** is set to the second from the right, create the source document with a size 2mm larger on each of the top, bottom, left and right sides than the size of the paper you wish to print.

   **Important**

   - If you place a checkmark next to the **Borderless Printing** option, the **Page Layout** and **Print Centered** options in the **Layout** tab will be displayed in gray out and you will not be able to configure them.
   - Depending on paper size, the length/width ratio of the paper may be different from that of the image, making it impossible for the whole image to fit on the paper. When this happens, crop the image with the application software to match paper size.
   - When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color unevenness on the edges of the paper. If you require exceptionally high quality, in the **Roll Paper Options** dialog box select **No** from the **Automatic Cutting** list. When you do so, the document will be printed without the left and right margins. After the printed material has exited the printer and has been cut, cut the upper and lower edges with a pair of scissors.
   - When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to be unevenly cut.

   You may be able to improve the situation by clicking **Specify...** on the **Main** tab and, in the **Paper Detailed Settings** dialog box, under **Drying Time**, set **Between Pages** to a higher value.
   - Margins may be formed on the left and right of the document even when borderless printing is set. Also, stains may appear on the back of the paper.
   - If margins are formed on the left and right of the document, adjust the amount extending off paper during borderless printing from the printer's control panel.

   See "**Borders appear in borderless printing**" for details on how to set the amount extending off paper.

   **Note**

   - When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
Three-sided Borderless Printing on Roll Paper

In normal borderless printing, paper sizes that match the width of the roll paper are combined to print without borders on all four sides. If you use the three-sided borderless printing feature, you can combine paper sizes that don't match the roll paper width, and print with no borders on three sides. However, if you perform three-sided borderless printing, you need to cut the right side of the paper after printing.

Three-sided Borderless Printing to Match Paper Size

The procedure for three-sided borderless printing by enlarging or reducing documents to match paper size is described below.

1. Open the printer driver setup window

2. Select the paper source

   From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

   For paper roll width, enter the same value set in the printer under Roll Width.

4. Select borderless printing

   In the Page Setup tab, place a checkmark next to the Borderless Printing option.
After the Information dialog is displayed, under Roll Width, select the same paper width as that of the paper roll loaded in the printer and click OK.

5. Click Borderless Setting

When the Borderless Setting dialog box is displayed, place a checkmark next to Three-sided Borderless, and then click OK.

6. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Fit Paper Size option. If the size of the document is different from the size of the paper you want to print on, select the paper size you want to print on from Printer Paper Size.

7. Complete the setting process

Click OK. If you print now, the document will be printed without margins on three sides to fit the paper size.

8. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing. Cut slightly to the inside of the margin as the document is enlarged to extend slightly beyond the specified size. To get the document to standard size, it is recommended to take measurements and cut in the correct positions.
**Printing Full-Size without Margins on Three Sides**

The procedure for three-sided borderless printing in the same size as the original document without enlarging or reducing the size is described below.

1. Open the **printer driver setup window**

2. Select the paper source

   From the **Paper Source** list on the **Page Setup** tab, select **Roll Paper**.

3. Select paper roll width

   For paper roll width, enter the same value set in the printer under **Roll Width**.

4. Select borderless printing

   In the **Page Setup** tab, place a checkmark next to the **Borderless Printing** option.

   ![](image)

   After the **Information** dialog is displayed, under **Roll Width**, select the same paper width as that of the paper roll loaded in the printer and click **OK**.

5. Click **Borderless Setting**
When the Borderless Setting dialog box is displayed, place a checkmark next to Three-sided Borderless, and then click OK.

6. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Print Image with Actual Size option.
If the size of the document is different from the size of the paper you want to print on, select the paper size you want to print on from Printer Paper Size.

7. Complete the setting process

Click OK.
If you print now, the document will be printed without margins on three sides while retaining the same document size.

8. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing.
To get the document to standard size, it is recommended to take measurements and cut in the correct positions.

Important

- If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered options in the Layout tab will be displayed in gray out and you will not be able to configure them.
- Depending on paper size, the length/width ratio of the paper may be different from that of the image, making it impossible for the whole image to fit on the paper. When this happens, crop the image with the application software to match paper size.
- When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper Options dialog box select No from the Automatic Cutting list. When you do so, the document will be printed without the left margin. After the printed material has exited the printer and has been cut, cut the upper, lower, and right edges with a pair of scissors.
- When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the cutter unit may come into contact with the paper surface scratching it and causing the paper to be unevenly cut.
You may be able to improve the situation by clicking **Specify...** on the **Main** tab and, in the **Paper Detailed Settings** dialog box, under **Drying Time**, set **Between Pages** to a higher value.

- Margins may be formed on the left of the document even when borderless printing is set. Also, stains may appear on the back of the paper.
- If margins are formed on the left of the document, adjust the amount extending off paper during borderless printing from the printer's control panel.

See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

**Note**

- When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
Printing Hanging and Horizontal Banners (Large-Format Printing)

A drapery or banner up to 18.0m can be made by enlarging or reducing original documents made on application software. However, there are cases in which an 18.0 meter banner cannot be printed because the application software used has limits on the document size that can be set.

The procedure for printing hanging and horizontal banners is as follows:

Print for width of roll

1. Create document by using application software

2. Open the printer driver setup window

3. Select the paper size

   Select the same original paper size created in the application soft in the Page Setup tab’s Page Size. In the event an optional size is set in the application software, select Custom Size from Custom Paper Size in Page Size and designate size in the dialog box that appears.

4. Select roll width

   Select the equivalent to the paper width of the roll set in the printer under Roll Width.

5. Set Enlarged/Reduced Printing

   Check Enlarged/Reduced Printing and select Fit Roll Paper Width. When the Information dialog box appears, select the equivalent to the paper width of the roll set in the printer.
6. Complete the setup

Click OK.

When printing is executed, a drapery or banner can be printed according to the roll.

## Enlarge and print

1. Register user-defined paper

Register both the actual desired print size (user-defined paper 1) and original document size created in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

**Note**

- Please set user-defined paper 2 to the same aspect ratio as user-defined paper 1. If the aspect ratio differs, the enlarged image may not turn out to be the expected size.
- After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the Ratio of the Width to Height, settings can be set to the same aspect ratio.
- Also set user-defined paper 2 to a size that doesn’t exceed the maximum size supported by the application.
- For example, when printing on paper 600mm wide and 3,000mm long, use the following settings.

  (when setting length to 1/6 the user-defined paper)
  - User-defined paper 1: Width 600mm, Height 3,000mm
  - User-defined paper 2: Width 100mm, Height 500mm

2. Create original document in application software

Use registered user-defined paper 2 to create original document in application software.

3. Open printer driver settings screen

4. Select Paper Size

Select registered user-defined paper 1 from Custom Paper Size in Page Setup tab’s Page Size.

5. Complete the setup

Click OK.

When you print, the hanging or horizontal banner is printed by using the user-defined size.

**Note**

- Maximum printable length is 18.0m. In the event the enlarged length exceeds 18.0m, the part of the image exceeding the length will not be printed.
- If printing cannot be performed correctly, you may be able to improve printing by using Special Settings on the Layout tab to change FineZoom Settings to Yes.
Printing by Dividing/Joining Documents

- Inputting Multiple-file Documents into Free Layout plus
- Lining Up and Printing Multiple Documents to Cut Sheets
- Printing by Connecting Multiple Pages
- Printing Multiple Pages All on One Page
- Dividing and Printing Posters
Lining Up and Printing Multiple Documents to Cut Sheets

You can line up multiple documents that were created separately and print them together on one page.

You must install imagePROGRAF Printer Driver Extra Kit to use this function. Go to the Canon website, download imagePROGRAF Printer Driver Extra Kit, and then install it.

The procedure for lining up and printing multiple documents to cut sheets is as follows:

1. Open the printer driver setup window

2. Select Free Layout

   On the Layout tab, select the Page Layout check box, and then from the pull-down menu, select Free Layout.

3. Complete the setup

   Click OK.

   When you print, Canon imagePROGRAF Free Layout starts. Canon imagePROGRAF Free Layout allows you to edit and rearrange images.
Note

- To lay out multiple application software documents onto one page, repeat steps 1 to 3 without closing the Canon imagePROGRAF Free Layout window.
Printing by Connecting Multiple Pages

You can eliminate the blank spaces between pages in a document that extends over multiple pages and print the document as one continuous document.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window

2. Select the paper source

   In **Paper Source**, select **Roll Paper**.

   ![Printer Driver Setup Window]

   **Important**
   - The paper feed method will differ according to the paper settings.

3. Set roll paper options

   Click **Roll Paper Options** to display the **Roll Paper Options** dialog box.
   Select the **Banner Printing** check box, and then click **OK**.
   The current settings are displayed in the settings preview on the left side of the **Page Setup** tab.

   ![Roll Paper Options]

4. Complete the setup

   Click **OK** on the **Page Setup** tab.
   When you print, the document is printed with the print conditions you set.
Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window

2. Select the print paper size

   From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.

3. Set number of pages to be printed per sheet

   On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.

   The current settings are displayed in the settings preview on the left side of the window.
4. Set the number of pages to be printed on one sheet and the page order

If necessary, click **Set...**, specify the following settings in the **Page Layout Printing** dialog box, and click **OK**.

![Page Layout Printing dialog box](image)

**Page Order**
To change the page arrangement order, select a placement method from the list.

**Page Border**
To print a page border around each document page, check this check box.

5. Complete the setup

Click **OK** on the **Layout** tab.

When you execute print, the specified number of pages will be arranged on each sheet of paper in the specified order.

**Important**
- When there is a checkmark attached to **Banner Printing** on the **Page Setup** tab, **Page Layout** is grayed out and cannot be set.
Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print these pages on separate sheets of paper. You can also paste the pages together to create a large print like a poster.

The procedure for dividing and printing posters is as follows:

### Setting for Dividing and Printing Posters

1. Open the printer driver setup window

2. Select the print paper size

   From the **Page Size** list on the **Page Setup** tab, select the size of the paper loaded in the printer.

3. Set number of divisions

   On the **Layout** tab, select the **Page Layout** check box, and from the pull-down menu, select **Poster (1 x 2)** or **Poster (2 x 2)**.

   The current settings are displayed in the settings preview on the left side of the window.
4. Complete the setup

Click **OK** on the **Layout** tab.
When you execute print, the document will be divided into several pages during printing.

**Important**

- When there is a checkmark attached to **Banner Printing** on the **Page Setup** tab, **Page Layout** is grayed out and cannot be set.

### Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the procedure below:

1. Display **Pages to Print** dialog box
   
   For **Page Layout**, click **Set...** to display the **Pages to Print** dialog box.

2. Set print range
   
   Clear the check boxes of the pages you do not want to print.
   In the setting view, the pages that you cleared are deleted and only the pages to be printed are displayed.
   Check the pages to be printed, and then click **OK**.
In the setting view on the left side of the Pages to Print dialog box, you can also clear the display by clicking the pages you do not want to print. To redisplay a cleared page, click that page again.

To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup

Click OK on the Layout tab.

When you print, only the specified pages are printed.

Important

If you partition and print as a poster, the source document will be printed in enlarged form, so the print results may become rough.
When you want to position the source document in the middle of the cut paper and print, or print with even margins on the right and left in relation to the width of the roll paper, use the Print Centered function. The print results when setting with Print Centered are as follows. Normally, if Print Centered is set when printed as in (A), it will be printed as in (B) for cut paper and (C) for roll paper.

Note

- When setting the magnification using Scaling from Enlarged/Reduced Printing on the Page Setup tab and printing, the start point for enlarge/reduce will always be fixed based on the top left corner of that page. For that reason, for reduced printing, the bottom and right margins of the paper will increase. At this time, if you place a checkmark next to Print Centered on the Layout tab, the top, bottom, left and right margins can all be printed evenly.

The procedure for printing in the center of the paper is as follows:

1. Open the printer driver setup window

2. Select the media type

   Select the type of paper loaded in the printer from the Media Type list on the Main tab. If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.
3. Select the paper size

Select the size of the paper you want to print from **Page Size** on the **Page Setup** tab.

4. Set magnification as necessary

Where necessary, attach a checkmark next to **Enlarged/Reduced Printing**, and set according to the objective.

5. Select the paper source

For **Paper Source**, select the setting that matches your purpose.

**Important**

- The paper feed method will differ according to the paper settings.
6. Select roll paper width

If you selected a roll paper for **Paper Source**, set **Roll Paper Width** to the width of the roll paper loaded in the printer.

7. Print document in the center of paper

Select the **Print Centered** check box on the **Layout** tab.

8. Complete the setup

Click **OK**.
When you print, the document is printed in the center of the paper.
Printing by Saving Roll Paper

- Saving Roll Paper by Rotating Document 90 Degrees
- Saving Roll Paper by Eliminating Upper and Lower Margins on Document
Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window

2. Select the media type

   Select the type of paper loaded in the printer from the Media Type list on the Main tab. If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select the paper size

   From the Page Size list on the Page Setup tab, select the same size as that of the document that was created with the application software.

4. Select the paper source

   In Paper Source, select Roll Paper.

   **Important**

   - The paper feed method will differ according to the paper settings.

5. Selecting Paper Saving

   Select the Rotate Page 90 degrees check box.
   The current settings are displayed in the settings preview on the left side of the window.
6. Select roll paper width

For **Roll Paper Width**, select the width of the roll paper loaded in the printer.

7. Complete the setup

Click **OK**.

When you print, you can rotate a portrait document 90 degrees to save paper.

**Important**

- When there is a checkmark attached to **Banner Printing** on the **Page Setup** tab, **Rotate Page 90 degrees** is grayed out and cannot be set.
• When selecting paper in portrait format as the **Page Size** from the **Page Setup** tab, if the length in the vertical direction is longer than the width selected in **Roll Width**, even if a checkmark is placed next to **Rotate Page 90 degrees**, the page will not be rotated.
Saving Roll Paper by Eliminating Upper and Lower Margins on Document

When printing on roll paper, you can save paper by reducing the upper and lower margins when printing.

The procedure for saving paper by reducing the upper and lower margins is as follows:

1. Open the **printer driver setup window**

2. Select the media type

   Select the type of paper loaded in the printer from the **Media Type** list on the **Main** tab. If **Auto (Use Printer Settings)** is selected, the paper configured in printer settings is printed.

3. Select the paper size

   From the **Page Size** list on the **Page Setup** tab, select the same size as that of the document that was created with the application software.
4. Select the paper source

For Paper Source, select Roll Paper.

**Important**
- The paper feed method will differ according to the paper settings.

5. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

6. Selecting Paper Saving

On the Layout tab, select the No Spaces at Top or Bottom check box.
The current settings are displayed in the settings preview on the left side of the window.
7. Complete the setup

   Click **OK**.

   When you print, the upper and lower margins are reduced so that you can save paper.
Switching the Paper Source to Match the Purpose

This printer has two paper sources: Roll and Cut Sheet. You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window

2. Select the media type

   Select the type of paper loaded in the printer from the Media Type list on the Main tab.

   If Auto (Use Printer Settings) is selected, the paper configured in printer settings is printed.

3. Select the paper source

   From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.

   Roll Paper
   Feeds paper using roll paper.

   Cut Sheet
   Feeds paper using the cut paper.

   Important
   • The paper feed method will differ according to the paper settings.

4. Complete the setup

   Click OK.

   When you execute print, the printer uses the specified paper source to print the data.
**Note**

- If the paper settings in the printer driver differ from the paper information registered on the printer, an error message may appear on the printer's operation panel. You can still print but you may not be able to obtain correct print results.
Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the **printer driver setup window**

2. Set the preview
   
   Check the **Preview before printing** check box on the **Main** tab.

3. Complete the setup
   
   Click **OK**.
   
   When you execute print, the Canon imagePROGRAF Preview opens and displays the print results.

**Related Topic**

> **Canon imagePROGRAF Preview**
Other Convenient Settings

- Stamp Printing
- Setting a Page Size and Orientation
- Registering a Frequently Used Printing Profile
- Cutting Roll Paper after Printing
Stamp Printing

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also allows you to print date, time and user name. "CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window

2. Select stamp
   On the Layout tab, select the Stamp check box, and then select the stamp to use from the list. The current settings are displayed in the settings preview on the left side of the Layout tab.

3. Complete the setup
   Click OK.
   When you execute print, the data is printed with the specified stamp.
Registering a Stamp

You can create and register a new stamp. You can also change and re-register some of the settings of an existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

## Registering a New Stamp

1. Open the printer driver setup window

2. Select stamp

   On the Layout tab, select the Stamp check box, and click Define Stamp....

   ![](image)

   The Define Stamp dialog box opens.
3. Set stamp details

Click Add to add a new stamp (Untitled) to the list.
In Name, enter the name of the stamp to register, and in Text, enter the character string you want as the stamp.
Change the Font, Size, and Color settings as necessary.

4. Set the other items

Set the following items as necessary.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print it on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
5. Complete the setup
   
   Click OK to return to the Layout tab.
   
   The registered title appears in the Stamp list.

### Changing and Registering Some of Stamp Settings

1. Select stamp
   
   On the Layout tab, select the Stamp check box, and click Define Stamp....
   
   The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed
   
   From Watermark List, select the title of the stamp you want to change the settings for.

3. Configure each setting while viewing the preview

4. Complete the setup
   
   Click OK to return to the Layout tab.
   
   The registered title appears in the Stamp list.

#### Note

- The stamp registered as the default setting cannot be changed.

### Deleting an Unnecessary Stamp

1. Select stamp
   
   On the Layout tab, select the Stamp check box, and click Define Stamp....
   
   The Define Stamp dialog box opens.

2. Select the stamp to be deleted
   
   Select the title that you wish to delete from the Watermark List and click Delete.
   
   Click Yes when the confirmation message appears.

3. Complete the setup
   
   Click OK to return to the Layout tab.

#### Note

- The stamp registered as the default setting cannot be deleted.
Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size and orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size

   Select a page size from the Page Size list on the Page Setup tab.

3. Set Orientation

   Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you want to perform printing with the original being rotated 90 degrees.

4. Complete the setup

   Click OK.
   When you execute print, the document will be printed with the selected page size and the orientation.
Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:

**Registering a Printing Profile**

1. Open the printer driver setup window

2. Set the necessary items

   On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to register.

3. Display Add dialog box

   On the Favorites tab, click Add....

   ![Add dialog box](image)

   The Add dialog box opens.

   ![Add dialog box](image)
4. Register favorite setting

   In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then click OK.
   The name and the icon appear in the Favorites list.
   To check the settings of the registered favorite, click Settings Details.

   **Note**
   - To save the settings of the favorite to a file, click Export... on the Favorites tab.

---

## Printing Using Favorite Settings

1. Open the printer driver setup window

2. Apply favorite

   From the Favorites list on the Favorites tab, select the favorite you want to use.
   Click Apply Favorite to replace the registered print settings.

3. Complete the setup

   Click OK.
   When you print, the document is printed with the settings of the registered favorite.

---

## Deleting Unnecessary Printing Profile

1. Select favorite to be deleted

   Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting

   Click Delete. When the confirmation message appears, click OK.
   The selected favorite is deleted from the Favorites list.

   **Note**
   - Printing profiles that are registered in the initial settings cannot be deleted.
   - The settings of the favorite being applied to the current print settings cannot be deleted. To delete that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings of that other favorite, and then delete the target favorite.
Cutting Roll Paper after Printing

The procedure for cutting roll paper automatically and printing cut guidelines is as follows:

1. Open the printer driver setup window
2. Select the paper source
   In Paper Source, select Roll Paper.

   ![Roll Paper Source Selection](image)

   **Important**
   - The paper feed method will differ according to the paper settings.

3. Display Roll Paper Options dialog box
   Click Roll Paper Options to display the Roll Paper Options dialog box.

   ![Roll Paper Options](image)

4. Set auto cut
   From Automatic Cutting, select the item that matches your purpose.
   The current settings are displayed in the settings preview on the left side of the Page Setup tab.
   - Yes
     The roll paper is cut automatically after printing.
   - No
     The roll paper is not cut after printing.
• **Print Cut Guideline**
  
  Cut guidelines are printed for cutting the roll paper manually after printing.

**Note**

• The default setting for automatic cutting is **Yes**.

After completing the setting, click **OK** to return to the **Page Setup** tab.

5. **Complete the setup**

  Click **OK** on the **Page Setup** tab.

  When you print, the roll paper is cut automatically after printing or cut guidelines are printed.
This printer supports printing using the original Canon SG Raster printer control language and printing using HP-GL/2 and HP RTL.

The printer automatically switches to the corresponding processing depending on whether SG Raster and HP-GL/2 or HP RTL job is received.

Note

• SG Raster is an abbreviation of Swift Graphic Raster.
• HP-GL/2 is an abbreviation of Hewlett-Packard Graphics Language/2, and HP RTL is an abbreviation of Hewlett-Packard Raster Transfer Language.
• Emulation is good for obtaining results similar to printing on other printers.

When printing from applications that support HP-GL/2 or HP RTL output, specify HP-GL/2 or HP RTL in the plotter output printer language settings.

HP-GL/2 and HP RTL emulation related settings are configured from the printer operation panel. For further details, refer to "HP-GL/2 Settings."

Note

• For instructions on configuring these settings, refer to the software documentation.
  It may not be possible to print jobs with excessively large amounts of data correctly.
Printing from Smartphone/Tablet

For more on printing from a device, refer to the device's or application's instruction manual.

- Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)
Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

- Wi-Fi connection (connecting devices using a wireless router)
- Wireless Direct connection (connecting devices without using a wireless router)

This section describes wireless direct, which allows you to print by connecting the devices to the printer directly.

Follow the procedure below to use wireless direct.

1. Change the Printer Setting to Wireless Direct Connection
2. Connect Wi-Fi Direct Compatible Devices such as Smartphones and Tablets to the Printer

This section also describes changing wireless direct connection to Wi-Fi connection.

Important

- Check the usage restrictions and switch the printer to the wireless direct.

Restrictions

- The administrator password is required to change settings if it is enabled for changing settings using the operation panel.
- If a device has already been connected to the printer directly and you want to add a device to connect, connect it to the printer directly. You can connect up to 5 devices to the printer at the same time.

Change the Printer Setting to Wireless Direct Connection

1. Make sure printer is turned on.

2. On the HOME screen, tap the Network icon.

   - Depending on the current LAN status, the icon displayed on the button may differ.

3. Tap Wireless Direct.
4. Tap **Settings**.

5. Tap **Enable/disable Wireless Direct** and tap **Yes**.

6. Confirm displayed message and tap **OK**.

After Wireless Direct is enabled, the identifier (SSID) etc. when using the printer with wireless direct connection are displayed.

By flicking the touch screen, you can check various settings of wireless direct.

---

**Note**

- The identifier (SSID) and password are specified automatically.
- By tapping **Show passwd.**, you can check the password. The password is required when connecting a device to the printer. (Depending on the device you are using, no password is required.)
- By tapping **Settings**, you can change the following settings.
  - Enable/disable Wireless Direct
  - Update SSID/password
  - Wireless Direct device name
  - Connection request confirmation

For updating the SSID / password or changing the name of the printer displayed on Wi-Fi Direct compatible device, see [Change Wireless Direct Connection Setting](#).

---

### Connect Wi-Fi Direct Compatible Devices such as Smartphones and Tablets to the Printer

1. Turn on Wi-Fi communication on Wi-Fi Direct compatible device.
   
   For more on turning on Wi-Fi communication, see your device's instruction manual.

2. Select "DIRECT-XXXX-TA-20" ("X" represents alphanumeric characters) from list displayed on device.

   **Note**
   
   - If "DIRECT-XXXX-TA-20" does not appear on the list, wireless direct is not enabled.
     
     See [Change the Printer Setting to Wireless Direct Connection](#) to enable wireless direct.
   
   - You can change the name of the printer displayed on Wi-Fi Direct compatible devices.
     
     See [Change Wireless Direct Connection Setting](#) as necessary.

3. Enter password on Wi-Fi Direct compatible device.
   
   The device is connected to the printer.
Note

- You can check the password set for the printer by the following method.

1. On the HOME screen, tap (Network).
2. Tap Wireless Direct.
3. Tap Show passwd.

- If your Wi-Fi Direct compatible device is set to prioritize using Wi-Fi Direct and it is connecting to the printer, the printer displays a confirmation screen asking if you allow the device to connect to the printer.
   Make sure the name on the touch screen is the same as that of your Wi-Fi Direct compatible device and tap Yes.

Change Wireless Direct Connection Setting

1. Make sure printer is turned on.

2. On the HOME screen, tap (Network).
   ➤ Menu Operations

3. Tap Wireless Direct.

4. Tap Settings.

5. Change settings as necessary.
   - To update the identifier (SSID) and the password for wireless direct
     Tap Update SSID/password to display the confirmation screen.
     To update the identifier (SSID) and the password, tap Yes.
     To check the updated password, tap Show passwd.
   - To change the printer’s name displayed on the Wi-Fi Direct compatible device
     Tap Wireless Direct device name to display the printer’s name (the initial value is "DIRECT-XXXX-TA-20") displayed on a Wi-Fi Direct compatible device.
     Follow the procedure below to change the name.
     1. Tap the device name entry field on the touch screen.
     2. Enter device name (up to 32 characters).
     3. Tap OK and confirm the entered device name.
     4. Tap OK.
To change the confirmation screen setting when a Wi-Fi Direct compatible device is connecting to the printer

Tap **Connection request confirmation** to display the confirmation screen.

If you want the printer to display the screen to inform you a Wi-Fi Direct compatible device is connecting to the printer, tap **Yes**.

**Important**

- To prevent an unauthorized access, we recommend you should not change the setting from the default.

When you finished performing the settings, the printer returns to the **Wireless Direct settings** screen.

6. Touch **HOME** button.

The HOME screen appears.

**Note**

- If you change the wireless direct setting on the printer, also change the setting on the device.

### Change the Printer Setting to Wi-Fi Connection

1. **Make sure printer is turned on.**

2. On the HOME screen, tap **Network**.

3. Tap **Wi-Fi**.

4. Tap **Settings**.

5. Tap **Enable/disable Wi-Fi** and tap **Enable**.

6. Confirm displayed message and tap **OK**.
Windows Software

- Printer Driver
  - Overview of the Printer Driver
  - Printer Driver Description
  - Updating the Printer Driver

- Printing Using Canon Application Software
  - Easy-PhotoPrint Editor Guide
  - Preview Guide
  - Free Layout plus Guide
  - Direct Print & Share Guide
  - Quick Utility Toolbox Guide
  - IJ Network Device Setup Utility Guide
  - Media Configuration Tool Guide
  - Device Management Console Guide
  - Accounting Manager Guide
  - PosterArtist Guide
Printer Driver

- Overview of the Printer Driver
- Printer Driver Description
- Updating the Printer Driver
Overview of the Printer Driver

- Canon IJ Printer Driver
- Changing the Print Options
- Canon imagePROGRAF Preview
- How to Open the Printer Driver Setup Window
- Updating Media Information in Printer Driver
- Setting Accounting Information
- Deleting the Undesired Print Job
- Canon IJ Status Monitor
- Instructions for Use (Printer Driver)
The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific model you are using.

### Installing the Printer Driver
Load the Setup CD-ROM that comes with the printer, and then install the driver from Start Setup.

### Specifying the Printer Driver
To specify the printer driver, open the Print dialog box of the application software you are using, and select "XXX" (where "XXX" is your model name).

### Displaying the Manual from the Printer Driver
To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

### Related Topic
- [How to Open the Printer Driver Setup Window](#)
Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Special Settings... on the Layout tab

   ![Special Settings dialog box]

   The Special Settings dialog box opens.

3. Change the individual settings

   If necessary, change the setting of each item, and then click OK.

   The Layout tab is displayed again.
The Canon imagePROGRAF Preview is an application software that displays what the print result will look like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the document layout, print order, and number of pages. You can also change the media type and paper source settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

Related Topic

⇒ Displaying the Print Results before Printing
How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software
   In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)
   The printer driver setup window appears.

   **Note**
   • Depending on application software you use, command names or menu names may vary and there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to configure a printing profile that is common to all application software.

1. Display the Devices and Printers window
   Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.

2. Right-click your model name icon, and then select Printing preferences from the displayed menu
   The printer driver setup window appears.

   **Important**
   • Opening the printer driver setup window through Printer properties displays such tabs regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not appear when opening through Printing preferences or application software. For tabs regarding Windows functions, refer to the user's manual for the Windows.
Updating Media Information in Printer Driver

This function gets the latest media information from the printer and updates the media information in the printer driver. When the media information is updated, the media displayed for Media Type on the Main tab is updated to the latest information.

The procedure for updating media information is described below.

1. Display the Devices and Printers window
   Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers. The Devices and Printers window is displayed.

2. Display setup window
   Right-click the "Your model name" icon, and select Printer properties. The printer's Properties window appears.

3. Update media information
   Click Update Media Information the Device Settings tab. When a confirmation message appears, click Start. If the paper information on the driver cannot be updated, click Initial Check Items and check the displayed information. The printer driver media information will update.

   **Important**
   - It may take some time to update the media information.

4. Finish updating media information
   When a confirmation message appears, click OK. The media information will be updated.

   **Important**
   - Restart the printer driver after updating media information.
   - Do not change media information on the printer while you are updating media information on the driver.

   **Important**
   - Ensure that a user with administrative privileges carries out the media information update. Users other than administrators can check if a media information update is required, but cannot carry out the update itself.
   - When you have added, deleted, or edited media using administrative tools (the Media Configuration Tool) but have not updated the media information, issues may arise such as the inability to print.
Setting Accounting Information

By setting accounting information, you add IDs to print jobs, and use the printer and cost management tool to tabulate print history information for any ID.

The procedure for setting accounting information is described below.

1. Display the **Devices and Printers** window
   
   Select the **Control Panel** -> **Hardware and Sound** (Hardware) -> **Devices and Printers**. The **Devices and Printers** window is displayed.

2. Display setup window
   
   Right-click the "Your model name" icon, and select **Printer properties**. The printer's properties window appears.

3. Click **Accounting** on the **Device Settings** tab

   ![Accounting dialog box](image)

   The **Accounting** dialog box opens.

4. If necessary, complete the following settings:
Account ID/Account ID2
Enter the account ID to be set. Enter the ID by using up to 20 alphanumeric characters (0 to 9, a to z, and A to Z).

Prohibits Account ID changes
Prohibits changes to account IDs that have already been set.
Check this check box to prevent other users from changing IDs.

5. Apply the settings
Click OK.
The Device Settings tab is displayed again.
The settings are enabled hereafter.

Note
• Prohibits Account ID changes can be set only by users with Administrator rights.
  If this is set, users without Administrator rights may not be able to set Account ID and Account ID2.
Deleting the Undesired Print Job

If the printer does not start printing, canceled or failed print job data may be remaining. Delete the undesired print job by using the Canon IJ Status Monitor.

1. Open the printer driver setup window

2. Display the Canon IJ Status Monitor
   
   Click **Status Monitor...** on the **Main** tab.
   
   The Canon IJ Status Monitor appears.

3. Display the print jobs
   
   Click **Display Send Queue**.
   
   The print queue window opens.

4. Delete the print jobs
   
   Select the print jobs you want to delete, and select **Cancel** from the **Document** menu.
   
   When the confirmation message appears, click **Yes**.
   
   The deletion of the print job is complete.

**Important**

- Users who have not been granted access permission for printer management cannot delete the print job of another user.
The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress of printing. You will know the status of the printer with graphics, icons, and messages.

### Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When launched, the Canon IJ Status Monitor appears as a button on the task bar.

Click the button of the status monitor displayed on the task bar. The Canon IJ Status Monitor appears.

**Note**

- To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup window and click **Status Monitor...** on the **Main** tab.
- The information displayed on the Canon IJ Status Monitor may differ depending on the country or region where you are using your printer.

### When Errors Occur

If an error occurs (e.g., if the printer runs out of paper or if the ink is low), the Canon IJ Status Monitor displays an error information dialog box.
In such cases, take the appropriate action as described.
Checking the Ink Status from Your Computer

You can check the remaining ink level and the ink tank types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor
   - On the Main tab, click Status Monitor....
   - The Canon IJ Status Monitor opens.

3. Display Estimated ink levels
   - Ink status is displayed as an illustration.

   ![Canon IJ Status Monitor](image)

   **Note**
   - The information displayed on the Canon IJ Status Monitor may differ depending on the country or region where you are using your printer.
Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the printer driver.

Restrictions on the Printer Driver

- Before installing, log on to Windows as user with administrator rights.
- Always check the following before installing the software.
  1. Quit the application software while it is running.
  2. If you are printing a document, abort printing or wait for it to finish.
  3. Close all the printer driver's dialog boxes.
- If you can set the number of copies with the application software, set them either with the printer driver or the application software.
- If you can configure enlarging/reducing settings with the application software, set the normal size (100%) in the printer driver, and then configure the magnification factor with the application software.
- Depending on the application software used, it may be possible to print collated copies; however, please do not use this feature when configuring layout printing with the Page Layout option in the Layout tab. This may cause incorrect layout.
- When printing enlarged/reduced documents, printed results may come out different due to a discrepancy between the image data resolution and the enlarging/reducing ratio.
- When printing reduced color images, 1-dot wide lines or points may disappear from the color images.
- Depending on the application software, lines drawn at almost horizontal angles may not print correctly. If that should happen, re-draw the line horizontally and print one more time.
- Immediately after installing (or updating) the printer driver, you might not be able to visualize new features in some of the application software. In all application software provided with printing features, choose Print from the File menu and, after selecting the printer you are using, click the Properties. After the Properties dialog box has opened, immediately close it by clicking OK.
- If characters strings specified as stamps have a large number of characters, or if the characters have a large point size, you may not be able to print stamp strings.
- If characters strings specified as stamps contain external characters after F040, you will not be able to print the stamp strings.
- If you update the model name of your printer through the General tab in the printer's Properties, the Favorites settings registered in the printer driver will be disabled. In such cases, save the Favorites settings as a file before changing the name of the printer and reload the saved file after you have updated the printer's name.
- Printing at high resolution requires a large amount of memory on your computer. When your computer is low on memory or you are using a large number of application software, the application software may not work correctly. In such cases, re-start Windows and, before resuming printing, close all the applications you are not using. Also, when the printer is not printing correctly, switch the Print Quality setting in the Main tab to a lower resolution.
• When using a local connection, if you do not see a check mark next to the Enable bidirectional support option in the Ports tab in the printer's Properties, it will not be possible to acquire printer and device information correctly.

• If you are using your printer with a USB connection, refrain from using standby mode. You can set standby mode through the Power Options on the Control Panel.

• In case of a large amount of print data, the printer may time-out during printing and you may no longer be able to print.

In such cases, in the Advanced tab in the printer's Properties, choose Spool print documents so program finishes printing faster and place a check mark next to Start printing after last page is spooled.

• Fine lines and gradients may not print correctly.

In such cases, choose Print from the File menu of application software and, after opening from there the property dialog box of the printer driver, follow the procedure below and then run printing.

1. In the Main tab, uncheck Preview before printing.
2. In the Layout tab, uncheck Page Layout.
3. If you are using a 32-bit driver, in the Layout tab, click on Special Settings to open the Special Settings dialog box and turn off Fast Graphic Process.

• In case of a large amount of print data, the printer may time-out during printing and you may no longer be able to print.

In such cases, you may be able to print by increasing the time set in Job timeout in the printer’s control panel.

• Depending on the application used, if you print using features like enlarging/reducing, layout printing, page borders and so on, some of the data in the resulting printed document, for example graphics, may differ from the source document.

• If you print very large images from your computer when it's running low on memory, you may not be able to print correctly; for example, it may take a very long time to print or parts of the image may end up missing.

In such cases, try printing after following the procedure indicated below.

◦ If you are using a 32-bit driver, open the Layout tab and click Special Settings. Turn off Fast Graphic Process.
◦ Increase your computer memory.
◦ Increase the virtual memory of your operating system.

• To print to cut sheets, you must use the Free Layout function. Go to the Canon website, download imagePROGRAF Printer Driver Extra Kit, and then install it.

• Do not change the Print Processor... settings in the Advanced tab in the printer Properties. If you change them, you will not be able to use the following features correctly.

◦ The Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab
◦ The Canon imagePROGRAF Preview feature

• In the cases described below, you will not be able to use the Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab as well as the Canon imagePROGRAF Preview feature.

◦ When right-clicking on the printer icon and choosing from See what's printing: Printer -> Pause Printing, or when right-clicking on the printer icon and choosing Pause Printing
◦ When right-clicking on the printer icon and choosing from See what's printing: Printer -> Use Printer Offline, or when right-clicking on the printer icon and choosing Use Printer Offline
- When printing during hours other than those set in Available from and To in the Advanced tab in the printer's Properties
- When printing with the Enable advanced printing features turned off in the Advanced tab in the printer's Properties
- When printing with Print directly to the printer enabled in the Advanced tab in printer's Properties
- When printing after the printing port in the Ports tab in the printer's Properties has changed to FILE:
  - When printing after choosing Output to file in the Print dialog box in the application software

  • If you perform a point-and-print installation, you will not be able to use the Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab as well as the Canon imagePROGRAF Preview feature.
  • If you print after setting Free Layout and Edit Using PosterArtist, refrain from printing from other drivers.
  • If you combine specific Print Quality with large paper sizes, you may not be able to correctly print stamps and borders.
  • In the Canon imagePROGRAF Preview, characters and fine lines visualized in the View screen may look differ from printed results. In such cases, try choosing the Layout tab, opening the Special Settings dialog and turning on Preview Switching.

Points to Note About Applications with Restrictions

- If, in Microsoft Excel, you tick Collate and then you print more than one copy, or if you do Entire workbook after configuring different settings in each tab, you may not be able to perform layout printing nor to get the intended printing results.
- If you try to print data on a very large-size paper through applications like Adobe Illustrator, you may not be able to print.
  In such cases, try printing after following the procedure indicated below.
  - Open the Main tab and uncheck Preview before printing.
  - If you are using a 32-bit driver, open the Layout tab and click Special Settings.
    Turn off Fast Graphic Process.
  - Increase the virtual memory of your operating system.
  - If you are using Adobe Illustrator, turn off/on Bitmap printing in the Print dialog box.

- In the cases described below, you will not be able to use the Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab.
  - When printing from application software which do not allow EMF spooling, like Adobe Photoshop LE, MS Photo Editor, Ace Draw and others.

- When printing from Adobe Photoshop, tone jumps may occur in the gradation of black and white photographs.
- When printing data created with Microsoft Word using Enlarged/Reduced Printing or Borderless Printing, you may not be able to print correctly.
  In such cases, try printing after following the procedure indicated below.
  - Open the printer folder from the start menu, right click on the printer icon and select Printing preferences. Launch the application after setting, in the Page Setup tab, Page Size, Enlarged/Reduced Printing and Borderless Printing.
  - Open Microsoft Word's Page setup dialog box and close it by clicking OK.
After configuring the printer driver, close momentarily the **Print** dialog box without printing. Then, open the printer driver's set up screen once again, close it by clicking **OK**, and run printing.
Printer Driver Description

▸ Main Tab Description
▸ Page Setup Tab Description
▸ Layout Tab Description
▸ Favorites Tab Description
▸ Maintenance Tab Description
▸ Device Settings Tab Description
▸ Canon IJ Status Monitor Description
Main Tab Description

The **Main** tab allows you to create a basic print setup in accordance with the media type. Unless special printing is required, normal printing can be performed just by setting the items on this tab.

Settings Preview

The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.
The printer illustration shows how to load paper to match the printer driver settings.
Check whether the printer is set up correctly by looking at the illustration before you start printing.

Media Type

Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is carried out properly for the specified paper.

Get Information...

Opens the **Paper Information on Printer** dialog box.
You can check the settings on the printer and apply the checked settings to the printer driver.

Specify...

Open the **Paper Detailed Settings** dialog box, and specify detailed print settings that match the media type loaded in the printer.

Pull-down menu

Switches the **Easy Settings** and **Advanced Settings**.

**Easy Settings**

This mode allows you to print by using pre-registered print settings.

**Print Target**

Print settings that are generally used frequently are pre-registered as print purposes. By using a print purpose to print, you can print by using settings that match the document.

**Default Settings**

Select this setting to print a general document such as an business documents.
**Photo (Color)**
Select this when printing a color illustration or a photograph.

**Poster**
Select this when printing a poster.

**CAD (Color Line Drawing)**
Select when printing data such as drawings.

**CAD Monochrome**
Select when printing data such as drawings in monochrome.

**Perspective, GIS**
Select when printing data such as perspectives and GIS.

**Print Quality**
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

- **High**
  Gives priority to print quality over printing speed.

- **Standard**
  Prints with average speed and quality. Resolution settings depend on media type.

- **Fast**
  Gives priority to printing speed over print quality.

- **Custom**
  Opens the **Custom** dialog box.
  Select this when you want to set the printing quality level individually.

**View Settings**
Opens the **View Settings** dialog box.

**Advanced Settings**
This mode allows you to print by specifying detailed settings that match your purpose.

**Print Priority**
Select elements to prioritize for print results.

- **Image**
  Prioritize image results when printing.

- **Line Drawing/Text**
  Prioritize detailed lines and text when printing.

- **Auto (Use Printer Settings)**
  Use printer settings when printing.

**Print Quality**
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
Important

- Depending on the Media Type settings, the same print results may be produced even if the Print Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality. Resolution settings depend on media type.

Fast
Gives priority to printing speed over print quality.

Custom
Opens the Custom dialog box.
Select this when you want to set the printing quality level individually.

Color Mode
Select the color to print.

Color
Prints with the number of colors in the document.

Monochrome
Print in grayscale.

Monochrome Bitmap
Print all non-white parts in black.

Color Settings
Opens the Color Settings dialog box.
You can adjust individual color settings such as Cyan, Magenta, Yellow, Brightness, and Contrast on the Color Adjustment tab, and select the Color Correction method on the Matching tab.

Thicken Fine Lines
Prints thin lines thicker for easier viewing.

Preview before printing
You can start up the Canon imagePROGRAF Preview, and check what the printing results will be before executing the print.
Check this check box to display a preview before printing.

Status Monitor...
Displays the status monitor.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory settings).
Paper Detailed Settings dialog box

Drying Time
Wait time can be set to allow ink to dry. Between Pages settings are only enabled for roll paper.

Between Pages
The wait time until outputting paper can be set after printing one page. Time is taken before cutting roll paper to allow the ink to dry, so even when Automatic Cutting in the Roll Paper Options of the Page Setup tab is set to Yes, page may be dropped into the basket with dried ink.

Printer Default
Settings in printer unit control panel are applied.

None
Page will be output immediately after printing

30sec. / 1min. / 3min. / 5min. / 10min. / 30min. / 60min.
Page will be output after set amount of time has passed after printing.

Between Scans
The wait time until printing next scan can be set after printing one scan in page. Set in the event smudging occurs in the page, unevenness occurs in borderless printing, etc., and you would like to avoid this smudging and unevenness.

Printer Default
Settings in printer unit control panel are applied.

None
Next scan will be print immediately after first scan is print.

0.5sec. / 1sec. / 3sec. / 5sec. / 7sec. / 9sec.
Next scan will be print after the set amount of time has passed after printing one scan.
* If smudges and/or unevenness occur, please increase time.

Roll Paper Safety Margin
In order for heavily curling paper to absorb well in platen, length of margin established on edge of paper can be selected.

Near End Margin
Roll Near End Margin length can be set.

Printer Default
Settings in printer unit control panel are applied.

3mm
Will be print in standard size.
* Please select when there are no particular problems with printing.

20mm
Please select when rubbing of the print heads occurs, such as when heavily curling paper is being used.

Cut Speed
Select auto-cut speed. This can be adjusted when paper cannot be cut precisely with auto-cut.

Printer Default
Settings in printer unit control panel are applied.
Fast
Select when cut is not smooth with Standard settings.

Standard
Select when there are no particular problems with auto-cut.

Slow
If this is selected for paper with adhesive, the cutter will not stick to the adhesive easily and it will slow deterioration of the cutter's capabilities.

Unidirectional Printing
Controls color unevenness and unaligned ruled lines.
Please check when printing in one direction.

Mirror
Select whether to print reflected image or not. When box is checked and turned on, text and images will be printed as if reflected in a mirror.

Custom dialog box
Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.

Important
- Certain print quality levels cannot be selected depending on the settings of Media Type.

Note
- The High, Standard, or Fast print quality modes are linked with the slider bar. Therefore when the slider bar is moved, the corresponding quality and value are displayed on the left. This is the same as when the corresponding radio button is selected for Print Quality on the Main tab.

View Settings dialog box

Print Target
Select the print purpose. The settings of the selected print purpose are displayed in Details.

Name
Displays the name of the selected print purpose.

Details
Displays the settings of the print purpose that was selected for Print Target.

Color Settings dialog box

Color Adjustment Tab
This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow, Tone, Brightness, and Contrast options.
Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color balance of the document. Use your application if you want to change the total color balance significantly. Use the printer driver only if you want to adjust the color balance slightly.

Brightness
Adjusts the brightness of your print. You cannot change the levels of pure white and black. However, the brightness of the colors between white and black can be changed. Colors become darker as you drag the slider toward the right and brighter as you drag the slider toward the left. You can also directly enter brightness values that are linked to the slider bar. Enter a value in the range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Matching Tab
This is displayed when Color is selected for Color Mode.
Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM, ICC Profile Matching, or None to match the purpose of the print operation.

Driver Matching
Print with the optimal color using the driver's original color profile. Normally, you should choose this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing from an ICM function-compatible application.
None
Print without performing color matching on the printer driver. Select this when performing color matching using applications such as Adobe Photoshop, or printing using a profile creation tool or color chart.

**Important**
- When setting not to use ICM in the application software, ICM and ICC Profile Matching of Color Correction do not function. There are also times when it does not print correctly.

Input Profile
Specifies the input profile to be used when you select ICC Profile Matching for Color Correction.

Printer Profile
Specifies the printer profile to be used when ICC Profile Matching is selected for Color Correction. Normally Auto is selected but you can also select a printer profile manually.

Rendering Intent
Specifies the matching method to be used when you select Driver Matching, ICM, or ICC Profile Matching for Color Correction.

Perceptual (Photo) / Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting this setting allows you to adjust colors easily using an application software.

Saturation (Poster/CAD) / Saturation
Reproduces vivid colors on data such as a poster. In addition, prints in easy-to-see colors suitable for line drawing.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image data so the color reproduction approximates the shared color regions. Select this method to print image data with colors that are close to the original colors.
The white spots are reproduced as white spots (background color) on the paper.

Absolute Colorimetric
This method uses the white spot definitions in the input and output ICC profiles to convert the image data.
Although the color and color balance of the white spots change, you may not be able to get the desired output results because of the profile combination.

**Important**
- Depending on the media type, you may obtain the same print results even when you change the Rendering Intent setting.
- If Driver Matching is selected for Color Correction, then Relative Colorimetric and Absolute Colorimetric are not displayed.
Page Setup Tab Description

The **Page Setup** tab allows you to set borderless printing for a document and specify the scaling.

**Settings Preview**
- The paper illustration shows how the original will be laid out on a sheet of paper.
- You can check an overall image of the layout.
- The printer illustration shows how to load paper to match the printer driver settings.
- Check whether the printer is set up correctly by looking at the illustration before you start printing.

**Page Size**
- Selects a page size.
- Ensure that you select the same page size as you selected within the application.
- When you select **Custom Size** from **Custom Paper Size**, the **Custom Size Settings** dialog box appears, and you can specify any vertical and horizontal dimensions for the paper.

**Borderless Printing**
- Chooses whether you are printing on a full page without any page margins or printing with page margins.
- In borderless printing, originals are enlarged to extend slightly off the paper. Thus, printing can be performed without any margins (border).

**Important**
- When **Cut Sheet** is selected for **Paper Source**, **Borderless Printing** is grayed out and cannot be set.

**Borderless Setting**
- Select **Borderless Printing** to enable it for clicking.
- Open the **Borderless Setting** dialog box, so that you can adjust **Amount of Extension**.

**Borderless Printing Method**
- This appears when you select **Borderless Printing**.
- Set the borderless printing method.
**Fit Paper Size**
Enlarge or reduce the document to match the size of the paper to be printed, and then print the document.

**Scale to fit Roll Paper Width**
You can enlarge or reduce the document to match the roll paper width and then print the document.

**Print Image with Actual Size**
Prints the document at its actual size.
When you select this check box, the Information dialog box appears, and you can select **Roll Width**.

**Printer Paper Size**
When you select the **Fit Paper Size** check box, you can specify the setting.
Select the size of the paper to be printed.
The list displays the paper sizes that support borderless printing.

**Enlarged/Reduced Printing**
You can enlarge or reduce a document and then print it.
When you select **Enlarged/Reduced Printing**, you can then set **Fit Paper Size**, **Fit Roll Paper Width**, or **Scaling**.

**Fit Paper Size**
Enlarge/reduce the document to match the size of the paper to be printed, and then print the document.

**Fit Roll Paper Width**
You can enlarge/reduce the document to match the roll paper width and then print the document.

**Scaling**
Enlarge or reduce the document to a specified scale before printing.

**Printer Paper Size**
When you select the **Fit Paper Size** check box, or **Scaling** check box, you can specify the setting.
Select the size of the paper to be printed.

**Orientation**
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that you selected in that application.

**Portrait**
Prints the document so that its top and bottom positions are unchanged relative to the paper feed direction. This is the default setting.

**Landscape**
Prints the document by rotating it 90 degrees relative to the paper feed direction.

**Rotate Page 90 degrees**
Rotate the long edge of the document 90 degrees, match it to the width of the roll paper, and then print the document.
When you print a portrait document onto roll paper, you can save paper by rotating the document 90 degrees and print the document horizontally relative to the paper.
Paper Source

Shows the source from which paper is supplied.
You may be able to switch the paper source with the printer driver.

Roll Paper
Feeds paper using roll paper.

Cut Sheet
Feeds paper using the cut paper.

Important

• Depending on the media type and size, the Paper Source settings that can be selected may differ.

Roll Width

Select the roll paper width.
Select the width that matches the width of the roll paper loaded in the printer. If you select Custom Size (XXXX), the Custom Size Settings dialog box will be displayed, and the roll width can be specified to any value.

Roll Paper Options
Displays the Roll Paper Options dialog box.
You can specify auto cut, banner printing, and other settings for printing on roll paper.

Size Options...
Displays the Paper Size Options dialog box.
The Paper Size Options dialog box allows you to create and register any user-defined paper.

Custom Size Settings dialog box (Paper Size)

This dialog box allows you to specify the size (width and height) of the custom paper.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the units specified in Units.

Units
Select the unit for entering a user-defined paper size.

Borderless Setting dialog box

Adjust how much of the document extends off the paper during borderless printing, and configure the three-sided borderless setting.

Amount of Extension
Adjusts how much of the document extends off the paper during borderless printing.
Moving the slider to the right increases the amount of extension and allows you to perform borderless printing with no problems.
Moving the slider to the left reduces the amount of extension and expands the range of the document to print.
Three-sided Borderless
If you check this check box, and the width or the length of the output paper size is smaller than the roll width, a margin will be created on the right of the document, and the remaining three sides (top, bottom, and left) will be borderless when printing.

Custom Size Settings dialog box (Roll Paper Width)
Enter the roll width you want to use.

Roll Paper Width
Specify the Width of the roll paper. Measurement is shown according to the units specified in Units.

Units
Select the unit for entering a user-defined paper size.

Roll Paper Options dialog box
You can specify settings for printing on roll paper.

Automatic Cutting
You can print cut guidelines for cutting the roll paper automatically or manually after printing.
Yes
Cut the roll paper automatically after printing.
No
Do not cut the roll paper automatically after printing.
Print Cut Guideline
Prints cut guidelines for cutting the roll paper manual after printing.

Banner Printing
Select this check box to print documents extending over several pages as one continuous document without any spaces between the pages.

Paper Size Options dialog box
You can create and register any user-defined paper. You can then select the defined paper size from Custom Paper Size of Page Size.

Paper Size List
The names and sizes of the paper sizes that the printer driver can use are displayed.

Delete
From Paper Size List, you can delete a user-defined paper that a user created.

Note
- Paper deletion is not possible in the following case:
  - When a standard paper size of the printer driver is selected
  - When an oversized paper size is selected
  - When a paper size with a red circle is selected
Custom Paper Size Name
You can specify the name of a user-defined paper.

Units
You can specify the units for the height and width dimensions of the user-defined paper.

Page Size
You can specify the Width and Height settings of the paper.

Borderless Printing Size
When you select this check box, you can select a size from the paper sizes that support Borderless Printing.

Fix the Ratio of the Width to Height
When you select this check box, you can change the size while keeping the Width and Height ratio.

Width
Specify the paper width.

Height
Specify the paper height.

Register with the OS
Register the set user-defined paper in the OS.
By registering in the OS, any user sharing the use of the printer or PC can use the set user-defined paper.

Add
You can register a user-defined paper that was set and overwrite the existing user-defined paper.

Display Series
You can narrow down the paper sizes to be displayed in Paper Size List.

Oversize
Add appropriate margins so that the document contents will not get cut off, and then print the document.
The **Layout** tab allows you to specify how to arrange the document onto the paper. You can also set the number of copies to be printed and the print sequence. If the application software that you used to create the document features the same functions, specify the settings from the application software.

**Settings Preview**

The paper illustration shows how the original will be laid out on a sheet of paper. You can check an overall image of the layout.

The printer illustration shows how to load paper to match the printer driver settings. Check whether the printer is set up correctly by looking at the illustration before you start printing.

**Page Layout**

Selects the size of the document you want to print and the type of printing.

**Poster (1 x 2) / Poster (2 x 2)**

Poster printing is performed. The value in parentheses represents the ratio of the vertical x horizontal lengths. As the number of divisions increases, the number of sheets used for printing increases. If you are pasting pages together to create a poster, increasing the number of divisions allows you to create a larger poster.

**Set...**

Opens the **Pages to Print** dialog box. Specify this setting when you want to print only specific pages.

**Free Layout**

You can freely position and print any document created with an application software. You must install imagePROGRAF Printer Driver Extra Kit to use this function. Go to the Canon website, download imagePROGRAF Printer Driver Extra Kit, and then install it.

**Set...**

Opens the **Free Layout Settings** dialog box. You can freely specify detailed settings for free layout.
2 Pages/Sheet / 4 Pages/Sheet / 6 Pages/Sheet / 8 Pages/Sheet / 9 Pages/Sheet / 16 Pages/Sheet

Multiple pages are assigned to one sheet of paper and printed. The number presents the number of pages assigned to one sheet.

Set...

Opens the Page Layout Printing dialog box.
You can freely specify detailed settings for assigned printing.

Edit Using PosterArtist

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print from PosterArtist. You must install PosterArtist to use this function. Go to the Canon website, download PosterArtist, and then install it.

Stamp

The Stamp function prints a specific character string over the document pages. You can select the characters to be printed from a list or use the Define Stamp dialog box to set any characters.

Define Stamp...

Opens the Define Stamp dialog box.
You can specify detailed stamp settings or register any stamp.

Print Centered

Prints document in center of paper.

Rotate 180 degrees

Rotates document 180 degrees and prints it.

No Spaces at Top or Bottom

When printing on roll paper, you can save paper by reducing the upper and lower margins when printing.

Copies

Specifies the number of copies you want to print. You can specify a value from 1 to 999.

Important

• If the application used to create your document has a similar function, specify the number of copies with the application without specifying it here.

Print from Last Page

Check this check box when you want to print from the last page in order. If you do this, you do not need to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate

Check the check box when you are printing two or more copies, and want to print them in groups.
Uncheck the check box when you want to print them as a group on the same page.

Page Options

Opens the Page Options dialog box.
You specify settings for printing information such as date, user name, and page number.

Special Settings

Opens the Special Settings dialog box.
If you are unable to obtained the desired print results, you can change the print processing method.
Pages to Print dialog box

When printing a poster that has been divided into several pages, you can specify which pages to print and just print those pages.
Simply clear the check boxes of the pages you do not want to print.
In the setting view, the pages that were unchecked are hidden, and only the pages to be printed are displayed.

Invert
Switches the pages to be displayed or hidden.

Note
• The Pages to Print dialog box appears only when Poster (1 x 2) or Poster (2 x 2) is selected for Page Layout.

Free Layout Settings dialog box

You can specify detailed settings for free layout.

Paper Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that you selected in that application.

Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed direction.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.

Roll Paper Length
Sets the roll paper length.

Auto
Automatically determines the roll paper length and prints.

Manual Settings
Determines and specifies the roll paper length.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Note
• The Free Layout Settings dialog box appears only when Free Layout is selected for Page Layout.

Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper, the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.
Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Note
- The Page Layout Printing dialog box appears only when 2 Pages/Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet is selected for Page Layout.

Define Stamp dialog box
The Define Stamp dialog box allows you to specify settings for printing a stamp over the document pages. In addition to the pre-registered ones, you can register and use your original stamp.

Watermark List
This is a list of the pre-registered stamps.

Add
Creates an original stamp.
Click this item to set Name, Text, Font, Style, Size, and Color.
Name
Enter the stamp name to be registered.

Text
Enter the characters to be used in the stamp.

Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Color
Select the color of the stamp text string.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Watermark List, and click this button.

Outline
Selects a frame that encloses the stamp text string.

Print Style
Select the stamp printing method.
Select Transparent to print the stamp on the back of the document, and select Overlap to print the stamp on the front.
Position
Specifies the stamp position on the page.
You can specify values in X and Y to set the coordinates, or you can drag the horizontal and vertical slide bars to the left/right or up/down to change the coordinates.

Move to Center
Moves the stamp to the center of the paper.

Angle
Set the stamp positioning angle.
You can specify a value in Set Angle to set the angle, or you can drag the slide bar left/right to change the angle.
When specifying an angle value, set a value in the range of -180 to 180.

Stamp first page only
Select this check box if you want to print a stamp only on the first page.

Page Options dialog box
Specify the print settings, such as date, user name, and page number.

Print Date
Select the position for printing the date.

Print Time Also
Prints the time along with the date.

Print User Name
Select the position for printing the user name.

Print Page Number
Select the position for printing the page number.

Format Settings
The Format Settings dialog box opens, and you can set the format.

Format Settings dialog box
Set the format to be used when printing the contents set in the Page Options dialog box.

Font
Select the font type.

Style
Select the font style.

Size
Select the font size.

Color
Select the font color.
Special Settings dialog box

The **Special Settings** dialog box allows you to change the print processing method if you do not get the print results you want.

Settings Summaries

This is a list of items that you can set in the **Special Settings** dialog box.

When you click an item that you want to set, the setting contents are displayed outside the box.

**Spooling at Printer Driver**

Set whether print jobs are to be spooled in the print driver or whether PageComposer processing is to be performed.

Setting **Do Not Print** or **No (EMF Spooling)** may improve the print results.

**FineZoom Settings**

Use this function to print on long paper.

- **Yes**
  
  The print problem may be corrected.
  
  Select this in usual cases.

- **No**
  
  Image distortions may be corrected (for example, small lines may be eliminated).

**Preview Switching**

If you check the **Preview before printing** check box on the **Main** tab and then print, PageComposer starts.

**Application Color Matching Priority**

You can assign higher priority to color management by the application software.

**Fast Graphic Process**

If image colors or line thicknesses are printed incorrectly, you may be able to get the print results you want by setting this function to off.

This is only displayed when using a 32-bit driver.

**Disable the color profile setting of the application software**

If the color profile information set in the application software is output to the printer driver, the printing results may include an unexpected tint. You can resolve the problem in this case by setting **Disable the color profile setting of the application software** to **On**.

**Important**

- Even if this is set to **On**, it will only disable some of the color profile information, and it is still possible to print using the color profile.
  
  This should normally be set to **Off** when using.

**Adjust Faint Lines**

This function prevents thin lines from fading when printing by darkening light colored lines.

**Sharpen Text**

Set this to print fine text clearly.
Favorites Tab Description

The **Favorites** tab allows you to register frequently used print settings as favorites.

**Favorites**
A list of the registered favorite settings appears. The Default Settings are registered in the initial settings.

**Details**
The settings of the favorite that you selected from **Favorites** appear.

**Comment**
The comment registered to the favorite appears.

**Apply Favorite**
You can change the print settings to the settings of the favorite that you selected from the **Favorites** list.

**Delete**
You can delete favorites that have become unnecessary.

**Edit...**
The **Edit** dialog box opens.
You can change the name and icon settings of the favorite that you selected from the **Favorites** list.

**Add...**
The **Add** dialog box opens.
You can register the current settings as a favorite.

**Application Settings Priority**
The setting in the application software will take priority over the favorites setting set on the printer driver. The setting in the application software is only prioritized for **Page Size**, **Orientation** and **Copies**.
Place a checkmark to prioritize the settings for the application software.

**Import...**
You can read the settings of the favorite that was saved to a file.
Export...
You can save the settings of a favorite to a file.

Edit dialog box
You can change the name and icon of the favorite that you selected from the Favorites list.

Name
Changes name to be displayed in Favorites list.

Icon
Changes icon to be displayed in Favorites list.

Comment
Changes information to be displayed in Comment.

Add dialog box
You can save the current print settings as the settings of a favorite.

Name
Set the name to be displayed in Favorites list.

Icon
Set the icon to be displayed in Favorites list.

Comment
Enter information to be displayed in Comment.
Maintenance Tab Description

The **Maintenance** tab allows you to perform printer maintenance or change the settings of the printer.

**Print Nozzle Check Pattern**

Prints a nozzle check pattern.

Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check pattern, and check whether the print head is working properly.

If the print result for a specific color is fainted, or if there are any unprinted sections, use **Print Head Cleaning** to clean the print head.

**Paper Source**

Displayed using the **Media Type**, **Page Size** and **Roll Width** for each currently set paper feed position.

**Print Head Cleaning**

Performs print head cleaning.

Print head cleaning removes any blockage in the print head nozzles.

Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels are sufficiently high.

There are two head cleaning functions, which are described below.

**Cleaning**

Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels are sufficiently high.

**System Cleaning**

**System Cleaning** is a more powerful cleaning function. Execute this function if the condition does not improve even after you repeat **Cleaning** several times.
### Important

- **System Cleaning** consumes an extremely large amount of ink. Executing system cleaning frequently will rapidly deplete your printer’s ink supply. Therefore, execute system cleaning only when necessary.

### Paper Feed Amount Adjustment

This function adjusts the paper feed amount if the print result is faint or contains streaks.

### View Status

This function displays printer information and setting values.

### Related Topics

- [Cleaning the Print Heads](#)
- [Printing a Nozzle Check Pattern](#)
Device Settings Tab Description

Many of the tabs in the Properties windows of the printer are controlled by Windows. However, the Device Settings tab is for specifying printer configuration-related settings and is part of the printer driver. The Device Settings tab allows you to specify settings related to the printer unit.

Update Media Information
Opens the Update Media Information dialog box.
Gets the latest media information from the printer and updates the media information in the printer driver.

Accounting
Opens the Accounting dialog box.
By setting Accounting information, you add IDs to print jobs, and use the printer and cost management tool to tabulate print history information for any ID.

Note
- Accounting can be set only by users with Administrator rights.
  Users without Administrator rights may not be able to set Accounting information.

Device Information
Opens the Device Information dialog box.
You can obtain the device information of the connected printer, and change the configuration to match the printer that is connected to the driver function.

About
Opens the About dialog box.
You can check information such as the version and copyright of the printer driver.

Accounting dialog box
Click Accounting to display the Accounting dialog box.
The Accounting dialog box allows you to add IDs to print jobs. You can then use the IDs, along with the printer and cost management tool, to tabulate print history information.
Account ID/Account ID2
Enter the account ID to be set. Enter the ID by using up to 20 alphanumeric characters (0 to 9, a to z, and A to Z).

Prohibits Account ID changes
Prohibits changes to account IDs that have already been set.
Check this check box to prevent other users from changing IDs.

Device Information dialog box
The Device Information dialog box allows you to obtain the device information of the connected printer, and change the configuration to match the printer that is connected to the driver function.

Settings Summary
This is a list of items that you can set in the Device Information dialog box.
When you click an item that you want to set, the setting contents are displayed outside the box.

Acquire Status
Obtain device type and hard disk information from the printer.
Canon IJ Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses graphics, icons, and messages to let you know the printer status.

Canon IJ Status Monitor Features

The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
- The status of the printer is shown on the screen in real time.
- You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
- Shown when a printer error occurs.
- You can immediately check how to respond.

You can check the ink status.
- This function displays graphics showing the ink tank type and the estimated ink levels.
- Icons and messages are displayed when ink is running low (ink level warning).

Canon IJ Status Monitor Overview

Canon IJ Status Monitor allows you to check the status of the printer and ink with graphics and messages. You can check the information on the printing document and the printing progress during printing. When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
- Canon IJ Status Monitor shows an icon when a warning or error occurs to the printer.
  - !: A warning is being displayed.
  - X: An operation error has occurred.
  - i: You are being informed of remaining ink levels, etc.
  - 0: There has been an error which requires a service.
Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Remaining Printing Time of Current Page
Displays the remaining print time of the pages being printed.

Display Send Queue
Shows the print window used to manage the print job that is being printed or being in the print queue.

Cancel Printing
Cancels the current print job.

Estimated ink levels
Displays icons to report a remaining ink level warning and an ink depletion error.

Click (the disclosure triangle) to display a pictorial representation of the estimated ink level in the ink tank.

Purchase Ink
A screen for purchasing ink appears. You can use this screen to purchase ink.

Ink Model Number
You can look up the correct ink tank for your printer.

Estimated Maintenance Cartridge Usage
Displays icons to report that the available space in the maintenance cartridge is low or the cartridge is full.

Click (the disclosure triangle) to display a pictorial representation of the estimated space available in the maintenance cartridge.

Paper Feed
Displays the size and type of paper loaded in each feeder.

Click (the disclosure triangle) to check the remaining amount of paper.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon IJ Status Monitor starts.

When Enable Status Monitor is selected, following commands are available.

Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs
Starts the Canon IJ Status Monitor window automatically and displays it in front of the other windows when a low ink warning occurs.
When a Maintenance Cartridge Warning Occurs
When a maintenance cartridge remaining space warning occurs, the Canon IJ status monitor starts automatically and appears in front of all other windows.

Other Warnings
When any other warning occurs, the Canon IJ Status Monitor will open automatically and be displayed in front of other windows.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Remote UI menu
You are able to open the printer’s Remote User Interface.
You are able to check the printer status and run maintenance functions on the printer when connected to and using it through a network.

Note
- When the printer is being used via USB connection Remote UI will not display.

Printer Information
Allows you check detailed information, such as the printer status, the print progress, and remaining ink levels.

Maintenance
Allows you to run printer maintenance and change printer settings.

Job Log
Displays the Job history window.

Job List
Displays the Print job window.

Ink Supplier Display Settings
Displays the Ink supplier information window.

Download Security Certificate
Displays the For secure communication window.
This window allows you to download the root certificate, register it to the browser, and disable warning displays.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and you can check the version and copyright information.
Updating the Printer Driver

- Obtaining the Latest Printer Driver
- Deleting the Unnecessary Printer Driver
- Before Installing the Printer Driver
- Installing the Printer Driver
Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved. You can check the version of the printer driver by clicking the **About** button on the **Main** tab.

You can access our website and download the latest printer driver for your model.

**Important**

- You can download the printer driver for free, but any Internet access charges incurred are your responsibility.

**Related Topics**

- [Before Installing the Printer Driver](#)
- [Installing the Printer Driver](#)
Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

   Select the **Control Panel** -&gt; **Programs** -&gt; **Uninstall a program** (**Programs and Features**).
   From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then click **Uninstall**.
   
   The confirmation window for uninstalling the model appears.

   **Important**
   - A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
     This dialog box appears when administrative rights are required to perform a task.
     When you are logged on to an administrator account, click **Yes** (or **Continue**, **Allow**) to continue.
     Some applications require an administrator account to continue. In such cases, switch to an administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

   Click **Start**. When the confirmation message appears, click **Yes**.
   When all the files have been deleted, click **Complete**.
   The deletion of the printer driver is complete.
Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also refer to this section if the printer driver cannot be installed.

Checking the Printer Status

- Turn on the printer.

Checking the Personal Computer Settings

- Terminate all running applications.
- Log on as a user who has the administrator account.

Related Topics

- Obtaining the Latest Printer Driver
- Installing the Printer Driver
Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver for your model.

The procedure for installing the downloaded printer driver is as follows:

1. Turn on the printer

2. Start the installer
   
   Double-click the icon of the downloaded file.
   
   The installation program starts.

   **Important**
   
   • A confirmation/warning dialog box may appear when starting, installing or uninstalling software.
   
   This dialog box appears when administrative rights are required to perform a task.
   
   When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
   
   Some applications require an administrator account to continue. In such cases, switch to an administrator account, and restart the operation from the beginning.

3. Install the printer driver
   
   Take the appropriate action as described on the screen.

4. Complete the installation
   
   Click Complete.
   
   Depending on the environment you are using, a message prompting you to restart the computer may be displayed. To complete the installation properly, restart the computer.

   **Important**
   
   • You can download the printer driver for free, but any Internet access charges incurred are your responsibility.

**Related Topics**

- [Obtaining the Latest Printer Driver](#)
- [Deleting the Unnecessary Printer Driver](#)
- [Before Installing the Printer Driver](#)
Printing Using Canon Application Software

- Easy-PhotoPrint Editor Guide
- Preview Guide
- Free Layout plus Guide
- Direct Print & Share Guide
- Quick Utility Toolbox Guide
- IJ Network Device Setup Utility Guide
- Media Configuration Tool Guide
- Device Management Console Guide
- Accounting Manager Guide
- PosterArtist Guide
macOS Software

Printer Driver
- Overview of the Printer Driver
- Description of Print Dialog
- Updating the Printer Driver

Printing Using Canon Application Software
- Easy-PhotoPrint Editor Guide
- Preview Guide
- Free Layout Guide
- Quick Utility Toolbox Guide
- IJ Network Device Setup Utility Guide
- Media Configuration Tool Guide
- Device Management Console Guide
- Accounting Manager Guide
Printing Using Canon Application Software

- Easy-PhotoPrint Editor Guide
- Preview Guide
- Free Layout Guide
- Quick Utility Toolbox Guide
- IJ Network Device Setup Utility Guide
- Media Configuration Tool Guide
- Device Management Console Guide
- Accounting Manager Guide
Managing Print Jobs

- Checking Print Job Information
- Accounting Manager Guide
- Basic Print Job Operations
  - Managing Job Queue (Delete)
Checking Print Job Information

You can check the details of the print job being processed (job queue) or delete it from the Web browser or the control panel of the printer.

• Using web browser:
  Log in to the printer from web browser, select **Job management**, and perform operations.

  ➤ [Configuration Changes Using Web Browser](#)

• Using operation panel:

  Tap **(Jobs)** on the HOME screen, and perform operations.
Basic Print Job Operations

▶ Managing Job Queue (Delete)
Managing Job Queue (Delete)

Print jobs being processed by the printer are collectively called the job queue. You can delete jobs in the job queue as needed.

This operation is available using the operation panel or Remote UI.

- **Using Operation Panel**
- **Using Remote UI**

• **Delete**
  
  You can delete the job queue that are not currently being deleted.

### Using Operation Panel

1. **Make sure printer is turned on.**

2. On the HOME screen, tap (Jobs).

3. Tap **Print job**.

4. In the list, tap the target job.

5. Tap **Delete**.

   ![Details of print job]

   - **Document name**: JobName1
   - **Job status**: Receiving
   - **User name**: Owner

   ![Delete button]

6. Confirm displayed message and tap **Yes**.

### Note

- Select **Delete all print jobs** on **Job management** to delete all jobs in the job queue

  ![Job management link]
Using Remote UI

1. Start up Remote UI.

2. Select Job management.

3. Select Print job.

4. In the list, select the target job.

5. Select Delete.
# Frequently Asked Questions

## General FAQ

- I want to easily create vertical or horizontal banners
- Does this printer support sub-ink tank system
- I want to know how to configure roll cutting
- I want to configure so that the roll is cut automatically after waiting for the ink to dry
- How do I print without borders
- I want to know the paper types that can be used in this printer
- The paper type that I want to print is not displayed on the Touch Screen
- Can I perform duplex printing
- I want to perform enlargement printing
- Network Settings and Common Problems

## Solve Problems

### Problems Regarding Paper

- Remove Jammed Roll Paper
- Remove a Jammed Sheet
- Remove Jammed Paper (Paper Feed Slot)
- Roll paper cannot be inserted into the Paper Feed Slot
- Roll Paper Remains/Lacks under Quantity Management
- Cannot load sheets
- Paper is not cut straight
- Paper is not cut
- Cutter Blade Does Not Work While Cutting Is in Progress
- Dent in the Tip of Paper
- The size of clear film cannot be detected
- Printer Keeps Ejecting the Roll Paper
- Margins are wide
- When printing on roll paper, the printed surface becomes scratched

### Printing Does Not Start

- Printer Suddenly Stopped Working for Some Reason
- The Data lamp on the Operation Panel does not light up
- The printer does not respond even if print jobs are sent
- "Preparing the ink system." is displayed
- "Agitating the ink" is displayed

### The Printer Stops During a Print Job

- Printing stops and an error message is displayed
- The printer ejects blank, unprinted paper
- The printer stops when printing a HP-GL/2 job (the carriage stops moving)
### Problems with the Printing Quality

- **Printing is faint**
- **Paper rubs against the Print Head**
- **The edges of the paper are dirty**
- **The surface of the paper is dirty**
- **The back side of the paper is dirty**
- **Immediately after borderless printing, the trailing edge margin is soiled during regular printing**
- **Printed colors are inaccurate**
- **Banding in different colors occurs**
- **Colors in printed images are uneven**
- **Image edges are blurred or white banding occurs**
- **The contrast becomes uneven during printing**
- **The length of printed images is inaccurate in the feeding direction**
- **Images are printed crooked**
- **Documents are printed in monochrome**
- **Line thickness is not uniform**
- **Lines or colors are misaligned**
- **Borders appear in borderless printing**
- **Cannot Specify Extension for borderless printing After Warning Message**

### Cannot Print over Network

- **Cannot Connect Printer to Network**
- **Cannot Print over TCP/IP Network**
- **Cannot Print over Bonjour networks**

### Cannot Find Printer on Network

- **Cannot Find Printer on Check Printer Settings Screen (Windows)**
- **Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen**
- **Searching Printer by IP Address or Host Name During Setup**
- **Cannot Find Printer while Using Wi-Fi**
- **Cannot Find Printer while Using Wired LAN**
- **Cannot Print Using AirPrint**

### Installation Problems

- **Removing Printer Software**
- **Taking Time to Setup Process (Windows)**
- **Failed to Printer Driver Installation (Windows)**

### HP-GL/2 problems

- **With HP-GL/2, printing is misaligned**
- **Lines or images are missing in printed HP-GL/2 jobs**
- **Lines are printed too thick or thin in HP-GL/2 print jobs**
- **HP-GL/2 jobs are printed in monochrome (or color)**
- **Printed colors of lines are inaccurate during HP-GL/2 printing**
- **HP-GL/2 jobs are printed 6 mm larger than specified**
- **HP-GL/2 jobs are printed at maximum size, even if a standard size is specified**
- **HP-GL/2 printing takes a long time**
- **The printer stops when printing a HP-GL/2 job (the carriage stops moving)**
Other Problems

- Printer does not turn on
- If the Printer Makes a Strange Sound
- Messages advising to check the maintenance cartridge are not cleared
- Printer consumes a lot of ink
- Ink Level Detection
I want to easily create vertical or horizontal banners

You can print originals that are in landscape (or portrait) orientation automatically enlarged to fit the roll width. This is an easy way to create vertical or horizontal banners.

- Printing Hanging and Horizontal Banners (Large-Format Printing) (Windows)
- Printing Hanging and Horizontal Banners (Large-Format Printing) (macOS)
Q
Does this printer support sub-ink tank system

A
This printer supports hot-swap ink tank replacement.
Even if an ink tank becomes empty during printing, since a certain amount of ink always is stored in a sub-ink tank, you can replace the ink tank while printing.

⇒ Replacing Ink Tanks
I want to know how to configure roll cutting

Cutting methods can be selected in the printer settings and printer driver settings.

To automatically cut roll paper after printing, open the **Cutting mode** settings on the printer, and then under **Automatic cut** set **Automatic Cutting** in the printer driver to **Yes**.

When using paper that is easily scratched, or paper where the ink requires extra time to fix, we recommend setting **Cutting mode** on the printer to **Eject cut**.

- **Specifying the Cutting Method for Rolls**
- **Cutting Roll Paper after Printing** (Windows)
- **Cutting Roll Paper after Printing** (macOS)
I want to configure so that the roll is cut automatically after waiting for the ink to dry

You can set an ink drying time in the printer driver. You can also configure the same settings on the printer itself.

- Main Tab Description (Windows)
- Paper Detailed Settings (macOS)
- Specifying the Ink Drying Time for Rolls
- Menu Structure
How do I print without borders

If printing on roll paper, you can set borderless printing in the printer driver settings. (If printing on sheets, borderless printing is not possible)

- Prints without Edges Based on the Scenarios (Windows)
- Prints without Edges Based on the Scenarios (macOS)
I want to know the paper types that can be used in this printer

For information about paper that can be used with this printer, see the imagePROGRAF home page or refer to the media information list.

⇒ Paper Information List
The paper type that I want to print is not displayed on the Touch Screen

If using a new paper type, start the Media Configuration Tool to get the latest media information.

- Updating paper information
Can I perform duplex printing

This printer cannot print double-sided.

An alternative to double-sided printing is to use the Folded Duplex function of the Windows software Free Layout plus, which prints two pages on one side, folds the sheet back from the center, and hangs it.
I want to perform enlargement printing

Use the printer driver to adjust the original to the paper size and width, or print enlarged or reduced by specifying a magnification factor.

- Scaled Printing (Windows)
- Scaled Printing (macOS)
## Network Settings and Common Problems

Here are frequently asked questions on network.

### Cannot Find Printer
- Cannot Find Printer on Check Printer Settings Screen (Windows)
- Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen
- Searching Printer by IP Address or Host Name During Setup
- Cannot Find Printer while Using Wi-Fi
- Cannot Find Printer while Using Wired LAN

### Cannot Print or Connect
- Cannot Connect Printer to Network
- Cannot Print over TCP/IP Network
- Cannot Print over Bonjour networks
- Printer Suddenly Stopped Working for Some Reason

### LAN Setting Tips/Changing LAN Settings
- Printer Connection Methods
- Default Network Settings
- Another Printer Found with Same Name
- Connecting to Another Computer via LAN/Changing from USB to LAN Connection
- Printing Network Settings
- Reconfiguration Method of LAN Connection/Reconfiguration Method of Wi-Fi Connection
- Reconfiguration of Network Settings using the Remote UI
- Network Status and Troubleshooting
Problems Regarding Paper

- Remove Jammed Roll Paper
- Remove a Jammed Sheet
- Remove Jammed Paper (Paper Feed Slot)
- Roll paper cannot be inserted into the Paper Feed Slot
- Roll Paper Remains/Lacks under Quantity Management
- Cannot load sheets
- Paper is not cut straight
- Paper is not cut
- Cutter Blade Does Not Work While Cutting Is in Progress
- Dent in the Tip of Paper
- The size of clear film cannot be detected
- Printer Keeps Ejecting the Roll Paper
- Margins are wide
- When printing on roll paper, the printed surface becomes scratched
Remove Jammed Roll Paper

If roll paper jams, follow the steps below to remove jams.

1. Turn off printer.
   ⇒ Turning the Printer On and Off

2. Cut loaded roll paper with regular scissors or the like.
   Before cutting, loose the roll paper and lift it up.


4. Remove jammed paper.
   • If paper is jammed inside the top cover
1. Open top cover and move carriage to the left or right side manually, away from the jam.

![Carriage movement diagram]

---

**Important**

- Do not move the carriage over jammed paper. This may damage the Print head.

2. Remove any jammed paper inside top cover.

   After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close top cover.

![Top cover closed diagram]

---

**Important**

- Do not touch the linear scale (A) or carriage shaft (B). This may stain your hands and damage the printer.
• If the paper from a roll is jammed by the paper feed slot
Remove the jammed paper from the paper feed slot.
After removing the paper, make sure there are no other scraps of paper in the printer.

• If the paper is jammed by the ejection guide
Remove the jammed paper from the output tray.
After removing the paper, make sure there are no other scraps of paper in the printer.
5. Pull release lever forward.

**Important**

- Changing the release lever position while printing is in progress causes paper jam, misaligned lines, or wrong colors. Be careful not to touch the release lever while printing in progress.
If a sheet jams, follow the steps below to remove it.

1. Turn off printer.
   - Turning the Printer On and Off

2. Push release lever back.

3. Remove jammed paper.
   - If paper is jammed inside the top cover
     1. Open top cover and move carriage to the left or right side manually, away from the jam.
Important

• Do not move the carriage over jammed paper. This may damage the Print head.

2. Remove any jammed paper inside top cover.

After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close top cover.

Important

• Do not touch the linear scale (A) or carriage shaft (B). This may stain your hands and damage the printer.
• If the paper is jammed by the paper feed slot
  Remove the jammed paper from the paper feed slot.
  After removing the paper, make sure there are no other scraps of paper in the printer.

• If the paper is jammed by the ejection guide
  Remove the jammed paper from the output tray.
  After removing the paper, make sure there are no other scraps of paper in the printer.
4. Pull release lever forward.

**Important**

- Changing the release lever position while printing is in progress causes paper jam, misaligned lines, or wrong colors. Be careful not to touch the release lever while printing in progress.
Remove Jammed Paper (Paper Feed Slot)

Follow these steps to remove any scraps left in the paper feed slot after you clear jammed sheets or roll paper.

1. Turn off printer.
   ⇒ Turning the Printer On and Off

2. Push release lever back.

3. Fold an A4 sheet lengthwise four times and insert it through the gap of paper feed slot. Push scrap out toward platen.

4. Remove scrap when it is pushed out onto platen.
5. If any scraps remain inside paper feed slot, repeat steps 4 and 5.

6. Close top cover.

7. Pull release lever forward.

---

**Important**

- Changing the release lever position while printing is in progress causes paper jam, misaligned lines, or wrong colors. Be careful not to touch the release lever while printing in progress.
Roll paper cannot be inserted into the Paper Feed Slot

Is the roll paper curled?

Check 1
Straighten out curls and reload the roll.

Is paper jammed in the feed slot?

Check 2
Remove the jammed paper.

Remove Jammed Roll Paper
Remove a Jammed Sheet

Note

• You cannot load a roll paper and sheets on the printer at the same time.
Check the setting of **Manage remaining roll amount**.

- If **Barcodes** is selected for **Manage remaining roll amount**:
  1. Enter **Roll paper length** and select **OK**.
  2. Select **Roll amount 3 (standard)** for **Roll amount warning setting**.

- If **Warning message only** is selected for **Manage remaining roll amount**:
  Select **Roll amount 3 (standard)** for **Roll amount warning setting**.

➤ [Paper-related settings](#)
Cannot load sheets

When using the roll holder and in the following cases, remove the roll holder and set the cut sheet according to the Paper Alignment Line (A) on the right side of the printer.

- The width of cut sheet is larger than the width of roll paper.
- Roll diameter of roll paper is large.
- Size of the cut sheet is A4 Letter, or less.
- Roll paper is not loaded in the roll holder.

Note

- You cannot load a roll paper and sheets on the printer at the same time.

Loading Sheets in the Printer
Paper is not cut straight

Check 1 Is the edge of the paper cutting position creased?
Straighten out any curling by the edges of the paper.

Check 2 Is the edge of the paper cutting position lifting up when cutting?
Reload the paper correctly.

Check 3 Is the paper a type that can be cut with the cutter blade?
Set Cutting mode in the touch screen menu to User cut, then and cut the roll paper with a cutting implement such as scissors.
⇒ Specifying the Cutting Method for Rolls

Check 4 Are you using the basket properly?
Make sure that you are using the basket properly.
⇒ Using the Basket

Check 5 Check that the Cut speed setting is correct.
Select Paper settings > Advanced on Paper menu in the touch screen menu, and change Cut speed.
If the paper edge cannot be cut straight at the cut starting position, it may be improved by selecting slower cut speed than that selected currently.
If the paper edge cannot be cut straight at the cut ending position, it may be improved by selecting faster cut speed than that selected currently.
Select Paper settings > Advanced on Paper menu in the touch screen menu, and change the Cut speed setting.
⇒ Menu Structure

Check 6 Did the printing material slip diagonally while being cut?
Set the Cutting mode in the touch screen menu to Eject cut, and then hold and cut the material after it has printed.
⇒ Specifying the Cutting Method for Rolls

Check 7 Is the cutter blade attached properly?
Attach the cutter blade properly.
⇒ Replacing the Cutter Blade
Check 8  Is the edge of the cutter blade blunt?

Replace the cutter blade.

⇒ Replacing the Cutter Blade
Paper is not cut

Check 1  Is Automatic Cutting in the printer driver set to No or Print Cut Guideline?
Set the printer driver Automatic Cutting setting to Yes.
- Page Setup Tab Description (Windows)
- Paper Detailed Settings (macOS)

Check 2  Is Cutting mode in the touch screen menu set to Eject cut or User cut?
If Cutting mode is set to Eject cut, select Feed/cut in the touch screen menu and cut the paper.
If Cutting mode is set to User cut, cut the roll paper with a cutting implement such as scissors.
- Specifying the Cutting Method for Rolls

Check 3  Is the cutter blade attached?
Attach the cutter blade.
- Replacing the Cutter Blade
Cutter Blade Does Not Work While Cutting Is in Progress

Check 1  Does a message appear on the touch screen?

If the cutter blade failed to cut the paper, it stops moving and a message appears on the touch screen. Remove the paper and try printing again.

⇒ Remove Jammed Roll Paper

Check 2  Make sure the cutter blade can cut paper used currently.

Select User cut for Cutting mode in the touch screen menu and cut the roll paper with a cutting implement such as scissors.

⇒ Specifying the Cutting Method for Rolls

Check 3  Check the setting value for Cut speed.

Selecting slower value may enable the cutter blade to cut paper. Select Paper settings > Advanced on Paper menu in the touch screen menu, and change the Cut speed setting.

⇒ Menu Structure
⇒ Paper-related settings

Check 4  Is the edge of the cutter blade blunt?

Replace the cutter blade.

⇒ Replacing the Cutter Blade
Dent in the Tip of Paper

Check Are you keeping the roll in the printer for a long time without printing on it? Doing so may leave a dent on the tip of paper and it remains when you print on the paper the next time. When printing quality is most important, we recommend cutting the paper tip before printing.

On the HOME screen, selecting **Feed/Cut > Cut paper > Yes** enables the printer to cut the paper tip at the shortest length.

⇒ **Menu Structure**
Q

The size of clear film cannot be detected

A

Check Is the platen dirty with ink?

Open the top cover and clean the entire platen area.

 ➞ Cleaning Inside the Top Cover
Printer Keeps Ejecting the Roll Paper

When a sheet is selected on the HOME screen, loading a roll paper with its surface left loose may make the printer recognize the loaded roll paper as a sheet.

In this case, selecting **Remove paper** on **Paper menu** may allow the printer to keep ejecting the paper.

Check the paper feed settings on the printer.

After roll ejection stops, follow these steps to reload the roll.

1. Push release lever back.

2. Using both hands, rotate the roll holder toward the back to rewind the roll.
   
   At this time, ensure that both ends of the roll are rewound evenly.

3. Pull release lever forward.
4. Load roll.

At this time, be sure to press the Load button and select **Load roll paper**.

- ➤ [Loading Rolls in the Printer](#)
Margins are wide

Check 1  Is auto cut being used on printed material with a wide margin on the trailing edge only?

Rolls are advanced a specific amount before cutting to prevent problems with cutting and paper ejection.

This operation is normal.

Check 2  Is leading edge detection set to Do not detect?

Do not detect may have been set by responding to the message Do you want to set to detect the leading edge of the paper? when Cutting mode was set to User cut in the touch screen menu.

If the message Do you want to set to detect the leading edge of the paper? appears when setting Cutting mode to User cut, select Detect (recommended).

Please note that if Detect (recommended) is selected and the paper has a strong curl, the Print head may rub against the edge of the paper when printing starts.

⇒ Specifying the Cutting Method for Rolls
When printing on roll paper, the printed surface becomes scratched

Make sure the roll paper has not lost tension during printing. If the roll paper loses tension, the paper surface could be damaged and the paper could wrinkle or fold. Select Paper settings > Advanced on Paper menu in the touch screen menu, and set Roll paper tension (printing) to High.

Menu Structure

Note

• Carrying out Adjust print quality is recommended when changing Roll paper tension (printing) settings.
Printing Does Not Start

- Printer Suddenly Stopped Working for Some Reason
- The Data lamp on the Operation Panel does not light up
- The printer does not respond even if print jobs are sent
- "Preparing the ink system." is displayed
- "Agitating the ink" is displayed
Printer Suddenly Stopped Working for Some Reason

- Cannot Connect to a Printer after Network Configuration Changes
- Cannot Connect to a Printer via Wireless LAN (Wi-Fi)
- Cannot Connect to a Printer through Wireless Direct
- Cannot Connect to a Printer via Wired LAN
- Cannot Print through Network

Q Cannot Connect to a Printer after Network Configuration Changes

A

It may take a while for the computer to obtain an IP address, or you may need to restart your computer. Make sure the computer has obtained a valid IP address, and try again to find the printer.

Q Cannot Connect to a Printer via Wireless LAN (Wi-Fi)

A

Check1 Check the power status of printer and devices (e.g. wireless router or computer) connected to the network.

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

It may be necessary to resolve wireless router problems (e.g. update interval of a key, problems of DHCP update interval, energy saving mode, etc.) or to update the wireless router firmware.

For details, contact the manufacturer of your wireless router.

Check2 Can you view any web pages on your computer?

Make sure your computer is connected to the wireless router properly.

For more on checking computer settings or connection status, see the instruction manual supplied with the computer or contact the manufacturer.

Check3 Is the printer connected to the wireless router?

Use the icon on the touch screen to check the connection status between the printer and wireless router. If the icon is not displayed, Wi-Fi is disabled. Turn on wireless communication on the printer.

Check4 Make sure the printer and wireless router network settings match.

Make sure the network settings of the printer (e.g. wireless router name, SSID, network key, etc.) are identical with those of the wireless router.
To check the settings of the wireless router, refer to the instruction manual provided with it or contact its manufacturer.

To check the current network settings of the printer, print out the network setting information.

⇒ Printing Network Settings

---

### Note

- IJ Network Device Setup Utility allows you to diagnose and repair the network status.

Select the link below to download IJ Network Device Setup Utility and install it.

⇒ Checking Printer Connection Status Using IJ Network Device Setup Utility

See below for starting up IJ Network Device Setup Utility.

- For Windows:
  ⇒ Starting Up IJ Network Device Setup Utility

- For macOS:
  ⇒ Starting Up IJ Network Device Setup Utility

---

Check5 Make sure the printer is not placed too far away from the wireless router.

If the distance between the printer and wireless router is too far, wireless communication becomes poor. Place the printer and wireless router close to each other.

⇒ Note

- Though an antenna is attached to most wireless routers, note that some of them have it inside.

---

Check6 Make sure wireless signal is strong. Monitor signal status and move printer and wireless router as necessary.

Place the printer and wireless router where there are no obstacles between them. Wireless communication between different rooms or floors is generally poor. Wireless communication can be impeded by building materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a wireless router is nearby, it may cause interference. Place the wireless router as far away from interference sources as possible.

⇒ Note

- IJ Network Device Setup Utility allows you to diagnose and repair the network status.

Select the link below to download IJ Network Device Setup Utility and install it.

⇒ Checking Printer Connection Status Using IJ Network Device Setup Utility

See below for starting up IJ Network Device Setup Utility.

- For Windows:
  ⇒ Starting Up IJ Network Device Setup Utility

- For macOS:
  ⇒ Starting Up IJ Network Device Setup Utility
Check 7 Make sure of the Wi-Fi channel numbers used for your computer.

You need to have the same Wi-Fi channel number that you are using for the wireless router as your computer. It is normally set in the way that you can use all the Wi-Fi channels. However, when the channels that you are using are restricted, the Wi-Fi channels do not match.

See the instruction manual provided with your computer and check the Wi-Fi channel number available for your computer.

Check 8 Make sure channel set on wireless router is a usable channel as confirmed in Check 7.

If it is not, change the channel set on the wireless router.

Check 9 Make sure security software's firewall is off.

If your security software's firewall is on, a message may appear warning you that Canon software is attempting to access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings. Some programs use a firewall by default.

Check 10 If printer is connected to an AirPort Base Station via LAN, make sure you use alphanumeric characters for network identifier (SSID). (macOS)

If the problem is not resolved, redo setup.

• For Windows:
  Perform setup using the Setup CD-ROM or from the web page.

• For macOS:
  Perform setup from the web page.

• Positioning:
  Make sure there are no obstacles between the printer and wireless router.

Cannot Connect to a Printer through Wireless Direct

Check 1 Check the power status of printer and other devices (smartphone or tablet).

Turn on the printer or devices.

If the power is already turned on, turn it off and on again.

Check 2 Is the icon displayed on the touch screen?

If not, Wireless Direct is disabled. Turn on Wireless Direct.
Check3  Check the settings of your device (smartphone/tablet).
Make sure Wi-Fi is enabled on your device.
For details, refer to your device's instruction manual.

Check4  Make sure printer is selected as connection for device (e.g. smartphone or tablet).
Select the identifier for Wireless Direct (SSID) specified for the printer as the connection destination for devices.
Check the destination on your device.
For details, refer to your device's instruction manual or visit the manufacturer's website.
To check the identifier for wireless direct (SSID) specified for the printer, display it using the operation panel of the printer or print out the network setting information of the printer.
• Display on the touch screen.
  ➔ LAN settings
• Print the network settings.
  ➔ Printing Network Settings

Check5  Have you entered the proper password specified for the Wireless Direct?
To check the password specified for the printer, display it using the operation panel of the printer or print out the network setting information of the printer.
• Display on the touch screen.
  ➔ LAN settings
• Print the network settings.
  ➔ Printing Network Settings

Check6  Make sure the printer is not placed too far away from the device.
If the distance between the printer and device is too far, wireless communication becomes poor. Place the printer and device close to each other.

Check7  Make sure 5 devices are already connected.
Wireless Direct does not allow more than 5 devices to be connected.

Q Cannot Connect to a Printer via Wired LAN

A

Check1  Make sure the printer is turned on.
Check2  Make sure the LAN cable is connected properly.
Make sure the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.

If the problem is not resolved, redo setup.

- For Windows:
  Perform setup using the Setup CD-ROM or from the web page.

- For macOS:
  Perform setup from the web page.

**Cannot Print through Network**

**Check1** Make sure the computer is connected to the wireless router.

For more on how to check the computer settings or connection status, see your computer instruction manual or contact its manufacturer.

**Check2** If the printer driver is not installed, install it. (Windows)

Install the printer driver using the Setup CD-ROM or install it from the Canon website.

**Check3** When using Wi-Fi, make sure wireless router does not restrict which computers can access it.

For more on connecting to and setting up your wireless router, see the wireless router instruction manual or contact its manufacturer.
The Data lamp on the Operation Panel does not light up

**A**

**Check 1** Does the printer have power?

Check that the power cord is firmly plugged all the way in. Push the **ON** button to turn on the power to the printer.

**Check 2** Was the correct printer selected?

In Windows, select the printer by clicking *Select Printer* or *Printer* in the printing dialog box and try printing again.

In macOS, open the dialog box of the printer driver, select the printer from the list of *Printer*, and try printing again.

**Check 3** Is the print job paused?

In Windows, restart the print job as follows.

1. Select the printer icon in the *Printers and Faxes* (or *Printers*) window.
2. Clear *Pause Printing* in the *File* menu to restart the print job.

In macOS, restart the print job as follows.

1. Click *Print & Scan* (or *Print & Fax*).
2. Select the printer, and then *Resume Printer* (or *Start Jobs*) in the *Printers* menu to restart the print job.
The printer does not respond even if print jobs are sent

A

Check 1 Is Pause printing set to Enable?
Set Pause printing on the touch screen menu to Disable.

Pausing Printing

Check 2 Is USB or LAN connection disabled?

- For USB connection:
  Set Use USB connection on the touch screen menu to Use.

- For LAN connection (wired/Wi-Fi/Wireless Direct):
  Set Enable/disable Wired LAN, Enable/disable Wi-Fi, or Enable/disable Wireless Direct on the touch screen menu to Enable.

Note

- You cannot enable wired LAN and Wi-Fi or Wireless Direct at the same time.
"Preparing the ink system." is displayed

The Print head and sub-ink tank are being filled with ink.
Wait until the system has been filled with ink.

Note

- This message might appear if you force the power off while the printer is operating.
  Always follow the correct procedure when turning off the power.
  ➔ Turning the Printer On and Off
"Agitating the ink" is displayed

Ink agitation is in progress.

Please wait until ink agitation is finished.

Agitation time varies depending on time elapsed since powering off (approximately 20 seconds to 2 minutes).
The Printer Stops During a Print Job

- Printing stops and an error message is displayed
- The printer ejects blank, unprinted paper
Printing stops and an error message is displayed

The last portion of roll paper was used during a print job, and paper could not be advanced because the trailing edge is taped to the roll.

Remove the used roll and insert a new roll.

- [Removing the Roll from the Printer](#)
- [Removing Rolls From the Roll Holder](#)
- [Loading and Printing on Rolls](#)
The printer ejects blank, unprinted paper

A

Check 1  The leading edge of the roll paper may have been trimmed.

The leading edge of the roll paper may be trimmed if Trim edge first is not set to Off or Manual in the touch screen menu.

⇒ Cutting the Leading Edge of Roll Paper Automatically

Check 2  Is the Print head nozzle blocked?

Print a nozzle check pattern to check the Print head status.

⇒ Checking for Nozzle Clogging

Check 3  Is the correct printer driver selected?

Print again using the correct printer driver for your printer.

Check 4  When you print data including HP RTL command, check the settings below in the touch screen menu.

• Set Auto rotation to OFF.
• If Rotate is set to 90 degrees, select 0 degrees and start printing.

⇒ Menu Structure

If none of the above apply, there may be a printer malfunction.

Contact your Canon dealer for assistance.
Problems with the Printing Quality

- Printing is faint
- Paper rubs against the Print Head
- The edges of the paper are dirty
- The surface of the paper is dirty
- The back side of the paper is dirty
- Immediately after borderless printing, the trailing edge margin is soiled during regular printing
- Printed colors are inaccurate
- Banding in different colors occurs
- Colors in printed images are uneven
- Image edges are blurred or white banding occurs
- The contrast becomes uneven during printing
- The length of printed images is inaccurate in the feeding direction
- Images are printed crooked
- Documents are printed in monochrome
- Line thickness is not uniform
- Lines or colors are misaligned
- Borders appear in borderless printing
- Cannot Specify Extension for borderless printing After Warning Message
Printing is faint

Check 1 Is the reverse side of the paper being used for printing?
Print on the printing surface.

Check 2 Is the Print head nozzle blocked?
Print a test pattern to check the nozzles and see if they are clogged.
⇒ Checking for Nozzle Clogging

Note
• To automatically check for nozzle blockages after printing, set Auto nozzle check in the touch screen menu to a setting other than Disable.

To show warnings based on nozzle check results, set Nozzle check error display in the touch screen menu to Enable.

However, printing may be stopped by warnings if this setting is set to Enable.
⇒ Menu Structure

Check 3 Was the printer left with the ink tank out?
The ink supply may become blocked by ink if the ink tank is left out.
If this happens, leave the printer for at least 24 hours with the ink tank in, and then carry out Print head cleaning.
⇒ Cleaning the Print Head

Check 4 Are paper scraps stuck in the top cover?
Follow the steps below to remove paper scraps left inside the top cover.

1. Open the top cover and make sure that the carriage is not over the platen.

2. Remove any paper scraps left inside the top cover.
⇒ Remove Jammed Roll Paper
⇒ Remove a Jammed Sheet

3. Close the top cover.

Check 5 Was the paper cut before the ink dried?
Set a longer Ink drying wait time in Advanced paper settings in the touch screen menu.
⇒ Menu Structure

Check 6 Is the printer driver Print Quality set to Fast?
Follow the steps below to set **Print Quality** to a setting other than **Fast**, and then print.

- **Windows**
  Change the **Print Quality** settings in the printer driver **Advanced Settings**.
  
  ⇒ [Changing the Print Quality and Correcting Image Data](#) (Windows)

- **macOS**
  Change the **Print Quality** in the printer driver **Quality & Media** settings.
  
  ⇒ [Changing the Print Quality and Correcting Image Data](#) (macOS)

If a setting lower than **Standard** is selected, the printing time is shorter and less ink is used though the print quality is reduced. If a printing looks faint, select a setting higher than **Standard**.

**Check 7** Does the paper used for printing create a lot of cutting dust?

Set **Cut-dust reduction** in the touch screen menu **Advanced paper settings** to **ON**.

⇒ [Reducing Dust from Cutting Rolls](#)
Paper rubs against the Print Head

**Check 1** Is the media type specified in the printer driver the same as the media type loaded in the printer?

Load paper of the same type as you have specified in the printer driver.

- [Loading Rolls in the Printer](#)
- [Loading Sheets in the Printer](#)

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the **Stop** button.
2. Change the paper type in the printer driver and try printing again.

**Check 2** Is the paper loaded properly?

If not loaded properly, paper can buckle and rub against the Print head.

Reload the paper.

- [Loading Rolls in the Printer](#)
- [Loading Sheets in the Printer](#)

**Check 3** Is the Print head height set too low?

Set **Paper Thickness (Head Height)** in the touch screen menu to **Auto**.

- [Troubleshooting Paper Abrasion and Blurry Images](#)

**Check 4** Is the paper thick, or a type that curls easily or is prone to buckling after absorbing ink?

If using paper-based printing material such as Heavyweight Coated Paper, set **Transport unit vacuum strength** in the touch screen menu to **Medium-strong** or **Strong**.

If that does not resolve the problem, increase the **Paper Thickness (Head Height)** setting in the touch screen menu.

- [Adjusting Vacuum Strength](#)
- [Troubleshooting Paper Abrasion and Blurry Images](#)

If using film-based printing material such as CAD Tracing Paper, set the **Transport unit vacuum strength** in the touch screen menu to **Standard**, **Medium-strong**, or **Strong**.

If that does not resolve the problem, increase the **Paper Thickness (Head Height)** setting in the touch screen menu.

- [Adjusting Vacuum Strength](#)
- [Troubleshooting Paper Abrasion and Blurry Images](#)
If using paper thinner than 0.004 inches (0.1 mm), set Transport unit vacuum strength in the touch screen menu to Weak.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen menu.

⇒ Adjusting Vacuum Strength
⇒ Troubleshooting Paper Abrasion and Blurry Images

Check 5 When loading paper in the printer, is the media loaded the same as the media type selected on the touch screen?

Select the correct media type in the touch screen menu when loading paper in the printer.

⇒ Loading Rolls in the Printer
⇒ Loading Sheets in the Printer

Check 6 Does the paper have a strong curl at the front edge or is it buckled?

Set Cutting mode in the touch screen menu to User cut, and set leading edge detection to Do not detect.

To keep track of the amount of roll paper remaining, set Manage remaining roll amount to Disable before loading the roll paper, and then restore the setting of Manage remaining roll amount after the roll paper is loaded.

⇒ Specifying the Cutting Method for Rolls
⇒ Keeping Track of the Amount of Roll Paper Left
The edges of the paper are dirty

Check 1 Was printing borderless or on small paper?
The platen may become dirtied by printing borderless or on small paper sizes.
Open the top cover and clean the platen.

⇒ Cleaning Inside the Top Cover

Check 2 Is the setting of Extension for borderless printing in the touch screen menu large?
The platen may become dirtied by setting a large amount of extension.
Reduce the setting of Extension for borderless printing in the touch screen menu to less than the current setting. (Select a smaller number than the current setting.)

⇒ Menu Structure

Check 3 Is the media type specified in the printer driver the same as the media type in the printer?
Make sure the same type of paper is specified on the printer as in the printer driver.

⇒ Changing the Type of Paper
Follow the steps below to change the printer driver settings.

1. To stop printing, press the Stop button.
2. Change the type of paper in the printer driver and try printing again.

Check 4 Is the paper creased or curled?
Straighten out the wrinkles or curls and reload the paper. Do not use paper that has been printed on previously.

⇒ Loading Rolls in the Printer
⇒ Loading Sheets in the Printer

Check 5 Is Cut-dust reduction in the touch screen menu Advanced paper settings set to ON?
A cut dust reduction line is printed at the paper cut position when Cut-dust reduction is set to ON.
If cutting dust reduction is not required, set Cut-dust reduction to OFF.

⇒ Menu Structure

Check 6 Is the Print head height set too low in the touch screen menu?
Set Paper Thickness (Head Height) to Auto.

- **Troubleshooting Paper Abrasion and Blurry Images**

**Check 7** Is the paper thick, or a type that curls easily or is prone to buckling after absorbing ink?

If using paper-based printing material such as thick-coat paper, set Transport unit vacuum strength in the touch screen menu to Medium-strong or Strong.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen menu.

- **Adjusting Vacuum Strength**
- **Troubleshooting Paper Abrasion and Blurry Images**

If using film-based printing material such as tracing paper, set the Transport unit vacuum strength in the touch screen menu to Standard, Medium-strong, or Strong.

If that does not resolve the problem, increase the Paper Thickness (Head Height) setting in the touch screen menu.

- **Adjusting Vacuum Strength**
- **Troubleshooting Paper Abrasion and Blurry Images**

**Check 8** Is the output guide clean?

Clean the output guide.

- **Cleaning the Printer Exterior**
The surface of the paper is dirty

A

Check 1 Is the paper retainer clean?

Clean the paper retainer.

⇒ Cleaning Inside the Top Cover

Check 2 Does this paper take longer to dry?

Set the Pause between pages in the touch screen menu to approximately 1 minute.

⇒ Menu Structure

Note

• When printing on paper that takes longer to dry, the paper may curl during printing and come in contact with the output tray.

In such situations, set an Ink drying wait time and an Ink drying target area for Pause between scans in the touch screen menu.

However, note that printing will now take longer.

⇒ Menu Structure

Note

• In a hot and humid environment, rolling paper printed with images containing areas of saturated color may transfer ink to the contact surface, affecting print quality.

Move the printer to a different environment, or let the paper dry before rolling it.
The back side of the paper is dirty

Check 1 Was the previous print job borderless, or printed on small paper?
Open the top cover and clean the platen.
⇒ Cleaning Inside the Top Cover

Check 2 Is Detect paper width in the touch screen menu set to Disable?
Printing with Detect paper width set to Disable may cause the platen to be dirtied.
Set Detect paper width in the touch screen menu to Enable, and then open the top cover and clean the platen.
⇒ Cleaning Inside the Top Cover
To continue printing with Detect paper width set to Disable, first open the top cover and clean the platen, and then manually feed roll paper over the platen when printing.
⇒ Cleaning Inside the Top Cover
⇒ Feeding Roll Paper Manually

Check 3 Paper may be gripped weakly over the platen.
Set a higher Transport unit vacuum strength in the touch screen menu.
⇒ Adjusting Vacuum Strength

Check 4 Is the setting of Extension for borderless printing in the touch screen menu large?
The platen may become dirtied by setting a large amount of extension.
Reduce the setting of Extension for borderless printing in the touch screen menu to less than the current setting. (Select a smaller number than the current setting.)
⇒ Menu Structure

Note

- If the platen is dirty, open the top cover and clean the platen.
- In a hot and humid environment, rolling paper printed with images containing areas of saturated color may transfer ink to the contact surface, affecting print quality.
  Move the printer to a different environment, or let the paper dry before rolling it.
Immediately after borderless printing, the trailing edge margin is soiled during regular printing

In some situations, borderless printing with automatic cutting of the leading and trailing edges on roll paper may transfer ink on the cutter blade to the next item printed.

Follow the steps below to change **Between Pages** in **Drying Time** to between 30 seconds and 3 minutes and perform borderless printing.

- **Windows**

  1. Click **Specify for Media Type** on the **Main** sheet of the printer driver.

  2. Select an ink drying time from the **Between Pages** list in **Drying Time**.

- **macOS**

  Select an ink drying time from the **Drying Time** list on the **Paper Detailed Settings** sheet of the printer driver.
Printed colors are inaccurate

Check 1 Has color been adjusted in the printer driver?
Follow the steps below to adjust color settings.

- Windows
  Adjust the color settings with Color Mode > Color Settings in Advanced Settings in the printer driver.
  ➡ Main Tab Description (Windows)
- macOS
  Adjust the color settings in the printer driver Color Options.
  ➡ Color Options (macOS)

Check 2 Has the computer or monitor color been adjusted?
Take the actions below.

- Refer to the computer and monitor documentation to adjust the colors.
- Adjust the settings of the color management software, referring to the software documentation as needed.

Check 3 Is the Print head nozzle blocked?
Print a test pattern to check the nozzles and see if they are clogged.
 ➡ Checking for Nozzle Clogging

Check 4 Is Application Color Matching Priority set to Off in a Windows printer driver?
In the printer driver Layout sheet, click Special Settings, and then set Application Color Matching Priority to On in the dialog box that appears.
 ➡ Layout Tab Description (Windows)
Banding in different colors occurs

Check 1  Are paper actually loaded on the printer and the media type selected on the touch screen the same?
Select the correct media type in the touch screen menu when loading paper in the printer.
  ➔ Loading Rolls in the Printer
  ➔ Loading Sheets in the Printer

Check 2  Has the paper feed rate been calibrated properly?
Adjust the feed amount.
  ➔ Adjusting Feed Amount

Check 3  Print job may have been interrupted while receiving, and therefore not printed at a fast frame rate
Exit other applications and cancel other print jobs.

Check 4  Is Set priority in the touch screen menu set to Prioritize length accuracy?
Setting Set priority to Prioritize print quality and adjusting the feed amount can help.
  ➔ Adjusting Feed Amount

Check 5  Check if the Print head is in the right position
Adjust the Print head position.
  ➔ Automatic Adjustment to Straighten Lines and Colors

Check 6  Make sure that the Print head nozzle is not blocked
Print a test pattern to check the nozzles and see if they are clogged.
  ➔ Checking for Nozzle Clogging

Note
  • To automatically check for nozzle blockages after printing, set Auto nozzle check in the touch screen menu to a setting other than Disable.
  To show warnings based on nozzle check results, set Nozzle check error display in the touch screen menu to Enable.
  However, printing may be stopped by warnings if this setting is set to Enable.
  ➔ Menu Structure
Check 7  Low Print Quality setting causing lines in the printing

Follow the steps below to set Print Quality to High, and then print.

• Windows
  Change the Print Quality settings in the printer driver Advanced Settings.
  ➤ Changing the Print Quality and Correcting Image Data (Windows)

• macOS
  Change the Print Quality in the printer driver Quality & Media settings.
  ➤ Changing the Print Quality and Correcting Image Data (macOS)

If a setting higher than Standard is selected, the printing time is longer and more ink is used.

Check 8  Is the media type specified in the printer driver the same as the media type loaded in the printer?

Load paper of the same type as you have specified in the printer driver.
  ➤ Loading Rolls in the Printer
  ➤ Loading Sheets in the Printer

Follow the steps below to change the printer driver settings.

1. To stop printing, press the Stop button.

2. Change the type of paper in the printer driver and try printing again.
Colors in printed images are uneven

Check 1  Does this paper curl easily?
Colors in printed images may be uneven at the leading edge of paper that curls easily. Change the Transport unit vacuum strength in the touch screen to increase the grip on the paper, or set a margin of at least 0.8 inches (20 mm) at the front edge of the paper.

» Adjusting Vacuum Strength

Check 2  Make sure you are not printing with AirPrint. (macOS)
Select a printer to use on Printers & Scanners under System Preferences.
If "...AirPrint" is included in the printer name shown on Kind, you are using the printer with AirPrint. In this case, install the CUPS driver and perform printing using the CUPS driver.

Check 3  Colors in printed images may be uneven if the Print Quality setting is too low
If using Windows, select Advanced Settings from the Main tab of the printer driver, and then select a higher Print Quality setting.
If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.
When Fast or Standard is selected, the printing time is shorter and less ink is used than with High, but the print quality is reduced.

» Changing the Print Quality and Correcting Image Data (Windows)
» Changing the Print Quality and Correcting Image Data (macOS)

Check 4  Colors in printed images may be uneven on the boundary between shades if there are dark and light areas in an image
Using the unidirectional printing function may reduce color unevenness in this situation.
Follow the steps below for unidirectional printing.
• Windows
  Open Paper Detailed Settings from the Main tab of the printer driver, and then select Unidirectional Printing.
• macOS
  Open Paper Detailed Settings in the printer driver, and then select Unidirectional Printing.

Check 5  If printing borderless, colors in printed images may be a little uneven at the leading edge of the paper because printing is interrupted to cut the paper
Set the printer driver **Automatic Cutting** settings to **No**, and then print. Doing this prints only the left and right sides borderless. Cut the top and bottom borders with a cutting implement such as scissors after the printed materials are output and cut.

### Note
- Selecting a higher **Print Quality** in the printer driver **Advanced Settings** may resolve the problem.
  
  ➤ [Changing the Print Quality and Correcting Image Data](#) (Windows)
  
  ➤ [Changing the Print Quality and Correcting Image Data](#) (macOS)

#### Check 6
Check if the Print head is in the right position

Adjust the Print head position.

➤ [Automatic Adjustment to Straighten Lines and Colors](#)

#### Check 7
Color may be uneven if printing materials were stacked while drying

To avoid uneven colors, we recommend drying each sheet separately.

#### Check 8
Density may be uneven if using Glossy Paper or Coated Paper

Set **Print Quality** to **High**, and then print.

#### Check 9
Is the media type specified in the printer driver the same as the media type loaded in the printer?

Load paper of the same type as you have specified in the printer driver.

➤ [Loading Rolls in the Printer](#)

➤ [Loading Sheets in the Printer](#)

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the **Stop** button.

2. Change the type of paper in the printer driver and try printing again.

#### Check 10
Is **Ink drying target area** for **Pause between scans** in the touch screen menu set to **Leading edge**?

If the **Ink drying target area** for **Pause between scans** is set to **Leading edge**, color may be uneven approximately 3.1 to 5.1 inches (80 to 130 mm) from the front edge of the paper. (The position depends on the **Print Quality** settings)

In this case, set **Ink drying target area** for **Pause between scans** to **Overall**.

However, note that printing will now take longer.

➤ [Menu Structure](#)
Image edges are blurred or white banding occurs

**Check 1**  
Paper may be gripped too strongly over the platen.  
Set a lower **Transport unit vacuum strength** in the touch screen menu.  
⇒ *Adjusting Vacuum Strength*

**Check 2**  
Check if the Print head is in the right position.  
For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, etc., set the Print head to the optimal height and then adjust the position of the Print head.  
⇒ *Adjusting the Print Head*

Setting a lower value for **Paper Thickness (Head Height)** in the touch screen menu may resolve the problem.  
⇒ *Troubleshooting Paper Abrasion and Blurry Images*

**Check 3**  
Is the media type specified in the printer driver the same as the media type loaded in the printer?  
Load the printer with the media type specified in the printer driver.  
⇒ *Loading Rolls in the Printer*  
⇒ *Loading Sheets in the Printer*

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the **Stop** button.

2. Reset the media type in the printer driver, and then print.
The contrast becomes uneven during printing

**Check 1** Has the paper feed rate been calibrated properly?
Adjust the feed amount.
⇒ *Adjusting Feed Amount*

**Check 2** Is the media type specified in the printer driver the same as the media type loaded in the printer?
Load the printer with the media type specified in the printer driver.
⇒ *Loading Rolls in the Printer*
⇒ *Loading Sheets in the Printer*
Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the **Stop** button.
2. Change the type of paper in the printer driver and try printing again.

**Check 3** Has the Print head position been calibrated properly?
Adjust the Print head position.
⇒ *Automatic Adjustment to Straighten Lines and Colors*
The length of printed images is inaccurate in the feeding direction

**Check 1** Is Set priority for Paper feed adjustment in the touch screen menu set to Prioritize print quality?

Set Set priority for Paper feed adjustment to Prioritize length accuracy, and then carry out Adjust feed length.

⇒ Adjusting Feed Amount

**Check 2** Is the media type specified in the printer driver the same as the media type loaded in the printer?

Load the printer with the media type specified in the printer driver.

⇒ Loading Rolls in the Printer
⇒ Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.

2. Reset the media type in the printer driver, and then print.
Images are printed crooked

Check 1  Is Skew detection accuracy in the touch screen menu set to Loose or OFF?
Set Skew detection accuracy to Standard, and then reload the paper.

⇒ Menu Structure

Check 2  Is Detect paper width set to Disable?
Set Detect paper width in the touch screen menu to Enable.

⇒ Menu Structure

Check 3  Has the roll paper been loaded at an angle?
If there is a gap between the roll paper and roll holder, reload the roll.

⇒ Loading Rolls on the Roll Holder
⇒ Loading Rolls in the Printer
Documents are printed in monochrome

Check 1  Is Color Mode set to Monochrome in the printer driver?

- For Windows
  In the Advanced Settings of the printer driver, specify Color in Color Mode and try printing again.

- For macOS
  In the Quality & Media of the printer driver, specify Color in Color Mode and try printing again.

Check 2  The Print head nozzle may be blocked.

Print a test pattern to check the color ink nozzles and see if they are clogged.

➤ Checking for Nozzle Clogging
Check 1 Is Fast Graphic Process set to On in the Windows printer driver Special Settings dialog box?

Access the printer driver Properties dialog box from Print in the File menu of the source application, and follow these steps to print.

1. Deselect Preview before printing in the Main sheet.
3. Click the Special Settings button in the Layout sheet, and then set Fast Graphic Process to Off in the Special Settings dialog box that opens.

Check 2 Is the media type specified in the printer driver the same as the media type loaded in the printer?

Load the printer with the media type specified in the printer driver.

- Loading Rolls in the Printer
- Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.
2. Reset the media type in the printer driver, and then print.

Check 3 Adjust the position of the Print head

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, etc., set the Print head to the optimal height and then adjust the position of the Print head.

- Adjusting the Print Head

Note

- Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the problem.
- Troubleshooting Paper Abrasion and Blurry Images
Lines or colors are misaligned

Check 1 Adjust the position of the Print head

If borders are misaligned or the print results are not uniform, adjust the position of the Print head.

- Adjusting the Print Head

For detailed printing of small text or fine lines on glossy or semi-gloss photo paper or proof paper, etc., set the Print head to the optimal height and then adjust the position of the Print head.

- Changing the Print Quality and Correcting Image Data (Windows)
- Changing the Print Quality and Correcting Image Data (macOS)

Note

- Setting a lower value for Paper Thickness (Head Height) in the touch screen menu may resolve the problem.

Troubleshooting Paper Abrasion and Blurry Images

Check 2 Is the media type specified in the printer driver the same as the media type loaded in the printer?

Load the printer with the media type specified in the printer driver.

- Loading Rolls in the Printer
- Loading Sheets in the Printer

Follow the steps below to match the media type in the printer driver to the media type loaded in the printer.

1. To stop printing, press the Stop button.
2. Reset the media type in the printer driver, and then print.

Check 3 Perform Print head angle alignment.

Select Print head angle adjustment in the touch screen menu to align the Print head angle.

- Adjusting Line Misalignment

Important

- Changing the release lever position while printing is in progress causes paper jam, misaligned lines, or wrong colors. Be careful not to touch the release lever while printing in progress.
Borders appear in borderless printing

Check the items below if white streaks or border appears on the edge of the paper in borderless printing.

**Check 1** Did you try adjusting the position of the Print head?
Adjusting the position of the Print head improves the printing accuracy.
- [ ] Adjusting the Print Head

**Check 2** If printing full-scale borderless, is the selected paper wider than the source size?
For borderless printing at actual size, use roll paper that has the same width as the actual page size.
- [ ] Printing Full-Size without Margins (Windows)
- [ ] Printing Full-Size without Margins (macOS)

**Check 3** Does the source file have margins?
Check that the printing image data does not have any objects like crop marks and transparent objects.

**Check 4** Is a margin set in application software?
Check that no margins are configured in the application software you are using.

**Check 5** Is the setting of Extension for borderless printing in the touch screen menu small?
Increase the setting of Extension for borderless printing in the touch screen menu to more than the current setting. (Select a larger number than the current setting.)
- [ ] Menu Structure
Cannot Specify Extension for borderless printing After Warning Message

If a large amount of borderless printing is performed for a long period, a warning message will appear and the specifying the setting of **Extension for borderless printing** will be impossible.

This condition can not be canceled.

<table>
<thead>
<tr>
<th>Notice list</th>
</tr>
</thead>
<tbody>
<tr>
<td>! Printing can still be performed, but margins will appear even if borderless printing is set.</td>
</tr>
</tbody>
</table>

**Note**

- All printing functions except the setting of **Extension for borderless printing** can be used.
Cannot Print over Network

- Cannot Connect Printer to Network
- Cannot Print over TCP/IP Network
- Cannot Print over Bonjour networks
Cannot Connect Printer to Network

Check1  Is the Ethernet cable connected correctly to the printer's wired LAN connector?

Make sure the printer is connected to the network with the correct Ethernet cable, and then turn the printer on. For instructions on connecting the cable, refer to the Setup Guide.

Check2  Make sure the Link indicator is lit.

The left and right indicators are lit if the printer is connected via 1000Base-T.

The left indicator is green if the printer is connected via 100Base-TX, and the right indicator is orange if connected via 10Base-T.

If the Link indicator is not lit, check the following points.

• The hub is on.
• The end of the Ethernet cable is connected correctly.
  Insert the Ethernet cable until it clicks and locks in place.
• There is no problem with the Ethernet cable.
  If there is any problem, replace the Ethernet cable.
Cannot Print over TCP/IP Network

A

**Check1** Is the printer's IP address configured correctly?
Make sure the printer's IP address is configured correctly.

**Note**
- For Windows, you can configure the printer's IP address using IJ Network Device Setup Utility.
  - For wired LAN: [Performing/Changing Wired LAN Connection (Ethernet Cable) Settings](#)
  - For Wi-Fi: [Performing/Changing Wi-Fi Settings](#)

**Check2** Are the printer's TCP/IP network settings configured correctly?
Make sure the printer's TCP/IP network settings are configured correctly.

**Check3** Is the computer you are trying to print from configured correctly?
Make sure the computer's TCP/IP network settings are configured correctly.
Cannot Print over Bonjour networks

Check1  Is the computer you are trying to print from configured correctly?
Make sure the computer is configured correctly.

Check2  Are the computer and printer on the same network?
Due to the nature of Bonjour, printing may not be possible if the printer is on another network behind a router. Make sure the computer and printer are on the same network. For information about network settings, ask your network administrator.

Check3  Are the printer's Bonjour settings configured correctly?
Make sure the Bonjour settings are configured correctly.
Cannot Find Printer on Network

- Cannot Find Printer on Check Printer Settings Screen (Windows)
- Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen
- Searching Printer by IP Address or Host Name During Setup
- Cannot Find Printer while Using Wi-Fi
- Cannot Find Printer while Using Wired LAN
- Cannot Print Using AirPrint
Cannot Find Printer on Check Printer Settings Screen (Windows)

If the printer cannot be found and the Check Printer Settings screen appears after searching the printer by Automatic search on the Search for Printers screen, click Redetect and search for the printer again by the IP address on the Search for Printers screen.

If the printer has not been found after searching it by the IP address, check network settings.
Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen

If you cannot proceed beyond the **Printer Connection** screen or the **Connect Cable** screen, check the following.

**Check1** Make sure USB cable is securely plugged in to printer and computer.

Connect the printer and the computer using a USB cable as the illustration below. The USB port is located at the right side of the printer.

Check the items below only if you cannot proceed beyond the Printer Connection screen.

**Check2** Follow procedure below to connect printer and computer again.

**Important**

- For macOS, make sure the lock icon is on the lower left of the **Printers & Scanners** screen.

  If the icon (locked) is displayed, click the icon to unlock. (The administrator name and the password are necessary to unlock.)

1. Turn off printer.
2. Unplug USB cable from printer and computer and connect it again.
3. Turn on printer.

**Check3** If you cannot resolve problem, follow procedure below to reinstall printer driver.

- For Windows:
  1. Click **Cancel**.
  2. Click **Back to Top** on **Setup Canceled** screen.
3. Click **Exit** on **Start Setup** screen and finish setup.

4. Turn off printer.

5. Restart computer.

6. Make sure you have no application software running.

7. Perform setup on web page.

   **Note**
   - You can use the Setup CD-ROM to redo setup.

• For macOS:

1. Click **Next**.
   - The screen telling you that installation has not been completed appears.

2. Click **No**.
   - The screen to select application software to install appears.

3. Click **Back to Top**.

4. Click **Exit** on **Start Setup** screen.

5. Turn off printer.

6. Restart computer.

7. Make sure you have no application software running.

8. Perform setup on web page.
Searching Printer by IP Address or Host Name During Setup

If the printer cannot be found on the Select Printer screen, search for the printer by an IP address or host name. Click Specify the IP address and run the search on the screen which appears by clicking Printer Not Found. The screen to select searching criteria appears.

1. Check printer's IP address or host name.

   To check the printer’s IP Address or host name, print out the network settings information or use the operation panel to display it.
   - Display on the touch screen.
     ➡ LAN settings
   - Print the network settings.
     ➡ Printing Network Settings

   **Note**
   - If you use the printer in an office, ask the network administrator.

2. Specify searching method.

   Select one of the method below.

   ![Printer Search Method Selection](image)

   **A: Search by IPv4 address**
   Select to search for printers by IPv4 address.

   **B: Search by IPv6 address**
   Select to search for printers by IPv6 address.
C: Search by host name
Select to search for printers by host name. A host name is referred to as LLNMNR host name or Bonjour name.

3. Enter IP address or host name and click **Next**.

Printer search starts.

**If an error screen appears:**
Resolve the error according to the instruction on the screen.
If the IP address you entered is already used for another device, follow the procedure below to specify printer’s IP address.

1. Select [(Network status)](Network status) icon.

   ➜ **Menu Operations**

   If you specify the administrator password, enter the password.

2. Select **Wi-Fi**.

3. Select **Settings**.

4. Select **Advanced**.

5. Select **TCP/IP settings**.
   - If you specify IPv4 address:
     1. Select **IPv4**.
     2. Select **Yes** on the displayed screen.
     3. Select **IP address**.
     4. Select **Manual setup**.
        Selecting **Auto setup** specifies the IP address automatically.
     5. Enter IP address.
     6. Select **OK**.
     7. Enter subnet mask.
8. Select OK.

9. Enter default gateway.

10. Select OK.

   The IPv4 address has been specified.

   • If you specify IPv6 address:


   2. Select Yes on the displayed screen.


   4. Select Enable.

      The IPv6 address has been specified.

   Important

      • If firewall is enabled on the computer, printers on a different subnet may not be detected. Disable firewall.

If firewall interferes with printer search:

• If message appears:

If a message appears warning that Canon software is attempting to access the network, set the security software to allow access.

After allowing the software to access, specify the IP address or host name and search for printers again.

If the printer is found, follow the instructions on the screen to continue to set up the network communication.

• If no message appears:

Cancel searching printers, and then set the security software to allow Canon software below to access the network.

  ◦ For Windows:

    Setup.exe or Setup64.exe in the win > Driver > DrvSetup folder on the Setup CD-ROM

  ◦ For macOS:

    Setup.app, canonijnetwork.bundle, cnwidsd.plugin, cnwidss.plugin

After setting the security software, specify the IP address or host name and search for printers again.
Note

- For more on firewall settings of your operating system or security software, see instruction manual or contact its manufacturer.
Cannot Find Printer while Using Wi-Fi

Check1 Make sure printer is turned on.
If not, make sure the printer is securely plugged in and press ON button to turn on.
The ON lamp flashes while the printer is initializing. Wait until the ON lamp stops flashing and remains lit.

Check2 Check the network status on the touch screen.
If the icon is displayed, or only the icon is displayed, wireless LAN is disabled.
Set Enable/disable Wi-Fi in the touch screen menu to Enable.
If the icon is displayed, see Check 3 or later checking items to make sure whether printer setup is complete or the settings of wireless router to connect are correct.

Check3 Make sure printer setup is complete on the computer.
If it is not, perform setup.
- For Windows:
  Perform setup using the Setup CD-ROM or from the web page.
- For macOS:
  Perform setup from the web page.

Note
- IJ Network Device Setup Utility allows you to diagnose and repair the network status. Download it from the web page.
  ➔ For Windows
  ➔ For macOS

Check4 Make sure printer and wireless router network settings match.
Make sure the network settings of the printer (e.g. wireless router name, SSID, network key, etc.) are identical with those of the wireless router.
To check the settings of the wireless router, refer to the instruction manual provided with it or contact its manufacturer.

Note
- Use 2.4 GHz frequency band to connect to a wireless router. Match the SSID set for the printer with that for 2.4 GHz frequency band of the wireless router.
To check the SSID set for the printer, print out the network setting information or use the operation panel to display it.

- Display on the touch screen.
  ➤ LAN settings
- Print the network settings.
  ➤ Printing Network Settings

**Note**

- IJ Network Device Setup Utility allows you to diagnose and repair the network status.
  Select the link below to download IJ Network Device Setup Utility and install it.
  ➤ Checking Printer Connection Status Using IJ Network Device Setup Utility
  See below for starting up IJ Network Device Setup Utility.
  - For Windows:
    ➤ Starting Up IJ Network Device Setup Utility
  - For macOS:
    ➤ Starting Up IJ Network Device Setup Utility

**Check5** Make sure the printer is not placed too far away from the wireless router.

If the distance between the printer and wireless router is too far, wireless communication becomes poor. Place the printer and wireless router close to each other.

**Note**

- Though an antenna is attached to most wireless routers, note that some of them have it inside.

**Check6** Make sure wireless signal is strong. Monitor signal strength and move printer and wireless router as necessary.

Place the printer and wireless router where there are no obstacles between them. Wireless communication between different rooms or floors is generally poor. Wireless communication can be impeded by building materials containing metal or concrete. If the printer cannot communicate with the computer over a Wi-Fi due to a wall, place the printer and the computer in the same room.

In addition, if a device like a microwave oven that emits radio waves of the same frequency bandwidth as a wireless router is nearby, it may cause interference. Place the wireless router as far away from interference sources as possible.

**Note**

- IJ Network Device Setup Utility allows you to diagnose and repair the network status.
  Select the link below to download IJ Network Device Setup Utility and install it.
  ➤ Checking Printer Connection Status Using IJ Network Device Setup Utility
  See below for starting up IJ Network Device Setup Utility.
  - For Windows:
    ➤ Starting Up IJ Network Device Setup Utility
  - For macOS:
Starting Up IJ Network Device Setup Utility

**Check 7** Make sure the computer is connected to the wireless router.

For more on how to check the computer settings or connection status, see your computer instruction manual or contact its manufacturer.

**Note**

- If you use a smartphone or tablet, make sure the Wi-Fi is enabled on the device.

**Check 8** Make sure **Enable bidirectional support** is selected in the **Ports** sheet of the properties dialog box of the printer driver. (Windows)

If not, select it to enable bidirectional support.

**Check 9** Make sure security software’s firewall is off.

If your security software’s firewall is on, a message may appear warning you that Canon software is attempting to access the network. If this warning message appears, set security software to always allow access.

If you are using any programs that switch between network environments, check their settings. Some programs use a firewall by default.

**Check 10** If printer is connected to an AirPort Base Station via LAN, make sure you use alphanumeric characters for network identifier (SSID). (macOS)

If the problem is not resolved, redo setup.

- For Windows:
  - Perform setup using the Setup CD-ROM or from the web page.
- For macOS:
  - Perform setup from the web page.
Cannot Find Printer while Using Wired LAN

Check1 Make sure printer is turned on.
If not, make sure the printer is securely plugged in and press **ON** button to turn on.
The **ON** lamp flashes while the printer is initializing. Wait until the **ON** lamp stops flashing and remains lit.

Check2 Is **icon** displayed on touch screen?
If the icon is not displayed, wired LAN is disabled.
If not, select **(Setup)** icon, Device settings, LAN settings, Wired LAN, Settings, and then select **Enable** for Enable/disable Wired LAN.

Check3 Make sure LAN cable is connected properly.
Make sure the printer is connected to the router with the LAN cable. If the LAN cable is loose, connect the cable properly.
If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN side of the router.
Cannot Print Using AirPrint

A

Check1  Make sure printer is turned on.
If the printer is turned on, turn it off and back on, and then check whether the issue is resolved.

Check2  Make sure printer is registered to your computer.

Check3  Make sure printer is connected by LAN to same network subnet as AirPrint compliant device when printing over LAN.

Check4  Make sure printer has enough paper and ink.

Check5  Make sure no error message is displayed on printer's touch screen.
Installation Problems

- Removing Printer Software
- Taking Time to Setup Process (Windows)
- Failed to Printer Driver Installation (Windows)
Removing Printer Software

Follow the steps below to remove utility software installed on the computer.

**Important**
- You must log in as an administrator or have administrator permissions.

**Note**
- See the pages below for how to remove printer drivers.
  - Deleting the Unnecessary Printer Driver (Windows)
  - Deleting the Unnecessary Printer Driver (macOS)

Removing the IJ Network Device Setup Utility (Windows)

Follow the steps below to remove the IJ Network Device Setup Utility.

- Windows 10
  1. Click **start**, select **Windows System**, and then select **Control Panel**.

  2. Under **Programs**, select **Programs and Features**, select IJ Network Device Setup Utility from the list of programs, and then click **Uninstall**.

- Windows 8.1
  1. Use the **Settings** charm on the desktop to open the **Control Panel**.

  2. Under **Programs**, select **Programs and Features**, select IJ Network Device Setup Utility from the list of programs, and then click the **Uninstall** button.

- Windows 7
  1. Select **Control Panel** from the **start** menu.

  2. Select **Uninstall a program**.

  3. Select IJ Network Device Setup Utility, and then click the **Uninstall** button.

**Note**
- If the **User Account Control** dialog box is displayed, click **Yes**.
Removing the IJ Network Device Setup Utility (macOS)

Follow the steps below to remove the IJ Network Device Setup Utility.

1. Select **Applications** from **Go** menu of Finder, double-click **Canon Utilities > IJ Network Device Setup Utility**, and then drag **Canon IJ Network Device Setup Utility** icon into **Trash**.

2. Restart computer.

   Empty the **Trash** and restart your computer.

**Note**

- To reinstall IJ Network Device Setup Utility, uninstall IJ Network Device Setup Utility and install it again from the Canon website.
Taking Time to Setup Process (Windows)

If Windows update starts during setup, or if you perform setup while Windows update is in progress, it may take a while to register the printer or to perform other processes.

Wait for a while. This is not a malfunction.
Failed to Printer Driver Installation (Windows)

• If installation does not start when you insert Setup CD-ROM:

  Follow the instructions below to start the installation.

  1. Make the following settings.
     ◦ In Windows 10, click Start button > File Explorer, and then click This PC from list on left.
     ◦ In Windows 8.1, select Explorer icon in Taskbar on Desktop, and then select This PC from list on left.
     ◦ In Windows 7, click Start, and then click Computer.

  2. Double-click the CD-ROM icon in the window that appears.
     If the contents of the CD-ROM appear, double-click MSETUP4.EXE.
     If you cannot install the printer driver with the Setup CD-ROM, install it from the Canon website.

  Note

  • If the CD-ROM icon does not appear, try the following:
     • Remove the CD-ROM from your computer and reinsert it.
     • Restart your computer.

  If the icon still does not appear, try a different disc and see if it appears. If it does, there is a problem with the Setup CD-ROM. Contact your nearest Canon service center to request a repair.
If you cannot get past the Printer Connection screen:

- **Cannot Proceed beyond Printer Connection Screen/Connect Cable Screen**

- **Other cases:**

  Reinstall the printer driver.

  If the printer driver was not installed correctly, uninstall the printer driver, restart your computer, and then reinstall the printer driver.

  **Deleting the Unnecessary Printer Driver**

  Reinstall the printer driver with the Setup CD-ROM or install it from the Canon website.

  **Note**

  - If the installer was stopped due to a Windows error, Windows operation may be unstable, and you may not be able to install the drivers. Restart your computer and then reinstall the drivers.
HP-GL/2 problems

- With HP-GL/2, printing is misaligned
- Lines or images are missing in printed HP-GL/2 jobs
- Lines are printed too thick or thin in HP-GL/2 print jobs
- HP-GL/2 jobs are printed in monochrome (or color)
- Printed colors of lines are inaccurate during HP-GL/2 printing
- HP-GL/2 jobs are printed 6 mm larger than specified
- HP-GL/2 jobs are printed at maximum size, even if a standard size is specified
- HP-GL/2 printing takes a long time
- The printer stops when printing a HP-GL/2 job (the carriage stops moving)
Q
With HP-GL/2, printing is misaligned

A
Check the Margin setting.
Adjust the Margin setting values in the touch screen menu.

⇒ Print settings
Lines or images are missing in printed HP-GL/2 jobs

Check 1: Is the memory full?
Check the size of the data in the print job.

Check 2: Is the printer receiving an HP-GL/2 command not supported by this printer?
Check the print job and settings.

Check 3: Has the printer received print data that includes HP RTL commands when Auto rotation is ON?
Set Auto rotation to OFF in the touch screen menu and print again.
  ➜ Print settings

Check 4: Is Oversize set to Disable?
Set Oversize to Enable in the touch screen menu.
  ➜ Print settings
Lines are printed too thick or thin in HP-GL/2 print jobs

Check 1
Check the Width setting in Pen setup menu.
Select Pen setup, then select Define palette, and change the Width setting of each pen in each palette.

Check 2
Check the Width correction setting.
Change the Width correction setting in the touch screen menu.

Check 3
Is Adjust faint lines set to OFF?
If fine lines are printed faintly, setting Adjust faint lines to ON will print the lines more distinctly.
HP-GL/2 jobs are printed in monochrome (or color)  

Check the **Color mode** setting.

Check the Color mode setting in the touch screen menu.

However, for optimal Print head performance, the printer consumes trace amounts of color ink even when **Monochrome** is selected as **Color mode**.
Printed colors of lines are inaccurate during HP-GL/2 printing

**Q**

**A**

Check Is Adjust faint lines set to ON?

Setting Adjust faint lines to OFF in the touch screen menu may help produce the expected results. However, lines in some colors may appear broken.

⇒ Print settings
HP-GL/2 jobs are printed 6 mm larger than specified

Check the page size of the HP-GL/2 print job, as created in the source application.

Set **Oversize** to **Disable** in the touch screen menu.

⇒ **Print settings**
HP-GL/2 jobs are printed at maximum size, even if a standard size is specified

Check the page size of the HP-GL/2 print job, as created in the source application.

Set Conserve paper to ON in the touch screen menu.

➤ Print settings
Q

HP-GL/2 printing takes a long time

A

Check 1: Is the print data size large?

Large print jobs with a lot of data take longer to print. Please wait a while until printing is finished.

Check 2: Is Input resolution set to 600 dpi?

Set Input resolution to 300 dpi.

⇒ Adjusting Feed Amount
The printer stops when printing a HP-GL/2 job (the carriage stops moving)

Check 1
The printer is analyzing the print job. Please wait a while until printing is finished.

Check 2
Is Input resolution set to 600 dpi?
Set Input resolution to 300 dpi.

⇒ Adjusting Feed Amount
Other Problems

- Printer does not turn on
- If the Printer Makes a Strange Sound
- Messages advising to check the maintenance cartridge are not cleared
- Printer consumes a lot of ink
- Ink Level Detection
Printer does not turn on

Check 1  Is the power cord plugged in?
Plug the power cord into the outlet, and then turn on the printer.

Check 2  Is the specified voltage being supplied?
Check the voltage of the outlet and breaker.

Specifications
If the Printer Makes a Strange Sound

Check 1

Has an unusual noise been produced from the vicinity of the roll holder?

If dust accumulates on the gear (A) at the end of the roll holder, a noise may produced from that area.

![Diagram of roll holder with labeled part A]

When the noise starts, clean the gear with the following procedure:

1. Remove the roll holder from the printer.
2. Wipe the dust off the gear with a damp, tightly wrung cloth, and then dry with a dry cloth.
3. Insert the roll holder in the printer.

Check 2

Operating noise may be heard from the printer even when not printing.

The following sounds do not indicate a problem with the printer.

- A suction sound can be heard from the platen
  
  To prevent the paper from rising, the surface of the platen has vacuum holes that create suction on the paper.

- Roll paper makes a fluttering sound during printing.
  
  There may be a fluttering sound when large paper is advanced.

- You suddenly hear the sound of cleaning operations.
  
  Cleaning is automatically performed at specified intervals in order to keep the printer maintained.

- You suddenly hear the sound of ink agitation.
  
  Ink is automatically agitated after specified intervals to maintain optimal print quality. Agitation takes approximately 20 seconds to 2 minutes.
Ink is also agitated automatically at the following times. Please note that no other operations can be performed while "Agitating the ink" is on the touch screen.

- After the printer is turned on
- After data transmission
- After ink tank replacement

In other cases, contact your Canon dealer.
Messages advising to check the maintenance cartridge are not cleared

The newly replaced maintenance cartridge is not recognized.

Remove the newly replaced maintenance cartridge, and then reinsert it again firmly.

⇒ Replacing the Maintenance Cartridge
Printer consumes a lot of ink

Are lots of full-color materials being printed?
In print jobs such as photos, images are filled with color. This consumes a lot of ink. This does not indicate a problem with the printer.

Is System cleaning being carried out frequently?
System cleaning uses a lot of ink. This is normal. We recommend that you only carry out System cleaning after the printer has been transported, if has not been used for a long time, or if there is a problem with the Print head.

You have just finished initial installation, when more ink is consumed to fill the system.
If using the printer for the first time, or using it after transport, the ink tank will supply an initial fill of ink to the Print head.
Although the amount of remaining ink may drop as a result, it does not indicate a problem.

Is the Print head nozzle blocked?
Check for nozzle clogging.

Checking for Nozzle Clogging
Ink Level Detection

The printer ink tank detects the amount of ink remaining to prevent running out of ink while printing and to avoid printer failure.

⇒ Ink Tanks

When using an ink tank refilled with ink, the function for detecting the remaining ink level may not operate properly and printing may stop. If you want to use an ink tank refilled with ink, you need to disable the function for detecting the remaining ink level.

Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc. is not liable for any damage that may occur as a result of refilling ink.

Important

• Once the function for detecting the remaining ink level is disabled, it cannot be restored for that ink tank. To restore the function for detecting the remaining ink level, replace the ink tank with a new ink tank for that printer.

• Repeatedly removing and inserting the same ink tank can cause the contacts between the ink tank and printer to malfunction, ink may leak from the ink tank, and the printer may become damaged.

Releasing ink level detection

Ink level detection will be deactivated if you load ink tanks once emptied.

If The above ink tank may be an ink tank that ran out of genuine Canon ink or a counterfeit Canon ink tank. appears on the touch screen, follow the steps below.

1. Move through the screens, performing the actions described in the messages that appear on the touch screen.

2. If an instruction to disable detection of remaining ink appears on the touch screen, hold down the Stop button for at least 5 seconds and then release it.

Ink level detection is now released.
**List of Support Code for Error**

Support codes appear on the PC when an error occurs.
Support codes are error identification numbers that appear alongside error messages.
If an error occurs, check the support code and follow the recommended steps to resolve the issue.

### Support code displayed

- **1000 to 1ZZZ**
  - 1005 100A 1012 1021 1024 1041
  - 1051 1052 1054 1058 1061 1200
  - 1201 1210 1213 1214 1300 1306
  - 1317 1322 1323 1324 1401 1403
  - 1408 1409 140A 140B 140C 140F
  - 1468 1477 1478 1480 1481 1485
  - 1492 1494 1495 1500 1551 1552
  - 1570 1571 1660 168B 1720 1721
  - 1722 1730 1731 1752 1753 1756
  - 1757

- **2000 to 2ZZZ**
  - 2130 2131 2132

- **3000 to 3ZZZ**
  - 3001 3200 3201 3250 3300 3301
  - 3302 3303 3306 3311 3312
  - 3313 3314 3315 3316 3317 3331
  - 3332 3333 3337 3341 3342 3414
  - 3415 3416 3417 3418 3419 3420
  - 3421 3422 3423 3424 3448

- **4000 to 4ZZZ**
  - 4111 4117 4801 4803 4905 4920
• 5000 to 5ZZZ
  5106  5200  5B16  5B20  5B21  5C00

• 6000 to 6ZZZ
  6502  6700  6702  6820  6900  6901
  6902  6910  6911  6920  6921  6930
  6931  6932  6933  6940  6941  6942
  6943  6944  6945  6946

• 7000 to 7ZZZ
  7050  7051  7052

• 8000 to 8ZZZ
  8200

• 9000 to 9ZZZ
  9000  9110

• A000 to ZZZZ
  B20A  B510
1005

Cause
You have attempted to print on a sheet, but no sheet is loaded.

What to Do
Check the media size and type for the print job on the touch screen, and then tap OK.

• Continuing to print
  Tap Load paper, and then load the paper.
  ➤ Loading and Printing on Sheets

• Stopping printing
  To stop printing, tap Cancel on the touch screen or press the Stop button.
100A

Cause

You have attempted to print on a roll, but no roll is loaded.

What to Do

Tap **Load paper** on the touch screen, and then load the paper roll and print.

- [Loading Rolls on the Roll Holder](#)
- [Loading Rolls in the Printer](#)

Note

- To stop printing, tap **Cancel** on the touch screen or press the **Stop** button.
Cause
You have attempted to print on a sheet, but no sheet is loaded.

What to Do
Tap Load paper on the touch screen, and then load cut paper and print.

⇒ Loading and Printing on Sheets

Note
• To stop printing, tap Cancel on the touch screen or press the Stop button.
1021

Cause

The printer has received a print job longer than the amount of roll paper left.

What to Do

• Continuing to print

To continue printing, tap **Print with the loaded paper.** on the touch screen. However, the roll paper may run out during the print job and you may not be able to print all of the document.

• Replacing paper

Tap **Replace the paper and print** and print on the touch screen. Change the **Paper Source** in the printer driver, or replace the paper with paper of the right length for the print job, and then try again.

⇒ **Removing the Roll from the Printer**
⇒ **Loading Rolls in the Printer**

• Stopping printing

To stop printing, tap **Cancel** on the touch screen or press the **Stop** button.
Cause

Possible causes include the following.

- Roll paper is empty.
- There is remaining roll paper, but because it could not be advanced, it could not be detected.

What to Do

- The roll paper has run out

Follow the steps below to replace the used roll with a new roll of the same type and size.

1. Tip back the release lever and remove the roll paper.
   - Removing the Roll from the Printer
   - Removing Rolls From the Roll Holder

2. Load the new roll.
   - Loading Rolls on the Roll Holder
   - Loading Rolls in the Printer

3. If no barcode was printed on the roll, specify the paper type.
   - Changing the Type of Paper

4. If Manage remaining roll amount is set to Barcodes in the touch screen menu and there is no barcode printed on the paper roll, set the paper length.
   - Specifying the Paper Length

5. If “There is a job whose printing is not complete. Do you want to print this job?” appears on the touch screen, tap Yes.
   
   Printing will resume, starting from the page on which the error occurred.

- Feed stopped because the end of the paper roll is attached to the core with tape

Remove the used roll paper and insert a new roll paper.

- Removing the Roll from the Printer
- Removing Rolls From the Roll Holder
- Loading and Printing on Rolls

- Feed stopped because the remaining paper roll is too heavy

It may be helpful to change the printing mode, which will change the paper feed timing.

If using Windows, select a higher Print Quality setting under Advanced Settings in the printer driver.

If using macOS, select Quality & Media in the printer driver, and then select a higher Print Quality setting.

- Setting the Print Quality Level (Custom) (Windows)
- Setting the Print Quality Level (Custom) (macOS)
Note

- To stop printing, press the Stop button.
1041

Cause
You have selected wrong paper source for Replace paper.

What to Do
Match the paper source for loading paper with the paper source setting for Replace paper.
For the roll paper, select Roll paper and load it.
For the cut sheet, select Cut sheet and load it.
Cause

The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
1052

Cause

The width of the roll paper set in **Fit Roll Paper Width** in the printer driver is not the same as the width of the roll paper loaded in the printer.

What to Do

You can continue to print, but note that this error may cause problems in the printing results.
1054

Cause
The paper in the printer is smaller than the paper size set in the printer driver.

What to Do
You can continue to print, but note that this error may cause problems in the printing results.
1058

Cause
Roll paper has almost run out.

What to Do
Printing will continue. Replace the roll paper in the printer with one that has enough paper for printing as soon as possible.

- Removing the Roll from the Printer
- Loading Rolls in the Printer

Note
- To stop printing, press the Stop button.
Cause
The media type specified in the printer driver is not the same as the media type loaded in the printer.

What to Do
Tap OK on the touch screen.

Make sure that the media type that appears on the touch screen is the same as the media type that has been loaded, and then tap OK.

• Printing again
Follow the steps below to match the media type in the printer driver and the media type specified for the printer.

1. Tap Cancel to stop printing.
2. Change the media type in the printer driver settings to the media type loaded in the printer, and then try again.

• Replacing paper
Follow the steps below to match the media type in the printer driver and the media type specified for the printer.

1. Tap Replace the paper and print.
2. Load the paper with the media type specified in the printer driver.

⇒ Loading and Printing on Rolls
⇒ Loading and Printing on Sheets

• Continuing to print
To continue printing, tap Print with the loaded paper. on the touch screen.

However, note that this error may cause paper jams and affect the printing quality.
1200

**Cause**
Top cover or print head lock lever is open.

**What to Do**
Open the top cover and make sure the print head lock lever is closed properly.
Make sure there are no foreign objects caught in the top cover, and then close the top cover.
If this error appears again, close the top cover, turn the power off, wait a moment, and then turn the power back on.

**Note**
- If installing a print head, close the top cover after finishing.
1201

**Cause**
The ink tank cover is open.

**What to Do**
Close the ink tank cover.
**Cause**
The ink tank cover is open.

**What to Do**
Close the ink tank cover.
1213

**Cause**
Release lever is released.

**What to Do**
Pull the release lever toward the front.
If the error occurs again, turn off the printer and wait a while before restoring power.
**1214**

**Cause**

While the printer was printing or performing maintenance, the release lever was released.

**What to Do**

Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and contact a Canon customer service center.

**Detailed error codes**

EC19-2F21
1300

Cause

Paper jammed inside the printer while printing.

What to Do

Follow these steps below to remove jammed paper.

1. Tip back the release lever and remove the jammed paper.
   - Remove Jammed Roll Paper
   - Remove a Jammed Sheet

2. Load the paper.
   - Loading Rolls in the Printer
   - Loading Sheets in the Printer

3. If "There is a job whose printing is not complete. Do you want to print this job?" appears on the touch screen, tap Yes.

   Printing will resume, starting from the page on which the error occurred.

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
1306

cause

A print job for rolls was received when a sheet is loaded.

What to Do

Follow these steps to load and print on a roll.

1. To remove the cut paper, tap **Remove paper** on the touch screen.
   ➤ **Removing Sheets**

2. Load a new roll.
   ➤ **Loading Rolls in the Printer**

Note

- To stop printing, tap **Cancel** on the touch screen or press the **Stop** button.
1317

Cause

Paper loaded crooked was detected when the paper was advanced.

What to Do

Tip back the release lever and reload the paper.

- Loading Rolls in the Printer
- Loading Sheets in the Printer

If this error appears again even after reloading the paper roll, remove the roll holder from the printer, insert the paper roll firmly into the roll holder until it is up against the flange, and then insert the roll holder into the printer.

- Loading Rolls on the Roll Holder

Important

- If this message continues to appear even after taking the steps above, or if you do not want this message to appear, set Skew detection accuracy in the printer menu to OFF or Loose. However, note that the paper will be printed skewed, which could cause paper jams and abnormal print results, or dirty the platen and the reverse of the next printed sheet.
Cause

Cannot detect paper size because paper is not in the correct position or because curled paper has been loaded.

What to Do

Tip back the release lever and remove any paper. Then check the paper and reload it.

- Loading Rolls in the Printer
- Loading Sheets in the Printer

If "There is a job whose printing is not complete. Do you want to print this job?" appears on the touch screen, tap Yes.

Printing will resume, starting from the page on which the error occurred.

Note

- If this error appears again even after reloading the paper roll, remove the roll holder from the printer, insert the paper roll firmly into the roll holder until it is up against the flange, and then insert the roll holder into the printer.
  - Loading Rolls on the Roll Holder

- This error might also appear if the platen has been dirtied by ink or another substance, or if the size of clear film could not be detected. In this case, open the top cover and clean the entire platen area.
  - Cleaning Inside the Top Cover
1323

Cause
An unsuitable paper size has been loaded.

What to Do
Tip back the release lever, remove any paper, and then reload paper of suitable size.

- Paper Sizes
- Loading Rolls in the Printer
- Loading Sheets in the Printer

Note
- Load unused A4/letter size or larger paper if printing calibration and nozzle check patterns. Each calibration may take several sheets of paper.
**Cause**

A print job for printing on sheets was sent when a roll is loaded.

**What to Do**

Follow the steps below to print again.

1. Tap **Remove paper** on the touch screen to stop printing.
2. Remove the paper roll, load cut paper of the size and type specified in the printer driver, and then try again.

   ➤ Removing the Roll from the Printer
   ➤ Loading and Printing on Sheets

**Note**

- To stop printing, tap **Cancel** on the touch screen or press the **Stop** button.
1401

Cause
Failed to recognize print head.

What to Do
Open the top cover and reattach the print head.

➤ Replacing the Print Head
**Cause**

There is a problem with the print head.

**What to Do**

Tap OK on the touch screen, and then replace the current print head with a new one.

- [Replacing the Print Head](#)

If you do not have a replacement print head ready, turn off the power and replace the print head once you have the new one.
Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

⇒ Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you have the new one.
Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

⇒ Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you have the new one.
Cause

There is a problem with the print head.

What to Do

Tap OK on the touch screen, and then replace the current print head with a new one.

⇒ Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you have the new one.
140B

**Cause**
Failed to recognize print head.

**What to Do**
Open the top cover and reattach the print head.

⇒ [Replacing the Print Head](#)
140C

**Cause**
There is a problem with the print head.

**What to Do**
Turn off the power, wait a moment, and then turn it back on.
Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

⇒ Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you have the new one.
1468

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC55-2F24
Cause
There is a problem with the print head.

What to Do
Open the top cover and replace the print head with a new one.

⇒ Replacing the Print Head
Cause
There is a problem with the print head.

What to Do
Tap OK on the touch screen, and then replace the current print head with a new one.

- Replacing the Print Head

If you do not have a replacement print head ready, turn off the power and replace the print head once you have the new one.
Cause
The attached print head was previously used in a different model.

What to Do
Attach the correct print head.

⇒ Replacing the Print Head
1481

**Cause**

The attached print head was previously used in a model that uses a different ink set.

**What to Do**

Attach the correct print head.

⇒ [Replacing the Print Head](#)
1485

Cause
Cannot use attached print head.

What to Do
Attach the correct print head.

⇒ Replacing the Print Head
1492

Cause
A printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC02-2F42 EC21-2F44 EC3F-2F40 EC3F-2F41
1494

**Cause**

There may be a problem with the print head.

**What to Do**

Turn off the power, wait a moment, and then turn it back on.

If the error appears again, remove and reattach the print head.

- [Replacing the Print Head](#)

If that does not get rid of the error, replace the print head with a new one.
Cause

The print head nozzle is blocked.

What to Do

Follow the steps below to clean the print head.

1. Tap Cancel on the touch screen to stop printing.
2. Clean the print head.
   ➔ Cleaning the Print Head

If this message still appears when printing, replace the print head.

➔ Replacing the Print Head

Important

• To continue printing, use the touch screen and tap Continue printing. However, the print results may not be satisfactory.
1500

**Cause**
The ink in the ink tank is running low.

**What to Do**
Prepare a new ink tank.
1551

Cause

A genuine Canon ink tank with a history of past use has been detected.

What to Do

To dismiss the message, tap OK on the touch screen.
1552

Cause
A genuine Canon ink tank has been inserted.

What to Do
To dismiss the message, tap OK on the touch screen.
1570

Cause
The ink in the ink tank has run out.

What to Do
Open the ink tank cover, and then replace the ink tank before the ink in the sub-ink tank of this printer becomes insufficient.

Replacing Ink Tanks

Note
• You can replace the ink tank even while printing.
1571

Cause
Ink tank removed during printing.

What to Do
If replacing the ink tank, insert a new ink tank.

⇒ Replacing Ink Tanks
1660

Cause
Ink tank not inserted.

What to Do
Insert the ink tank correctly.

⇒ Replacing Ink Tanks
168B

**Cause**

The ink tank cannot be recognized.

Printing cannot be executed because the ink tank may not be compatible with this printer.

**What to Do**

Install the appropriate ink tank.
1720

**Cause**

The maintenance cartridge is full.
It needs to be replaced.

**What to Do**

Replace the maintenance cartridge.

⇒ [Replacing the Maintenance Cartridge](#)
1721

**Cause**

The maintenance cartridge is not installed.

**What to Do**

Install the maintenance cartridge.

- [Replacing the Maintenance Cartridge](#)
1722

**Cause**
Incorrect type of maintenance cartridge.

**What to Do**
Insert the correct maintenance cartridge.

- [Replacing the Maintenance Cartridge](#)

If this error continues to appear, contact a Canon customer service center.
1730

<table>
<thead>
<tr>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ink tank may be an ink tank that ran out of genuine Canon ink or a counterfeit Canon ink tank.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>To print, you must replace the ink tank or disable the function for detecting the remaining ink level.</td>
</tr>
<tr>
<td>To disable the function for detecting the remaining ink level, press and hold the printer’s Stop button for at least 5 seconds, and then release it.</td>
</tr>
<tr>
<td>By this operation, the fact that you have disabled the function for detecting the remaining ink level will be memorized. Please be advised that Canon shall not be liable for any malfunction or trouble caused by continuation of printing under the ink out condition or by using refilled ink tanks.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the function for detecting the remaining ink level is disabled, the ink tank in gray is displayed on the touch screen when checking the current ink level.</td>
</tr>
</tbody>
</table>

To report the counterfeit ink tank, access Canon website from the following link.

Report Counterfeit
1731

Cause
Non-genuine Canon ink tank has been detected.

What to Do
To print, you must replace the ink tank or disable the function for detecting the remaining ink level.

To disable the function for detecting the remaining ink level, press and hold the printer's Stop button for at least 5 seconds, and then release it.

By this operation, the fact that you have disabled the function for detecting the remaining ink level will be memorized. Please be advised that Canon shall not be liable for any malfunction or trouble caused by using a non-genuine Canon ink tank.

Note
• If the function for detecting the remaining ink level is disabled, the ink tank in gray is displayed on the touch screen when checking the current ink level.

To report the counterfeit ink tank, access Canon website from the following link.

Report Counterfeit
Cause
The ink has run out.

What to Do
Open the ink tank cover, and then replace the ink tank.

» Replacing Ink Tanks
Cause

The remaining level of the ink cannot be correctly detected.

What to Do

Replace the ink tank. Printing will restart.

⇒ Replacing Ink Tanks

An ink tank that was once empty is installed.

If you want to continue printing, you need to disable the function for detecting the remaining ink level.

To disable this function, press and hold the printer’s Stop button for at least 5 seconds, and then release it.

With this operation, disabling the function for detecting the remaining ink level is memorized.

Please be advised that Canon shall not be liable for any malfunction or trouble caused by continuation of printing under the ink out condition or by using refilled ink tanks.
1756

**Cause**

The ink may become insufficient.

**What to Do**

To perform the next process or to continue the specified process, replace the ink tank.

⇒ [Replacing Ink Tanks](#)
1757

Cause
Cannot fill ink reserve tank.

What to Do
Check the touch screen, remove the ink tank for the affected color, and then reinsert it.
If the inserted ink tank is empty, replace it with a new ink tank.

⇒ Replacing Ink Tanks
2130

Cause
The roll paper width set in the print job is not the same as the width of the roll paper in the printer.

What to Do
Tap OK on the touch screen to go to the next screen.
Check the media type and size that appear and tap OK.

• Printing without changes
   Tap Print with the loaded paper.. However, note that this error may cause paper jams and affect the printing quality.

• Stopping printing
   Tap Cancel on the touch screen or press the Stop button.

• Replacing the roll paper
   Follow the steps below to replace the paper with roll paper of the width set in the printer driver.
   1. Tap Replace the paper and print, then remove the roll paper.
      ➤ Removing the Roll from the Printer
      ➤ Removing Rolls From the Roll Holder
   2. Replace the paper with paper of the width set in the printer driver.
      ➤ Loading Rolls on the Roll Holder
      ➤ Loading Rolls in the Printer

Printing begins.

Note
• To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll paper width in the dialog box that appears.
• To change print settings in macOS, open the printer driver and select Fit Roll Paper Width, and then set the roll paper width in that panel to the width of the paper loaded in the printer.
• To suppress this message, set Detect paper setting mismatch in the touch screen menu to Do not detect. However, note that this error may affect the printing quality.

➤ Menu Structure
Cause
The roll paper loaded in the printer is narrower than the roll paper width in the print job.

What to Do
Tap OK on the touch screen to go to the next screen.
Check the media type and size that appear and tap OK.

- Printing without changes
  Tap Print with the loaded paper.
  However, note that this error may cause paper jams and affect the printing quality.

- Stopping printing
  Tap Cancel on the touch screen or press the Stop button.

- Replacing the roll paper
  Follow the steps below to replace the paper with roll paper of the width specified in the print job paper size settings.
  1. Tap Replace the paper and print, then remove the roll paper.
     ➔ Removing the Roll from the Printer
     ➔ Removing Rolls From the Roll Holder
  2. Replace the paper with paper of the width set in the printer driver.
     ➔ Loading Rolls on the Roll Holder
     ➔ Loading Rolls in the Printer
  Printing begins.

Note
- To change print settings in Windows, select Fit Roll Paper Width in the printer driver and set the roll paper width in the dialog box that appears.
- To change print settings in macOS, open the printer driver and select Fit Roll Paper Width, and then set the roll paper width in that panel to the width of the paper loaded in the printer.
- To suppress this message, set Detect paper setting mismatch in the touch screen menu to Do not detect. However, note that this error may affect the printing quality.
  ➔ Menu Structure
2132

Cause

Cannot print internal printer data, such as test prints, for the following reasons.

- The paper roll loaded in the printer is too small.
- The cut paper loaded in the printer is the wrong size or type.

What to Do

- Roll
  Tap Replace the paper and print on the touch screen, or tip back the release lever and replace the paper with paper of the correct size.

  ➜ Loading Rolls in the Printer

  To stop printing, tap Cancel or press the Stop button.

- Sheet
  Tip back the release lever, remove any paper, and then load paper of the same size and type as the first page.

  ➜ Loading Sheets in the Printer

  To stop printing, press the Stop button.
3001

Cause
The print head nozzle is becoming blocked.

What to Do
Check the printed materials.
If the printed materials are scratched, clean the print head.

➤ Cleaning the Print Head
3200

Cause
It is almost time to replace consumables for which service is required.

What to Do
This can used for a little while, until the message “Part replacement needed.” appears.
Contact your Canon dealer for assistance.
3201

Cause
It is past the recommended time to replace consumables for which service is required.

What to Do
Contact your Canon dealer for assistance.
3250

**Cause**

The maintenance cartridge is almost full.

**What to Do**

Prepare a new maintenance cartridge because an error may occur if you continue to use the printer while the maintenance cartridge is full.

- [Replacing the Maintenance Cartridge](#)
3300

Cause
Printer memory is full in HP-GL/2 emulation mode.

What to Do
Check the print data.
Printing will continue, but you may not obtain correct printing results.
Check the printing results.
3301

**Cause**

Parameter specified in HP-GL/2 command is not supported.

**What to Do**

Check the print data.

Printing will continue, but you may not obtain correct printing results.

Check the printing results.
3302

Cause
Unsupported HP-GL/2 command was used.

What to Do
Check the print data.
Printing will continue, but you may not obtain correct printing results.
Check the printing results.
3303

**Cause**
Printer memory is full in HP-GL/2 emulation mode.

**What to Do**
Check the print data.
Printing will continue, but you may not obtain correct printing results.
Check the printing results.
3304

**Cause**

Printer memory is full in HP-GL/2 emulation mode.

**What to Do**

Check the print data.

Printing will continue, but you may not obtain correct printing results.

Check the printing results.
3306

**Cause**
Media information cannot be recognized because the printer media information is corrupt.

**What to Do**
Start the Media Configuration Tool, and then recover the media information.

- Media Configuration Tool Guide

To set the Media Configuration Tool to recovery mode, open the Media Configuration Tool, select this device and then click **OK**.

Select and load the media information backup file.

If you do not have a media information backup file, contact a Canon customer service center.
3311

**Cause**
Incorrect print data.
Illegal number of parameters.

**What to Do**
Defective print data, please check the print results.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
Cause
Incorrect print data.
Required items have been omitted.

What to Do
Defective print data, please check the print results.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
3313

Cause
Incorrect print data.
Data out of range.

What to Do
Defective print data, please check the print results.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
3314

**Cause**

Incorrect print data.
Resolution value out of range.

**What to Do**

Defective print data, please check the print results.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
3315

Cause
Incorrect print data.
Compression method value out of range.

What to Do
Defective print data, please check the print results.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
3316

**Cause**
- Incorrect print data.
- Incorrect data formatting (color sequence, bit count).

**What to Do**
- Defective print data, please check the print results.
- If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
3317

Cause
Incorrect print data.
Illegal combination of resolution and image data format.

What to Do
Defective print data, please check the print results.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
3331

**Cause**
Print results may be abnormal as there is a large volume of print data.

**What to Do**
Check the print job.
Cause

Unsupported JPEG data format.

What to Do

Check the JPEG data.

Printable file formats are as follows.

- **Files which conforms to JFIF 1.02**
  - Processing method: Basic DCT
  - Color mode: RGB/GrayScale
  - Number of colors: 24bit/8bit
  - Number of pixels: 38400 or less vertically and horizontally

* Does not support some samplings.
Cause
Unsupported JPEG data format.

What to Do
Check the JPEG data.
Printable file formats are as follows.

• **Files which conforms to JFIF 1.02**
  ◦ Processing method: Basic DCT
  ◦ Color mode: RGB/GrayScale
  ◦ Number of colors: 24bit/8bit
  ◦ Number of pixels: 38400 or less vertically and horizontally

* Does not support some samplings.
Cause
Printer is running out of memory during JPEG image processing.

What to Do
Print the image without rotating it.

To change image rotation when printing: (Setup) > Device settings > Print settings > JPEG print settings > Paper settings > Rotate.

Note
- You may be able to print the file by increasing JPEG file compression.
3341

Cause
Print data contains illegal image processing table.

What to Do
Check the print job image processing table.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
3342

Cause
Incorrect resolution value.

What to Do
Check the print settings.
If using printing software such as RIP (Raster Image Processor), contact the software manufacturer.
Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.
Check that the address and port numbers of the sending mail server (SMTP server) are correct in the Remote UI mail server settings.

⇒ Setting Mail Server
If this does not resolve the error, check the status of the mail server.
Contact the mail server administrator to check the server settings and status.
Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.
Check that the address and port numbers of the receiving mail server (POP3 server) are correct in the Remote UI mail server settings.

⇒ Setting Mail Server

If this does not resolve the error, check the status of the mail server.
Contact the mail server administrator to check the server settings and status.
**Cause**

Communication with mail server failed.

**What to Do**

Tap OK on the touch screen to dismiss the error.

Check that the mail server and device secure connection (SSL) settings match.

Check the secure connection (SSL) settings in **Remote UI**.

⇒ [Setting Mail Server](#)

Contact the mail server administrator to configure a secure connection (SSL) to the mail server.
3417

Cause
Communication with mail server failed.

What to Do

Tap OK on the touch screen to dismiss the error.

Check that the mail server and device secure connection (SSL) settings match.

Check the secure connection (SSL) settings in Remote UI.

- Setting Mail Server

Contact the mail server administrator to configure a secure connection (SSL) to the mail server.
3418

**Cause**
Communication with mail server failed.

**What to Do**
Tap **OK** on the touch screen to dismiss the error.
Check that the sending mail server (SMTP server) is correctly configured in the Remote UI mail server settings.

- [Setting Mail Server](#)

If this does not resolve the error, check the status of the mail server.
Contact the mail server administrator to check the server settings and status.
Cause
Communication with mail server failed.

What to Do
Tap **OK** on the touch screen to dismiss the error.

Check that the sending account and password are correctly configured in the Remote UI mail server settings.

- **Setting Mail Server**

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
3420

**Cause**
Communication with mail server failed.

**What to Do**
Tap OK on the touch screen to dismiss the error.
Check that the receiving mail server (POP3 server) is correctly configured in the Remote UI mail server settings.

➤ **Setting Mail Server**
If this does not resolve the error, check the status of the mail server.
Contact the mail server administrator to check the server settings and status.
3421

**Cause**

Communication with mail server failed.

**What to Do**

Tap **OK** on the touch screen to dismiss the error.

Check that the receiving account and password are correctly configured in the Remote UI mail server settings.

⇒ Setting Mail Server

If this does not resolve the error, check the status of the mail server.

Contact the mail server administrator to check the server settings and status.
3422

Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.
Check that the settings on the mail server and the APOP settings on this device match.
Check this device’s APOP settings in Remote UI.

➡ Setting Mail Server
Contact the mail server administrator for configuring APOP on the mail server.
Cause
Communication with mail server failed.

What to Do
Tap OK on the touch screen to dismiss the error.
Check if the Remote UI mail server settings are correct.

➡️ Setting Mail Server
If this does not resolve the error, check the status of the mail server.
Contact the mail server administrator to check the server settings and status.
3424

Cause
Sending mail failed.

What to Do
Tap OK on the touch screen to dismiss the error.
Specify the correct destination mail address and try again.
**Cause**

IP address is conflicting.

**What to Do**

Tap **OK** on the touch screen to dismiss the error.

Check the network configuration and change the network configuration to prevent a conflict with other network devices.

For details on changing the network configuration, refer to the documentation for your network device.
4111

Cause

The media type specified is incompatible with this device.

What to Do

Tap OK on the touch screen to dismiss the error.

Check the media type settings, and then try again.
Cause
The print job received contains settings not compatible with borderless printing.

What to Do

• Changing the print job settings

Follow these steps to change the settings of the print job to enable borderless printing.

1. Tap Cancel on the touch screen to stop printing.
2. Check that the paper source is set to Roll Paper in your application.
3. Check that banner printing is not set, and then try again.

See the media information list for media types compatible with borderless printing.

→ Paper Information List

• Printing with a border

Tap Print with border on the touch screen.

Printing with a border is now enabled.

Note

• To force the printer to print, set Detect paper setting mismatch in the touch screen menu to Do not detect.

However, note that this error may affect the printing quality.
4801

**Cause**

A printer error has occurred.

**What to Do**

Turn off the power, wait a moment, and then turn it back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and contact a Canon customer service center.

**Detailed error codes**

EC01-2F90 EC01-2F95 EC04-2F31 EC05-2F92 EC06-2F9A EC06-2F9B EC06-2F9C EC0F-2F96
EC23-2F11 EC23-2F18 EC31-2F1C EC31-2F1D EC31-2F1E EC31-2F22 EC33-2F3D
4803

Cause
Printer error has occurred.

What to Do
Turn off the power, wait a moment, and then turn it back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and contact a Canon customer service center.

Detailed error codes
EC51-203C
4905

<table>
<thead>
<tr>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>A printer error has occurred.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn off the power, wait a moment, and then turn it back on.</td>
</tr>
<tr>
<td>If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and contact a Canon customer service center.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Detailed error codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>EC51-3304 EC51-3306 EC51-3307 EC51-3308 EC51-3309 EC51-330A</td>
</tr>
</tbody>
</table>
Cause

Cannot cut paper for one of the following reasons.

• Paper that has been cut remains on the output guide.
• There is a foreign object near the output slot that is obstructing the cutter blade.
• The paper is not being used under the recommended usage conditions.
• The paper in use cannot be used with **Automatic cut**.

What to Do

• **Paper that has been cut remains on the output guide**

  Follow the steps below to resume printing.

  1. Tip back the release lever and remove the paper.  
     ➤ **Removing the Roll from the Printer**  
     ➤ **Removing Sheets**

  3. Load the paper.  
     ➤ **Loading Rolls in the Printer**  
     ➤ **Loading Sheets in the Printer**

  3. If “**There is a job whose printing is not complete. Do you want to print this job?**” appears on the touch screen, tap **Yes**.

     Printing will resume, starting from the page on which the error occurred.

     ➤ **Loading Rolls in the Printer**

• **A foreign object near the output slot is obstructing the cutter blade**

  Follow the steps below to resume printing.

  1. Open the top cover and remove any foreign objects.

  2. If “**There is a job whose printing is not complete. Do you want to print this job?**” appears on the touch screen, tap **Yes**.

     Printing will resume, starting from the page on which the error occurred.

• **Paper not being used under the recommended usage conditions**

  Every paper type has different recommended conditions of use. Use all paper under its recommended usage conditions.

  See the media information list for recommended usage conditions.

  ➤ **Paper Information List**

• **The paper in use cannot be used with Automatic cut**

  Set the roll paper cutting method to **User cut** and cut the roll paper with a cutting implement such as scissors.

  ➤ **Specifying the Cutting Method for Rolls**
See the media information list for paper types that can be used with **Automatic cut**.

⇒ Paper Information List

If this does not apply, there may be a cutter blade malfunction.

Contact your Canon dealer for assistance.
Cause

Paper feed adjustment may have failed for the following reasons.

- The paper for printing a test pattern is soiled. Otherwise, you have loaded colored paper.
- The printer may be exposed to strong light, such as direct sunlight, which can cause the sensors to malfunction.
- The test pattern was printed too faintly.

What to Do

Tap OK on the touch screen to dismiss the error, and then take the following actions.

- Load unused paper.
- Make adjustments to ensure that the printer is not exposed to strong light.
- Print a nozzle check pattern to check the print head status.

If the pattern has gaps or horizontal white lines, the print head nozzle is blocked. Clean the print head.

⇒ Checking for Nozzle Clogging
4932

Cause
The print head cannot be calibrated because the printer is loaded with very transparent film-type paper.

What to Do
Tap OK on the touch screen to dismiss the error.
We recommend calibrating the print head with a frequently used, non-film paper.

⇒ Automatic Adjustment to Straighten Lines and Colors
Cause
The print head nozzle may be blocked.

What to Do
Follow the steps below to repeat Print head alignment.

1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.
   - Checking for Nozzle Clogging
3. If the nozzle is blocked, clean the print head.
   - Cleaning the Print Head
4. Repeat Print head alignment.
   - Automatic Adjustment to Straighten Lines and Colors
4934

Cause
The print head nozzle may be blocked.

What to Do
Follow the steps below to repeat Print head alignment.

1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.
   ➤ Checking for Nozzle Clogging
3. If the nozzle is blocked, clean the print head.
   ➤ Cleaning the Print Head
4. Repeat Print head alignment.
   ➤ Automatic Adjustment to Straighten Lines and Colors
4935

Cause
The print head nozzle may be blocked.

What to Do
Follow the steps below to repeat Print head alignment.

1. Tap OK on the touch screen to dismiss the error.
2. Print a test pattern to check the nozzles.
   - Checking for Nozzle Clogging
3. If the nozzle is blocked, clean the print head.
   - Cleaning the Print Head
4. Repeat Print head alignment.
   - Automatic Adjustment to Straighten Lines and Colors
Causes
Print head position adjustment failed.

What to Do
Tap OK on the touch screen to dismiss the error and retry **Print head alignment** following the steps below.

1. Print a test pattern to check the nozzles.
   - [Checking for Nozzle Clogging](#)
2. If the nozzle is blocked, clean the print head.
   - [Cleaning the Print Head](#)
3. Retry **Print head alignment**.
   - [Automatic Adjustment to Straighten Lines and Colors](#)

If any print head nozzles are still blocked, replace the print head.
- [Replacing the Print Head](#)

If the error appears again, the printer may be damaged. Contact a Canon customer service center.
4950

**Cause**

WPS (Push button method) connection failed.

**What to Do**

Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
4951

Cause
AOSS (BUFFALO) connection failed.

What to Do
Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
4952

**Cause**

Failed to connect to the wireless LAN router.

**What to Do**

Follow the instructions on the touch screen to try connecting to the wireless LAN router again.
4953

Cause
Failed to acquire IP address.

What to Do
Check the information that appears on the touch screen, and then try connecting again.
Cause
Failed to set up wireless LAN using Easy wireless connect.

What to Do
Tap OK on the touch screen to dismiss the error, and then configure the settings again.
4955

Cause
IPv4/IPv6 settings were changed, but wired LAN and wireless LAN are disabled.

What to Do
Tap OK on the touch screen to dismiss the error, and then enable wired LAN or wireless LAN.
4956

Cause

Attempted to change LAN settings, but they cannot be changed for the following reasons.

- Printer is operating
- Printer currently being configured using Remote UI

What to Do

Tap OK on the touch screen to dismiss the error, exit other processes and then configure the settings again.
4957

Cause

Raku Raku WLAN Start (NEC) connection failed.

What to Do

Tap OK on the touch screen to dismiss the error and try connecting again.
5106

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC03-4061
5200

**Cause**
A printer error has occurred.

**What to Do**
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**
EC21-2F7E
Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC22-4001
5B20

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC41-4001
5B21

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC48-4001
5C00

**Cause**
A printer error has occurred.

**What to Do**
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

**Detailed error codes**
EC31-4001
6502

**Cause**
A printer error has occurred.

**What to Do**
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**
EC56-2FE0
6700

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC57-404F
Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC57-4040
6820

**Cause**
A printer error has occurred.

**What to Do**
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

**Detailed error codes**
EC07-4060 EC51-4041 EC51-4042 EC51-4045 EC51-4046 EC51-4047 EC51-404C EC51-404D
EC51-404E EC51-4070 EC51-4071 EC51-4072
6900

**Cause**
A printer error has occurred.

**What to Do**
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**
EC51-3000
A printer error has occurred.

What to Do

Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes

EC51-3001
6902

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3006
6910

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3002
6911

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3003
A printer error has occurred.

**What to Do**

Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**

EC51-3004
6921

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3005
6930

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3100
6931

**Cause**
A printer error has occurred.

**What to Do**
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**
EC51-3101
A printer error has occurred.

Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

EC51-3102
A printer error has occurred.

What to Do

Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes

EC51-3103
6940

Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3104
6941

**Cause**
A printer error has occurred.

**What to Do**
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**
EC51-3105
A printer error has occurred.

Turn off the power and unplug the power cord. Wait a moment and turn the power back on. If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

EC51-3106
A printer error has occurred.

**What to Do**

Turn off the power and unplug the power cord.

Wait a moment and turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**

EC51-3107
Cause
A printer error has occurred.

What to Do
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes
EC51-3108
A printer error has occurred.

Turn off the power and unplug the power cord. Wait a moment and turn the power back on.

If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

Detailed error codes

EC51-3109
6946

**Cause**
A printer error has occurred.

**What to Do**
Turn off the power and unplug the power cord.
Wait a moment and turn the power back on.
If the error appears again, make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then contact a Canon customer service center.

**Detailed error codes**
EC51-3110
7050

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC51-5001
Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC51-5002
7052

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC51-5003
8200

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC24-4049 EC24-404A EC24-404B
9000

**Cause**

A printer error has occurred.

**What to Do**

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.

Contact your Canon dealer for assistance.

**Detailed error codes**

EC51-2F07
9110

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC52-4038 EC52-4039
Cause

A printer error has occurred.

What to Do

Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.

Contact your Canon dealer for assistance.

Detailed error codes

EC03-403A
B510

Cause
A printer error has occurred.

What to Do
Make a note of the detailed error code (ECxx-xxxx) that appears on the touch screen, and then turn off the power and unplug the power cord.
Contact your Canon dealer for assistance.

Detailed error codes
EC32-4001